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Download software patches

Manage support contracts

Look up HP support contacts

Review information about available services

Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to
https://softwaresupport.hp.com and click Register.

To find more information about access levels, go to: https://softwaresupport.hp.com/web/softwaresupport/access-levels

HP Software Integrations, Solutions and Best Practices

Visit the Integrations and Solutions Catalog at https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01702710 to explore how the
products in the HP Software catalog work together, exchange information, and solve business needs.

Visit the Cross Portfolio Best Practices Library at https://hpin.hp.com/group/best-practices-hpsw to access a wide variety of best practice documents and materials.
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Platform Administration Overview

This guide provides instructions on how to open, configure, and administer HP Business Service
Management (BSM).

The guide is divided into the following parts:

« Accessing and Navigating BSM. Describes how to start BSM, how to log into the application,
and a general overview of the user interface.

« Setup and Maintenance. Describes basic setup options such as infrastructure settings, time
zones, languages, logs, and backups.

« Data Enrichment. This part has the following sections:
= Location Manager. Describes how to work with multiple geographic locations.

m Content Packs. Describes how to define objects or Cls included in content packs monitored by
BSM.

« Users, Permissions, and Recipients. Describes how to control user access to BSM.
« Reports and Alerts Administration. Describes how to schedule reports and set up alerts.
- Downtime Management. Describes how to control system downtime.

« Troubleshooting. Discusses common system issues or limitations.
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Part 1: Accessing and Navigating BSM

HP Business Service Management (9.26) Page 10 of 397



Chapter 1: Starting, Stopping, or Restarting BSM

This section provides instructions for starting, stopping, or restarting BSM.

Note: If you are working in a distributed environment, first enable the Data Processing Server, and
then enable the Gateway Server.

Tasks

How to Start, Stop, or Restart BSM
To start or stop BSM in Windows:

Select Start > Programs > HP Business Service Management > Administration > Enable |
Disable Business Service Management.

To start, stop, or restart BSM in Linux:
/opt/HP/BSM/scripts/run_hpbsm <start | stop | restart>
To start, stop, or restart BSM using a Daemon Script: (in Linux)
/etc/init.d/hpbsmd <start | stop | restart>
Note: When you stop BSM in Windows, the HP Business Service Management service is not

removed from Microsoft’s Services window. The BSM service is removed from the Services
window only after you uninstall BSM.

Ul Description

Windows Start Menu

In a Windows environment, the installation process adds an HP Business Service Management menu
to the Windows Start Menu.
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This menu includes the following options:

Option Description

Open HP Business Service Opens the BSM application Login page in a web browser.
Management

Administration > Configure HP Runs the Setup and Database Configuration utility. This
Business Service Management enables you to create and connect to management, RTSM,

RTSM history, and application databases/user schemas on
Microsoft SQL Server or Oracle Server. For details, see
Server Deployment and Setting Database Parameters in the
BSM Installation Guide.

Administration > Disable HP Stops BSM on the specific machine, and disables it from
Business Service Management running automatically when the machine is started.
Administration > Enable HP Starts BSM on the specific machine, and sets it to run
Business Service Management automatically when the machine is started.

Administration > HP Business Opens the BSM Status page in a web browser. This page
Service Management Status displays the status of the services run by the BSM Service

and High Availability Controller.

Documentation > HP Business Opens the BSM Help in a web browser.
Service Management Help
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Chapter 2: Viewing Status of Processes and Services

This section discusses how to view the status of processes and services run by the BSM service and
High Availability Controller.

Tasks

How to View the Status of Processes and Services
In Windows:

Select Start > Programs > HP Business Service Management > Administration > HP Business
Service Management Status.

In Linux:

Enter the following command: opt/HP/BSM/tools/bsmstatus/bsmstatus.sh

Troubleshooting and Limitations

Remote Viewing Limitations

« The JBoss application server must be running to enable viewing the status of the processes and
services from a remote computer.

o If JMX-RMI with basic authentication over SSL was set up using the SYSTEM user in Window or
Linux, the processes and services status page does not display any data. For details on configuring
JMX-RMI with basic authentication over SSL, see Securing JMX-RMI Channel Used for Internal
BSM Communications in the BSM Hardening Guide.
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Chapter 3: Logging into BSM

This section provides instructions for logging into BSM.

Note: HP Software-as-a-Service customers access BSM using the HP Software-as-a-Service
support Web site (portal.saas.hp.com).

Learn About

Accessing BSM

You can access BSM using a supported web browser, from any computer with a network connection
(intranet or Internet) to the BSM servers.

Note: You can only open one BSM session per browser.
The level of access granted to a user depends on the user's permissions. For more information, see

"Permissions" on page 189.

By default, BSM is configured with Lightweight Single Sign-On (LW-SSO). For more information, see
"Logging into BSM with LW-SSQO" on page 22.

The following table provides information on how to access BSM based on BSM's LDAP configuration.

User login APIs/REST

No LDAP —only = No LDAP field. The domain name is not required.

internal users , . . :
The domain name is not required. Youcan | Optional: You can enter

enter your user name or internal/user name. | internal/user name.

Only one LDAP = No LDAP field. The domain name is not required.
The domain name is not mandatory. Optional: You can enter your
domain/user name.
You can enter your user name or
domain/user name.

Several LDAPs  LDAP field drop down list appears. —

HP Business Service Management (9.26) Page 14 of 397


http://portal.saas.hp.com/
http://portal.saas.hp.com/

BSM Platform Administration Guide
Chapter 3: Logging into BSM

User login APIs/REST
Mixed mode No LDAP field. The domain name is not required.
with one LDAP , . .
The domain name is not mandatory. Optional: You can enter your
internal/user name or domain/user

You can enter your user name or

. ) name.
domain/user name or internal/user name.

Several LDAPs | LDAP field drop down list appears and —
with mixed contains internal name
mode

Requirements

For details on browser requirements, as well as minimum requirements to view BSM, see the BSM
System Requirements and Support Matrixes guide.

Tasks

This section includes:
« "How to Log into BSM" below
« "How to Enable Automatic Login" on the next page
« "How to Modify Automatic Login Settings" on the next page
o "How to Log In Using a URL" on page 17

» "How to Log Out of BSM" on page 17

How to Log into BSM

1. Inabrowser, enter the following URL:
http://<server_name>.<domain_name>/bsm

where

<server_name> and <domain_name> represent the Fully Qualified Domain Name (FQDN) of
the BSM server (for example, http://server1.domain1.ext/bsm). If there are multiple servers, or if
BSM is deployed in a distributed architecture, specify the load balancer or Gateway Server URL,
as required.

2. Enteryourlogin name and password. Initial access can be gained using the administrator user
name ("admin") and password. If there are multiple LDAP configurations, select the relevant
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LDAP domain to access BSM.

Note: The password is configured in the final step of the Setup and Database Configuration
utility or in the Config server utility which can be run separately from the installation.

Caution: We recommend that the system superuser change this password upon first login to
prevent unauthorized entry. For details on changing the user password, see "Personal
Settings" on page 283. The login name cannot be changed.

After you log in, your login name appears at the top right of the page, under the top menu bar.

Note: If Lightweight Single Sign-On (LW-SSO) is disabled, you do not need to add the .<domain_
name> syntax in the login URL. For information on LW-SSO, see "Logging into BSM with LW-
SSO" on page 22.

How to Enable Automatic Login

If you enable automatic login, when you open BSM, the Login page does not appear and you do not
have to enter your user name or password to access BSM.

Caution: This could be considered a security risk and should be used with caution.

1. Onthe BSM Login page, select Remember my login name and password for 14 days.
2. When completing your session, close the browser window. Do not click Logout at the top of the

page. Clicking Logout disables the automatic login option and requires the login name and
password to be entered when accessing BSM.

How to Modify Automatic Login Settings
1. Navigate to Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Click Foundations and select Security. In this context, you can modify the following options:

Option Does the following

Days to Sets the number of days that users can log in automatically without entering a user
remember name and password. The default value is 14.
login
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Option Does the following

Enable If this option is set to true, the Remember my login name and password check
automatic = box appears in the Login page. Selecting this check box in the Login page enables
login the user to log in without opening the Login page when next accessing BSM. For

details see "How to Enable Automatic Login" on the previous page.

If this option is set to false, users cannot bypass the Login page and will always
need to enter a user name and password when opening BSM. The default value is
true.

Maximum  Sets the number of machines that can simultaneously access BSM using the
machines same login name. The default value is 0 which means that the number of logins is
per login  unlimited. It is highly recommended to set the maximum number of sessions to 1.
name

How to Log In Using a URL

You can log into BSM using a URL that contains several parameters (including your login name and
password). This is a convenient way to create a bookmark to BSM or to send a direct link to other
users.

Caution: Though convenient, this method is not secure since the password is not encrypted in the
URL.

In a browser, enter the following URL:
http://<server_name>.<domain_name>/<HPBSM_root_directory>/TopazSiteServiet?
autologin=yes&strategyName=Topaz&requestType=login&userlogin=
<loginname>&userpassword=<password>&createSession=true

where:
« <server_name> represents the name of the BSM server.

« <domain_name> represents the name of the user's domain according to the user's network
configuration.

« <loginname> and <password> represent the login name and password of a user defined in BSM.

You can also create a URL to access BSM using the Link to This Page window. For further information,
see "Creating a Link to a BSM Page" on page 26.

How to Log Out of BSM

When you complete your session, it is recommended that you log out to prevent unauthorized entry.

Click Logout at the top of the page.
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Note: Clicking Logout cancels the Automatic Login option. If a user logs out, the next time the
user logs in, the Login page will open and the user will need to enter a login name and password.
This can be useful if another user needs to log in on the same machine using a different user name
and password.

Ul Description

BSM Login Page

User interface elements are described below:
Ul Element (A-Z) Description
LDAP domain If there are multiple LDAP Configurations or if Mixed mode

authentication is enabled, select the relevant domain to access BSM.

Login Name Enter the relevant login name to access BSM.
Password Enter the relevant password to access BSM.
Remember my login Select this option to bypass the Login page the next time you open
name and password for = BSM. For further information, see "How to Enable Automatic Login" on
14 days page 16.

Tips/Troubleshooting

Login Troubleshooting

To resolve login issues, reference the possible login failure causes in the following table using the error
number shown in the error alert dialog box. For additional troubleshooting information, refer to the HP
Software Self-solve Knowledge Base.
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Error
No. Problem/Possible Cause(s)

LI0O01 BSM failed to connect to the JBoss
application server running on the

Gateway Server. This may be due to:
« The JBoss server being down.
« Problems with the BSM service.

« The port required by the
application server being used by
another application.

LI002 = The JBoss application server running
on the Gateway Server is not
responding or is not installed

correctly.

LIO03 = The management database is
corrupted (for example, if a user
record was accidentally deleted from

the database).

LIO04 The connection between the Tomcat
servlet engine and the JBoss
application server failed due to a
Remote Method Invocation (RMI)
exception. This may be due to

problems in RMI calls to JBoss.

HP Business Service Management (9.26)

Solution(s)

Solution 1: Close all applications on the Gateway
Server machine and restart the machine.

Solution 2: Ensure that there are no other running
applications on the Gateway Server machine that
use this port (for example, applications that run from
the Startup directory, another instance of JBoss, an
MSDE or Microsoft SQL Server, or any other
process).

Restart BSM.

Try logging in as a different user, or ask the BSM
administrator to create a new user for you.

Ensure that none of the JBoss ports are in use by
another process. Also, ensure that the RMI ports
are bound.

For details on ports, see "Port Usage" on page 113.
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Error

No. Problem/Possible Cause(s)

LIO0S | The BSM login fails or hangs. This
may be due to:

« Anincorrect login name/password
combination.

« Aninability to connect to the
management database.

« The current user does not have
access rights to a profile.

« Authentication strategy has not
been set/configured correctly.

HP Business Service Management (9.26)

Solution(s)

Solution 1: Ensure that you enter a correct login
name/password combination.

Solution 2: Ensure that the connection to the
management database is healthy:

1. Inthe web browser, type http://<Gateway or
Data Processing Server name>:29000 to
connect to the JMX management console.

2. Click the link System > JMX MBeans >
Topaz > Topaz:service=Connection Pool
Information.

3. Locate java.lang.String
showConfigurationSummary() and click
Invoke.

4. In Active configurations in the Connection
Factory, find the appropriate row for the
management database.

5. Verify that columns Active Connection and/or
Idle Connection have a value greater than 0
for the management database.

6. If there is a problem with the connection to the
database, verify that the database machine is
up and running. If required, rerun the Setup and
Database Configuration utility.

Solution 3: Ensure that the user has appropriate
permissions to access BSM. For details on user
permissions, see "Permissions" on page 189.

Solution 4: Verify that an authentication strategy
has been configured correctly. For details on
authentication strategies, see "Authentication
Strategies" on page 291.
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Error

No. Problem/Possible Cause(s)

LIO06 | The BSM login fails. This may be due
to:

« Incorrect cookie settings in the
web browser.

« Anunsupported character in the
names of the machines running
the BSM servers.

LIO07 | The BSM login fails. This is because
the maximum number has been
reached of concurrent logins from
different machines that access HP
Business Service Management using
the same login name.

Forgot Password

Solution(s)

Solution 1: Ensure that the client web browser is
set to accept cookies from BSM servers.

Solution 2: Ensure that there are no underscore
characters (_) in the names of the machines running
the BSM servers. If there are, either rename the
server or use the server's IP address when
accessing the machine. For example, to access
BSM, use

http://111.222.33.44/<HPBSM root
directory>

instead of

http://my_server/<HPBSM root directory>

Solution 1: Log out of the instances of BSM that
have logged in using the same login name from
different machines. You can then retry logging in, if
the maximum number has not been reached.

Solution 2: Log in using a different login name, if
available.

Solution 3: The administrator can edit the
Infrastructure Settings to remove the limitation or
increase the maximum number of concurrent logins
using the same login name from different machines.
For details, see "How to Modify Automatic Login
Settings" on page 16.

To reset your password, contact your system administrator.

For information about assigning passwords, see "Configure BSM Users" on page 184 and "Define a

Superuser" on page 184.

HP Business Service Management (9.26)
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Chapter 4: Logging into BSM with LW-550

Lightweight Single Sign-On (LW-SSO) Authentication Support enables users to log into BSM
automatically and securely without needing to enter a user name and password.

Learn About

Working with LW-SSO

By default, BSM is configured with Lightweight Single Sign-On (LW-SSO). With LW-SSO, once you log
in to BSM you automatically have access to other configured applications, without needing to log into
those applications.

When LW-SSO Authentication Support is enabled, you must ensure that the other applications in the
Single Sign-On environment have LW-SSO enabled and are working with the same initString. If the
applications are in different domains, the domains must be trusted domains.

Disabling LW-SSO

If you do not require Single Sign-On for BSM, it is recommended that you disable LW-SSO. You can
disable LW-SSO using the SSO Configuration Wizard. For information on how to disable LW-SSO
using the SSO Configuration Wizard, see "How to Disable LW-SSO" on the next page.

Using Client-Side Authentication Certificates for Secure User Access to BSM

You can provide user access to BSM using client-side authentication certificates. This provides a
secure alternative to entering a user name and password to log in.

From the SSO Configuration Wizard, you can configure LW-SSO to accept such certificates. When a
certificate is accepted, users are automatically logged into BSM if the client certificate card is inserted
in the machine. If LW-SSO is configured to accept certificate, users are not able to login to BSM
without the client certificate card. For information about the SSO Configuration Wizard, see "SSO
Configuration Wizard" on page 306.

For configuration instructions, see "Smart Card Authentication on BSM Servers" in the Smart Card
Authentication Configuration Guide.

Using an External Authentication Point for Secure User Access to BSM

LW-SSO 2.4 enables you to use an external authentication point. This allows you to use your own
credential validation method, for example LDAP, a proprietary user/password database, or a custom
SSO solution.
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The external authentication point is an external URL that performs the actual user authentication. It
obtains the user credentials (usually the user name and password, but it could be something else, such
as the user's class-B certificate, or a proprietary SSO token), validates these credentials, and then
creates an "authentication assertion", a token that states who the authenticated useris. The
authentication assertion usually also provides information about how the user was authenticated.

For information about configuring an external authentication point for secure access to BSM, see
"LDAP General Configuration Page" on page 301.

Tasks

How to Disable LW-SSO

1. Select Admin > Platform > Users and Permissions > Authentication Management, and
click Configure.

2. Select Disable to disable SSO.

How to Secure User Access to BSM Using an External Authentication Point

1. If you are using LDAP, ensure that the same user repository is used by BSM and the
authentication point server.

If you are not using LDAP, create the users manually in BSM.

2. Setthe LW-SSO configuration file on the authentication point server side to use the same
initString as in BSM.

a. Inabrowseron the BSM Gateway server, enter the URL of the JMX console:
http://<Gateway or Data Processing Server name>:29000/

b. Enter your JMX console authentication credentials. The JMX Agent View appears.
c. Under the domain name Topaz, click service=LW-SSO Configuration.

d. Locate the AuthenticationPointServer attribute and enter the Authentication Point Server
URL.

e. Locate the ValidationPointEnabled attribute and set it to true.

f. If you do not want particular URLSs to use this feature, locate addNonsecureURL() and add
the URLs to the list.

g. Click Apply Changes.
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3. Restart the BSM Gateway server.

4. Make sure that you can log into BSM through the external authentication point. If you are unable to
login, see "Unable to Log into BSM when Using an External Authentication Point" on page 314.

Tips/Troubleshooting

BSM Login Page Appears after Entering Valid Client Certificate

If the BSM Login page appears after entering a valid client certificate, test the following:

« Trytologin using the User Identifier (often email address).
If you can log in, make sure that the LDAP user filter was configured to use the same user identifier.

« Ifthe Login page still appears and you are using the Apache web server, add the following to <BSM
Gateway installation directory>/Webserver/conf/extra/httpd-ssl.conf under #SSLOptions:
SSLOptions +ExportCertData.

For details on how to configure Apache to require a client certificate, see "Configuring Apache to
Require a Client Certificate" in the BSM Hardening Guide. A link to the Hardening Guide can be
found on the Planning and Deployment Documentation page.

Resetting LDAP/SSO Settings Using the JMX Console

If your LDAP or SSO settings have not been configured properly, you may not be able to access BSM.
If this happens, reset your LDAP or SSO settings remotely using the JMX console.

1. Inthe JMX Agent View, under the domain name Topaz, click service=SSO.

2. Locate the void setSingleSignOnMode() attribute and set it to Disabled.

Unable to Login

If LDAP is configured and you are unable to login:

1. Inthe JMX Agent View, under the domain name Foundations, click service=users-remote-
repository.

2. Locate void disabledLDAPConfiguration() and invoke it to disable all LDAP configurations.
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Users

This section provides instructions for tracking who attempted to log into BSM, and for displaying a list
of users currently logged in.

How To Track Who Attempted to Log into BSM

Open the following file:
<HPBSM GW root directory>\log\Jboss\UserActions.servlets.log.

How To Display a List of Users Currently Logged into BSM

1. Open the JMX console on the machine that is running BSM. (For detailed instructions, see "JMX
Console" on page 93.)

2. Under the Topaz section, select service=Active Topaz Sessions.

3. Invoke the java.lang.String showActiveSessions() operation.
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This section provides instructions for sending a user to a target page in BSM.

To access
Select Admin > Link to this page.

Learn About

Overview

Depending on which Link to this page option you select, the receiver can access a BSM page using
one of the following:

« Their own user name and password.
« A URL encrypted with your user name and password.

« A URL encrypted with another user's user name and password.

Note: By default, only administrators have permission to access this feature.

Using an Encrypted URL

When using an encrypted URL, the receiver bypasses the BSM Login page because the URL supplies
the user name and password information.

The user name in the URL must be an account with sufficient privileges to access the target page. If
the account does not have sufficient privileges, a higher level page for which the receiver has
permissions appears.

Example:

You want to direct the receiver to the Infrastructure Settings page, but you select the Use
credentials option for a regular user (who is not authorized to view Infrastructure Settings). When
areceiver enters this URL, the receiver is sent to the Setup and Maintenance page and is unable to
access Infrastructure Settings.
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Verifying User Names and Passwords

The Link to this page option does not verify the user name and password sent in the URL. Verification
is done only when the receiver tries to access the target page. If the user name and password are not
correct, or the user account has been deleted, the receiver is sent to the BSM Login page to log in
normally. Once logged in, the receiver does not proceed to the target page and there is no message
displaying the reason for the login failure.

Third-party Portals

To view Service Health or MyBSM pages in a third-party portal, select the Embedded link check box
in the Link to this page window. When the user accesses the generated URL, only the specific page
is displayed, and not the entire BSM application with menus.

Note: In a third-party portal, only one Service Health or MyBSM page can be embedded in each
portal page. If you need to see more information, create a page that uses multiple or tabbed
components. For details, see "How to Set Up the MyBSM Workspace" in the BSM User Guide.

Creating a Direct Link to RTSM

You can create a link to a specific target page in Run-time Service Model (RTSM) using the Direct
Links feature. For details on Direct Links, see "Generate a Direct Link - Overview" in the Modeling
Guide.

Security Notes and Precautions

When using BSM direct login, the user name and password in the URL are encrypted so that no login
information is ever revealed.

Sending encrypted information by email entails a security risk, since the mail system can be breached.
If the email is intercepted, access to BSM is given to an unknown party.

Do not use the URL from Direct Login as a link in any web page.

Receivers have all privileges of the user name they were given in the URL.

Tasks

How to Create and Send a Link to a User

1. Access the BSM page whose link you want to send to a user.

2. Click Admin > Link to this page.
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3. Select one of the following:

m Tocreate alink with no user name or password, click No credentials. Users will need to enter
their own user name and password.

m Tocreate alink with your user name and password, click My credentials.

m Tocreate alink with another user's user name and password, click User credentials and in the
login name and password fields, enter a user name and password of a BSM user.

4. Click Create a link.
5. Click Copy to clipboard.

6. Send thelink to the user.

Ul Description

Link to This Page Window
User interface elements are described below:
Ul
Element
(A-2) Description
Cancel Cancels the Link to This Page operation.

Create link Creates the URL of the current BSM page. The user enters this URL in their browser
and the specified BSM page is displayed.

Note: If you select this option after selecting No credentials or Use credentials (to
use credentials other than your own) and you want to invoke the login URL on the
same local machine you created it on, you must first log out of BSM.

Confirm Re-enter the password entered in the Password field.
password

Copy to Copies the content of the Link field to the clipboard. This button is only available after
clipboard  you click Create Link.

Note: If you use the Firefox browser, you must change your security settings for this
option to work. Enter about: config in the browser's search window, locate the
signed.applets.codebase_principal_support option, and set it to true.
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Ul
Element
(A-Z)

Embedded
link

Generate
HTML

Link

Login
name

My
credentials

No
credentials

Password

Use
credentials

Description
Displayed in Service Health and MyBSM only.

Select this check box to create a URL which can be used in a third-party portal, so that
only the specific page is displayed, and not the entire BSM application with menus.

Generates an HTML page for the specified BSM page.

Note: If you select this option after selecting No credentials or Use credentials (to
use credentials other than your own) and you want to log in using the generated HTML
page on the same local machine you created it on, you must first log out of BSM.

Displays the URL that the receiver uses to access the specified BSM page.

Note: This field only appears after clicking Create link.

The login user name to be encrypted in the URL the receiver uses to access the
specified page. This must be the user name of an actual user.

Select to encrypt the link with your user name and password.

Select if receivers need to use their own user name and password to access the page
specified in the link.

The password to be encrypted in the URL that the receiver uses to access the
specified page. This must be the password of an actual user.

Select to encrypt the link with the login user name and password of another user.
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BSM runs in a web browser. This section describes BSM navigational functions and the BSM user
interface.

Learn About

Site Map

The Site Map enables quick access to all top- and second-level contexts in the Applications or
Administration menu. By default, the Site Map is the first page that opens after logging into BSM.You
can also access the Site Map by clicking the Site Map link on the menu bar.

I5¥1  Business Service Management - Site Map

¢ - MESM  Aplicaions +  Admin v Help v SheMa
e
AoiicEons Agministraton
= Service Health B System Availability Manai
m iew Sulldsr ). Bummany

pm— [ —

Customimags

O 2ake i + ., Service Health Analyzer

@ —

Assignments - Mesim aizstor Az grmens | KB Assigamens | Srozapetion Sules
1 sstection

Rpostionss - kP | icxrs | Busness Ruies | COmaC e
Event Tampists

Service Level Management Veriastion Tools

Agreemants Manager e Bope Templates

£L4 Date Corraation: - -

o RTSM Administration
Mosating - T Usharsa Lissaer | Loseiing

Assignments - Heatn indicator AsSignmens | KPI Assigrments | Pronagation Rules Ervichman: mansgar

Servises Mensger Cats Flow Manzgement - Rxzonsiianon Pr

Title and Menu Bars

The title bar displays a logo, the name of the active BSM application, and the current user. It also
displays the Full Screen View link and a Logout button - Logout |

The menu bar enables navigation to the applications, Administration Console pages, help resources,
and a link to the Site Map. For more information, see "Ul Description" on page 33.

My BSM  Applications ~  Admin+~ Help~ Site Map

Tabs

Tabs enable navigation to various contexts within a particular area of BSM, such as to different types of
reports within an application, views within a report, or administrative functions within the Administration
Console. In certain contexts, tabs are used to distinguish between functions; in other contexts, tabs
are used to group logically similar functions or features together.

The tab main menus enable navigation from a tab front page to various contexts related to the tab. Tab
main menus appear when selecting a tab that represents a category containing several contexts, such
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as report types or administrative settings. Tab main menus include a description and thumbnail image
of each tab context.

Setup and Maintenance | Report Scheduling Locations

Downloads 7

Download HP Business Service
Management components, including tools
for menitoring yvour enterprize and
recording business processes.

License Management 7 e —

Wiew and update your licensing
information. i e

Tab controls enable you to navigate from any context related to a tab to any other of the tab's contexts.
To open the tab main menu, click the tab name.

To quickly jump to another context related to the tab, click the down arrow (= to open the tab drop-down
menu and click a tab menu option to move to that context.

Setup and Maintenance ‘ Re

Downloads

Licenze Management

Data Partitiening and Purging
Manage Profile Databazes
Sy=tem Health
Infrazstructure Settingz
Audit Log

Server Deployment

Navigation Buttons

-

The forward and back buttons, *-?—-]-'-—-" , positioned in the upper left corner of the window, enable
you to navigate between viewed pages. You can go back to your most recently viewed page or forward
to the page you viewed before you clicked the back button.

Clicking the down arrow adjacent to the forward and back buttons, displays a list of the last 20 pages
that you viewed during the current session. You can click any one of these links to display the desired
page.

The pages are stored in the BSM server. For all reports, if you return to a previously viewed page, the
page opens exactly as you left it with the filters and conditions selected as previously.

There are several pages whose contexts and selections are not saved as previously viewed and when
you return to that page, you may have to make your selections again. For example, if you were working
in a specific context in Infrastructure Settings and return to the Infrastructure Settings page using the
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history option, your context has not been saved and you are returned to the default Infrastructure
Settings page.

Tip: You can change the number of pages stored in history (default is 20) by accessing the file
<HPBSM GW root directory>\confisettings\website.xml and changing the value of the
history.max.saved.pages field. You must restart BSM for the change to take affect. This change
is on the server and, therefore, affects all users.

Breadcrumbs

Breadcrumbs enable you to keep track of your location within the active application. They provide links
back to each page you navigated through to get to the current page.

You can view previous pages within a multi-level context by clicking one of the links in the breadcrumb.
For example, in the following breadcrumb trail, you would click Breakdown Summary to return to the
Breakdown Summary report:

Business Process = Breakdown Surnmary > Tranzaction Breakdown Raw Data = WebTrace by Location

If the breadcrumb is longer than the width of the screen, only the tail of the breadcrumb is displayed.

Click the View Et icon to the left of the breadcrumb to display the hidden portion of the breadcrumb in
the current tab.

Tip: The web browser Back function is not supported in BSM. Using the Back function does not
always revert the current context to the previous context. To navigate to a previous context, use
the navigation buttons within BSM or the breadcrumb function.

Tasks

How to Access Full Screen View

Note: When selecting Full Screen View, Menu Bar, Breadcrumbs, and Tabs are hidden.

« Click the Full Screen View link to display the current page over the full screen.

« Toreturn to the standard view of the page, click Standard View or press Esc on your keyboard.

How to Change the Default Entry Page

The Site Map is the default page displayed when you log into BSM. You can select a different BSM
page to display when you log in.
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1. From the upper right corner of the Site Map, click Change the default page.
2. Onthe Personal Settings page, click the Customization Menu tab.
3. Inthe left pane, highlight the page you want to display when you log into BSM.

4. Click Set at Default Entry Context.

Ul Description

The Menu Bar enables navigation to the following applications and resources:

My BSM  Applications = Admin+ Help-  Site Map

o "MyBSM " below
« "Applications Menu" below
o "Admin Menu" on page 35

« "Help Menu" on page 36

MyBSM

Opens the MyBSM application, a portal that individual users can customize to display key content
relevant to them. For details, see "Monitoring Your Environment With MyBSM" in the BSM User
Guide.

Applications Menu

BSM features the business user applications listed below. You access all applications from the
Applications menu, except for the MyBSM application which is accessed from the Menu Bar.

Note: Only applications for which you have a valid license will appear in the Applications menu.

Menu

Option Description

Service Opens the Service Health application, a real-time dashboard for viewing

Health performance and availability metrics from a business perspective. For details, see

"Introduction to Service Health" in the BSM User Guide.
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Menu
Option

Cl Status

Service
Level
Management

End User
Management

Operations
Management

Transaction
Management

System
Availability
Management

Service
Health
Analyzer

User
Reports

Application
Management
for SOA

Description

Opens the CI Status Reports interface. Cl Status reports enable you to view and
analyze performance data collected by BSM data collectors and stored in the BSM
database. For details, see "Cl Status Reports User Interface" in the BSM User
Guide.

Opens the Service Level Management application to proactively manage service
levels from a business perspective. Service Level Management provides IT
Operations teams and service providers with a tool to manage service levels and
provide service level agreement (SLA) compliance reporting for complex business
applications in distributed environments. For details, see"Working with the Service
Level Management Application" in the BSM User Guide.

Opens the End User Management application, used to monitor applications from the
end user perspective and analyze the most probable cause of performance issues.
For details, see "End User Management Reports Overview" inthe BSM User
Guide.

Opens the Operations Management application, used to proactively manage events
from a business perspective, in order to restore services and minimize service
disruptions. For details, see "Operations Management Overview" in the BSM User
Guide.

Displays transaction topology and infrastructure for data collection and report
viewing. For details, see "Transaction Management Overview" in the BSM User
Guide.

Opens the System Availability Management application, used for complete system
and infrastructure monitoring as well as event management. For details, see
"System Availability Management Overview" in the BSM User Guide.

Opens the Service Health Analyzer application, used to view Cls with anomalies.
For further information, see "Service Health Analyzer Overview" on page 1

Opens the Report Manager, used for creating and saving user reports—customized
reports containing user-defined data and formatting that can help you focus on
specific aspects of your organization's application and infrastructure resource
performance. For details on the Report Manager, see "User Reports Overview" in
the BSM User Guide.

Opens the Application Management for SOA reports. Used to monitor your Service
Oriented Architecture (SOA) environment, by monitoring the performance of SOA
components within the environment. For details, see "Application Management for
SOA Reports" on page 1 in Application Management for SOA.
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Admin Menu

Administrators use the Admin menu to administer the BSM platform and applications. The Admin
menu consists of several sections, organized by function.

Note: The options available to you depend on your deployment package.

Menu Option

Service Health

Service Level
Management

Operations
Management

End User
Management

System
Availability
Management

Service Health
Analyzer

RTSM
Administration

Platform

Description

Opens the Service Health Administration pages, where you attach health
indicators and Key Performance Indicators (KPIs) to Cls, define the custom and
geographical maps, and customize the repositories. For details, see "View-
Specific and Cross-View Administration" on page 1 in the BSM Application
Administration Guide.

Opens the Service Level Management Administration pages, where you create
service agreements (SLAs, OLAs, UCs) and build services that link to the data
that Service Level Management collects. For details, see "Introduction to SLM
Administration" on page 1 in the BSM Application Administration Guide.

Opens the Operations Management Administration pages. For details, see
"Operations Management Administration Overview" on page 1 in the BSM
Application Administration Guide.

Opens the End User Management Administration pages, where you configure and
administer Business Process Monitor and Real User Monitor data collectors, as
well as configure transaction order, color settings, and report filters. For details,
see "End User Management Administration" on page 1 in the BSM Application
Administration Guide.

Opens the System Availability Management Administration pages, where you
configure and administer the SiteScope data collector. For details, see "System
Availability Management Administration Overview" on page 1in the BSM
Application Administration Guide.

Opens the Service Health Analyzer application, used to view Cls with anomalies.
For further information, see "Service Health Analyzer Overview" on page 1

Opens the RTSM Administration pages, where you build and manage a model of
your IT universe in the Run-time Service Model (RTSM). From RTSM
Administration, you use Data Flow Management and the adapter sources that are
used to populate the IT Universe model with configuration items (Cls), the
templates for creating Cls, and the viewing system for viewing the Cls in BSM
applications. You can also manually create Cls to add to the model. For details,
see the Modeling Guide.

Opens the Platform Administration pages, which provide complete platform
administration and configuration functionality.
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Menu Option

Integrations

Link to this
page

Personal
Settings

Help Menu

Description

Opens the BSM Integrations administration area, where you can administer the
following:

« BSM Connector integrations to capture and forward data from third-party
systems to BSM.

« Mappings between Cls and Operations Orchestration runbooks.

« Application Lifecycle Management integrations to export related data and
monitoring tools configurations.

« Deprecated integration methods - Integrations Adapter and EMS Integrations.

For details, see "Integrating with Other Applications - Overview" on page 1

Select to access the Link to this page feature, where you can create a URL that
enables direct access to a specific page in BSM. For details, see "Creating a Link
toa BSM Page" on page 26.

By default only administrators have security rights to access this feature.

Select to access the Personal Settings tab, which enables personalization of
various aspects of BSM, including menus and passwords. Note that Personal
Settings are available to all users. For details, see "Personal Settings" on
page 283.

You access the following online resources from the BSM Help menu:

Menu Option

Help on this
page

BSM Help

Planning and
Deployment
Guides

Product News
and Updates

Description

Opens the BSM Help file to the topic that describes the current page or context.

Opens the BSM Help home page. The home page provides quick links to the
main help topics.

Opens a page with links to planning guides, installation and upgrade guides
(including release notes), data collector installation guides, and other resources.

Opens the Product News page on the HP Software Support website (requires
HP Passport login). The URL for this web site is
http://support.openview.hp.com/product_news.jsp.
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Menu Option

Troubleshooting

& Knowledge
Base

HP Software
Support

HP Software
Web Site

Movies

Site Map

What's New?

HP BPM
Anywhere

About HP
Business
Service
Management
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Description

Opens the troubleshooting page on the HP Software Support website (requires
HP Passport login). The URL for this web site is
http://support.openview.hp.com/troubleshooting.jsp.

Opens the HP Software Support website. This site enables you to browse the
knowledge base and add your own articles, post to and search user discussion
forums, submit support requests, download patches and updated
documentation, and more. The URL for this web site is
http://support.openview.hp.com/.

Opens the HP Software Support website, which contains information and
resources about HP Software products and services. The URL for this web site
is https://softwaresupport.hp.com

Opens the Movies panel with links to instructional movies about how to use
BSM.

Opens the site map, with links to all top-level contexts in the Applications menu
or the Administration Console.

Note: The Site Map is the default entry page when you log into BSM. To change
the default entry page, see "How to Change the Default Entry Page" on page 32.

Opens the What's New document, which describes the new features and
enhancements in this version.

Opens HP BPM Anywhere.

Opens the About HP Business Service Management dialog box, which provides
version, license, patch, and third-party notice information.
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Chapter 8: Customizing BSM

This section describes how to customize BSM.

Learn About

Section 508 Compliance

BSM is compliant with the accessibility and usability standards for people with disabilities set by the
US Federal Electronic and Information Technology Accessibility and Compliance Act ("Section 508"),
and supports the JAWS® screen reader. For more information, see "How to Enable Section 508
Compliance" on the next page.

Personalization

BSM remembers from one session to the next adjustments you made to tables (such as column width
and column visibility) in a variety of applications and features, such as recipient management, reports
management, reports, and report scheduling.

Note: If two or more users are logged in simultaneously with the same credentials, your settings
may not be saved.

Customization of the Title Bar

You can customize the header text of the application title and the logo (HP logo by default) displayed in
the upper left-hand corner of the BSM window. This change is made on the server side and affects all
users accessing BSM.

For details, see "How to Customize the Title Bar" on the next page.

Automatic Session Expiration

By default, a ping-to-server mechanism, called Session Keepalive, prevents your BSM session from
timing out when not in active use. You can enable automatic session expiration by disabling Session
Keepalive. If you disable Session Keepalive, your session expires after 5 minutes.

For details, see "How to Enable Automatic Session Expiration" on the next page.
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Tasks

How to Enable Section 508 Compliance
JAWS users should change the User Accessibility setting to true to comply with the Section 508.

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Select Foundations.
3. Select Business Service Management Interface.

4. Inthe Business Service Management Interface - Display area, locate User Accessibility and
select true.

How to Customize the Title Bar
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select the Foundations context.
3. Select Business Service Management Interface from the list.

4. Inthe Business Service Management Interface - Customized Masthead table, change the
following:

= Inthe Customized Masthead Application Title, enter the text to use as the title for the
application. Business Service Management appears by default if there is no value defined for
this field. You can use html coding to enter the text but do not include any scripts. If you using
html, verify its validity before saving.

= Inthe Customized Masthead Logo URL, enter the URL of the file containing the logo you
want to appear at the top of the window. The HP logo appears by default if there is no value
defined for this field. It is recommended to use an image with a height of 19 pixels. If the image
is larger, it does not appear correctly in the title bar.

When you modify these settings, the changes appear as soon as the browser is refreshed.

How to Enable Automatic Session Expiration

By default, a ping-to-server mechanism prevents your BSM session from timing out when not in active
use. You can enable automatic session expiration.
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1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select Business Service Management Interface.

4. Inthe Business Service Management Interface - Timing area, locate Enable Session
Keepalive and select false.

HP Business Service Management (9.26) Page 40 of 397



Chapter 9: Working with BSM Tables

You can manipulate tables in BSM in a number of ways.
Note: Not all tables support all table functionality.

The following is describes a variety of BSM table controls:

« Filtering. BSM tables include various filtering options. For advanced editing of filters, click .

« Sorting. Click a column heading to sort the table by that column. The sort order toggles between
ascending and descending order each time you click the column heading.

o Selecting columns. Click to select which columns to display.

« Changing column width. Drag a column heading border to the left or right to modify the column

width. Click to reset the column width to its original state.

« Changing column order. Drag a column heading to the left or right to change the order in which
the columns appear.

« Paging. Click the page control buttons Ll _[t-200f25 »| Mliomovetoatable's first,

previous, next, or last page.

[m
« Exporting. Click the appropriate button to export a table to another format, such as Excel @, PDF

, orCSV E

For details about table functionality in reports, see Common Report and Page Elements in the BSM
User Guide.
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Chapter 10: Downloads

After the servers for BSM are installed, there are several components that can be downloaded. These
components include tools for monitoring your enterprise and recording business processes.

These components are located separately in the Web delivery package download area. You can upload
them to the BSM Downloads page. These files can then be downloaded from BSM and used when
required.

You can also upload files to the Downloads page for internal web distribution to your users.

To access

Click Admin> Platform > Setup and Maintenance > Downloads

Tasks

How to Upload Files to the Downloads Page

Copy the files that you want available in the Downloads page to the
<BSM root directory>\AppServer\webapps\site.war\admin\install directory on the BSM Gateway
Server. If required, create the admin\install directory structure.

How to Download Files from the Downloads Page

1. Click Admin> Platform > Setup and Maintenance > Downloads.

2. Right-click the file you want to download and select Save Target As.

Note: Since some files run immediately when you click to download them, right-click the file
you want to download, select Save Target As, and select the location in which you want to
save thefile.

3. Select the location in which you want to save the file and click Save.

4. Runthe component's setup file to install the component.
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Ul Components

Download Components Page

This page lists the BSM components available for download, including tools for monitoring your
enterprise and recording business processes.

User interface elements are described below:

Ul Element (A-2) Description

Resets the table columns' width to its default setting. You
can adjust the width of the table's columns by dragging the
borders of the column to the right or the left.

Opens the Select Columns dialog box enabling you to select
the columns you want to be displayed on the table.

I o Divides the table of data into pages. You move from page to
w | 240 Fzzzz 02| [H]
J J - g J J page by clicking the relevant button:

« Toview more reports, click Next page or Last page.

« Toview previous reports in the list, click Previous page
or First page.
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Ul Element (A-2)

Category

Description

Document

File Name

System

HP Business Service Management (9.26)

Description

The downloadable component's category. Available
categories are:

« Business Process Monitor. Downloadable files that
enable you to install and run Business Process Monitor
components on BSM.

. Data Flow Probe. The Data Flow Probe downloadable
file that enables you to install and run the Data Flow Probe
component on BSM.

« Diagnostics. Downloadable files that enable you to
install and run Diagnostics components.

« Other. Used for other applications for download. If you
see no applications listed for this category, there are none
available.

« Real User Monitor. Downloadable files that enable you
toinstall and run Real User Monitor components.

« SiteScope. The SiteScope downloadable file that enables
you toinstall and run SiteScope components.

Note: Ensure that you have selected the file that
corresponds to your operating system.

« TransactionVision. Downloadable files that enable you
toinstall and run TransactionVision components.

« TransactionVision or Diagnostics. Downloadable files
that enable you to install and run the HP
Diagnostics/TransactionVision Agent for Java file.

An explanation of the specific downloadable file.

A link to the PDF describing the component.

Note: Not all components have a corresponding PDF
document available.

The name of the specific file available for download.

The operating system on which BSM components are to run.
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The License Management page enables you to update your BSM deployment with a new BSM license
and to view the status of your current license.

To access

To open the License Management Page, select Admin > Platform > Setup and Maintenance >
License Management.

Learn About

About Managing BSM Licenses

You must have a valid BSM license to run monitors and transactions, and to use various integral
applications in BSM.

The BSM license enables you to simultaneously run a predetermined number of monitors and
transactions for a specified period of time. The number of monitors and transactions that you can run
simultaneously, the specific applications that you can run, and the license expiration date, depend on
the license your organization purchased from HP.

You install the initial license in the configuration wizard, during the installation process.

BSM posts a license expiration reminder after the Login page of the web site (for administrators only) 15
days before license expiration.

Several BSM applications require additional licensing. To use these applications, you must obtain a
license from HP and then upload the license file in BSM. For specific information on the Operations
Manager i (OMi) licensing structure, see Licensing in the BSM Application Administration Guide.

Tasks

How to add a new license to your BSM deployment

1. Select Admin > Platform > Setup and Maintenance > License Management.

2. Click Add license from file to open the Add License dialog box where you can search for the
relevant .dat file. The file is uploaded from the client machine to the BSM server.

3. At the bottom of the License Management page, click the Server Deployment link.
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Ul Description

License Management Page

Ul Element

4

Name

License
Type

Days Left

Expiration
Date

Capacity

Capacity
Details

Server
Deployment
Link

Description

Add license from file. Opens the Add License dialog box.

From the dialog box browse to and select the license file to upload. The license file is
adatafile witha .DAT extension.

The name of the licensed feature. It includes an association to the product resource
with which it was bundled.

There are three types of licenses:

« Evaluation: A license with a fixed trial period of up to 60 days.
This type of license is available only until a Time Based or Permanent license is
purchased. Once purchased, the trial period immediately terminates.

Note: An Evaluation license cannot be renewed.
- Time Based: A license which has a time-based expiration date.

« Permanent: A license which does not expire.

Displays the number of remaining days for which the license is valid.

When green, the expiry time is pending; when red, the license is expired.

Displays the license's fixed expiration date.

This date is displayed only for time-based licenses.

If the license is capacity-based, the amount of capacity available and the amount of
capacity used is displayed as a status bar.

Note: This feature is available when the license is capacity-based. If the license is
not capacity-based, the words Not Applicable appear in the capacity column.

If the license is capacity-based, the amount of capacity available and the amount of
capacity used is displayed as aratio.

Note: This feature is available when the license is capacity-based. If the license is
not capacity-based, the words Not Applicable appear in the capacity column.

When you add a license to BSM, you must enable the application in the Server
Deployment page. This includes a check to see whether the physical resources of
your deployment can handle the added application.

For details, see "Customizing BSM Server Deployment" on page 49.

HP Business Service Management (9.26) Page 47 of 397



BSM Platform Administration Guide
Chapter 11: License Management

Tips/Troubleshooting

Manual License Activation

Some licenses are not automatically activated upon installation. These licenses must be activated for
specific use and do not run at all times. To activate such a license, click the Server Deployment link
at the bottom of the License Manager pane.

Installed Licenses and Server Deployment

Although a particular license is installed, you may find that not all features offered by the license are
available to you. This can be a result of how these features are configured in BSM. You can configure
these on the Server Deployment page, available by clicking the Server Deployment link at the bottom
of the License Management pane, or by running the BSM Setup and Database Configuration Utility. For
details, see "Server Deployment and Setting Database Parameters" in the BSM Installation Guide.

Make sure that the enabled application matches the installed licenses.
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This section provides information about how to determine and configure the optimal BSM server
deployment.

To access

Select Admin > Platform > Setup and Maintenance > Server Deployment

Learn About

Server Deployment Overview

BSM is composed of many applications and subsystems that consume hardware and software
resources. The available applications answer a variety of use cases, not all of which are required by
every user. You can align the deployment of the BSM servers with your company's business
requirements by enabling or disabling BSM applications according to your business needs..

BSM's Server Deployment page provides a mechanism to deploy only the applications required by your
company. You can determine the required hardware according to the required capacity for your specific
deployment. The Server Deployment feature displays exactly how much hardware capacity you need
for your deployment and enables you to free up unused resources.

The Server Deployment page is available both in the Setup and Database Configuration utility that is
run once BSM servers are installed, and in the Platform Admin area of the BSM interface. This enables
you to update your deployment, enable or disable applications as needed, and adjust your deployment's
capacities even after installation is complete and any time you have adjustments to make to your BSM
deployment. You can enable or disable applications, as needed, so as not to use any unnecessary
resources in your deployment.

Capacity Calculator

You can use the capacity calculator Excel sheet to determine the scope and size of your BSM
deployment. You input the information regarding the scope of your deployment in terms of numbers of
applications running, users, and expected data. The capacity calculator then calculates the required
memory, CPU cores, and determines the size of your deployment. If you are making any change to
your deployment, for example adding a license for an application, you use the information in the
capacity calculator to determine your hardware requirements and deployment configuration.

You can upload a file that has been saved with your data directly into the Server Deployment page. This
enables you to automatically populate the fields in the page with the data as you entered it into the
Excel sheet.
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If you used the file when you first installed BSM, use your saved version whenever you need to make
any changes to your deployment. If you do not have your own version, you can download the latest
version from the HP Software Support site (https://softwaresupport.hp.com).

You enter the information regarding your deployment in the Deployment Calculator sheet of the file. In
the Capacity Questionnaire columns, include information such as applications and size and the
Output tables automatically calculate the hardware and software requirements. Make sure to save the
file in a location from which you can upload it to the Server Deployment page. It is recommended that
you make a copy of the file each time before updating it.

When you update the capacity calculator, you are not making any changes to your deployment. You
use the capacity calculator to update the values in the Server Deployment page. Only changing values
and clicking Save in the Server Deployment page actually updates your deployment.

Tasks

How to Update Your BSM Licenses, Applications, or Deployment Scope

This task describes how to make changes to your server deployment.

1. Use the capacity calculator to determine the required capacity of your
deployment change

Before you make any changes to your BSM deployment, such as adding a license for an
application, it is recommended that you use the capacity calculator Excel file to determine if your
current servers meet the required capacity.

It is recommended that you modify the saved version of the capacity calculator that was used prior
to installing BSM. If you did not save your own version of the capacity calculator before installation
or thereafter, you can download the latest version from the HP Software Support site
(http://h20230.www2.hp.com/selfsolve/manuals).

Make sure to save the file with your current requirements in a location from which you can upload it
to the Server Deployment page.

2. Add a new license — optional

Perform this step if you are updating your deployment with a new license.
a. Select Admin > Platform > Setup and Maintenance > License Management.

b. Click Add license from file to open the Add License dialog box where you can search for the
relevant .dat file. The file is uploaded from the client machine to the BSM server.

c. Atthe bottom of the License Management page, click the Server Deployment link.
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3. Update the deployment in the Server Deployment page
Select Admin > Platform > Setup and Maintenance > Server Deployment.
= Input table. Click the Browse button to upload the saved version of your capacity calculator
Excel file. When you select afile to upload, the values entered in the capacity calculator file

automatically populate the Server Deployment page with the correct information for your
deployment.

Alternatively, you can enter the required information in the upper table manually, but it is
recommended to use the capacity calculator so that it calculates the capacity for you and
determines the scope of your deployment based on the values you input.

= Server status table. In the lower table indicating the status of the servers, ensure that the
required memory does not exceed the detected memory on the servers. If it does, you must
either remove selected applications, change the capacity level, or increase the memory on the
servers.

4. Restart BSM

After you click Save in the Server Deployment page, you need to restart BSM. For details, see
"Starting, Stopping, or Restarting BSM" on page 11.

5. Verify results

Verify that any applications you added to your deployment now appear in the BSM menus. For
example, if you enabled the System Availability Management application, you can now find the
menu option under both the Admin and Applications menu.

Conversely, if you removed any applications from your deployment, they are no longer available in
the applicable menus.

Ul Description

Server Deployment Page

This page enables you to update your deployment and determine if your hardware meets the memory
requirements of any change you make. After you save the changes to this page, BSM must be
restarted for the changes to take effect.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element Description

<Capacity Use the Browse button to locate and upload your saved capacity calculator Excel file.
Calculator
file

name>

If you have not yet entered your values into a capacity calculator, it is recommended
that you do so prior to making any changes to this page. You can download the latest
version of the capacity calculator from the HP Software Support site
(http://h20230.www2.hp.com/selfsolve/manuals).

<Capacity The upper table in the page displays the current information regarding deployment and
table> applications. If you upload a capacity calculator file, this table is automatically updated
with the information in the capacity calculator.

You can change capacity level of your deployment for:
« Users. Number of logged in users.

« Model. The number of configuration items in your model determines whether your
model is small, medium, large, or extra-large.

« Metric Data. The number of monitored applications, transactions, locations, and
hosts determines whether your metric data load is small, medium, or large.

You can also enable/disable applications and features, and change their capacity
levels.

After you click Save and restart BSM:

« If you selected an application that was previously not selected, the application is
available in BSM and applicable menus.

« If you cleared an application that was previously selected, the application is no
longer accessible.
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Ul
Element Description

<Server The lower table lists all the servers running BSM including:

status
table> « Status. Whether the machine is up and running.

« Aligned. Whether this machine is aligned with the current deployment
configuration. It would be aligned only if BSM was restarted on this machine after
any changes were made. If BSM was not yet restarted on this machine since any
configuration changes were made in this page, the machine is not aligned.

« Machine. The name of the server.

« Installed. Which type of BSM server is installed on the machine, Gateway or
Processing or both (Typical installation when Gateway and Data Processing are on
the same machine).

« Activated. Which type of BSM server is currently activated on the machine,
Gateway or DPS (data processing server).

« Detected. The free memory detected on the machine.

« Required. The required memory for each type of server based on the applications
and capacity levels listed in the upper table.

If the Required memory is higher than the memory in the Detected column, you must
either:

m Change capacity levels for your deployment, for example: clear applications from
the list of available applications.

= Add memory to the physical machines and try to update your deployment again.

To Link to page on which you can disable server machines whose installed BSM

disable components are no longer relevant to the ongoing operation of the system. Before

machine  disabling a machine, verify that it is no longer an operational part of the BSM server
architecture. To re-enable a machine after disabling it here, you need to run the Setup
and Database Configuration Utility on that machine.

Troubleshooting and Limitations

Troubleshooting

« If an application is missing from the BSM interface, activate it using the Server Deployment page.
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« If an application was activated but does not appear in the BSM interface, restart all BSM servers.

« If an application was selected in the capacity calculator but was not imported to the Server
Deployment page, ensure that you have a valid license for this application.
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Database Overview

From the Setup and Maintenance tab of the Platform Administration, you can create the databases
BSM uses to store monitoring data.

A profile database stores data for different types of data sources (Business Process Monitor,
SiteScope). You can either create one database for all data or create dedicated databases (for
example, for each data type).

A profile database can collect the following types of data:
« Service Level Management data
o SOAdata
» Datafrom Real User Monitor and Business Process Monitor
» Datausedin Service Health
« Diagnostics data

An analytics database stores data for the Service Health Analyzer application.

Supported Database Types
BSM supports two database types:

« Microsoft SQL server. This database runs on Windows operating systems only.

« Oracle server. This database runs on any BSM supported operating system. An Oracle server
database is referred to as a user schema.

Database Management Tasks

The Database Management page enables you to perform the following database management tasks:
« Create a new database. BSM creates a new database and populates it with profile tables.

« Assign a default profile database. You must assign a default profile database, to enable BSM to
collect the required data. The first database added on the Database Management page is
designated as the default profile database.

HP Business Service Management (9.26) Page 55 of 397



BSM Platform Administration Guide
Chapter 13: Managing Databases

« Connect to an existing database populated with tables. BSM connects to a database that was
either manually created and populated with tables, or previously defined in Platform Administration.

For details on creating databases, assigning a default profile database, and connecting to an existing
database, see "Creating Databases" below.

Deploying Databases

To deploy databases on Microsoft SQL server or Oracle server for your organization's particular
environment, follow the instructions in "Introduction to Preparing the Database Environment" in the
BSM Database Guide. We recommend that you review the relevant portions of the BSM Database
Guide before performing profile and analytics database management tasks.

Additional Database Tasks

BSM aggregates non-obsolete data when generating future reports. To mark data as obsolete, see
"Marking Data as Obsolete for Reports" on page 64

The purging manager configures data partitioning for performance enhancement and automatic removal
of historical data from profile databases. For details, see "Partitioning Databases and Purging
Historical Data from Databases" on page 70

By default, the Data Marking utility always runs the data marking process, followed by the re-
aggregation process. To run re-aggregation only, see "Running Re-aggregation Only" on page 77

Database Loader

The database loader persister is responsible for storing incoming data samples until the data is
processed by the loader in order to prevent data loss in case of system failure. To learn more, see
"Database Loader Persistence Folders" on page 78.

Creating Databases

This section provides information and instructions for creating profile and analytics databases.

Note: It is possible to create multiple profile databases. However, we recommend that you do not
create more than 10 profile databases. Creating more than 10 profile databases can adversely
affect the performance of the metric load in the database and the performance of the Partition
Manager. Note that historical data will be lost (for example, SLM data, Alerts, SiS data, and KPI
Over Time) if you change the default profile schema.

Note: This section is not relevant to HP Software-as-a-Service customers.
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To access

« Tocreate a profile database, select Admin > Platform > Setup and Maintenance > Manage
Profile Databases.

« Tocreate an analytics database, select Admin > Platform > Setup and Maintenance > Manage
Analytics Databases.

Tasks

This section includes:
» "How to Create a Profile Database on a Microsoft SQL Server" below
» "How to Create a Profile User Schema on an Oracle Server" below
« "How to Create an Analytics Database on a Microsoft SQL Server" on the next page

« "How to Create an Analytics Database on an Oracle Server" on page 59

How to Create a Profile Database on a Microsoft SQL Server

Tip: We recommend that you configure Microsoft SQL server databases manually, and then
connect to them in the Database Management page. For details on manually configuring Microsoft
SQL server databases, see "Microsoft SQL Server Deployment Overview" in the BSM Database
Guide.

Before beginning this procedure, make sure you have the following database server connection
information: server name, database user name and password, and server port.

1. Access the Database Management page, located at Admin> Platform > Setup and
Maintenance > Manage Profile Databases.

2. Select MS SQL from the drop-down list, and click Add.
3. Enter the parameters of your database on the Profile Database Properties - MS SQL Server

page. For information about the profile database parameters, see "Profile Database Properties —
MS SQL Server Page" on page 60 .

How to Create a Profile User Schema on an Oracle Server

Tip: We recommend that you configure Oracle server user schemas manually, and then connect
to them in the Database Management page. For details on manually configuring Oracle server user

HP Business Service Management (9.26) Page 57 of 397



BSM Platform Administration Guide
Chapter 13: Managing Databases

schemas, see "Oracle Server Deployment Overview" in the BSM Database Guide

Prerequisites

« Create a dedicated default tablespace for profile user schemas (and a dedicated temporary
tablespace, if required).

« Use asecure network connection if you do not want to submit database administrator connection
parameters over a non-secure connection. If you do not want to submit database administrator
connection parameters using your web browser at all, you can manually create profile user
schemas and then connect to them from the Database Management page.

« Make sure you have the following database server connection information: host name, SID, port,
database administrator user name and password, default tablespace, and temporary tablespace.

To add a profile user schema:

1. Access the Database Management page, located at Admin > Platform > Setup and
Maintenance > Manage Profile Databases.

2. Select Oracle from the drop-down list, and click Add.
3. Enter the parameters of your user schema on the Profile Database Properties - Oracle Server

page. For information about the profile database parameters, see "Profile User Schema Properties
— Oracle Server Page" on page 62.

Note: If your profile database is part of Oracle Real Application Cluster (RAC), see "Support for
Oracle Real Application Cluster" in the BSM Database Guide.

How to Create an Analytics Database on a Microsoft SQL Server

Tip: We recommend that you configure Microsoft SQL server databases manually, and then
connect to them in the Database Management page. For details on manually configuring Microsoft
SQL server databases, see "Microsoft SQL Server Deployment Overview" in the BSM Database
Guide.

Before beginning this procedure, make sure you have the following database server connection
information: server name, database user name and password, and server port.

1. Access the Database Management page, located at Admin> Platform > Setup and
Maintenance > Manage Analytics Databases.

2. Select MS SQL from the drop-down list, and click Add.
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3. Enter the parameters of your database on the Analytics Database Properties - MS SQL Server

page. For information about the profile database parameters, see "Profile Database Properties —
MS SQL Server Page" on the next page.

How to Create an Analytics Database on an Oracle Server

Prerequisites

Create a dedicated default tablespace for SHA user schemas (and a dedicated temporary
tablespace, if required).

Use a secure network connection if you do not want to submit database administrator connection
parameters over a non-secure connection. If you do not want to submit database administrator
connection parameters using your web browser at all, you can manually create SHA user schemas
and then connect to them from the Database Management page.

Make sure you have the following database server connection information: host name, SID, port,
database administrator user name and password, default tablespace, and temporary tablespace.

To add an analytics user schema:

1.

Access the Database Management page, located at Admin > Platform > Setup and
Maintenance > Manage Analytics Databases.

Select Oracle from the drop-down list, and click Add.

Enter the parameters of your user schema on the Analytics Database Properties - Oracle
Server page. For information about the analytics database parameters, see "Profile User Schema
Properties — Oracle Server Page" on page 62.

Note: If your analytics database is part of Oracle Real Application Cluster (RAC), see "Support for
Oracle Real Application Cluster" in the BSM Database Guide.

Ul Description

This section includes:

"Database Management Page" below
"Profile Database Properties — MS SQL Server Page" on the next page

"Profile User Schema Properties — Oracle Server Page" on page 62

Database Management Page

User interface elements are described below:
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Ul Element
(A-2) Description
& Click to edit the properties of the Microsoft SQL server database or Oracle server
user schema.
5 Disconnects the database or user schema. This button only appears if you have
more than one connected databases or user schema.
Note: You cannot delete the default profile database or a database that is in use.
Add Adds a Microsoft SQL server database or Oracle server user schema, as specified
in the drop-down database list.
Database The name of the database.
Name
Database The type of database, either Microsoft SQL or Oracle.
Type

Server Name  The name of the server on which the database is running.

Profile Database Properties — MS SQL Server Page

User interface elements are described below:

Ul Element

(A-2) Description

Create « To create a new database, or connect to an existing, empty database and
database populate it with profile tables, select the check box.

and/or tables
« Toconnect to an existing database already populated with profile tables, clear
the check box.

Database « If you are configuring a new database, type a descriptive name for the
name database.

« If you are connecting to a database that was previously created, type the name
of the existing database.

Disconnect Disconnects the database from BSM.

Note: This button appears only after you have clicked the Disconnect Database

#® button on the Database Management page.

This option is not available for analytics databases.
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Ul Element
(A-Z)

Make this my
default profile
database

Port

Server name

SQL server
authentication

Time Zone

User name

User
Password

Windows
authentication

Description
Select this check box to make this database the default profile database.

Note:

« This setting is required if you are collecting Service Health, Real User Monitor,
HP Diagnostics (if installed), Service Level Management, SOA.

« Selecting this check box overwrites the existing default profile database.

« This option is available only for profile databases.

Enter the port number if:

« The Microsoft SQL server's TCP/IP port is configured to work on a port
different from the default (1433).

« You use a non-default port in static mode.

« You use a non-default port in dynamic mode. In this case, enter port 1434.

Enter the name of the machine on which the Microsoft SQL server is installed. If
you are using a non-default instance in dynamic mode, enter the server name in the
following format: <my_server\my_instance>

Select if the Microsoft SQL server is using SQL server authentication.

If you select the Make this my default profile database option, select the time
zone of the data in this database from the drop-down list.

This option is only available for profile databases.

« If you are using Windows authentication, this field should remain empty.

« If you are using SQL server authentication, enter the user name of a user with
administrative rights on Microsoft SQL server.

« If you are using Windows authentication, this field should remain empty. Make
sure that the BSM service is run by a Windows user configured in the database
server as an authorized Windows login.

« If you are using SQL server authentication, enter the password of a user with
administrative rights on Microsoft SQL server.

Select if the Microsoft SQL server is using Windows authentication.
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Profile User Schema Properties — Oracle Server Page

User interface elements are described below:

Ul Element (A-2)

Create database
and/or tables

Database
administrator
password

Database
administrator user
name

Default tablespace

Disconnect

Host name

Description

« Tocreate a new user schema, or connect to an existing, empty user
schema and populate it with profile tables, select the check box.

« Toconnect to an existing user schema already populated with profile
tables, clear the check box.

Note: Clearing this check box disables the database administrator
connection parameter and tablespace fields on the page, and instructs the
platform to ignore the information in these fields when connecting to the
Oracle server machine.

Enter the password of a user with administrative permissions on the Oracle
server. This parameter is used to create the user, and is not stored in the
system.

Note: This field is enabled only if you selected the Create database
and/or tables check box.

Enter the user name of a user with administrative permissions on the
Oracle server. This parameter is used to create the user, and is not stored
in the system.

Note: This field is enabled only if you selected the Create database
and/or tables check box.

Enter the name of the default tablespace designated for use with user
schemas.

For details on creating a dedicated tablespace, see "Oracle Server
Deployment Overview" in the BSM Database Guide.

If you did not create, and do not require, a dedicated default tablespace,
specify an alternate tablespace. The default Oracle tablespace is called
users.

Disconnects the user schema from BSM.
Note: This button appears only after you have clicked the Disconnect

Database X button on the Database Management page.

Enter the name of the machine on which the Oracle server is installed.
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Ul Element (A-2) Description

Make this my default = Select or clear as required.

rofile database
P Note:

« This setting is required if you are collecting Service Health, Real User
Monitor, HP Diagnostics (if installed), Service Level Management,
SOA.

« Selecting this check box overwrites the existing default profile
database.

« This option is only available for profile databases.

Port Enter the Oracle listener port, if different from the default value, 1521.
Retype password Retype the user schema password.
SID Enter the Oracle instance name that uniquely identifies the instance of the

Oracle database being used, if different from the default value, orcl.

Temporary Enter the name of the dedicated temporary tablespace designated for use
tablespace with user schemas.

If you did not create, and do not require, a dedicated temporary tablespace,
specify an alternate tablespace, if different from the default Oracle
temporary tablespace, temp.

Time Zone If you select the Make this my default profile database option,select the
time zone of the data in this database from the drop-down list.

This option is only available for profile databases.

User schema name « Ifyou are configuring a new user schema, enter a descriptive name for
the user schema.

« Ifyou are connecting to a user schema that was previously created,
enter the name of the existing user schema.

User schema « If you are configuring a new user schema, enter a password that
password enables access to the user schema.

« Ifyou are connecting to a user schema that was previously created,
enter the password of the existing user schema.

Note: You must specify a unique user schema name for each user schema
you create for BSM on the Oracle server.
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Tips/Troubleshooting

Timeouts

Database creation can take several minutes. The browser might time out before the creation process is
completed. However, the creation process continues on the server side.

If a timeout occurs before you a confirmation message appears, verify that the database name appears
in the database list on the Database Management page to ensure that the database was successfully
created.

Syntax Rules
« The database name cannot contain: /, \\, :, *, ?,\",<, >, |, or spaces, and cannot begin with a digit.

« The host name cannot contain: /, :, *, ?,\",<, >, |, or spaces.

Marking Data as Obsolete for Reports

Using the Data Marking utility, you can mark Business Process Monitor and SiteScope data as
obsolete. BSM aggregates only non-obsolete data when generating future reports.

Note: This section is not relevant to HP Software-as-a-Service customers.

To access

On the Gateway Server, double-click the <HPBSM Gateway Server root
directory>\tools\dataMarking\dataMarking.bat file.

Learn About

Data Marking Utility Overview

The Data Marking utility enables BSM users with superuser security privileges to mark specific sets of
data in profile databases as obsolete so that the marked data is not included when generating reports.

While the utility does not physically remove marked data from the database, it renders the marked data
unusable in reports and applications by assigning the marked data a status of unavailable in the
database.

In this way, the Data Marking utility enables you to filter out obsolete data and enables BSM to display
only the most relevant data for the specified time period. After you mark a specific set of data from a
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given time period as obsolete, BSM reruns the aggregation process on the remaining raw data for the
relevant time period.

Additional Data Marking Utility Features

If necessary, you can re-aggregate a defined set of data without marking it as obsolete. This might be
necessary if data marking passed successfully but re-aggregation failed. For details, see "Running Re-
aggregation Only" on page 77.

Since the Data Marking utility supports partitions, users running the Purging Manager can also use the
Data Marking utility. For details, see "Partitioning Databases and Purging Historical Data from
Databases" on page 70.

Tasks

This section includes:
« "How to Mark Data as Obsolete" below
« "How to Mark Obsolete Data as Valid" on the next page

« "How to Configure Data Marking Maximum Time Duration" on the next page

How to Mark Data as Obsolete

1. Onthe Gateway Server, double-click the <HPBSM Gateway Server root
directory>\tools\dataMarking\dataMarking.bat file. A Command Prompt window opens,
followed by the Data Marking Utility Login dialog box.

2. Enter the user name and password of a BSM user with superuser privileges.

3. From the View by drop-down list, select the type of data to appear in the Data Marking Utility
page, for example, data from Applications or SiteScope.

4. Click Mark data as obsolete.

5. Select the appropriate critera to mark as obsolete (Applications, Business Transaction Flows,
Transactions, Locations, or SiteScope Targets).

6. Select the Start Time and Duration for the Data Marking and Re-aggregation process. For
example, if you select a Start Time of May 22, 2013 8:20 am, and a Duration of 3 hours, the Data
Marking utility marks all data in the selected criteria that is dated May 22, 2013 with a time stamp
of 8:20 am through 11:20 am.
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7.

8.

Before the Data Marking utility marks the data as obsolete, you can view the SLAs affected by the
marked data by clicking Get Info. For details, see "Data Marking Information Window" on
page 68.

Click Start. The progress bars display the progress of the Data Marking and Re-aggregation
process.

Note: There is no indication in the user interface of which data is to be marked as obsolete.

How to Mark Obsolete Data as Valid

You can select obsolete data and mark it as valid.

Note: There is no indication in the user interface of which data was marked obsolete.

. Onthe Gateway Server, double-click the <HPBSM Gateway Server root

directory>\tools\dataMarking\dataMarking.bat file. A Command Prompt window opens,
followed by the Data Marking Utility Login dialog box.

Enter the user name and password of a BSM user with superuser privileges.

From the View by drop-down list, select the type of view to appear in the Data Marking Utility
pagee, for example, data from Applications or SiteScope

Click Mark data as valid.

Select the appropriate critera to mark as valid (Applications, Business Transaction Flows,
Transactions, Locations, or SiteScope Targets).

Select the Start Time and Duration for the Data Marking and Re-aggregation process. For
example, if you select a Start Time of May 22, 2013 8:20 am, and a Duration of 3 hours, the Data
Marking utility marks all data in the selected criteria that is dated May 22, 2013 with a time stamp
of 8:20 am through 11:20 am.

Before the Data Marking utility marks the data as valid, you can view the SLAs affected by the
marked data by clicking Get Info. For details, see "Data Marking Information Window" on
page 68.

Click Start. The progress bars display the progress of the Data Marking and Re-aggregation
process.

How to Configure Data Marking Maximum Time Duration

You can configure the maximum duration for which the marked data is obsolete. For example, you can
set the maximum duration to be 15 hours. This means that you cannot mark data as obsolete (or valid)
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for more than 14 hours and 59 minutes.

The default maximum duration is 6 hours and 59 minutes.

To configure the maximum duration:

1. Openthe <Gateway Server root directory>\tools\dataMarking\dataMarking.bat file in a text

editor.

2. Add the DmaximumbDuration property, with a value of the maximum duration in hours, to the SET
SERVICE_MANAGER_OPTS line.

For example, to change the maximum duration to 23 hours and 59 minutes:

SET SERVICE_MANAGER_OPTS=
-DhacProcessName=%PROCESS _NAME?%
-Dlog.folder.path.output=%PROCESS_NAME% -DmaximumDuration=24

3. Save and close the file.

Ul Description

Data Marking Utility Page

This page enables you to select sets of data as obsolete by application or by location for Business
Process Monitor data, and by the SiteScope target machine for SiteScope data.

User interface elements are described below:

Ul Element
(A-Z)

Advanced
Button

Applications
BTF

Duration

Description

This button appears if the re-aggregation only feature has been enabled. It
enables you to run re-aggregation without the data marking process. For more
information see "Running Re-aggregation Only" on page 77.

List of applications you can mark as obsolete.
List of business transaction flows you can mark as obsolete.
Note: This field is visible only in the Applications view (View by > Applications).

Select the period of time, starting from the specified start time, for the utility to
mark data as obsolete. The default value is 6 hours and 59 minutes.

For details on customizing this value, see "How to Configure Data Marking
Maximum Time Duration" on the previous page.
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(A-Z)

Get Info

Locations

Mark data as
obsolete

Mark data as
valid (undo
mark as
obsolete)

Progress

SiteScope
Targets

Start
Start Time

Transactions

View by
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Description

Click before running the Data Marking utility to view the SLAs affected by the
marked data. For details, see "Data Marking Information Window" below.

List of locations you can mark as obsolete.

Marks the filtered criteria (Applications, Business Transaction Flows,
Transactions, Locations, or SiteScope Targets) as obsolete.

Makes selected data valid after having been marked as obsolete.

Displays the progress of the data marking process and re-aggregation process.

List of SiteScope target machines (machines being monitored by SiteScope) that
you can mark as obsolete.

Note: This field is visible only in the SiteScope view (View by > SiteScope
View).

Activates the Data Marking utility and marks data as obsolete.
Select a starting date and time for data to be marked as obsolete.

List of transactions you can mark as obsolete.

Note: This field is visible only in the Applications view (View by > Applications).

Select the type of view to be visible in the Data Marking utility:
« Applications
« Locations

« SiteScope Targets

Data Marking Information Window

The Data Marking Information window displays the data to be marked as obsolete by the Data Marking

utility.

The lower portion of the Data Marking Information window displays the SLAs affected by the marked
data. You can recalculate the affected SLAs on the Agreements Manager tab under Admin > Service
Level Management. For details, see Recalculation for SLAs in the BSM Application Administration

Guide.

User interface elements are described below:
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Ul Element

(A-2) Description

Application The name of the application to be marked as obsolete.

Name

Number of The number of data rows per selected criteria to be marked as obsolete. A row
Rows to appears for each criterion selected in the Data Marking Utility window.
Update

Total Rows to ' The sum of all the number of rows to be marked as obsolete. This number can
Update differ from the value of the Number of Rows to Update field.

Tips/Troubleshooting

Tips

« Do not run more than one instance of the Data Marking utility at a time, as this can affect the re-
aggregation process.

« Do not mark data sets for time periods that include purged data (data that has been removed using
the Partition and Purging Manager) as this can affect the re-aggregation process.

Limitations
« The Data Marking utility does not mark late arriving data.

For example, if a set of data for a specific time period is marked as obsolete and BSM later receives
data from that time period (which arrived late due to a Business Process Monitor temporarily being
unable to connect to the Gateway Server), the late arriving data is not marked as obsolete and is
available for use in reports. Use the Get Info button to check for late arriving data. If any value other
than zero rows are displayed, run the utility again, if required, to mark the data that arrived late as
obsolete.

« The Data Marking utility does not mark data as obsolete if it arrives while the utility is running.

For example, if a set of data for a specific time period is marked as obsolete, and during that same
time period (while the utility is running), data arrives and enters the profile database, the rows of
newly arrived data are not marked as obsolete, and are therefore included in the report. In this case,
after the utility finishes running, click the Get Info button to determine whether all rows of data were
marked as obsolete for the selected time period. If rows are displayed, run the utility again, if
required, to mark the data that arrived during the run as obsolete. This is a rare scenario, as you
typically mark data for a previous time period and not for a time period that ends in the future.

« While the Data Marking utility is running and removing data, reports that are generated for that time
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period may not show accurate results. Therefore, it is recommended to run the utility during off-peak
BSM usage times.

Troubleshooting

Generally, when an error occurs, the Data Marking utility displays the following error message:

The Data Marking utility must shut down due to an internal error. For details see:
<HPBSMGateway Server root directory>\log\datamarking.log

Reasons for which the utility might display this error include:
« Failure to connect to the database server or profile database.

« Failure to complete the data marking process, for example, due to a communication error between
the aggregation server and database.

« Failure of BSM to successfully re-aggregate raw data for the defined data set.

If an error occurs, check the <HPBSMGateway Server root directory>\log\datamarking.log file for
error information.

Partitioning Databases and Purging Historical Data from
Databases

The BSM database tables are created based on predefined database templates. The purging manager
configures data partitioning for performance enhancement and automatic removal of historical data
from profile databases.

Note: This section is not relevant to HP Software-as-a-Service customers.

To access

Select Admin > Platform > Setup and Maintenance > Data Partitioning and Purging.

Learn About

Partitioning

The database tables can quickly become very large due to the large amount of data generated by the
BSM data collectors. Over time, this can severely degrade system performance.
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The Purging Manager automatically splits fast growing tables into partitions based on internal settings.
Splitting the tables into partitions optimizes database performance.

New partitions are created based on an internal configuration regardless of whether or not the partition
is filled.

New partitions for a table are created in the same Oracle tablespace or Microsoft SQL file group as the
table’s last partition. These partitions automatically acquire the storage parameters of this tablespace.

Note: The partitioning method used by the Partition and Purging Manager is Database Native
Partitioning. (Refer to the database support matrix in the release notes for the SQL SERVER and
Oracle Enterprise editions supported for this release). In an Oracle database, the Oracle
Partitioning option must be enabled in order to partition or purge data from an Oracle database.

EPM

The size of each partition is determined by the EPM (Events per Minute) value displayed on the Purging
Manager page. The default EPM value is preset according to the appropriate level for each database
table.

If the data partitions are too large (accumulating much more than 1 million rows), you can raise the EPM
value to create new partitions more frequently.

If the data partitions are too small (accumulating much less than 1 million rows), you can lower the
EPM value to create new partitions less frequently.

Purging

By default, the Purging Manager does not purge data. However, you can configure the Purging Manager
to purge data by defining the amount of time the data in a table's partition is retained.

The Purging Manager runs every hour and purges data older than the defined retention time.

Tasks

This task includes the following topics:
» "Prerequisites" below
« "How to Change a Database Template" on the next page
« "How to Change Settings for Multiple Databases" on the next page
« "How to Change Settings for Individual Databases" on page 73

« "How to Determine the Events Per Minute for a Database Table" on page 73

Prerequisites
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Ensure that you have at least one profile database configured in your BSM system.

« Fordetails on configuring a profile database on a Microsoft SQL server, see "How to Create a
Profile Database on a Microsoft SQL Server" on page 57.

« For details on configuring a user schema on an Oracle server, see "How to Create a Profile User
Schema on an Oracle Server" on page 57.

How to Change a Database Template

To change settings for a database template, follow these steps:
1. Click Admin > Platform > Setup and Maintenance > Data Partitioning and Purging.

2. Click the Template and Multiple Databases tab.

Note: The settings displayed in the Template and Multiple Databases tab are the settings
configured for the template. To view the settings for a specific database tables, click the
Database Specific tab.

3. Click the Apply to link at the top left of the page. The Apply to window appears with a list of
databases and templates.

4. Select the required template.

Note: We recommend that you also select all the available databases.

5. Click OK.

6. Select the check box next to the database tables whose database template you want to change.
You can select multiple tables.

7. Modify the Keep Data for and Change to EPM fields as necessary, and click Apply.

How to Change Settings for Multiple Databases

To change settings for multiple databases, follow these steps:
1. Click Admin > Platform > Setup and Maintenance > Data Partitioning and Purging.

2. Click the Template and Multiple Databases tab.

Note: The settings displayed in the Template and Multiple Databases tab are the settings
configured for the template. To view the settings for a specific database tables, click the
Database Specific tab.
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Click the Apply to link at the top left of the page and ensure that the databases you want to
change are selected. Clear the check box next to the template if you do not want your changes to
apply to the template.

Click OK.

Select the check box next to the database tables you want to change. You can select multiple
database tables.

Modify the Keep Data for and Change to EPM fields as necessary, and click Apply.

Note: Changes made to the databases are displayed only in the Database Specific tab.

How to Change Settings for Individual Databases

To change settings for individual databases, follow these steps:

1.

2.

Click Admin> Platform > Setup and Maintenance > Data Partitioning and Purging.

Click the Database Specific tab.

Note: The settings displayed in the Database Specific tab are the settings configured for the
databases. To view the template settings, click the Template and Multiple Databases tab.

In the Select a profile database field, select the profile database to which you want your changes
to apply.
Select the check box next to the database tables you want to change.

Modify the Keep Data for and Change to EPM fields as necessary, and click Apply.

How to Determine the Events Per Minute for a Database Table

You can determine the amount of events per minute (EPM) that arrives to a database table from the
data collectors. You enter this number in the Change to EPM field at the top of the Purging Manager

page.

To determine the Events Per Minute for a database table:

1.

2.

Open the file located at:
<Gateway Server root directory>\log\db_loader\LoaderStatistics.log

Locate the line in the select data sample that reads:
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Statistics for: DB Name: <database name> Sample: <sample name> - (collected over
<time period>):

3. Locate the line in the statistics section of the data sample that reads:
Insert to DB EPS (MainFlow)

The selected number represents the events per second. Multiply this number by 60 to determine the
number of events per minute.

To determine to which database table in the Purging Manager the sample belongs, follow the
instructions for Generic Reporting Engine AP in the BSM Extensibility Guide. The resulting list
displays the database table in parentheses next to the name of the sample. You can then enter the
EPM number for the correct table.

If you have more than one Gateway Server, add the values obtained from each server.

Ul Description

Purging Manager Page
User interface elements are described below:
Ul Element (A-2) Description
Apply to Select the databases and template to which you want the

configurations on the Template and Multiple Databases tab to
apply. You can clear all databases to make changes only to the
selected template.

Change to EPM Enables you to configure the amount of data per minute that
arrives in a database table from the data collectors.

Note: Leave this field empty to retain the existing EPM value.

For details on determining this value, see "How to Determine the
Events Per Minute for a Database Table" on the previous page

Database Specific This tab displays the configurations for the tables associated with
the database selected in the Select a profile database drop-down
list. From this tab you can change the EPM or data retention time a
specific database table.

Description Describes the corresponding database table.
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Ul Element (A-2) Description

Epm Value The amount of data per minute that arrives in the database tables
from the data collectors. For details on determining this value, see
"How to Determine the Events Per Minute for a Database Table"
on page 73.

Keep Data for The time range for retaining data in the database tables. This
element appears as follows:

« Selection fields. At the top of the page, set the time period for
how long you want data kept in the selected database tables.

« Column heading. Displays the amount of time data remains
in a database table before it is purged. This value is configured
in the Keep Data for selection fields at the top of the page.

Note: The time period configured in the Keep Data for fields
indicates that the data is stored for at least the specified amount of

time; it does not indicate when the data is purged. By default,
retention time is Infinite, meaning that the data is not purged.

Name of Table in Database The name of the table in the database.

Database tables are listed by the data collector from which the
data was gathered. The following data types are available:

o Alerts

« Business Logic Engine

« Business Process Monitor

« DG (Diagnostics Business Transaction Sample)
« Diagnostics

« Real User Monitor

« SOA

« Service Level Management

« SiteScope

« TV

« UDX (Universal Data Exchange - custom data)

« WebTrace
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Ul Element (A-2) Description

Select a profile database Select a profile database for which you want to modify time range
configurations for purging data.

Note: This field is visible only on the Database Specific tab.

Template and Multiple This tab displays the configurations for the templates that are
Databases selected in the Select a profile database drop-down list.
Select this tab to:

« Change the partitioning and purging parameters for multiple
profile databases.

« Change the database template, for new databases added in the
future.

Tips/Troubleshooting

Raw Data not Aggregated

Prior to purging, the Partition and Purging Manager performs an additional check to ensure that raw data
is not purged before it has been aggregated and reported to BSM.

If a particular set of data is scheduled for purging but its raw data has not yet been aggregated, the
Partition and Purging Manager does not purge the data according to its schedule. The Partition and
Purging Manager automatically purges the data on its next hourly run only after the data has been
aggregated.

For example, if data was scheduled to be purged on Sunday at 8:00 but its data will only be aggregated
on Sunday at 10:00, the Partition and Purging Manager checks the data at 8:00, does not purge the
data, and automatically purges the data on its next hourly run only after Sunday at 10:00 after the data
has been aggregated.

Data not Purged per Schedule

If data is not purged according to the schedules set in the Partition and Purging Manager and the profile
databases are growing too large, check that the aggregator is running properly and view the Partition
and Purging Manager logs located on the Data Processing Server at <HPBSM server root
directory>\log\pmanager.log.

Purging Principle

When defining purging for your raw and aggregated data make sure that the length of time raw data is
kept is shorter than the length of time one-hour chunks of aggregated data are kept, which is shorter
than the length of time one-day chunks of aggregated data are kept.
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Purging policy is one year for raw data (for example, Business Process Monitor or SiteScope).

The purging policy for Offline BLE States limits the amount of data that can be used for SLA
calculation. Even if raw data is available for longer periods of time, the SLAs can only be calculated for
the Offline BLE States purging policy setting minus one month. By default, this means that SLA data
can be calculated for just three months.

You cannot create an SLA or recalculate an SLA for a time period earlier than three months even if there
is raw data for that time period.

New Profile Databases

Any changes made under the Template and Multiple Databases tab affect the default time periods for
new profile databases created in the system. If a new profile database is created after you made
changes to the time periods in the Template and Multiple Databases tab, data is kept in the tables of
that new profile database for the time periods now defined in the Template and Multiple Databases for
all tables.

Running Re-aggregation Only

By default, the Data Marking utility (see "Marking Data as Obsolete for Reports" on page 64) always
runs the data marking process, followed by the re-aggregation process. If required, you can enable a
feature that allows you to run re-aggregation only. This might be necessary if data marking passed
successfully but re-aggregation failed.

Alternatively, you can use this feature to re-aggregate a defined set of data without marking it as
unwanted for report generation (for example, if data was aggregated and then late-arriving data was
inserted into the raw data tables in the database).

To access

On the Gateway Server, double-click the <HPBSM Gateway Server root
directory>\tools\dataMarking\dataMarking.bat file

Tasks

Prerequisite

You must enable the re-aggregation feature in the dataMarking.bat file in order to run the data re-
aggregation process in the Data Marking utility.

1. Open the file <Gateway Server root directory>\tools\dataMarking\dataMarking.bat in a text
editor.

2. Add the DadvancedMode property with a value of true to the SET SERVICE_MANAGER _
OPTS line. For example:
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3.

SET SERVICE_MANAGER_OPTS=-DhacProcessName=%PROCESS_NAME % -DadvancedMode=true

Save the file. The next time you open the Data Marking utility, the Advanced button appears.

How to Run Data Re-aggregation Only

1.

On the Gateway Server, double-click the <HPBSM Gateway Server root
directory>\tools\dataMarking\dataMarking.bat file. A Command Prompt window opens,
followed by the Data Marking Utility Login dialog box.

Enter the user name and password of a BSM user with superuser privileges. The Data Marking
Utility page appears.

Click Advanced. The Advanced window appears.
Select the Run re-aggregation only check box.
Select the categories of data for the re-aggregation and click OK to confirm selection.

Click Start.

Ul Description

Data Marking Utility page

For information see "Data Marking Utility Page" on page 67.

Advanced Window

The Advanced window is accessed by clicking Advanced on the "Data Marking Utility Page" on
page 67. User interface elements are described below:

Ul Element (A-Z) Description

Raw data status Displays the status of the last re-aggregation.

Run Reaggregation Selecting this check box enables running re-aggregation without data
only marking.

Database Loader Persistence Folders

This topic provides an overview of the database loader persister and the loader persistence folders.
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Learn About

Database Loader Persister - Overview

The database loader persister is responsible for storing incoming data samples until the data is
processed by the loader in order to prevent data loss in case of system failure. The data samples are
assigned a unique ID number when stored in the database loader persistence folder. This enables the
data samples to be deleted from the database loader persistence folders after the data is processed.

The loader persister stores the data samples in files called partitions on a local disk. Each partition has
a predefined number of data samples it can accommodate. When the limit is reached, a new partition is
created. When removing data samples from the main persister, the corresponding partition is found and
updated accordingly. When all samples from the partition are removed, the partition file is deleted from
the disk.

Upon initialization, the loader persister reads the partition that remained on the disk from the previous
run. After the partitions are fully and successfully read, they are deleted from the disk.

Loader Persister Folder Sub-directories

Each gateway server contains a folder named persist_dir\db_loader which contains the following
sub-directories:

. .persist_dir\db_loader\main\dlq — contains samples that the system was not able to insert into
the database, for example wrong sample, duplicated samples, or samples with time stamp older
then data purging period.

There is no size limit and no limit of the number of samples in this folder. Old files are not
automatically purged. If these samples were added to this folder due to an error, for example, there
was a data flow problem, you can reinsert these samples into the database.

« .persist_dir\db_loader\main\current — contains samples that are currently in the loader memory.
The size of this folder is limited by memory restrictions of the database loader.

« .persist_dir\db_loader\flattenfailure — contains hierarchy samples (trans_t) that temporarily failed
to open because of a database connectivity problem. There is no size limit.

« .persist_dir\db_loader\recovery — contains samples that the system was temporarily unable to
insert. This is usually because of database availability issues. The limit for each sample type is five
sub-folders. Each subfolder can contain up to 509 files with up to 8192 samples in each file
(approximately 20M of samples for each sample type). After this limit is exceeded, the loader stops
working and will not read data from the BUS.
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BSM enables you to modify the value of many settings that determine how BSM and its applications
run. You configure most infrastructure settings using the Infrastructure Settings Manager.

Some infrastructure settings are configured outside the Infrastructure Settings Manager. For details,
see How to Modify the Ping Time Interval, and Locations and Expirations of Temporary Image Files.

To access

Select Admin> Platform > Setup and Maintenance > Infrastructure Settings

Learn About

Infrastructure Settings Manager Overview

In the Infrastructure Settings Manager, you can select different contexts from which to view and edit
settings. These contexts appear in the following groups:

« Applications. This list includes those contexts that determine how the various applications running
within BSM behave. Contexts such as Service Health Application, MyBSM, and Service Level
Management are listed.

« Foundations. This list includes those contexts that determine how the different areas of the BSM
foundation run. Contexts such as RTSM (Run-time Service Model) and LDAP Configuration are
listed.

Descriptions of the individual settings appear in the Description column of the table on the
Infrastructure Settings Manager page.

Tasks

How to Modify Infrastructure Settings Using the Infrastructure Settings
Manager

Caution: Modifying certain settings can adversely affect the performance of BSM. It is highly
recommended not to modify any settings without first consulting HP Software Support or your HP
Services representative.
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1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Select a group of contexts: Applications, Foundations, or All.

3. Select a specific context from the drop-down box.

4. All configurable infrastructure settings relating to that context are displayed, along with

descriptions and the current values of each setting. Click the Edit Setting button and modify the
value of a specific setting.

Ul Description

Infrastructure Settings Manager Page

User interface elements are described below:

Ul Element

(A-2) Description

Click to edit the current value of the given setting in the relevant context table.
All Select to view all the settings for both Applications and Foundations.

Applications = Select to edit one of the BSM Applications.
Description  Describes the specific infrastructure setting.

Note: This field is visible on both the Infrastructure Settings Manager page, and the

Edit Setting dialog box after clicking the Edit Setting E button next to the relevant
setting.

Foundations Select to edit one of the BSM Foundations.
Name The name of the setting.

Note: This field is visible on both the Infrastructure Settings Manager page, and the

Edit Setting dialog box after clicking the Edit Setting E button next to the relevant
setting.

Restore Restores the default value of the setting.

Default
Note: This button is visible on the Edit Setting dialog box after clicking the Edit

Setting button next to the relevant setting.
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Ul Element
(A-2) Description
Value The current value of the given setting.

Note: This field is visible on both the Infrastructure Settings Manager page, and the

Edit Setting dialog box after clicking the Edit Setting & button next to the relevant
setting.

Modifying the Ping Time Interval

Note: This infrastructure settings task is performed outside the Infrastructure Settings Manager.
You can modify the time interval after which BSM pings the server to refresh a session.
To modify the ping time interval:
1. Open the file <Gateway Server root directory>\confisettings\website.xml in a text editor.
2. Search for the parameter: user.session.ping.timeinterval.

3. Change the value (120, by default) for the ping time interval. This value must be less than half, and
it is recommended that it be less than a third, of the value specified for the session timeout period
(the user.session.timeout parameter).

4. Restart BSM on the Gateway Server machine.

5. If you have multiple Gateway Server machines, repeat this procedure on all the machines.

Configuring the Database Statistics Age

The Database Statistics monitor checks the relevance of the database statistics. The default is to
check the statistics for past day. You can configure the number of days to be used for verification of
database statistics.

To configure the Database Statistics Age:
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select DB Health.

4. Inthe DB Health - DB Health Settings table, locate DB Statistics age. Change the value as
needed.
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Configuring the Maximum Number of Late Arrival Samples

The WDE Late Arrivals monitor checks the number of data samples that reach the database more than
an hour after the data is recorded. Late arriving samples are not included in the data aggregation for
reports. You can configure the maximum number of late arrival samples, which if exceeded triggers an
error. The default value is 1.

To configure the Maximum Number of Late Arrival Samples:
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select Offline Aggregator.

4. Inthe Offline Aggregator - General table, locate Maximum number of late arrival samples.
Change the value as needed.

Configuring the Maximum Number of Cls Marked as
Candidate for Deletion

The CI Lifecyle monitor checks the number of Cls in RTSM that are marked as candidates for deletion
by the aging mechanism. Cls that are marked as candidates for deletion are removed from RTSM in the
next aging run. If the maximum number of Cls that can be marked for deletion is reached, a critical error
is triggered. The default value is 1.

To configure the Maximum Number of Cls Marked as Candidate for Deletion:
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select Platform Administration.

4. Inthe Platform Administration - Cl Lifecycle monitor table, locate Maximum number of Cls
marked as candidate for deletion. Change the value as needed.

Configuring the Maximum Number of Bus Queue Messages

The Bus Queue monitor checks the number of messages waiting in each of the HornetQ Bus Queues.
You can configure the maximum number of messages in the HornetQ Bus Queues. If the maximum
number of messages waiting in the HormetQ Bus queues is reached, a critical message is triggered. If
half the maximum number is reached, a warning is triggered. The default value is 200.

To configure the Maximum Number of Bus Queue Messages:
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1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select Platform Administration.

4. Inthe Platform Administration - Bus Queues monitor table, locate Maximum number of
messages in Bus Queues. Change the value as needed.

Configuring the Mobile Health Report Locations Threshold

The Locations component in the Mobile Health report displays the ten locations with the worst
performance or availability. You can define the minimal number of sessions per location to be displayed
in the Locations component. The default value is 0 which means that all locations are displayed on the
map and table in Mobile Health report.

To configure the Mobile Health report locations table threshold:
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Applications.
3. Select End User/System Availability Management.

4. Inthe End User/System Availability Management - Data table, locate RUM Mobile Health
report: Display locations that have at least x sessions. Change the value as needed.

Locations and Expirations of Temporary Image Files

When you generate a report in BSM applications, or when BSM automatically generates a report to
send through the scheduled report mechanism, images (for example, graphs) are created. BSM saves
these images, for a limited period of time, in temporary directories on the Gateway Server machines on
which the images are generated.

Note: This infrastructure settings task is performed outside the Infrastructure Settings Manager.

Learn About

This section includes:
« "Accessing Temp Directories with Multiple Gateway Server Machines" on the next page

« "Length of Time BSM Keeps Temporary Image Files" on the next page
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Accessing Temp Directories with Multiple Gateway Server Machines

BSM reports access the Gateway Server machine using a virtual IP and the load balancer sends
requests to any of the Gateway Server machines. Therefore, the image files need to be in a common
location that is configured on all the Gateway Server machines and shared among them. This is typical
when there are multiple Gateway Server machines running behind a load balancer in the BSM
architecture.

To support a shared location for temporary images in a Windows environment, the following
configuration is recommended:

« All Gateway Servers—and the machine on which the shared image directory is defined, if different
from the Gateway Servers—should be on the same Windows domain.

« ThellS virtual directory should be configured to use the credentials of an account that is a member
of the domain users group.

« The account for the virtual directory should be given read/write permissions on the shared image
directory.

Note: If your server configuration requires placing servers on different Windows domain
configurations, contact HP Software Support.

If you set a custom path to temporary images, as defined in the images.save.directory.offline
parameter (for details, see "How to Modify the Directory in Which Temporary Image Files Are Stored"
on page 88), you must map the physical directory containing the images to a virtual directory in the web
server on all Gateway Server machines.

Length of Time BSM Keeps Temporary Image Files

You can modify settings that control how long BSM keeps temporary image files generated by the
Gateway Server machine, before removing them from the defined temporary directories. You can
modify settings for the following directories in the <HPBSM Gateway Server root
directory>\confi\topaz.config file:

Directory Setting Description

remove.files.0.path= Path to images created when generating
..I..[AppServer/webapps/site.war/Imgs/chartTemp/offline = reports

remove.files.1.path= Path to images created when generating
..I..[AppServer/webapps/site.war/Imgs/chartTemp/online = reports in BSM applications

remove.files.3.path= Path to images created by the Snapshot
..I..IAppServer/webapps/site.war/snapshots on Error mechanism and viewed in Error
Summary reports
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For the above temporary image directories, you can modify the following settings:
« remove.files.directory.number=<number of directories>
Specifies the total number of directories for which you are defining settings.
« remove.files.<num_of_path>.path=<path to directory>

Specifies the path to the directory that contains the files you want to remove. For the default
directories that remove temporary image files, these values must match the
images.save.directory.online and images.save.directory.offline parameters, also defined in the
topaz.config file.

Note: In Windows environments, use UNC path syntax (\\\\server\\path) when defining the
path. In Linux environments, use forward slashes (/) only when defining the path.

« remove.files.<num_of_path>.expirationTime=<file expiration time in sec>

Specifies the time, in seconds, that BSM leaves a file in the specified directory. For example, if you
specify "3600" (the number of seconds in 1 hour), files older than one hour are removed.

Leave this setting empty if you want BSM to use only maximum size criteria (see below).
« remove.files.<num_of_path>.maxSize=<maximum size of directory in KB>

Specifies the total size, in KB, to which the defined directory can grow before BSM removes files.
For example, if you specify "100000" (100 MB), when the directory exceeds 100 MB, the oldest files
are removed in order to reduce the directory size to 100 MB.

If you also define a value in the remove.files.<num_of_path>.expirationTime parameter, BSM
first removes expired files. BSM then removes additional files if the maximum directory size limit is
still exceeded, deleting the oldest files first. If no files have passed their expiration time, BSM
removes files based only on the maximum directory size criteria.

This parameter is used in conjunction with the remove.files.<num_of_defined_
path>.deletePercents parameter (see below), which instructs BSM to remove the specified
percentage of files, in addition to the files removed using the remove.files.<num_of_
path>.maxSize parameter.

Leave this and the remove.files.<num_of_defined_path>.deletePercents settings empty if you
want BSM to use only the expiration time criterion.

« remove.files.<num_of_path>.deletePercents=<percent to remove>
Specifies the additional amount by which BSM reduces directory size—expressed as a percentage

of the maximum allowed directory size—after directory size has been initially reduced according to
the remove.files.<num_of_path>.maxSize parameter. BSM deletes the oldest files first.
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If you want BSM to use only the expiration time criterion, leave this and the remove.files.<num_
of_path>.maxSize settings empty .

« remove.files.<num_of_path>.sleepTime=<thread sleep time in sec>

Specifies how often BSM runs the mechanism that performs the defined work.

Example:

BSM is instructed to perform the following work once every 30 minutes: BSM first checks
whether there are files older than 1 hour and, if so, deletes them. Then BSM checks whether
the total directory size is greater than 250 MB, and if so, it reduces directory size to 250 MB by

removing the oldest files. Finally, BSM reduces the total directory size by 50% by removing the
oldest files. As aresult, BSM leaves files totaling 125 MB in the directory.

# remove files older than 1 hour (3600 sec.)
remove.files.0.expirationTime=3600

# reduce folder size to 250 MB
remove.files.0.maxSize=250000

# remove an additional 50% of max. folder size (125 MB)
remove.files.0.deletePercents=50

# perform work once every 30 min. (1800 sec)

remove.files.0.sleepTime=1800

Tip: You can configure the file removal mechanism to remove files from any defined directory.
You define the parameters and increment the index. For example, to clean out a temp directory,
you would specify 6 instead of 5 for the number of directories in the
remove.files.directory.number parameter; then you would define the directory's path and
settings using the index value 4 (since 0-4 are already being used by the default settings) in the

num_of_path section of the parameter. Do not use this mechanism to remove files without
first consulting with your HP Software Support representative.

Tasks

This section includes:
« "How to Modify the Directory in Which Temporary Image Files Are Stored" on the next page

« "How to Configure the Virtual Directory in 11S" on the next page
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"How to Configure the Virtual Directory on Apache HTTP Web Server" on the next page
"How to Configure the Virtual Directory on Sun Java System Web Server" on page 90
"How to Modify Length of Time BSM Keeps Temporary Image Files" on page 91

"How to Specify the Directories from Which Temporary Image Files Are Removed" on page 92

How to Modify the Directory in Which Temporary Image Files Are Stored

You can modify the path to the directory where BSM stores generated images used in scheduled
reports. For example, you might want to save generated images to a different disk partition, hard drive,
or machine that has a greater storage capacity than the partition/drive/machine on which the Gateway
Server machine is installed.

To modify the path to the directory holding temporary image files:

1.

2.

Open the file <Gateway Server root directory>\confi\topaz.config in a text editor.
Search for the parameter images.save.directory.offline.

Remove the comment marker (#) from the line that begins #images.save.directory.offline= and
modify the value to specify the required path.

Note: In Windows environments, use UNC path syntax (\\\\server\\path) when defining the
path. In a Linux environment, use forward slashes (/) and not backslashes (\) when defining
the path.

Save the topaz.config file.

Restart BSM on the Gateway Server machine.

Repeat the above procedure on all Gateway Server machines.

Map the newly defined physical directory containing the images to a virtual directory in the web

server on all Gateway Server machines. For details, see "Accessing Temp Directories with
Multiple Gateway Server Machines" on page 85.

How to Configure the Virtual Directory in IIS

1.

Rename the default physical directory containing the temporary scheduled report images on the
Gateway Server machine.

For example, rename:
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<Gateway Server root directory>\AppServer\webapps\
site.war\Imgs\chartTemp\offline

to

<Gateway Server root directory>\AppServer\webapps
\site.war\Imgs\chartTemp\old offline

2. InthelIS Internet Services Manager on the Gateway Server machine, navigate to Default Web
site > Topaz > Imgs > ChartTemp.

The renamed offline directory appears in the right frame.

3. Intheright frame, right-click and select New > Virtual Directory. The Virtual Directory Creation
Wizard opens. Click Next.

4. Inthe Virtual Directory Alias dialog box, type off1line in the Alias box to create the new virtual
directory. Click Next.

5. Inthe Web Site Content Directory dialog box, type or browse to the path of the physical directory
containing the temporary images, as defined in the images.save.directory.offline parameter (for
details, see "Accessing Temp Directories with Multiple Gateway Server Machines" on page 85).
Click Next.

6. If the physical directory containing the temporary images resides on the local machine, in the
Access Permissions dialog box, specify Read and Write permissions.

If the physical directory containing the temporary images resides on a machine on the network, in
the User Name and Password dialog box, enter a user name and password of a user with
permissions to access that machine.

7. Click Next and Finish to complete Virtual Directory creation.

8. Restart BSM on the Gateway Server machine.

9. Repeat the above procedure on all Gateway Server machines.

How to Configure the Virtual Directory on Apache HTTP Web Server

1. Rename the default physical directory containing the temporary scheduled report images on the
Gateway Server machine.

For example, rename:

<Gateway Server root
directory>\AppServer\webapps\site.war\Imgs\chartTemp\offline

to
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<Gateway Server root directory>\AppServer\webapps\site.war\Imgs\chartTemp\old_
offline

2. Open the Apache configuration file <Gateway Server root
directory>\WebServer\confihttpd.conf with a text editor.

3. Map a virtual directory named offline to the physical location of the common directory as follows:
a. Locate the line (note lower case "t" in topaz):
Alias /topaz "C:\HPBSM/AppServer/webapps/site.war/"
b. Above that line add the following line:
Alias /topaz/Imgs/chartTemp/offline "<shared_temp_image_directory>"
c. Locate the line (note upper case "T" in Topaz):
Alias /Topaz "C:\HPBSM/AppServer/webapps/site.war/"
d. Above that line add the following line:
Alias /Topaz/Imgs/chartTemp/offline "<shared_temp_image_directory>"
4. Replace <shared_temp_image_ directory> with the path to the physical directory containing the
temporary scheduled report images, as defined in the images.save.directory.offline parameter

(for details, see "How to Modify the Directory in Which Temporary Image Files Are Stored" on
page 88).

When specifying <shared_temp_image_directory> you must use double quotes and forward
slashes, for example:

Alias /Topaz/Imgs/chartTemp/offline "//myhost.myurl.com/chartTemp/offline"
5. Savethefile.
6. Restart BSM on the Gateway Server machine.

7. Repeat the above procedure on all Gateway Server machines.

How to Configure the Virtual Directory on Sun Java System Web Server

1. Rename the default physical directory containing the temporary scheduled report images on the
Gateway Server machine.

For example, rename:
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<Gateway Server root
directory>\AppServer\webapps\site.war\Imgs\chartTemp\offline

to

<Gateway Server root directory>\AppServer\webapps\site.war\Imgs\chartTemp\old_
offline

Open the Sun Java System Web Server configuration file <Sun Java System Web Server
installation directory>\server\<server_nam>\config\obj.conf with a text editor.

Add the following line inside the <Object name=default> directive (before the line NameTrans
fn=document-root root="$docroot", and before the line NameTrans fn="pfx2dir"
from="/Imgs" dir="ProductDir/Site Imgs/", if it exists):

NameTrans fn="pfx2dir" from="/topaz/Imgs/chartTemp/offline"
dir="<shared_temp_image_directory>"

where <shared_temp_image_directory> represents the path to the physical directory containing
the temporary scheduled report images, as defined in the images.save.directory.offline

parameter (for details, see "How to Modify the Directory in Which Temporary Image Files Are
Stored" on page 88).

Save thefile.
Restart the Sun Java System Web Server on the Gateway Server machine.

Repeat the above procedure on all Gateway Server machines.

How to Modify Length of Time BSM Keeps Temporary Image Files

1.

2.

Open the file <HPBSM Gateway Server root directory>\confitopaz.config in a text editor.

Before modifying the values, back up the file or comment out (using #) the default lines so that the
default values are available as a reference.

Modify the settings as required.
Save the topaz.config file.
Restart BSM on the Gateway Server machine.

Repeat the above procedure on all Gateway Server machines.
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How to Specify the Directories from Which Temporary Image Files Are
Removed

By default, temporary image files are removed from the root path of the specified directory. However,
you can also configure BSM to remove temporary image files from the subdirectories of the specified
path.

To configure BSM to remove temporary images files from subdirectories:
1. Open the file <Gateway Server root directory>\confi\topaz.config in a text editor.
2. Insert the following line after the specified path's other settings (described in the previous section):
remove.files.<num_of_path>.removeRecursively=yes
3. Save the topaz.config file.
4. Restart BSM on the Gateway Server machine.

5. Repeat the above procedure on all Gateway Server machines.

Enabling Docker Support for RUM Applications

You can configure whether to enable Docker monitoring options in RUM's Monitoring Settings to
monitor applications deployed on Docker containers.

Note: This is currently the beta version of this feature. For further information about this feature,
contact RUM_for_Docker Dev.

To enable Docker support for RUM applications:
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select EUM Administration.

4. Inthe EUM Administration - EUM Administration table, locate Enable Docker support for RUM
applications.

5. Set the value to true.
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Chapter 15: JMX Console

This section provides an overview to the JMX console and instructions for changing the JMX
password.

To access

Enter the relevant URL: http://<Gateway or Data Processing Server name>:29000/
where

<Gateway or Data Processing Server name> is the name of the machine on which BSM is running.

Note: By default, for security reasons, the JMX console is accessible only from the localhost. You
can disable this limitation so that you can access the JMX console remotely. See "How to Enable
Accessing JMX Console Remotely" on the next page.

Learn About

JMX Console Overview

The JMX console comes embedded in BSM, and enables you to:
« Perform management operations
« View performance of processes
« Troubleshoot problematic areas of BSM

The credentials to access the JMX console were configured when you installed BSM. To change your
JMX password, see "How to Change the JMX Password" below.

You can configure the JMX console to work with SSL to encrypt JMX data for added security. For
details, see "Configuring JBOSS to Work with SSL" in the BSM Hardening Guide.

Tasks

How to Change the JMX Password

1. Stop the BSM Gateway or Data Processing Server.
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2.

4.

Run the appropriate file, depending on the operating system in use, on either the Gateway or Data
Processing Server:

Operating System File Name
Windows <HPBSM root directory>\tools\jmx\changeCredentials.bat
Solaris <HPBSM root directory>\tools\jmx\changeCredentials.sh

The Change Password dialog box opens. Enter and confirm your new password. The operating
system registers and encrypts the password change on either the Gateway or Data Processing
Server.

Restart BSM.

Note: The login name cannot be changed.

How to Enable Accessing JMX Console Remotely

You can change the access level to the JMX console with the Restrict remote access to JMX
console infrastructure setting. The default value is true which allows access to the JMX console only
from the localhost.

1.

2.

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
Select Foundations.

Select Security.

In the Security-Login table, locate Restrict remote access to JMX console. Change the value to
false.
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This section provides information about baselines and how to enable, configure, and manually invoke
them.

Learn About

Baseline Overview

An application's status is determined by its transactions' actual performance and availability in relation
to configured performance and availability thresholds. You can use this information in components
such as Service Health, End User Management, Service Level Management, and Service Health
Analyzer.

When you configure an application for monitoring by Business Process Monitor, you can determine
whether its transactions' performance thresholds are static thresholds (specific threshold values that
you configure), or are calculated using baselines based on historical transaction data.

You can configure BSM to calculate baselines from actual performance metrics. Creating a baseline
enables you to learn the normal performance of your applications. Knowing how an application typically
performs enables you to determine whether a performance problem is an isolated incident or a sign of a
trend.

Baselines are updated periodically as new metrics data are received.

Note: A minimum amount of accumulated data is necessary before baselines can be calculated.
This depends on the number of samples collected and takes approximately one week after
baselines are enabled in BSM. You can speed up the process by manually invoking a baseline with
limited data. For details, see "How to Manually Invoke a Baseline" on page 98 below.

Baseline Coefficient

When baselining is enabled, BSM collects metric data from incoming samples over a period of time.
After enough data has been collected, BSM creates a baseline for the metric and calculates the mean
and standard deviation.

Mean and standard deviation values for a metric are used to create a baseline sleeve and to identify
metrics that deviate from the baseline. The mean and standard deviation are a statistical way of
estimating the normal behavior of a metric. By default, the baseline sleeve is calculated using a
coefficient of + or - 3 times the standard deviation from a metric's mean value.

This means that a metric is considered abnormal if its value is greater than the mean value plus 3 times
the standard deviation, or less than the mean value minus 3 times the standard deviation.
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This can be summarized as follows:
((Mean Value)-(3*STD)) <= NORMAL VALUE <= ((Mean Value)+(3*STD))

You can set a different coefficient for each data collector. For example you could set a coefficient of 2
for Cls received from BPM and a coefficient of 5 for Cls received from Diagnostics.

Seasonality and Trends

When calculating a metric's baseline, the baseline engine takes into account such things as
seasonality and trends.

« Seasonality - When a repeated pattern at constant time intervals occurs, a metric has seasonality.
For example a metric might have typical values at 8:00 every day when users log on, and different
values at 12:00 when users take a break.

« Trends - When a metric's values have a consistent linear change over time, a trend is identified.

Seasonality and trends are considered to be part of the normal behavior of a metric, and the baseline
sleeve is adjusted accordingly.

Baseline Example

The following example shows the baseline sleeve for the OK, minor, and critical thresholds for a
transaction in the Metrics Over Time report:
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Manually Invoking a Baseline

When you initially install and configure BSM it takes a week for the system to gather Cl data required to
establish a baseline. You can speed up this process by manually creating a baseline using limited data
from a single day after installing BSM. This means that 24 hours after installing and configuring BSM,
the system can already identify anomalies.

If you manually create a baseline with less than a week's data, the baseline will not include any
seasonal information such as different patterns over weekends, however, over time BSM will
automatically refine and improve the baseline as more data becomes available.

Note: You cannot manually create a baseline on the same day that you install BSM. This is
because the baseline process required an off-line process which runs automatically every night.
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Tasks

How to Enable Baselines

1. Select the Baselining option in:

m The Setup and Database Configuration Utility in a regular deployment (for details, see the
BSM Installation Guide).

m The Upgrade Wizard if you are performing an upgrade (see the Upgrade Guide relevant to your
upgrade path).

2. Create an Analytics database (Admin > Platform > Manage Analytics Databases) (see
"Creating Databases" on page 56).

Note: You can also enable baselining after BSM has been installed.

How to Set the Coefficient for a Data Collector

1. Select Admin > Platform > Infrastructure Settings > Applications > Service
Health Analyzer > Baseline Coefficient.

2. Enter the required coefficient. Multiple values should be separated by a semi-colon, for example
BPM,2.0;SiS,2.5;DIAG,5.0;PA,3.5;RUM,2.0;NNM,4.0.

If you do not set a coefficient for a data collector, BSM uses the default value of 3. For more
information on coefficients, see "Baseline Coefficient” on page 95.

How to Manually Invoke a Baseline

1. Inaweb browser, open the baseline JMX page using the following link:
http://<DPS>:29924/mbean?objectname=Topaz:service=Baseline+Services

2. Invoke the showTasks operation to identify the task IDs of your domain for example:

HP Business Service Management (9.26) Page 98 of 397



BSM Platform Administration Guide
Chapter 16: Baselines

Task Metric

ID Client Domain Status Start of period End of period Next run

33 1 RUM idle Sat Nov 29 Mon Dec 29 Mon Dec 29
00:00:00 IST 00:00:00 IST 00:01:00IST
2011 2011 2011

34 1 BPM idle Sat Nov 29 Mon Dec 29 Mon Dec 29
00:00:00 IST 00:00:00 IST 00:01:00IST
2011 2011 2011

3. Record the relevant task IDs and dates, and go back to the baseline JMX page (as listed above).
4. Invoke the calculateNow operation on each of the relevant task IDs.

5. To confirm that the process ran successfully, invoke the showTasks operation again and confirm
that the dates have been updated. The process might take some time.

Tips/Troubleshooting

JVM Often Crashes in Baseline Processes while Running Baseline Tasks

This problem is caused by the Java Virtual Machine. You can identify the problem by the following
errors in the file hs_err_pid.log:

« EXCEPTION_ACCESS_VIOLATION

« guarantee(result == EXCEPTION_CONTINUE_EXECUTION) failed: Unexpected result from
topLevelExceptionFilter

The log file is located in the working directory at the time of process execution.

Toresolve this problem, change the baseline process from 64 bit to 32 bit as follows:
1. Inthe JMX console, stop the service basel_engine as follows:
a. Inabrowser, enter http://[<DPS$>:11021/ and enter your user name and password.
b. Under Foundations, click Foundations:type=NannyManager.
c. Underjava.lang.String showServicelnfoAsHTML, click Invoke.
d. Nextto basel_engine, click Stop.

2. Onthe Data Processing Server, copy the file \HPBSM\JRE\bin\hpbsm_basel_engine.exe to
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the directory \HPBSM\JRE64\bin, overriding the existing file with the copy.

3. Restart the basel_engine service.
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You use the audit log to keep track of different actions performed by users in the system, according to
specific contexts.

To access

Select Admin > Platform > Setup and Maintenance > Audit Log

Learn About

About the Audit Log

You use the audit log to keep track of different actions performed by users in the system, according to
the following specific contexts:

« Alert Administration. Displays actions related to creating and managing alerts.

« CI Status Alert Administration. Displays actions related to creating alert schemes for a
configuration item (Cl) status alert.

. Data Collector Maintenance. Displays actions related to removing Business Process Monitors
and SiteScopes.

. Database Management. Displays actions related to creating, deleting, and modifying users and
passwords for profile databases, as well as modifying the status of the Purging Manager.

« Deleted Entities. Displays actions related to adding and deleting data collectors (Real User
Monitor engines and SiteScope monitors) from End User Management Administration.

« Downtime/Event Scheduling. Displays actions related to creating and modifying downtime and
scheduled events.

« End User Management Applications. Displays actions related to adding, editing, updating,
disabling and deleting event-based alerts, as well as registering and unregistering alert recipients.

« IT World Configuration. Displays actions, including editing, updating, and removing Cls and
relationships, performed in the IT Universe Manager application.

« Locations Manager. Displays actions related to adding, modifying, and deleting locations,
performed in the Location Manager application.

« Notification Template Administration. Displays actions related to modifying open ticket
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information, ticket settings, closed tickets, ticket templates, and subscription information:
notification types (locations or general messages), and recipients.

« Operations Management. Displays actions related to Operations Management, such as the
creating and modifying of content packs, event rules, and notifications.

« Permissions Management. Displays all actions related to assigning permissions, roles, and
permission operations on resources for users and user groups.

« Recipient Administration. Displays actions related to modifying information about the recipients
of audit logs.

« Scheduled Report Administration. Displays actions related to modifying the reporting method
and schedule of reported events.

« Service Health. Displays actions related to the Service Health application.

« Service Health Administration. Displays actions related to configurations made in Service Health
Administration.

« Service Level Management Configuration. Displays actions related to service level agreements
performed in the Service Level Management application.

« SLA Alert Administration. Displays actions related to creating, modifying, or deleting SLA alerts.
« System Availability Manager. Displays actions related to system availability and SiteScope.

« User Defined Reports. Displays actions related to the creation and modification of Custom
reports.

« User/Group Management. Displays actions related to adding, modifying, and deleting users and
user groups.

« View Manager. Displays actions related to KPIs such as adding a KPI, editing a KPI, and deleting

a KPI. Additionally, it displays actions related to changing the Save KPI data over time for this CI
and the Monitor changes options.

Tasks

How to Use the Audit Log

1. Select Admin > Platform > Setup and Maintenance > Audit Log.
2. Select a context.

3. Where relevant, select a profile from the list. BSM updates the table with the relevant information.
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4. Optionally, click the Auditing Filters link to open the Auditing Filters pane and specify filter criteria.
The following filters are available:

m User. Specify a userin the system to view actions performed by only that user.
m Containing text. Specify a text string that the action must contain to be displayed.

m Start after and End before. Specify a starting and ending time period to view actions for only

that period. Click the More J button to open the Calendar dialog box where you can select a
date.

5. Click Apply. BSM updates the table with the relevant information.

If required, use the Previous Page ﬂ or Next Page ﬂ arrows to navigate to the previous or next
page of the Audit Log.

How to Customize a Log File for Audit Log
The Audit Log uses the Apache logdj logging utility.

To customize the log file, edit its configuration file, located at:
<HPBSM root directory>\conficore\Tools\log4j\EJB\auditlog.properties
using the log4j configuration syntax. The log level should be set to INFO or higher.

Note: Do not change the appender name:
com.mercury.topaz.tmc.bizobjects.audit.AuditManager.writeAudit

Ul Descriptions

Note: For details about the audit log for EUM Alert Administration, see Alerts Log Report in the
BSM User Guide.

Audit Log Page
This page enables you to keep track of different actions performed by users in the system.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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<Audit log
table>

<EUM
applications>
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Description

Moves to the previous page or next page in the Audit Log.

Displays the contents of the audit log.

Select an <EUM application> for which you want to view the actions performed.

Note: This field is displayed only if you have chosen the End User Management-
Applications context.

Auditing Click the Auditing Filters heading to specify filter criteria.

Filters

Context Select a context to view.

For user Displays the user whose actions are displayed in the Audit Log, as specified in the
Auditing Filters pane.
Default Value: All

SiteScope Select a SiteScope for which you want to view the actions performed.
Note: This field is displayed only if you have chosen the System Availability
Manager context.

Time period Displays the time period whose actions are displayed in the Audit Log, as
specified in the Auditing Filters pane.
Default Value: All

Auditing Filters Pane

User interface elements are described below:

Ul Element (A-Z) Description

-]

[E24]

Apply
Cancel

Clear All

HP Business Service Management (9.26)

Opens the Calendar dialog box enabling you to select a date.

Expands the Auditing Filters pane.
Collapses the Auditing Filters pane.

Applies the selected filters.
Cancels filtering and closes the Auditing Filters pane.

Clears the filters and displays all log items.
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Ul Element (A-Z) Description

Containing text = Specify a text string to filter out all the actions that do not include this text string.

End before Specify an ending time until which you want to view actions.
Start after Specify a starting time from which you want to view actions.
User Select a user to view actions performed by only that user.
Audit Log Table
User interface elements are described below:
Ul Element (A-Z) Description
Actions Displays the actions performed by the specified user.

Additional Information = Displays additional information, where relevant.
Modification Date Displays the date and time that the specified actions were performed.

Modified By Displays the user who performed the specified actions.
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System Health is a standalone application that uses the SiteScope monitoring system to enable you to
monitor the servers, databases, and data collectors running as part of your BSM system.

You can use System Health to:

« Measure performance by viewing the output from monitors running on the various system
components.

« Monitor areas of the databases that influence performance.
« Display problematic areas of the servers, databases, and data collectors.
o Perform operations on your environment, such as:

= Move Backend Services. You can move backend services from one server to another of the
same type, in case the server machine is not functioning properly or requires downtime for
servicing.

m Configure Backup Servers. You can define a backup server in case the server machine is not
functioning properly or requires downtime for servicing.

= Manage BSM Processes. You can start or stop various BSM processes.
« View logfiles on specific components in a variety of formats.

« View information on components and monitors in .csv format (displaying current status) and Quick
Report format (displaying status of the past 24 hours).

You can access System Health through BSM or in a web browser.

For further information, see the System Health Guide.
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This section provides information about BSM server clocks.

Learn About

Checking Server Time Against NTP Server

In order to ensure that the BSM server clocks are accurate and synchronized, the BSM servers check
their system clocks against an NTP server every 20 minutes by default.

If no NTP server is reachable, the database clock is used for synchronization instead.

Viewing the Log for BSM Server Time Synchronization

You can view the log for BSM server time synchronization by accessing <BSM_HOME>\logs\topaz_
all.ejb.log.

Tasks

How to Add NTP Servers

Several NTP servers are configured by default, but you can manually add one in the configuration file:

<BSM_HOME>\confisettings\mtime\mtime.xml

How to View the BSM Server Time

You can view the current BSM server time via the following URLs:

« Toview Unix time in plain text:
http://<BSM_Server>/topaz/services/technical/time?alt=text/plain
Example results:

1314089070858
« Toview the current time in XML format:

http://<BSM_Server>/topaz/services/technical/time
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Example results:

<entry xmlns="http://www.w3.0rg/2005/Atom">

<id>timeService:1</id>

<title type="text" xml:lang="en">Time service.</title>

<summary type="text" xml:lang="en">The time is 2011-08-23 08:44:30,858</summary>
<published>2011-08-23T11:44:31.382+03:00</published>

<content type="text">1314089070858</content>

</entry>
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This section provides information about BSM Logs.

Note: This chapter is not relevant for HP Software-as-a-Service customers.

Learn About

This section includes:
o "BSM Logs - Overview" below
« "Log File Locations" below
« "Log File Locations in a Distributed Deployment" on the next page
« "Log Severity Levels" on the next page
« "Log File Size and Automatic Archiving" on the next page
« "JBoss and Tomcat Logs" on page 111
o "*.hprof Files" on page 111
» "Debug Trace Logging for an Event" on page 111

« "Logging Administrator Tool" on page 112

BSM Logs - Overview

BSM records the procedures and actions performed by the various components in log files. The log files
are usually designed to aid HP Software Support when BSM does not perform as expected.

You can view log files with any text editor.

Log File Locations

Most log files are located in the <HPBSM root directory>\log directory and in subdirectories
organized by component.

Log file properties are defined in files in the following directory and its subdirectories: <HPBSM root
directory>\conficore\Tools\log4j.
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Log File Locations in a Distributed Deployment

In one-machine or compact installations, all BSM servers and their logs reside on the same machine. In
the case of a distributed deployment of the servers among several machines, logs for a particular
server are usually saved on the computer on which the server is installed. However, if it is necessary
for you to inspect logs, you should do so on all machines.

When comparing logs on client machines with those on the BSM server machines, keep in mind that
the date and time recorded in a log are recorded from the machine on which the log was produced. It
follows that if there is a time difference between the server and client machines, the same event is
recorded by each machine with a different time stamp.

Log Severity Levels

Each log is configured so that the information it records corresponds to a certain severity threshold.
Because the various logs are used to keep track of different information, each is preset to an
appropriate default level. For details on changing the log level, see "How to Change Log Levels" on
page 112.

Typical log levels are listed below from narrowest to widest scope:

« Error. The log records only events that adversely affect the immediate functioning of BSM. When a
malfunction occurs, you can check if Error messages were logged and inspect their content to trace
the source of the failure.

« Warning. The log's scope includes, in addition to Error-level events, problems for which BSM is
currently able to compensate and incidents that should be noted to prevent possible future
malfunctions.

« Info. The log records all activity. Most of the information is routine and the log file quickly fills up.
« Debug. This level is used by HP Software Support when troubleshooting problems.

The default severity threshold level for log files differs per log, but is generally set to either Warning or
Error.

Note: The names of the different log levels may vary slightly on different servers and for different
procedures. For example, Info may be referred to as Always logged or Flow.

Log File Size and Automatic Archiving

A size limit is set for each type of log file. When a file reaches this limit, it is renamed and becomes an
archived log. A new active log file is then created.

For many logs, you can configure the number of archived log files that are saved. When a file reaches
its size limit, it is renamed with the numbered extension 1 (log.1). If there is currently an archived log
with the extension 1 (log.1), it is renamed to log.2, log.2 becomes log.3, and so on, until the oldest
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archived log file (with the number corresponding to the maximum number of files to be saved) is
permanently deleted.

The maximum file size and the number of archived log files are defined in the log properties files located
in <HPBSM root directory>\conficore\Tools\log4j. An example is:

def.file.max.size=2000KB
def.files.backup.count=10

JBoss and Tomcat Logs
The following <HPBSM root directory>\log directory holds JBoss- and Tomcat-related log files:

« jboss_boot.log. Logs startup activities including running the JBoss process, deployment, and
startup status, as well as the number of busy ports.

« jboss_server.log. Logs all JBoss activities including JBoss messages, deployment, and startup
status.

» jboss_tomcat.log. Logs the Tomcat messages.

Note: You can view the JMX Console at http://<HPBSM server>:29000/

* hprof Files

*.hprof files contain a dump heap of a BSM process's data structures. These files are generated by the
JVM if a process fails with a Java Out Of Heap Memory condition.

You are rarely aware of a problem because the problematic process restarts automatically after a
failure. The existence of many *.hprof files indicates that there may be a problem in one of the BSM
components, and its contents should be analyzed to determine the problem.

If you run out of disk space, you can delete the*.hprof files.

Debug Trace Logging for an Event

You can enable debug trace logging for an event by setting the custom attribute _ TRACE__. It may
have any severity level. By default, the event flow trace logging level is set to INFO. Only events with
the custom attribute _ TRACE___ set are logged to the flow trace log files. To enable flow tracing for all
events, set the flow trace log level to DEBUG.

You can enable trace logging on the HPOM server or agent sending the event, or you can add the trace
to the event at a later time. Whenever this custom attribute is enabled on an event, trace output for this
event appears in the following trace logs:

« BSM Data Processing Server: log/opr-backend/opr-flowtrace-backend.log

« BSM Gateway Server: log/opr-gateway/opr-flowtrace-gateway.log
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Logging Administrator Tool

The Logging Administrator tool enables you to temporarily modify the level of details displayed in BSM
logs, as well as create custom logs. You can access the BSM Logging Administrator Tool from the
following URL:

http://<BSM Gateway Server>/topaz/logAdminBsm.jsp

Tasks

How to Delete BSM Logs

You can delete all BSM log files under /opt/HB/BSM/log and *.hprof files under /opt/HP/BSM/bin
after stopping BSM. This enables you to free up disk space. However, from a support perspective, it
may be useful to save older logs.

Caution: Do not delete the log directory.

1. Stop BSM.
2. Delete all files under <BSM>\log. Do not delete the log directory.

3. Delete all .hprof files under /lopt/HP/BSM/bin/.

Note: Some files cannot be deleted, because they are owned by [IS or Apache.

How to Change Log Levels

If requested by HP Software Support, you may have to change the severity threshold level in a log, for
example, to a debug level.

1. Open the log properties file in a text editor. Log file properties are defined in files in the following
directory: <HPBSM root directory>\conficore\Tools\log4;.

2. Locate the loglevel parameter. For example,

loglevel=ERROR

3. Change the level to the required level. For example,

loglevel=DEBUG

4. Save thefile.
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This sections provides a list of the ports that are used by BSM. This list can be used as a tool for
troubleshooting, monitoring and ensuring BSM servers are configured correctly. In addition, instructions
are provided for configuring these ports.

Learn About

This section includes:
« "Port Usage Overview" below
« "Data Processing Server (DPS)" on the next page

« "Gateway Server (GW)" on page 117

Port Usage Overview

The BSM suite uses a number of ports. A port is an application-specific or process-specific software
construct serving as a communications endpoint in a computer's host operating system. Each port is
associated with the IP address of the server, as well as the type of protocol used for communication.

Some of the ports listed below are optional (depending on which infrastructure is being used), others are
mandatory. Some of the listed ports are only used for troubleshooting access to the application via the
Java Management Extensions (JMX) consoles. It is important, however to have access to these ports
so that data from BSM can be quickly accessed and issues can be identified.

Each of the mandatory ports must remain open for proper BSM operation. Optional ports may become

mandatory if particular configurations of BSM are used. For example, BSM can use either SQL Server

or Oracle as its database. Depending on which database is used, ports 1433/1434 (SQL Server) or port
1521 is mandatory.

System Health can be used to monitor the status of the BSM applications, processes and services that
utilize these ports. A mapping from each port to the infrastructure defined and monitored by System
Health appears in each of the following tables. For some ports, there is no one-to-one mapping to
infrastructure in System Health. In these situations the mapping will be listed as N/A.

Note: An extensive range of ports are used between the BSM Data Processing Server (DPS) and
Gateway (GW) server for the use of Java’s Remote Method Invocation (RMI) protocol. HP
Software does not advise or support the use of operating system firewalls on either of these
servers. HP Software does not advise or support having firewall servers installed between these
BSM servers.

Note: In the following tables, OUTBOUND and INBOUND is windows terminology and
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OUTPUT/INPUT is Linux firewall/iptables packet filtering terminology.

Data Processing Server (DPS)

Port

Number Type of Traffic

25

161

383

1099

1433

1434

1521

4447

5445

5455

HP Business Service Management (9.26)

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

INBOUND/INPUT

INBOUND/INPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

Port Usage

SMTP channel from the HP Business
Management Server to the SMTP mail
server

SNMP channel from the Data
Processing Server to the SNMP
manager

Events coming from HP Operations
Manager into the Operations
Management application

Naming service used by the JBOSS
application server

Connection between the HP BSM
Servers and Microsoft SQL Server

Connection between the HP BSM
Servers and Microsoft SQL Server
Browser Server. This port is only used
when a named instance is used.

Connection between the HP BSM
Servers and Oracle Database Server

Remote Method Invocation (RMI)
channel between HP Business Service
Management servers

HornetQ Bus port for the connection
between the Data Processing Server
and the Gateway Server

HornetQ Bus processes for the
connection between HP Business
Service Management servers

Mandatory/Optional

Optional.
Mandatory if SMTP
is used for Alerts

Mandatory

Optional.

Mandatory if HP
Operations Manager
is used

Optional.

Optional.
Mandatory if SQL
Server database
used

Optional.
Mandatory if SQL
Server database
used

Optional.
Mandatory if Oracle
database used

Mandatory

Mandatory

Mandatory.
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Port

Number Type of Traffic

8009

8443

11020

11021

21212

21301

29000

29602

29608

29610

29612

29622

29628

29630
29700
29711
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Localhost

INBOUND/INPUT
INBOUND/INPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

INBOUND/INPUT

Localhost

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT
INBOUND/INPUT
INBOUND/INPUT

Port Usage

Tomcat AJP13 connector

Secure Connection to RTSM URL

RMI management channel for the HP
Business Service Management
Service (Nanny Manager)

HTTP channel for the HP Business
Service Management Service (Nanny
Manager)

HTTP channel for the ODB process

RMI communication from backend to
EPI server Admin services

HTTP channel for the JMX console and
RMI communication

RMI management channel for the
HornetQ Bus processes

RMI management channel for the
Offline BLE process

RMI management channel for the
Partition and Purging Manager

RMI management channel for the ODB
process

RMI management channel for the OPR
backend process

RMI for script execution for OPR
backend process

RMI port for online BLE processes
RMI port for Marble Supervisor process

RMI port for Marble Worker 1 (online
BLE)

Mandatory/Optional

Mandatory for
localhost access

Mandatory

Mandatory

Mandatory, JMX

Mandatory, JMX

Mandatory

Mandatory for
localhost access,
JMX, JBOSS,
Tomcat, Jetty
Mandatory
Mandatory
Mandatory
Mandatory
Mandatory

Mandatory

Mandatory
Mandatory

Mandatory
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Port

Number Type of Traffic

29712

29713

29714
29720

29800

29811

29812

29813

29820

29908
29910

29922

29928

29930

30020

31000-

32999

49152-
65535

HP Business Service Management (9.26)

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT
INBOUND/INPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT
OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

INBOUND/INPUT

INBOUND/INPUT

Port Usage

RMI port for Marble Worker 2 (online
BLE)

RMI port for Marble Worker 3 (online
BLE)

RMI port for Marble (online BLE)

RMI port for Marble Matcher (online
BLE)

HTTP port for Marble Supervisor
process

HTTP port for Marble Worker 1 (online
BLE)

HTTP port for Marble Worker 2 (online
BLE)

HTTP port for Marble Worker 3 (online
BLE)

HTTP port for Marble Matcher (online
BLE)

HTTP port for offline BLE processes

HTTP channel for the Partition and
Purging Manager

HTTP channel for the OPR backend
process

HTTP port for script execution for
pipeline processing in OMi

HTTP port for Business Impact
process

HTTP port for marble loader processes

HP Business Service Management
service (Nanny Manager) uses the first
available port in each range

Dynamic ports are used for inter-
component channels using Java RMI

Mandatory/Optional

Mandatory

Mandatory

Mandatory

Mandatory

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory

Mandatory
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Gateway Server (GW)

Port
Number Type of Traffic

25 OUTBOUND/OUTPUT

80 OUTBOUND/OUTPUT

123 OUTBOUND/OUTPUT

383 INBOUND/INPUT
389 OUTBOUND/OUTPUT
443 OUTBOUND/OUTPUT
1099 INBOUND/INPUT

1433 OUTBOUND/OUTPUT

1434 OUTBOUND/OUTPUT

HP Business Service Management (9.26)

Port Usage

SMTP channel from the HP
Business Management Server to
the SMTP mail server

HTTP channel to Gateway
Server Applications / Apache or
[IS Web Server

NTP channel from the Gateway
Serverto the NTP server

Events coming from HP
Operations Manager into the
Operations Management
application

Connection between the
Gateway Server and LDAP
server for authentication

HTTPS channel to Gateway
Server Applications. This is also
used for reverse proxy / Apache
or [IS Web Server

Naming service used by the
JBOSS application server

Connection between the HP
BSM Servers and Microsoft SQL
Server

Connection between the HP
BSM Servers and Microsoft SQL
Server Browser Server. This port
is only used when a named
instance is used.

Mandatory/Optional

Optional.
Mandatory if SMTP is used
for Alerts

Mandatory.

Optional if you are
accessing console through
HTTPS (port 443)

Optional.

Not needed if Network
Time Protocol not used, but
we recommend using this
to keep times between
servers in sync.

Optional.
Mandatory if HP Operations
Manager is used

Optional.
Mandatory if LDAP is used

Optional.
Mandatory if HTTPS
access is used.

Mandatory

Optional.
Mandatory if SQL Server
database used

Optional.
Mandatory if SQL Server
database used
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Port

Number Type of Traffic

1521

5445

5455

8009

8443

11020

11021

21212
21302

21303

29000

29602

HP Business Service Management (9.26)

OUTBOUND/OUTPUT

INBOUND/INPUT

INBOUND/INPUT

Localhost

INBOUND/INPUT

INBOUND/INPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT
INBOUND/INPUT

INBOUND/INPUT

Localhost

INBOUND/INPUT

Port Usage

Connection between the HP
BSM Servers and Oracle
Database Server

HornetQ Bus port for the
connection between the Data
Processing Server and the
Gateway Server

HornetQ Bus processes for the
connection between HP
Business Service Management
servers

Tomcat AJP13 connector

Secure Connection to RTSM
URL

RMI management channel for
the HP Business Service
Management Service (Nanny
Manager)

HTTP channel for the HP
Business Service Management
Service (Nanny Manager)

HTTP connection to ODB

RMI communication from
console web-app to admin web-

app

RMI communication from
console web-app to custom
action script server running on
the same host

HTTP channel for the JMX
console and RMI
communications

RMI management channel for
the HornetQ Bus processes

Mandatory/Optional
Optional, Mandatory if

Oracle database used

Mandatory

Mandatory

Mandatory for localhost
access

Mandatory

Mandatory

Mandatory, JMX

Mandatory, JMX

Mandatory

Mandatory

Mandatory for localhost
access, JMX, JBOSS,
Tomcat, Jetty

Mandatory
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Port

Number Type of Traffic

29603

29604

29612
29616
29903
29904
29916
29929

31000-
32999

49152-
65535

Tasks

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

INBOUND/INPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT

OUTBOUND/OUTPUT
INBOUND/INPUT

INBOUND/INPUT

Port Usage

RMI management channel for
the DB Loader process

RMI management channel for
the Web Data Entry (WDE)
process

RMI management channel for
the ODB process

RMI management channel for
the Scheduler process

HTTP channel for the DB Loader
process

HTTP channel for the Web Data
Entry (WDE) process

HTTP channel for the Scheduler
process

HTTP port for the OPR process

HP Business Service
Management service (Nanny
Manager), uses the first
available port in range

Dynamic ports are used for inter-
component channels using Java
RMI

Mandatory/Optional

Mandatory

Mandatory

Mandatory

Mandatory

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory, JMX

Mandatory

Mandatory

Note: The ports listed above are the ports BSM uses. If you need to change a port assignment, it
is strongly recommended that you first consult with HP Software Support.

This section includes:

« "How to Manually Change Port 80" on the next page

« "How to Manually Change Ports 1433 and 1521" on page 121

« "How to Manually Change Port 8009" on page 122

HP Business Service Management (9.26)
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« "How to Manually Change Port 29000" on page 122

o "How to Manually Change Port 4447" on page 123

How to Manually Change Port 80

Port 80 is used by the BSM Web Server. To modify this port, you must reconfigure other components
on the BSM server and restart BSM.

1. Modify the virtual Gateway Server settings.

a. Navigate to Administration Tab > Platform > Setup and Maintenance Tab >
Infrastructure Settings and locate the Platform Administration - Host Configuration
table. If this table is not visible, set the Select Context option to All.

b. Modify the Default Virtual Gateway Server for Application Users URL to
http://<server name>:<new port>.

c. Modify the Default Virtual Gateway Server for Data Collectors URL to
http://<server name>:<new port>.

2. Modify the direct Gateway Server settings

a. Inthe same table, modify the Direct Gateway Server for Application Users Server URL to
include the new port.

b. Modify the Direct Gateway Server for Data Collectors URL to include the new port.
3. Modify the local virtual Gateway Server settings

a. Inthe same table, modify the Local Virtual Gateway Server for Application Users URL to
include the new port.

b. Modify the Local Virtual Gateway Server for Data Collectors URL to include the new port.
4. Modify the Open BSM URL

a. Remotely connect to the BSM Gateway server and select Start > All Programs > HP
Business Service Management.

b. Right-click Open HP Business Service Management and select Properties.

c. Inthe Web Document tab, modify the URL field as follows: http://<Gateway Server>:<new
port>/topaz.

5. Modify the web server settings
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Modify the web server settings. This procedure varies depending on your version of Windows and
web server type. They should all be performed in the BSM Gateway server. The following are
examples for Windows Server 2008 using three different web servers:

For IIS 7.x / 8.x with Windows Server 2008 / 2008 R2 / 2012 / 2012 R2:

a. Open Microsoft's Computer Management tool by right-clicking My Computer and selecting
Manage.

b. Expand Roles > Web Server and select Internet Information Services.

c. Intheright-hand panel you can see the I1IS Manager. In the left part of this panel
(Connections), expand the connection of the current machine and expand the Sites node.

d. Right-click Default Web Site and select Edit Bindings.
e. Select the line that listens to port 80 and click edit to change the value to the new port.
For Apache with Windows Server 2008:
a. Open the file <BSM_Gateway home>\WebServer\confihttpd.conf in a text editor.
b. Gotothe line that begins with Listen, and modify the port value as required.
c. Gotothe line that begins with ServerName and modify the port value as required.

6. Restart all BSM servers and update data collectors.

Restart all BSM servers and update any data collectors that were configured before you modified
the port (for example, RUM, BPM, SiteScope). Modify the Gateway Server address in each data
collector to reflect the new port as follows: BSM Gateway>:<new port>.

How to Manually Change Ports 1433 and 1521

These ports control the communication between HP BSM and Database Servers.
1. Modify the Management Database port

Run the Setup and Database Configuration Utility. Modify the port in the screen that specified the
Management Database port. For details about the Setup and Database Configuration Utility, see
the BSM Installation Guide.

Note: You can also perform this procedure manually as follows: On all BSM servers
(Gateway and DPS), open <BSM_home>\confiTopazInfra.ini in a text editor and modify the
dbPort property as required.

2. Modify Profile Database port.
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Navigate to Admin > Platform > Setup and Maintenance > Manage Profile Databases and

click the Edit Database Properties button J to modify the desired database configuration to
include the new port.

3. Restart all BSM servers.

How to Manually Change Port 8009

This port number is the port through which the Tomcat AJP13 connector enables communication
between components on the BSM server. Perform the following on each BSM server whose Tomcat
AJP13 connector port you want to redirect, and restart BSM.

1. Change the Web Server Tomcat AJP13 connector port definition.

a. Inatext editor, open the file /lopt/HP/BSM/jboss-
as/standalone/configuration/standalone.xml.

b. Locate the port 8009 section.
c. Change the port number.
2. Change the Tomcat AJP13 listening port definition.

a. Inatext editor, open the files located in the folder <BACroot>\WebServer\conf.
b. Change port 8009 wherever it appears in the files. Verify that port 8009 appears at least once.

3. Restart all BSM servers.

How to Manually Change Port 29000

This port number is the port through which the Tomcat connector enables BSM server HTTP
communication. Perform the following on each BSM server whose Tomcat connector port you want to

redirect, and restart BSM.

Note: After this port is changed, the HAC status will not be displayed in the BSM Status page.
This does not affect the normal execution of BSM.

1. Change the Tomcat HTTP connector listening port definition.

a. Inatext editor, open the file Jlopt/HP/BSM/jboss-as/bin/standalone.conf.
b. Locate the string -Djmx.http.port=29000.

c. Change the port number.
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2. Change the value of the topaz.adminserver.url parameter from 29000 to the new port number.
a. Inatext editor, open the file <BSM_home>\conf\topaz.config.
b. Inaweb browser, access http://localhost:<new port number>/topaz
c. Under the Internal Port line, insert the following new row:

internalport=<new port>

topaz.administrator.url+http://localhost:9090/topaz

# Internal Port At topaz.config file

internalport=9090

3. Restart all BSM servers.
4. Forchanges on the Processing server,
a. Inatext editor, open the file <BSM_home>\confitopaz.config.
b. Inaweb browser, access http://localhost:<new port number>/topaz.
c. Underthe Internal Portline, insert the following new row:
internalport=<new port>

5. Restart all BSM servers.

How to Manually Change Port 4447
This port number is the JBoss RMI/JRMP invoker.

1. Change the JBoss configuration.
a. Inatext editor, open the file Jlopt/HP/BSM/confi/settings/jboss_config.xml.

b. Change the port number in the section [jboss.config.socket_name.remoting].
<value from="4000" t0="99999" type="number">

4447
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</value>

c. Inatext editor, open the file Jlopt/HP/BSM/jboss-
as/standalone/configuration/standalone.xml.

d. Locate <socket-binding name="remoting" port="4447"/>.

e. Change the port number.

Note: The port must be in the range of 4000 to 99999.

2. Restart the BSM servers.
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BSM directories that contain key configuration and data files should be backed up on a daily basis as a
precautionary measure.

The table below lists the BSM directories that contain such files and should therefore be backed up. All
directories are under <HPBSM root directory>.

Resource

\HPBSM\BLE

\HPBSM\conf

\HPBSM\dat

\HPBSM\dbverify\conf

\HPBSM\EJBContainer\bin

\HPBSM\bin

\HPBSM\lib

\HPBSM\AppServe\GDE

\HPBSM\odb\conf
\HPBSM\odbl\lib

\HPBSM\odb\classes

\HPBSM\odb\runtime\fcmdb
\HPBSM\_postinstall

\HPBSM\opr\bin

HP Business Service Management (9.26)

Comments

Configuration of business rules. Back up if business
rules have been created.

Assorted BSM configuration files.
Assorted BSM configuration files.

Configuration files for dbverify. This directory does
not have to be backed up if dbverify has not been
run.

Configuration files for the scripts used to run BSM,
and environment settings.

BSM binary files. Back up if changes were made to
any of the installation defaults.

BSM library files. Back up if changes were made to
any of the installation defaults.

Configuration files for the Generic Reporting Engine,
used for obtaining data for reports.

RTSM main configuration directory

RTSM library files. Back up if changes were made
to any of the installation defaults.

RTSM patch files. Back up if any patches were
added.

RTSM adapter files.
Post-installation configuration files.

Operations Management application binary files.
Back up if changes were made to any of the
installation defaults.
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Resource

\HPBSM\opnlib

\HPBSM\opr\webapps

\HPBSM\opr\newconfig

\HPBSM\AppServer\webapps\site.war\WEB-
INF\sam\hi-mapping-monitors.xml

HP Business Service Management (9.26)

Comments

Operations Management library files. Back up if
changes were made to any of the installation
defaults.

BSM web application files. Back up if changes were
made to any of the installation defaults.

Assorted BSM configuration files and libraries.

Custom EMS monitor types. Back up if any
customer EMS SiteScope monitors were
configured.

This file is present only if BSM was upgraded from
versions 9.0 - 9.20.
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This section describes how to configure BSM to work with languages other than English and discusses
some of the issues that arise when using a non-Latin character set.

Learn About

Multilingual User (MLU) Interface Support

The BSM user interface can be viewed in the following languages in your web browser:

Language Language Preference in Web Browser
French French (France) [fr]

Spanish Spanish [es-ES]

German German [de-DE]

Russian Russian [ru-RU]

Japanese Japanese [ja]

Korean Korean [ko]

Simplified Chinese Chinese (China) [zh-cn]

The following are languages in which BSM can operate but the user interface of only Run-time Service
Model (RTSM)-related pages are presented in the language:

Language Preference in Web

Language Browser

Dutch Dutch (Netherlands) [nl]
Portuguese Portuguese (Brazil) [pt-br]
Italian Italian (Italy) [it]

Use the language preference option in your browser to select how to view BSM. The language
preference chosen affects only your local machine (the client machine) and not the BSM machine or
any other user accessing the same BSM machine.
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Tasks

How to Display Non-Latin Languages in Service Health Top View

1.

Verify that you correctly followed the instructions for installing the JRE on a non-Western
Windows system. See the Oracle web site for details.

Make sure that you:

m Have administrative permissions to install the J2SE Runtime Environment on Microsoft
Windows 2000 and XP.

m (For users installing the JRE on non-Western 32-bit machines) - Select a Custom Setup Type.
In Custom Setup under feature 2 (Support for Additional Languages), select This feature
is installed on local hard drive.

Close all instances of the web browser.

Log into BSM and access Service Health Top View. Verify that the Chinese or Japanese
characters now appear correctly.

How to Set Up and View BSM in a Specific Language

1.

Install the appropriate language's fonts on your local machine if they are not yet installed. If you
select a language in your web browser whose fonts have not been installed, BSM displays the
characters as squares.

If you are logged into BSM, you must log out. Click Logout at the top of the BSM window.

Close every open browser window or, alternatively, clear the cache (if BSM is running on Internet
Explorer).

If BSM is running on Intermnet Explorer, configure the web browser on your local machine to select
the language in which you want to view BSM (Tools > Internet Options).

a. Click the Languages button and in the Language Preference dialog box, highlight the
language in which you want to view BSM.

b. If the language you want is not listed in the dialog box, click Add to display the list of
languages. Select the language you want to add and click OK.

c. Click Move Up to move the selected language to the first row.

d. Click OK to save the settings.
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e. Open the BSM login window.

f. From the Internet Explorer menu, select View > Refresh. BSM immediately refreshes and the
user interface is displayed in the selected language.

Note: For details on viewing web pages in Internet Explorer that are written in a different
language, see How to View Web Pages That Are Written in a Different Language
(http://support.microsoft.com/kb/306872/en-us).

4. If BSMis being viewed on Firefox, configure the web browser on your local machine as follows:

a. Select Tools > Options > Advanced. Click Edit Languages. The Language dialog box
opens.

b. Highlight the language in which you want to view BSM.

If the language you want is not listed in the dialog box, expand the Select language to add...
list, select the language, and click Add.

c. Click Move Up to move the selected language to the first row.

d. Click OK to save the settings. Click OK to close the Language dialog box.

Troubleshooting and Limitations

This section includes:
« "Installation and Deployment Issues" on the next page
« "Database Environment Issues" on page 131
o "Administration Issues" on page 132
« "Service Level Management Issues" on page 133
« "Application Management for Siebel Issues" on page 133
« "Report Issues" on page 133
« "Business Process Monitor Issues" on page 133
« "Real User Monitor Issues" on page 134
« "End User Management Administration Issues" on page 134

« "Data Flow Management Issues" on page 134
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« "Multilingual Issues" on page 134

o "Multilingual User (MLU) Interface Support Issues" on page 135

Installation and Deployment Issues

« Ifyouuse a CJK language in your browser, you must ensure that the Gateway Server machine
running BSM has East Asian languages installed. On the machine on which the BSM Gateway
Server is installed, select Control Panel > Regional & Language Options > Languages >
Install files for East Asian languages.

Note: This configuration will not work for an SQL Server installed in English.

« If youinstalled BSM on a non-English Windows operating system, the command line tool output
may not be displayed correctly because the Windows and OEM code pages differ. This may not be
the case on many Asian language systems, but is often experienced on non-English European
systems.

To fix this, configure the Windows Command Prompt so that a TrueType font is used and the OEM
code page is the same as the Windows code page.

In a Windows Command Prompt window (run cmd.exe):
a. Right-click the title bar, select Properties, and open the Font tab.

b. Change the font from Raster Fonts to a TrueType font, and change the font size if necessary
(for example: select Lucida Console, 12 pt).

c. If prompted, modify the shortcut to make the font change global.

Note: If you use other command line tools, such as PowerShell or Cygwin Bash, change the
font for each of these tools separately.

To change the codeset for the system, open the registry editor (regedit), and go to: Computer\HKEY_
LOCAL_MACHINE\SYSTEM\

CurrentControlSet\Control\N1ls\CodePage. If the values of ACP and OEMCP differ, edit
OEMCP to the same value as for ACP, and reboot the system.

Note: If changing the OEM code page for the system is not acceptable, for each newly opened
Comand Prompt window, change the code page value using the command: chcp <APC
value>.

« Business Process Monitors and the Gateway Server must be installed on an operating system that
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has the same locale as the data.

« During Business Process Monitor installation, non-Latin characters cannot be used for the host
name and location. If necessary, after installation you can change the names to include non-Latin
characters, in Admin > End User Management > Settings.

« Theinstallation path for all BSM components must not contain non-Latin characters.

« When content packs are available in more than one language, the language of content packs
automatically loaded during BSM installation depends on the current locale of the host operating
system. If there are matching content packs for the current locale, these are installed. If the locale
does not have localized content packs, English content packs are used. Later, a user can upload
the content pack in another language manually.

At every Gateway Server startup, the contents of the following directory is checked: <HPBSM root
directory>/conf/opr/content/<locale of server>

Any package that has not already been loaded, and that does not have unresolved package
dependencies (references to packages, which are neither already loaded nor in the same folder), is
loaded during this startup.

The following directory is checked next: <HPBSM root directory>/conf/opr/content/en_US

Any content packs that were not uploaded from the first location are uploaded. This can result in
mixed-language content.

The packages are loaded with the standard import mode; already existing artifacts are not changed.
Only new artifacts are added.

Note: Progress can be followed in the admin backend log file. The operation is done in the
background and may still be in progress when a user logs in. The system prevents multiple
content packages from being loaded at the same time.

Database Environment Issues

« Towork in a non-Latin-character language BSM environment, you can use either an Oracle Server
database or a Microsoft SQL Server database. When using a Microsoft SQL Server database, it
should use the same encoding as you use in your BSM servers. When using an Oracle Server
database, the encoding of the database can also be UTF-8 or AL32UTF-8, which supports both non-
Latin-character languages as well as multiple languages. For a list of supported and tested
database servers, refer to the BSM System Requirements and Support Matrixes.

« When you create a new Oracle instance in an Oracle database, you must specify the character set

for the instance. All character data, including data in the data dictionary, is stored in the instance's
character set. For details on working with Oracle databases, refer to Deploying and Maintaining the
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Oracle Server Database in the BSM Database Guide. For supported and certified Oracle character
sets, refer to Oracle Summary Checklist in the BSM Database Guide.

« The SiteScope Database Query Monitor can connect to an Oracle database but the Oracle user
names and passwords must contain only Latin characters.

Administration Issues

o Email alerts sent with ISO-2022-JP encoding are supported only by an SMTP server running on a
Windows platform. Use of this encoding affects all BSM servers.

« When using the default authentication strategy, Lightweight SSO, to authenticate users logging into
BSM, user names and passwords can be in non-Latin characters.

« Tosupport non-Latin characters in BSM databases, the encoding for databases must be defined as
UTF-8 or AL32UTF-8 (Oracle only), or set to the specific language.

Note: This cannot be done for SQL Server.

« Tosupport non-Latin characters in log files, set the log4j encoding property on the log4j
configuration files.

To write a specific log in UTF-8 encoding, do the following:

a. Search the specific log name in log4j configuration at conf/core/Tools/log4;.

b. Inthe properties file where this log file is configured, add the following property:

logdj.appender.<appender name>.Encoding=UTF-8

For example, the jboss_server.log configuration follows:

e e e R
### define appender: jboss.appender ###
T e e R
# jboss.appender is set to be a FileAppender which outputs to log/jboss_
server.log

log4j.
log4j.

appender.
appender.

server.log

log4j.
log4j.

log4j

log4j.
log4j.

appender.
appender.
.appender.
appender.
appender.

jboss.
jboss.

jboss.
jboss.
jboss.
jboss.
jboss.

appender=org.apache.log4j.RollingFileAppender
appender.File=${merc.home}/${log.file.path}/jboss_

appender.MaxFileSize=${def.file.max.size}
appender.Encoding=UTF-8
appender.MaxBackupIndex=${def.files.backup.count}
appender.layout=org.apache.log4j.PatternLayout
appender.layout.ConversionPattern=${msg.layout}
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Service Level Management Issues

Service Level Management does not support service names that contain more than 50 multibyte
characters.

Application Management for Siebel Issues

« Non-Latin characters may not appear or may be corrupted in the Topology View. If you encounter
this problem, install the Arial Unicode Microsoft font from the Microsoft web site.

« By default, BSM only supports English language Siebel. Do not deliver data from a non-English
version of Siebel to BSM. You should use special translation adapters to enable BSM to work with a
non-English version of the Siebel application. For details, contact HP Software Support.

Report Issues

o BSM does not support Custom Report names that contain more than 50 multibyte characters.

« The Page Component Breakdown report does not support URLs that contain multibyte characters.
When specifying a URL and a location from which to run the breakdown, you must enter Latin
characters in the URL box.

« Excel reports must have Latin-character file names when uploading to BSM running on a Chinese
Simplified operating system. To view Excel reports, select Applications > User Reports >
Report Manager.

« Reports downloaded from BSM to Excel cannot be displayed properly on an operating system
whose language differs from the data language.

To download Excel files with multibyte data when BSM is installed on an English-language
machine, set the user.encoding entry in the <HPBSM root
directory>\AppServer\resources\strings.properties file to the correct encoding.

Business Process Monitor Issues

« Ifthe Business Process Monitor (BPM) log files contain non-Latin-character data, you must open
them in a viewer that supports UTF-8 format parsing, for example, Notepad, rather than from the
View BPM Files window in the BPM Admin Console.

Log files that are saved in the default encoding of the server on which the BPM Admin Console is
installed are shown correctly in the View BPM Files window.

« AllBPM instances (such as application, scripts, and parameters) should be named with Latin
characters or BPM Server locale characters only.
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Real User Monitor Issues

« Real User Monitor supports non-Latin characters in UTF-8 format. For details on configuring the
RUM probe to support non-Unicode encodings, see Configuring the HP Real User Monitor Probe for
[18N in the Real User Monitor Administration Guide.

« Tosupport non-Latin characters from Real User Monitor, the encoding for BSM databases must be
defined as UTF-8, or set to the specific language. For further details, see "Database Environment
Issues" on page 131.

« The Real User Monitor Probe Windows installation screens are in English only and are not
translated. For details on installing the Real User Monitor Probe, see Installing the HP Real User
Monitor Probe in the Real User Monitor Administration Guide.

End User Management Administration Issues

« Global replace does not support non-Latin-character languages.

o When accessing the Status Snapshot in End User Management (Applications > End User
Management > Status Snapshot), certain characters appear unreadable. To resolve this, ensure
that you have installed files for East Asian Languages on your local machine, as follows:

Select Start > Control Panel > Regional and Language Options > select the Languages tab >
select Install Files for East Asian Languages.

Data Flow Management Issues

When exporting a Cl instance to a PDF file, Japanese characters are not displayed in the PDF file.
(Data Flow Management > Discovery Control Panel > Basic Mode. Run discovery. When
discovery has finished, select a CIT in the Statistics Results pane. Click the View Instances button.
In the Discovered by dialog box, select Export Data to File > Export Displayed Cls to PDF.)

Multilingual Issues

« The SNMP notification method does not support multilingual text, and can only send a notification in
the character set of the Gateway Server machine. This is because BSM uses SNMP version 1.0,
which does not support multilingual data.

« Error messages in the Failed Transactions report do not display correctly when BSM runs on an
English operating system and the Business Process Monitor runs on a Japanese operating system.
To access the Failed Transactions report, select Applications > End User Management >
Business Processes > Error Summary. Locate the General Errors table, and click a link to open
the Failed Transactions window.
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o BSM can store multilingual data only when Oracle is used and is set up as UTF-8 encoding.
However, a regular executable cannot usually accept multilingual data on the command line.

The following table describes the procedures that you must perform to add multilingual data to the
command line when running an executable file upon alert:

Platform Procedure

Windows = To prevent multilingual data from being lost, write the application with a wmain
function instead of a main function. You can also use another main-type function that
can take command line parameters of type wchar instead of type char.

Note: When you use the SubAlerts command line option, the created XML file does
not include an encoding attribute, and the encoding is different from the default UTF-8
encoding.

Solaris Inform the writer of the application that the parameters passed to the application must
be encoded in UTF-8.

For details on Using a Custom Command Line When Running an Executable File upon Alert, see
"Run Executable File Dialog Box" in the BSM Application Administration Guide.

« An executable file that was created for a previous version of BSM is compatible with a multilingual
version.

Multilingual User (MLU) Interface Support Issues

« Thereis no language pack installation. All translated languages are integrated into the BSM
Multilingual User Interface (MLU).

« Dataremains in the language it is entered in, even if the language of the web browser changes.
Changing the language of the web browser on your local machine does not change the language of
any data that was entered by a user.

« You cannot deploy a package if the server locale is different from the client locale and the package
name contains non-Latin characters. For details, see "Package Manager" in the RTSM
Administration Guide.

« You cannot create a package that contains resources (for example, views and TQLs) having non-
Latin characters in their names, if the server locale is different from the client locale. For details, see
"Package Creation and Deployment in a Non-English Locale" in the RTSM Administration Guide.

« Inthe Modeling Studio, you cannot create a new view if the view's name contains more than 18

Japanese characters. For details on creating new views, see "Modeling Studio" in the Modeling
Guide.
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« InLocation Manager, all geographical locations are in English, regardless of the Ul language
selected. Logical locations may be named in any language you choose, and remain in that language
even if the Ul language is subsequently changed.

« The BSM server status HTML page appears only in English. It is not translated into any other
language. For details, see Post-Deployment in the BSM Installation Guide.
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This section provides information about the Location Manager.

To access

o Select Admin > Platform > Locations

« Toaccess Location Manager from End User Management Administration , select Admin > End
User Management > Settings > Business Process Monitor Settings > BPM Agents and click

to open the Change Agent Location dialog box.

Learn About

Location Manager Overview

The Location Manager is used to define geographical and logical location Cls and assign them ranges
of IP addresses. Location Cls can be attached to any other Cl. They are used, for example, to attach a
location to a Business Process Monitor (BPM) agent or a page discovered automatically by Real User
Monitor (RUM).

Location Manager is accessible to users who have Administrator or System Modifier predefined
permissions. Permissions are configured in Admin > Platform > Users and Permissions.

Location Details and Descriptions

« Location Entity. An entity that describes a place in the world. It may be a geographical location,
such as a country or a city, or a logical location, such as a building. The location entity may be
connected to devices and logical Cls representing end-users or data center locations.

« Geographical Location. An absolute location in the world, selected from a predefined list of
cities/states/countries, and assigned specific geographical coordinates.

« Logical Location. A user-defined virtual location, which may or may not relate to a real location in
physical space. If you assign geographical coordinates to a logical location, these coordinates can
be changed or deleted.

Note: All geographical locations are in English, regardless of the Ul language selected. Logical
locations may be named in any language you choose, and remain in that language even if the
Ul language is subsequently changed.
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« Hierarchy. Locations may be nested under other locations, creating a hierarchical tree with a
maximum of seven levels under the root.

« Geographical Coordinates. Longitude/latitude values, in degrees (expressed as decimal
fractions). Coordinates are assigned to individual locations.

« Default Container. The parent location for all locations discovered automatically by Real User
Monitor (RUM). By default, the Default Container is World (the root of the Locations tree), but any
location on the tree can be set as the Default Container.

« IP Ranges. Each location may be assigned a set of IP ranges. An IP range is a range of IP
addresses that have been designated for use by devices in a certain geographical area.

Populating the Location Manager

Location Manager can be populated with locations in a number of ways:

« Using the Location Manager in Platform Admin. For details on the user interface, see "Location
Manager Page" on page 144.

o Mass upload from an XML file. BSM enables you to create and define location Cls using an XML
file external to the user interface. Mass upload is an alternative to using the user interface, and
better suited for defining a large number of locations.

For details, see "How to Create a Hierarchy of Locations using XML File" on the next page.

« Using Real User Monitor (RUM). When RUM encounters an IP address for which the location is
unknown, that IP is propagated to the Location Manager for location discovery. The Location
Manager then searches in the Hexasoft IP2Location repository for a geographical location that
matches the given IP address. If a match is found, new locations are created in the Location
Manager for the IP address. Depending on the information in the IP addresses repository, at most
three locations (country, state, and city) may be created for each IP address.

Note: If End User Management (EUM) is enabled after being disabled, it may take a few hours
until automatic discovery of locations starts to work. This is the time that it takes for the IP-to-
location information to load into the database.

Tasks

This section includes the following tasks:
« "How to Create a Hierarchy of Locations using XML File" on the next page
« "How to Populate the Location Manager" on page 142

« "How to Update Locations Using Mass Upload" on page 142
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« "How to Set a Geographical Location" on page 144

« "How to View Location Cls in IT Universe Manager" on page 144

How to Create a Hierarchy of Locations using XML File

You can define your own hierarchy of locations by creating an XML file and loading it through a Java
Management Extensions (JMX) console. (For details on accessing and using the JMX, see "JMX
Console" on page 93.)

The XML can be generated and edited in any tool that supports text. You can create the file yourself, or
base it on an XML file created by BSM in the JMX console, which already includes the tags, elements,
and attributes necessary for the mass upload XML file.

XML File Details

For a reference detailing all the XML tags, elements, and attributes included in the mass upload file, see
"XML Tag Reference" on page 151.

Each mass upload XML must begin with the following declarations:

o <?xml version="1.0" encoding="UTF-8"?> This states that this is an XML file with UTF-8
character encoding.

« <IDOCTYPE locations_manager SYSTEM "./locations.dtd"> This is the document type
declaration. The locations.dtd file is located in the HPBSM/conf/locations folder. The path to
locations.dtd must be specified relative to the location of your XML file, and may need to be
updated. If your XML file is saved in the same location as locations.dtd, no path is necessary.

The XML file is validated using the locations.dtd file. If the XML structure is incorrect, you get a
SAXParseException and the operation fails. If the DOCTYPE line does not correctly reference the
path of the locations.dtd file, validation and the entire operation fails.

Note: Populating the location manager through XML results in deletion of all locations that were
previously defined in the Location Manager.

XML File Example

In this example, customer 1 wants to upload an XML file to create a hierarchy of locations in Location
Manager, as follows: The first location, a site in Los Angeles, includes geographical coordinates, ISP
address ranges, and ISPs. Locations 2 and 3 are nested under the first location (Los Angeles), and 2a
and 2b are under 2. Location 4 is parallel to Los Angeles in the hierarchy.

World
o Los Angeles; latitude 34.0396, longitude -118.2661; ISPv4 address range 4.38.41.136 to

4.38.80.152 (ISP = Level 3 Communications); ISPv6 address range
2002:0C19:8B00:0000:0000:0000:0000:0000 to 2002:0C 19:B28F:0000:0000:0000:0000:0000 (ISP
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= AT_T WorldNet Services)
= |ocation 2
o location_2a
o location_2b
= |ocation 3
« location 4

There is no need to add the World root location.
The XML file used to upload this hierarchy of locations is as follows:

<?xml version="1.0" encoding="utf-8" ?>
<IDOCTYPE locations_manager SYSTEM "conf/locations/locations.dtd">
<locations_manager>
<customer_hierarchy customer_id="1">
<locations_list>
<location location_name="Los Angeles">
<latitude>34.0396</latitude>
<longitude>-118.2661</longitude>
<ip_ranges>
<ip_range>
<start_ip>4.38.41.136</start_ip>
<end_ip>4.38.80.152</end_ip>
<isp>Level 3 Communications</isp>
</ip_range>
<ip_range ip_v6="true">

<start_1ip>2002:0C19:8B00:0000: 0000 : 0000 : 0000 :0000</start_

ip>

<end_1ip>2002:0C19:B28F : 0000 : 0000 : 0000 :0000:0000< /end_ip>

<isp>AT_T WorldNet Services</isp>
</ip_range>
</ip_ranges>
<locations_list>
<location location_name="location_2">
<locations_list>
<location location_name="location_2a" />
<location location_name="location_2b" />
</locations_list>
</location>
<location location_name="location_3" />
</locations_list>
</location>
<location location_name="location_4" />
</locations_list>
</customer_hierarchy>
</locations_manager>
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For information on each of the XML elements and attributes, see "XML Tag Reference" on page 151.

How to Populate the Location Manager
The Location Manager can be populated with location Cls in a number of ways. You can:
« Create locations with the user interface. Use the Locations Manager user interface to create,

edit, and manage locations and assign them IP ranges. For details about the user interface, see
"Location Manager Page" on page 144.

« Populate the Location Manager using an XML file. Upload location Cls to the Location Manager
using an XML file external to the user interface. Mass upload is an alternative to using the user
interface, and better suited for populating the Location Manager with a large number of locations.

For details on this task, see "How to Update Locations Using Mass Upload" below.

How to Update Locations Using Mass Upload

This task describes how to load an XML file, change an existing location hierarchy using XML, and
view the results.

The XML file must comply with the rules listed below. If any of the rules are violated,
buildLocationsHierarchyFromXML aborts before any changes are made to the locations model:

« Notwo locations on the same hierarchical level (having the same parent) may have the same name.
A location directly under customer _hierarchy (that is, directly under the root location, World) and a
location in another place in the hierarchy may not have the same name unless one instance refers to
a geographical location and the other to a logical location; or they refer to different types (country,
state or city) of geographical locations, such as the country Mexico and city Mexico, or the state
New York and city New York.

« A maximum of seven levels of hierarchy can be defined.
« Notwo locations may have the same ID.
« Alllocation ID values in the XML must match an existing location with that ID.

« Notwo overlapping IP ranges are allowed.

Note: Saving the existing hierarchy in a file may lengthen the time required to load the new XML
file.

To Upload Locations Using Mass Upload:

Create the file yourself in any tool that supports text. Save the XML file you created to a network
location accessible to the BSM server. For details, see "How to Create a Hierarchy of Locations using
XML File" on page 140. For details on the XML file elements and attributes, see "XML Tag Reference"
on page 151.
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Or

7.

Export the current hierarchy as XML using the JMX console, as described in the steps below.

Open the JMX console on this machine. (For detailed instructions, see "JMX Console" on
page 93.)

Under the BSM-Platform section, select service=Locations Manager.
Invoke the convertLocationsHierarchyToXML method with the following values:

m customerld. By default, use 1 for customerlD. If you are an HP SaaS customer, use your HP
SaaS customer ID.

m target path. The location where you want to save the XML file.
Open the XML file you just saved:

m Check that the list of existing locations looks accurate. The World root location is not included
in this XML file.

m To add a new location, no ID should be defined.
= To modify alocation, change the fields, but do not change the real ID.
m Todelete alocation, delete all its details from the XML file.

m To change a location's position in the hierarchy, move the location with its real ID to another
position in the XML file.

Save the XML file you created to a network location accessible to the BSM server.

Save the XML file into the same directory as the locations.dtd file so you do not have to
reference a different path in the document type declaration line of the XML file. The
locations.dtd is located in the <HPBSM root directory>\confilocations directory.

To upload your edited XML file, in the JMX service=Locations Manager, invoke the
buildLocationsHierarchyFromXML method.

a. Inthe xmliFilePath parameter, enter the path to the location where you saved the XML file.

b. Inthe savelnFile parameter, select True to save the existing locations hierarchy in the file
<HPBSM root directory>\confllocations\current_locations_hierarchy.xml.

The locations have now been uploaded to the Location Manager. They are visible on the Locations Tree
of the user interface and through the JMX console.
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How to View the Location Hierarchy through the JMX

1. Under service=Locations Manager, locate the getAllLocations method.

2. Enterthe relevant customer ID. By default, use 1 for customerlD. If you are an HP SaaS
customer, use your HP SaaS customer ID.

3. Invoke the method and check that all your locations are there, including the World root location.

How to Set a Geographical Location

In the Location Properties area, you can set a geographical location and its coordinates from a
predefined list of countries and areas, states, and cities; or name a logical location and set its
geographical coordinates. Defining a location as a geographical location allows Discovery to
automatically assign discovered IP addresses to the location.

To define a location as a geographical location:

1. Inthe Location Properties area, select the appropriate country/state/city (country alone,
country/state, or country/city may be selected as well).

2. Click .

How to View Location Cls in IT Universe Manager
1. Select Admin > RTSM Administration > Modeling > IT Universe Manager.

2. Select Locations view.

Ul Descriptions

This section includes:
« "Location Manager Page" below
« "New/Edit IP Range Dialog Box" on page 149
« "Geographical Map Dialog Box" on page 150

o "XML Tag Reference" on page 151

Location Manager Page

The Location Manager page enables you to manage locations and assign the locations IP ranges.
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The Location Manager page includes the following areas:
"Locations Area Left Pane" below
"Location Properties Area" on the next page

« "IP Ranges Area" on page 147
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In the Locations area, on the left pane of the Locations page, you can add, delete, and move locations,
and set a location as the default container. Locations appear in a tree structure, with a maximum of

seven hierarchical levels, whose root (level zero) is called World.

User interface elements are described below. You can also access these actions from a context menu

by right-clicking on the Locations area of the left pane.

ul
Element Description

L]

Add location. Click to add a new location below the selected location. Opens the

Location Properties area. See "Location Properties Area" on the next page
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Ul

Element Description

b4

L
.!‘.9"5'3

g

o

Delete location. Click to delete a location and its children locations.

If you delete a location, any IP ranges assigned to it or its children can be moved to its
parent location. To do this, select the Move IP Ranges to the Parent Location check
box in the Confirmation window that appears.

Cut location. Click to cut a location. The location is copied to the clipboard, and can be
pasted below another element in the locations tree.

Note: When a location is cut, it remains visible, grayed out, in its former place on the tree,
until it has been pasted in a different position. To deselect a cut location before it has
been pasted to a different position, and return it to its original position, click Cut location
again.

Paste location. Available when a location has been cut and the user has navigated to
another part of the tree.

Set as default container. Click to set a particular location as the default container. This
is the parent location for all automatically discovered locations.

For more information, see "Location Manager Overview" on page 138.

Location Properties Area

In the Location Properties area, you can set a geographical location and its coordinates from a
predefined list of countries and areas, states, and cities; or name a logical location and set its
geographical coordinates. Defining a location as a geographical location allows Discovery to
automatically assign discovered IP addresses to the location. To define a location as a geographical
location, select the appropriate country/state/city (country alone, country/state, or country/city may be

selected as well) and click =

Note: Geographical location can be set only from a predefined list. If you manually enter the name
of alocation, it is created as alogical location.

User interface elements are described below:

Ul Element Description

<Country or Use the first and third drop-down controls to select country or area and city.
Area>/<State>/<City> When USA is selected as country, the middle dropdown becomes

available, and can be used to select a particular state.
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Ul Element Description

[+ Set geographical location. Click to locate the geographical coordinates
(longitude and latitude) of the selected country/state/city and automatically
enter name and coordinates into the appropriate fields under Location
Properties, defining the location as a geographical location.

IE' Select Location Coordinates. Click to launch the Geographical Map
dialog box, which can be used to select the geographical coordinates of
any location.

For more information, see "Geographical Map Dialog Box" on page 150.

Get coordinates from nearest parent. Click to copy the geographical
coordinates of the closest parent location with coordinates, to the selected
location.

Name Enter the name of the location in the Name text box.

Notes:

If you assign the same name to more than one location under different
parents, a small caution symbol displays indicating that the name has
already been defined for another location and suggesting that the name be
changed.

If you change the name of a geographical location, its association with the
original geographical location is maintained.

Longitude/Latitude Enter the longitude and latitude of the location.

If you select a location from the predefined drop-down lists of countries,
states, and cities, or from the Geographical Map dialog box, the longitude
and latitude boxes are filled automatically.

IP Ranges Area

You can use the IP Ranges area to assign IP ranges to a location. Real User Monitor (RUM) then uses
these ranges to assign newly discovered pages and other Cls to particular locations.

The table of IP ranges may contain thousands of pages. To view the table in a single file, you can
export it in Excel or Adobe Acrobat (PDF) formats.

User interface elements are described below:
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Ul
Element Description

|:| New IP Range. Click to create a new IP range. Opens the New |IP Range dialog box.
Note: A particular IP range can be assigned to only one location.

If you try to assign an IP range that overlaps with a parent IP range, a message displays,
warning that this action will remove the IP range from the parent location. (Only the area
of overlapping ranges is removed, and the parent IP ranges are adjusted accordingly.)
Click Remove from Parent to remove the overlapping IP range from the parent and
reassign it to the selected location, or Cancel.

If you try to assign an IP range that overlaps with a range already assigned to another
location (not a parent), an error message is displayed and you must select a different IP
range.

Edit IP Range. Click to edit a selected IP range. Opens the Edit IP Range dialog box.
See "New/Edit IP Range Dialog Box" on the next page.

5]

Delete IP Range. Click to delete one or more selected IP ranges.

%]

W

Export to Excel. Click to export IP range information for the selected location to an
Excel spreadsheet.

Export to PDF. Click to export IP range information for the selected location to an Adobe

Acrobat file.
Find To find an existing range in which a particular IP address is located:
Range
of IP 1. Select the appropriate radio button:

= |IPv4 (Internet Protocol version 4) for addresses consisting of four numbers, each
ranging from 0 to 255, in dot-decimal notation)

m [IPv6 (Internet Protocol version 6) for addresses consisting of eight hexadecimal
numbers, each ranging from 0 to FFFF, in colon-separated notation)

2. Enterthe IP address in the Find Range of IP box.

3. Click .

The system highlights the range in which the IP address is found.

Note: This searches for the IP range in the currently selected location only.

HP Business Service Management (9.26) Page 148 of 397



BSM Platform Administration Guide
Chapter 24: Location Manager

Ul

Element Description

From Tofilter the IP ranges for a particular string of text in their lower and upper IP range limits,
IP/To ISP names, or IP versions, enter the string in the From IP, To IP, ISP, or IP Version
IP, ISP, boxes.

IP

These boxes may be used in combination with each other. An asterisk (*) may be used as

Version i
a wildcard to represent one or more characters.

For example:
« Tofilter for IPv6 addresses, enter "6" in the IP Version box

« Tofilter for IPv4 address ranges whose upper limits end in 0, enter "*. *.*.0" in the
From IP box.

New/Edit IP Range Dialog Box

To access, select Admin > Platform > Locations and click L under IP Ranges.

User interface elements are described below:

Ul

Element Description

IP Choose IPv4 or IPv6 to select:
version

« Internet Protocol version 4 (for IP addresses consisting of four numbers, each ranging
from 0 to 255, in dot-decimal notation)

« Internet Protocol version 6 (for IP addresses consisting of eight hexadecimal
numbers, each ranging from 0 to FFFF, in colon-separated notation)

From Use the From IP and To IP boxes to set the range of IP addresses for the location.

IP/To IP
« ForIPv4, as you enter an IP address in the From IP box, a corresponding address

ending with 255 is automatically entered into the To IP box. All values in both boxes
may be changed to any permissible value (0-255), but the address in the To IP box
must be the same or higher than the address in the From IP box.

The IPv4 range must not exceed 50,000,000 IP addresses.

o ForlIPv6, as you enter an IP address in the From IP box, the same address is
automatically entered into the To IP box. All values in both boxes may be changed to
any permissible value (0-FFFF), and the address in the To IP box may be higher, the
same, or lower than the address in the From IP box.

ISP Specify the Internet Service Provider in the ISP box.
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Geographical Map Dialog Box

The Geographical Map dialog box enables you to select the geographical coordinates of any location. If
geographical coordinates were previously entered into the Longitude and Latitude boxes, these are
passed to the Geographical Map dialog box, which opens with a pin on that location.

Note: Users who are not connected to the Internet see another version of this map.

To access, from the Location Properties area of the Locations page, click .
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User interface elements are described below:

Ul Element Description

Zoom In. Click to zoom in on the map.

Note: This icon is located on the toolbar. Another Zoom In icon with
identical functionality appears on the map.
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Ul Element Description

Zoom Out. Click to zoom out on the map.

Note: This icon is located on the toolbar. Another Zoom Out icon with
identical functionality appears on the map.

Reset. If you open the Geographical Map at a particular set of coordinates
and then pan elsewhere, clicking Reset recenters the map to the starting
coordinates.

Pin/Drag radio Select Pin to move the pin to any location on the map by clicking on that
buttons location. Double-clicking moves the pin and zooms in on the location.

Select Drag to drag the map.

<Country or Use the first and third drop-down controls to select country or area and city.
Area>/<State>/<City> When USA is selected as country, the middle drop-down becomes
available, and can be used to select a particular state.

Find location on map. Click to locate the selected country or area and
city on the map.

r T | Pan in Any Direction. Click and hold on this control and drag to pan

L across the map.

Road View Click to see aroad map of the world.

Aerial View Click to see an aerial photographic map of the world.

Bird's Eye The bird's-eye view is disabled.

Labels In Aerial View, click to display or hide map labels. This is disabled in Road
View.

Enter Coordinates Click to automatically copy the coordinates of the pinned location to the

Longitude and Latitude boxes of the Location Properties area.

XML Tag Reference

Following are tables that list all the elements and attributes that are used in the mass upload XML file:

« Elements Table

Element Description Attributes
locations_ Initial element in a block containing Location Manager data
manager
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Element Description Attributes
customer_ Initial element in a hierarchy of locations for a particular customer customer_
hierarchy id
locations_list | Initial element in alist of locations
location Initial element in block defining attributes for a particular location location_
name

latitude Latitude of the location, in degrees
longitude Longitude of the location, in degrees
ip_ranges Initial element in a list of IP address ranges for a particular location
ip_range Initial element in block defining attributes for a particular IP address ip_v6

range
start_ip Lower limit of IP address range

IP address ranges may be IPv4 or IPv6. Location Manager supports

the following notation formats:

IPv4 — number of 4 bytes

IPv4 — string in x.x.x.x format

IPv6 — number of 16 bytes

IPv6 — string in x:x:x:x:x:x:x:x format

IPv6 — IPv6 regular expression
end _ip Upper limit of IP address range. For supported IPv4 and IPv6 notation

formats, see start_ip, above.

Note: IPv4 range must not exceed 50,000,000 IP addresses.
isp Name of ISP for the range
« Attribute Table

Parent
Attribute Element Description Example
customer_ customer_ Number. Unique and mandatory. ID number of the <customer_
id hierarchy | customer for whom a hierarchy of locations is built. hierarchy
customer_
id="1">
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Parent
Attribute Element

location_ | location
name
ip_v6 ip_range

« Implied Attribute Table

The following attributes are exported when exporting the current hierarchy as XML but are not required

Description Example

String. Mandatory. Not unique (several locations, if not = <location

siblings, can have the same name). Name of a location_
particular location. name="Los
Angeles">

Boolean. ="true" if IP addresses for a particularrange  <ip_rangeip_
are in IP version 6 format. Otherwise, they are in IP v6="true">
version 4 format.

when defining new locations in the XML. When updating an existing location through XML, these
attributes need to be preserved:

Attribute
original_geo_location_id

location_type

location_id

Example:

Parent Element Description
location Used to identify geographical locations
location Possible values:

« "undefined" (default)

« "country"
« "state"
o "city"
location The real ID of an existing location

<location_name="UNKNOWN" location_type="undefined" location_

id="47a3711c334fd8577858c6da60b3e0eb6" original geo location_id="Unknown_Unknown">

Troubleshooting/Limitations

Location Export/Import XML via JMX Console Limitation

Inthe BSM Ul, you can create two sub-locations with the same name.

Using the JMX console, you can create an XML file of this location hierarchy.

However, using the JMX console, you cannot create a location hierarchy from the XML file that was

created from a hierarchy that contains sub-locations with the same name.
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This section discusses BSM-specific content packs only. For information about the HP Universal
CMDB Discovery and Integration Content Pack, see Package Manager in the RTSM Administration
Guide.

Learn About

This section includes:
« "Content Packs Overview" below
« "Content Types " on the next page
« "Content Pack Types " on the next page
« "Content Pack Definitions" on page 156

« "Content Packs Manager Interfaces " on page 157

Content Packs Overview

Content is information that BSM uses to describe and enrich the objects or configuration items that you
are monitoring in your IT environment. The objects can be, for example, network hardware, operating
systems, applications, services or users.

Content for a specific management area can be contained in a dedicated content pack. A content pack
can contain a complete snapshot of all, or any part of, your content -- the rules, tools, mappings,
indicators and assignments that you define and configure to help users manage your IT environment.
Content packs are used to exchange customized data between instances of BSM, for example in test
and production environments.

The Content Packs Manager helps you manage packs of content data. It enables you to create a
content pack, save it in afile, install or update content, and take content from one installed instance of
BSM and upload it to another, using the export and import features.

BSM provides a number of content packs, for example for Smart Plug-ins (SPIs), that you can either
use in the default configuration or, if necessary, modify to suit the demands of your environment. Such
content is usually specified as Predefined, and can be modified (Predefined (Customized)). This
modified content can be reverted to the predefined values.

You can use the Content Packs Manager to perform the following tasks:

« Define the contents of a content pack and save the definition. For details, see "Defining Content
Packs" on page 157.
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« Manage dependencies between content packs. For details, see "Dependencies in Content Packs"
on page 165.

« Export a content pack (definition and content) and the data it references to a file called a content
pack. For details, see "Exporting Content Packs" on page 168.

« Import a content pack (definition and content) and the data it references. For details, see "Importing
Content Packs" on page 166.

Content Types

Content types are referred to using the following terminology:
» Predefined Content

Predefined content is usually content provided by HP or HP Partners and is designed to provide the
initial configurations for a BSM installation.After installing a predefined content pack, you may
change these initial artifacts to suit your environment and management needs. Any modified
predefined artifacts are labeled as Predefined (Customized).It is not possible to remove
predefined artifacts, but you can revert any customized artifacts to their original, "predefined"
values.

« Custom Content

Custom content is content that is created by the customer, for example for managing a custom, in-
house application, and is labeled as Custom.

o Customized Content

Modified predefined artifacts are labeled as Predefined (Customized).You can revert any
customized artifacts to their original, "predefined" values.

Content Pack Types

Content pack types are referred to using the following terminology:
« Predefined Content Pack

Predefined content packs are collections of predefined content typically provided by HP or HP
Partners and are designed to provide the initial configurations for a BSM installation.

After installing a predefined content pack, you may change these initial artifacts to suit your
environment and management needs. Any modified predefined artifacts are labeled as Predefined
(Customized). It is not possible to remove predefined artifacts, but you can revert any customized
artifacts to their original, "predefined" values.

When importing the content of predefined content packs, this content is labeled as Predefined.
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m Predefined content packs must contain unique content. It is not possible to include identical
content in more than one predefined content pack. This is checked on export and an appropriate
error message displayed.

m Predefined content packs must not contain referenced content.

= Predefined content packs cannot be modified or directly deleted (as opposed to artifacts which
can be modified). If you want to make changes to a predefined content pack, you must create a
new version. When you import a new predefined content pack version, it overwrites the old
version.

Note: To modify a predefined content pack, select Create a New Version of the Selected
Content Pack Definition and specify a new version number. For more details, see "How to
Create a New Version of a Predefined Content Pack Definition" on page 159.

It is only possible to delete a predefined content pack in Content Pack Development mode
(enabled in the Infrastructure Setting: Operations Management - Content Manager
Settings).

o Custom Content Pack

Custom content packs are collections of content typically created by the BSM user, for example for
managing a custom, in-house application.

When importing the content of custom content packs, this content is labeled as Custom.

Custom content packs can have the same content as other custom or predefined content packs.

Content Pack Definitions

Content Pack Definitions serve two purposes:
« Creating Content Packs including the artifacts referenced by it.
« Describing predefined content of the system, serving as an inventory of predefined content.

A Content Pack Definition is identified by its name and version. It is not possible to have two Content
Pack Definitions in the system with same name and version. It is possible to duplicate any definition by
specifying either different name or different version. A new or duplicated content pack definition is
labeled as a custom definition.

Only one Content Pack Definition with a given name can be predefined. If a Content Pack with
predefined content based on a Content Pack Definition with the same name is imported, its definition
does replace the existing definition.

Predefined content packs with predefined content from HP are imported during the BSM product
installation. You can change the predefined artifacts, which then are marked as Predefined
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(Customized). You can also revert customized artifacts to their original predefined values, but you
cannot delete them.

Content Packs Manager Interfaces

The features and functionality of the Content Pack manager are accessible from following interfaces.
- BSM Content Packs User Interface
For details, see "Contact Packs Page" on page 162.
« ContentManager Command-line Interface (CLlI)
The features and functionality of the Content Pack manager are also accessible using the
ContentManager command-line interface. You can access the ContentManager command-line

interface directly, in a shell, or remotely, for example, in a script.

For details, see "Content Pack Manager Command-Line Interface" on page 176.

Note: You cannot use the ContentManager command-line interface to create a content pack
definition.

« ContentAutoUpload Command-line Interface (CLI)

During BSM installation, all prdefined Content Pack Definition files are automatically uploaded from
the default content pack location on the Data Processing Server:

<BSM Root Dir>/conf/opr/content/<locale>

Using the ContentAutoUpload, you can:

m Retrigger the default content pack upload

m  Specify a different folder from where content packs are uploaded

For details, see "Content Pack Auto Upload Command-Line Interface" on page 179.

Defining Content Packs

This section provides instructions for defining content packs.

To access

o Select Admin > Platform > Content Packs.
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Select Admin > Operations Management > Setup > Content Packs

Learn About

Defining Content Packs - Overview

A content pack definition contains a list of the data and the relationships between them to be included in
a content pack which you can export to another BSM installation.

Creating a content pack is a two-step process. First you create the content pack definition in the
Content Manager, and then you use the definition to export selected content to a content pack file.

Note: The content pack definition does not include the ClI types themselves. To exchange Cl
types, use the features provided by the Run-time Service Model (RTSM).

Tasks

This section includes the following tasks:

"How to Grant and Restrict Access to Content Packs Manager" below

"How to Create and Edit Content Pack Definitions" on the next page

"How to Create a New Version of a Predefined Content Pack Definition" on the next page
"How to Set a Dependency" on page 160

"How to Check your Content Packs Before Publishing " on page 160

How to Grant and Restrict Access to Content Packs Manager

1.

2.

Select Admin > Platform > Users and Permissions.

Click User Management.

Select the user for which you want to modify the Content Manager permissions.
Click the Permissions tab in the right pane.

In the Context pane, select Operations Management context > Administrative Uls > Content
Pack.

Click the Operations tab.

Assign the permissions as needed.
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How to Create and Edit Content Pack Definitions

1. Click Admin > Platform > Content Packs to open the Content Packs page.

m To create a new content pack definition, click IZI The Create New Content Pack Definition
wizard opens.

= To edit an existing content pack definition, select it and click . The Edit Content Pack
Definition dialog box opens.

2. Inthe General page of the wizard, or the General tab of the dialog box, enter information in the
Display Name, Name, and Version fields.

= The Name and Version combination must be unique.

m The Name field is limited to a maximum length of 255 characters. The first character must be a
letter (A-Z, a-z) or an underscore (_). All other characters may be letters, numbers, or
underscores. No leading or trailing spaces are allowed. When you export the content pack, the
contents of the Name field is the default file name for the file, with OMi Content Pack -as a
prefix.

= The Display Name is the name displayed in the Content Pack Definitions list, and need not be
unique. It is limited to a maximum length of 255 characters.

m The Version is afree text field. Use Version in combination with Display Name to manage
version control of your content packs.

3. Continue to follow the wizard pages or edit the tabs of the dialog box to select content, set
dependencies, and view a summary of your content pack definition's contents and any problems
found.

For details on the user interface and all the available options, see "New Content Pack Definition
Wizard" on page 164.

How to Create a New Version of a Predefined Content Pack Definition
1. Make sure that the Enable Content Pack development settings is enabled:

Caution: It is not recommended to create new versions of predefined Content Packs that you
are not responsible for as this may result in upgrade errors in the future.

a. Click Admin > Platform > Setup and Maintenance > Infrastructure Settings to open the
Infrastructure Settings.
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b. Select Applications and from the Applications drop-down list, select Operations
Management.

c. From the Operations Management - Content Manager Settings pane, set Enable Content
Pack development to true.

Click Admin > Platform > Content Packs to open the Content Packs page and select the
predefined content pack definition for which you want to create a new version.

Click . to open the Create New Content Pack Definition Version dialog box.
Change the version number of the content pack and click OK.
The new version of this content pack is saved as a custom content pack.

Open the new version of the content pack definition, make the changes that you need, and save
the changes.

For details on the user interface and all the available options, see "New Content Pack Definition
Wizard" on page 164.

How to Set a Dependency

1.

Open your Content Pack Definition for editing in the Content Manager and select the
Dependencies tab.

Inspect all content artifacts printed in normal font. Select the Content Pack that is the owner of the

referenced artifact and click the Set Dependency toolbar button or shortcut menu to set a
dependency toit. The goal is to have no content artifacts displayed in normal font in the
Dependencies tab.

How to Check your Content Packs Before Publishing

Before you publish a newly developed content pack, you should make the following checks on a
system where all available Content Packs (at least all OOTB Content Packs) plus your Content Pack

is imported.

These checks help you to have clear ownerships of the content artifacts, which helps in upgrade
scenarios and in developing new Content Packs.

Problems Found by Content Manager

Select your Content Pack Definition in the Content Manager and check if there is a Problems
Found panel reported at the bottom of the Details pane.
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This section typically reports inconsistencies between your Content Pack Definition and the
available content. You must solve the reported problems before exporting the Content Pack. For
example, your Content Pack Definition references content or dependent content that does not exist
in the system. You must either remove the referenced content or dependency from your Content
Pack Definition or make sure that the referenced content dependency is "installed".

o Check for Content in other Content Packs

Open your Content Pack Definition for editing in the Content Manager and select the Content tab.
Check if there is a section titled Content in other Content Packs (bottom of Included Content
pane).

In the Content in other Content Packs section, inspect each content artifact and decide if you are
really the owner of this content artifact. If you are not the owner, exclude the content artifact from
your Content Pack Definition and set a dependency to the owning Content Pack. Otherwise,
contact the owner of the other Content Packs and request that they exclude the content artifact
from their Content Pack Definition.

To exclude a content artifact from a content pack, select the artifact and click the Exclude i)
toolbar button or shortcut menu.

« Check for Referenced Content included in This Content Pack

Select your Content Pack Definition in the Content Manager and check if there is a Referenced
Content included in This Content Pack panel reported in the Details pane.

It is not recommended to have referenced content within your own Content Pack because this is an
indication that the ownership of such content is not clear. If you are the owner, include the
referenced content into your Content Pack Definition. Select the referenced content in the Included

Content pane and click the Include Referenced Content '] toolbar button or shortcut menu.

If you are not the owner, set a dependency to the Content Pack Definition that owns the referenced
content. For details, see "How to Set a Dependency" on the previous page.

« Include the referenced content into your Content Pack Definition
Open your Content Pack Definition for editing in the Content Manager and select the Content tab.

In the Available Content pane, search for referenced content, select it, and click the Add to

Included Content /. toolbar button or shortcut menu to include it in your Content Pack Definition.

Make sure that you have completed the steps described above.

Ul Description

This section includes:
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« "Contact Packs Page" below

o "New Content Pack Definition Wizard" on page 164

Contact Packs Page

The Contact Packs page enables you to manage content pack definitions. A content pack definition
describes the items included in a content pack. A content pack is a snapshot of the configuration data
and other items that you have defined to help manage the resources in the IT environment you are
monitoring with BSM. The Content Packs page displays a list of all known content pack definitions.

« Definitions Pane

The Content Pack Definitions pane displays a list of all the content pack definitions that are available
for your environment.

Ul elements are listed in the following table.

Ul

Elements Description

el

Refresh. Refreshes the contents of the displayed list. Use if new content becomes
available while you are working or you uploaded new contents (for example, from the
command-line interface).

New Item. Opens the Create New Content Pack Definition wizard. For details about
the wizard, see "New Content Pack Definition Wizard" on page 164.

Create a New Version of the Selected Content Pack Definition. Opens the Create
New Content Pack Definition Version dialog box from which you can create a new
version of the selected content pack definition.

Alternatively, double-click a section in the Details pane to open the appropriate tab in
the Create New Content Pack Definition Version dialog box or the Content Pack
Definition in the Definitions pane (not valid for content packs that are not predefined).

For details, see "How to Create a New Version of a Predefined Content Pack Definition"
on page 159.

Edit Item. Opens the Edit Content Pack Definition dialog box, which enables to you edit
the name, version, and description, content to be included, and dependencies for the
selected content pack. This dialog box presents the same screens as the Create New
Content Pack Definition wizard, but in tab format.

Alternatively, double-click a section in the Details pane to open the appropriate tab in
the Edit Content Pack Definition dialog box or the Content Pack Definition in the
Definitions pane (not valid for content packs that are not predefined).

For details, see "New Content Pack Definition Wizard" on page 164.
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Ul
Elements Description

Delete Item. Deletes the selected content pack definition (but not referenced content
such as indicators and KPIs) from the list of definitions displayed.

Import Content Pack Definitions and Content. Opens the Import Content Pack
dialog box, which enables you to specify or browse to a file that contains the definition
details for import.

For details, see "Importing Content Packs" on page 166.

= Export Content Pack Definitions and Content. Opens the Select Location for
Download dialog box, which enables you to specify or browse to a file location where
you want to export the definition details.

Export Content Pack Definitions and Content (Predefined). Opens the Select
Location for Download dialog box, which enables you to specify or browse to a file
location where you want to export the definition details as a predefined content pack.

o Details Pane

The Details pane provides high-level information concerning the properties of the selected content
pack definition and a short summary of the content pack definition's content and any problems found.

User interface elements are described below:

ul
Elements Description

General Displays the name, display name, version, dependent content packs, a description of
the selected content pack definition, and its origin (whether it is predefined or not).
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Ul
Elements Description

Summary Displays a summary of the selected content pack definition's contents, divided into the
following subsections. Each subsection contains a list of content and for each item in
the list, the following information is displayed:

« Total number of artifacts

« Number of predefined artifacts

« Number of predefined (customized) artifacts
« Number of custom artifacts

Expanding the content group displays the artifacts contained within that group, the ClI
Type of the artifact, and the origin of the artifact (Predefined, Predefined (Customized),
Custom).

« Selected Content. Displays a list of the content, grouped by content type, selected
forinclusion in the selected Content Pack Definition.

« Referenced Content Included in This Content Pack. Displays a list of the
referenced content, grouped by content type, included in this content pack.

« Referenced Content from Other Content Packs. Displays a list of the dependent
content, grouped by content type, referenced from other content packs.

Problems Displays information on any problems, such as unresolved dependencies (content that
Found is included in the selected content pack definition but no longer exists in BSM), found in
the selected content pack definition.

New Content Pack Definition Wizard

The New Content Pack Definition wizard enables you to create a new content pack definition, giving it
a name, version, and description, selecting the content to be included,setting dependencies, and
diagnosing problems.

To access the New Content Pack Definition Wizard, from the Content Pack Definitions page, click IZI

Wizard Map This wizard contains:

"New Content Pack Definition Wizard — General Page" on page 169 > "New
Content Pack Definition Wizard — Content Page" on page 170 > "New Content
Pack Definition Wizard — Dependencies Page" on page 174 > "New Content
Pack Definition Wizard — Summary Page" on page 175
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Troubleshooting and Limitations

Content Not Included in Content Pack

Make sure you perform the Include action at the correct level in the configuration item type hierarchy so
that all elements assigned to the selected configuration item type (and any children) are included at the
same time.

Unresolved References to Cls on Import

Content pack contains references to configuration items that do not exist on the target system. Make
sure that the Override and Create options are correctly specified before starting the import.

Dependencies in Content Packs

Some content in BSM is part of a hierarchy that may relate to and depend upon other content. When
you select content for inclusion in a content pack, its dependent content must also be included, either
as part of the same content pack, or referred to from another content pack that will also be uploaded.
For example, if you include a KPI assignment, any indicators, KPls, menus, or rules necessary for this
KPI assignment must also be included.

Automatically Including Dependent Content

If you select content that has dependent content, and the dependent content is not part of another
content pack, the dependent content is automatically included in the content pack definition along with
the content that requires it.

For example, the correlation rule BB DB Connection Status requires two indicators: the BB
Component indicator BB DB Connection Status and the Database indicator Database Server
Status. If you include the correlation rule BB DB Connection Status in a content pack definition and the
indicators BB DB Connection Status and Database Server Status are not included in other content
packs, they are automatically included in this content pack definition.

Setting Dependency

If dependent content is included in more than one other content pack, you can select which content
pack to reference. This is called setting dependency.

For example, if Content Packs A and B both include the indicator CPU Load and you select the
correlation rule Database Affects WebApp (which depends on CPU Load) for inclusion in Content
Pack C, you can set the dependency in Content Pack C to reference CPU Load in either Content Pack
AorB.
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Referencing Dependent Content Included in Another Content Pack

If dependent content is already included in another content pack, by default the new content pack
references its inclusion in the other content pack rather than including it in both. You can, however, use
the Dependencies page to also add it to the included content in the new content pack.

For example, if content pack definition A includes the indicator Ping Availability and now you select
the correlation rule Database Affects WebApp (which depends on Ping Availability) for inclusion in
Content Pack B, Content Pack B references the inclusion of Ping Availability in Content Pack A.

On the Content Pack B Dependencies page, Ping Availability is listed in bold, under Content Pack A
The dependency is set automatically. To include Ping Availability in Content Pack B (and thus, in
both contact packs), select it and click Add to Included Content.

Note: It is not recommended to have content in multiple content packs. It is preferable to set
dependencies between content packs.

Deleting Referenced Content Pack

If you delete a referenced content pack containing dependent content, the dependent content is
automatically added to the content pack definition that depends on it.

For example, if Content Pack B includes the correlation rule Database Affects WebApp and
references the dependent indicator Extend TS in Content Pack A, and you delete Content Pack A,
Extend TS is automatically included in Content Pack B.

Note: You are warned via a pop-up message if you delete a referenced content pack containing
dependent content.

Deleting Referenced Content Pack on Which Dependency Was Set

If you delete a referenced content pack on which dependency was set, the dependent content is
automatically added to the content pack definition that depends on it. You can set dependency to
another content pack manually, but it is not set automatically.

For example, if Content Packs A and B both include the indicator Extend TS, and Content Pack C
includes the correlation rule Database Affects WebApp (which depends on Extend TS) and has
dependency set to reference Extend TS in Content Pack A, and then you delete Content Pack A,
Extend TS is automatically included in Content Pack C. You can then set dependency to Extend TS
in Content Pack B, but it is not set automatically.

Importing Content Packs

This section provides instructions for importing content packs.
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To access
¢ Admin > Platform > Content Packs and cIick

« Admin > Operations Management > Setup > Content Packs and click

Learn About

Predefined or Custom Content Packs

The content of a content pack is either predefined or custom depending on how the content pack was
exported. When importing a content pack, you generally overwrite any existing data and add any new
data. If you are importing a predefined content pack, only predefined content is overwritten with new
data. Customized content is left untouched. Importing a custom content pack always overwrites
existing data.

Content Pack Formats

Content packs are usually in ZIP format. However, XML format content packs can also be imported.
Content Packs imported through the Content Manager Ul must reside on the system on which the BSM
browser is running.

Testing the Import Operation

You can test the import operation without actually importing any of the listed data. The Test feature
enables you to view any unresolved dependencies (for example, to unknown CI types) contained in the
imported content pack definition.

Tasks

How to Import Content Packs

When you import a content pack, existing items with the same ID are generally overwritten. If you are
importing a predefined content pack, only predefined content is overwritten with new data. Customized
content is left untouched. Importing a custom content pack always overwrites existing data.

Unresolved references in the imported definition (for example, to unknown CI types) are not allowed.

Note: In SaaS installations, predefined content packs can only be imported by a SaaS Admin
(Super User).
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1. Click Admin > Platform > Content Packs to open the Content Packs page.

2. From the Content Pack Definitions pane, click to open the Import Content Pack dialog box.

3. Inthe Import Content Pack dialog box, click Browse (...) and locate the content pack you want
to import.

The default location for content packs is:
<HPBSM root directory>/conf/opr/content/<locale>
In a distributed deployment, this directory is located on the Data Processing server.

4. Optional: You can click Test to run the import in test mode. In test mode, changes are not
committed, so you can see if any problems exist before running an actual import.

5. Select Import to start the import or test operation.

Note: It is not possible to start an import if an import is already running.

Exporting Content Packs

This section provides instructions for exporting content packs.
To access

« Admin > Platform > Content Packs and click

« Admin > Operations Management > Setup > Content Packs and click

Learn About

Configuration Data

Using the Content Packs Manager, you can export configuration data to a file. The contact pack
contains references to the configuration data and the referenced data.

The configuration data in a content pack makes references to configuration items stored in the Run-
time Service Model (RTSM) used by the system from which the content pack was exported. If these
configuration items are not present in the RTSM used by the system into which you want to import the
content pack, the configuration data in the content pack cannot work.

HP Business Service Management (9.26) Page 168 of 397



BSM Platform Administration Guide
Chapter 25: Content Packs

Export Modes

You can export a Content Pack definition and included content. There are two modes:
« Normal Mode
Content of exported content packs is labeled as custom.
« Content Pack Development Mode

When a content pack is exported, you can define its content as predefined or custom, and is
independent of whether the content pack definition used as base for the export is predefined or
custom.

Content Pack Development mode is enabled under the Operations Management - Content Manager
Infrastructure Settings.

Caution: It is not recommended to create new versions of predefined Content Packs that you
are not responsible for - as this may result in upgrade errors in the future.

Tasks

How to Export Content Packs

Note: It is not possible to export predefined content packs.

1. Click Admin > Platform > Content Packs to open the Content Packs page.

2. Inthe Content Pack Definitions pane, select the content pack that you want to export.

3. To export the selected content pack to a file, click , select the location where you want to save
the content pack, and select Save.

New Content Pack Definition Wizard — General Page

This wizard page enables you to define the display name, name, version and description of a new
content package.

User interface elements are described below:
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Ul
Elements

ID

Display
Name

Name

Version

Description

Predefined

Description

No action required. The content pack ID is assigned automatically when the content
pack is first created.

Note: ID field is only displayed in the General tab of the Edit Content Pack Definition
dialog box, not on the General page of the Create New Content Pack Definition
wizard.

Name displayed in Content Pack Definitions list. This name does not have to be
unique. It is limited to a maximum length of 255 characters.

Name of the content pack definition, which is limited to a maximum length of 255
characters. The first character must be a letter (A-Z, a-z) or an underscore (). All
other characters may be letters, numbers, or underscores. No leading or trailing
spaces are allowed.

Note: The name and version combination must be unique.

When you export the content pack, this is the default file name for the file, with OMi
Content Pack - as a prefix.

Required, free text field. Use to control versions of your content packs. It is limited to
a maximum length of 255 characters.

Brief description (limited to 1024 characters) of the content pack definition you want to
add to (or have selected in) the Content Pack Definitions pane. Use the Description
box to remind other users of the scope and content of the content pack.

Predefined content is usually content provided by HP or HP Partners and is designed
to provide the initial configurations for a BSM installation.After installing a predefined
content pack, you may change these initial artifacts to suit your environment and
management needs. Any modified predefined artifacts are labeled as Predefined
(Customized). It is not possible to remove predefined artifacts, but you can revert
any customized artifacts to their original, "predefined" values.

Note: Only displayed in the Details pane.

New Content Pack Definition Wizard — Content Page

This wizard page enables you to select the content to be included in a new content pack definition.

User interface elements are described below:
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Ul

Elements

(A-Z) Description

Refresh: Refreshes the contents of the displayed list. Use if new content becomes
available while you are working or you have uploaded new contents (for example,
from the command-line interface).

(=) Add to Included Content: Adds the selected item(s) to the list of included content.

If included content has already been included in another content pack, it is listed in
the Content in Other Content Packs pane, and can safely be excluded from the
content pack you are creating. It is not necessary to include content in multiple
content packs.

Tip: Selecting a Cl type automatically selects all assigned content of the Cl type and
also all assigned content for child Cl types. Selecting specific content, such as an
individual indicator or KPI, automatically selects the reference to the Cl type to which
the content is related.

Expand Selection: Expands the Available Content or Included Content list to
display items belonging to the selected group.

&

Collapse Others: Collapses all open branches except for the selected branch.

&

Kdl Expand: Expands the Filter pane to display available filters.
| %] Collapse: Collapses the Filter pane.

Expands the selected folder.

&=

Collapses the selected folder.

Include Referenced Content: Adds the selected item(s) to the list of included
content.

T'

Exclude: Removes the selected item(s) from the list of included content.

&

Exclude All: Removes all items from the list of included content.

=
=l

Display All Selected Content Pack Items: Expands the Included Content list to
display all items selected for inclusion in the content pack.

&
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Ul

Elements

(A-Z) Description

Search Content: Use the Search field to find the content in the Available Content or

Included Content pane. Enter a search string in the Search box and click . The
first content to match the specified string is highlighted. If that content is not initially
visible, the tree expands to display it.

To find the next occurrence of content matching the specified string, click E again.

The search string must be at least three characters long. Searching is automatically
started as soon as the third character is entered and the first match is highlighted.
This prerequisite avoids searches being started too often and resources being

blocked. Names with less than three characters can be found by clicking Q.

Available Hierarchical list representing the available content in your IT environment.

Content
Tip: Toinclude content in a content pack definition, drag it from the Available
Content pane to the Included Content pane or select it and click the Add to
Included Content button. BSM warns you if content already exists in other content
packs when you perform an include operation.
Color coding:
« Folder with no content: gray
« Selected content: bold
« Referenced content: italic
« Dependent content pack definition with version number: blue
Filter: Filters the CI Types tree to display only Cl types that have content assigned to them.
Show only
Cl types
with
assigned
content
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ul
Elements
(A-Z) Description
Included List of content selected for inclusion in a content pack, along with any dependent
Content content.
Tip: To exclude an item, select an item (or group of items) and select the Exclude
button.
Color coding:
« Folder with no content: gray
« Selected content: bold
« Referenced content: italic
« Dependent content pack definition with version number: blue
Contentin | If content selected for inclusion is included in other content packs, it is listed here to
Other indicate that it can be removed from this content pack. It is not necessary to include
Content the same content in multiple content packs, and the recommended practice is not to
Packs do so.
Shortcut Menus

BSM provides many shortcut menus. The shortcut menus enable quick and direct access to
information about selected elements and actions that you can perform on them.

You display a shortcut menu by right-clicking an element in the user interface. The information available
and the actions that are possible from a shortcut menu depend on the element you right-click and the
context in which it exists.

The shortcut menu in the Content page includes the following elements:

Ul Elements (A-Z) Description

Add to Included Content = Adds the selected item(s) to the list of included content.

Collapse Others Collapses all open branches except for the selected branch.
Display All Selected Expands the Included Content list to display all items selected for
Content Pack Items inclusion in the content pack.

Exclude Removes the selected item(s) from the list of included content.

Exclude All

Removes all item from the list of included content.

HP Business Service Management (9.26) Page 173 of 397



BSM Platform Administration Guide
Chapter 25: Content Packs

Ul Elements (A-Z) Description

Expand Selection Expands the Available Content or Included Content list to display

items belonging to the selected group.

Include Referenced Adds the selected item(s) to the list of included content.

Content

New Content Pack Definition Wizard — Dependencies Page

This wizard page enables you to set dependencies on dependent content that is included in more than
one other content pack.

User interface elements are described below:

Ul
Elements

&

%

(=)

<Color
coding>

<Version
dropdown
box>

Description

Refresh. Refreshes the contents of the displayed list of dependencies. Use if new
content becomes available while you are working or you have uploaded new contents
(for example, from the command-line interface).

Set Dependency. If referenced content is also included in other content pack
definitions, a message indicating this is displayed, and one of these was automatically
set for you.

To specify a different content pack definition for this content, use the Set Dependency
action. To include the referenced content in your content pack definition, use the Add
to Included Content action.

The dependent content in the referenced content pack is displayed in bold, indicating
that dependency has been set onit.

Add to Included Content. Adds the selected dependent content to the list of content
included in this content pack.

Color coding:
« Internally referenced content: normal
« Content included in the currently selected content pack definition: bold

« Content included in another content pack definition: gray

If there is more than one version of a content pack that could be specified for referenced
content, the version dropdown box becomes active and displays the selected content
pack version.You can select an alternative version and set the dependency toiit.
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New Content Pack Definition Wizard — Summary Page

This wizard page enables you to see summary information regarding the content, dependencies, and
any problems found in a new content pack definition.

User interface elements are described in the table below.

The Summary Page displays a summary of the selected content pack definition's contents, divided into
the following subsections. Each subsection contains a list of content and for each item in the list, the
following information is displayed:

« Total number of artifacts

« Number of predefined artifacts

« Number of Predefined (Customized) artifacts
« Number of custom artifacts

Expanding the content group displays the artifacts contained within that group, the CI Type of the
artifact (where applicable), and the origin of the artifact (Predefined, Predefined (Customized),
Custom).

For example, indicators, mapping rules, and indicators, also show Cl type, that is, the type of
configuration item to which the indicator is assigned (for example: Application, Host, or
Oracle System).

Ul Elements Description

Selected Content  Displays a list of the selected content, grouped by content type, included in the
selected content pack definition.

Referenced Displays a list of the referenced content, grouped by content type, included in
Content Included  the selected content pack definition.
in This Content

Pack

Referenced Displays a list of the dependent content referenced from other content packs,
Content from including the display name and version of each referenced content pack.
Other Content

Packs

Problems Found  Displays information on any problems, such as unresolved dependencies
(content that is included in the selected content pack definition but no longer
exists in BSM), found in the selected content pack definition.
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Content Pack Manager Command-Line Interface

This section describes the options and parameters available in the ContentManager command-line
interface.

Note: The appropriate identity assurance software (for example, Activldentity) must be installed to
be able to authenticate using a smart card when executing the ContentManager command-line
interface.

When connecting to BSM servers using Remote Desktop Connections, the client system must
also have the appropriate identity assurance software, such as Activldentity, installed to be able to
authenticate using a smart card attached to the client system when executing the ContentManager
command-line interface remotely.

In addition, in the Remote Desktop Connections dialog box, select More Show Options > Local
Resources > More to open the Local devices and resources dialog box. Ensure that the Smart
Cards checkbox is selected.

Location

<BSM_Root_Directory>/bin/ContentManager

Synopsis
ContentManager <Operation> [Connection] <UserCredentials> [Option]
« Operation (one of the following):
Import Operations:
-import <in_file> [-test]
Export Operations:
-snapshot -output <out_file>
-export <name> -output <out_file>
[-contentPackVersion <version>] [-asPredefined]
Miscellaneous Operations:
-list

-delete <name> [-contentPackVersion <version>]
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-version

« Connection (one of the following):

-url <URL>

-server <gatewayserver> [-port <port>] [-ssl]

« User Credentials:

-username <login name> [-password <password>]

[-customer <customer Id>]

« Option:

-verbose
Options

Option
-asPredefined

-cpv,-contentPackVersion
<version>

-cu-customer <customer

Id>

-d,-delete <content_pack_
name>

-e,-export <content_pack_
name>

-h,-help

-i,-import <input_file>

HP Business Service Management (9.26)

Description
Marks the exported Content Pack as predefined.

Version number of the Content Pack Definition

Id of customer in SaaS environment.
If this parameter is not set the default value is 1.

Deletes the content pack definition specified in <content_pack_
name>. It does not delete the content pack’s content. Content
includes definitions for event type indicators, health indicators,
calculation rules for key performance indicators (KP1), topology-
based correlation rules, tool definitions, view mappings, and graph
families.

Exports the named content pack definition and its content to the file
specified using the -output option.

Displays a summary of the command options and exits.

Imports the content pack definition and its content from the specified
file.

Importing a custom content pack overwrites the existing objects.
Importing a predefined content pack overwrites all none-customized
objects.
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Option
§, ks <arg>
-,-list

-0,-output <output_file>

-p,-port <port>

-password <password>

-sc, -smartcard

-server <gateway_server>

-skipCheck

-shapshot

-ssl

-t,-test

-u, -url <URL>

-username <login_name>

HP Business Service Management (9.26)

Description
Specifies the java key store to be used for authentication.
Lists the content pack definitions.

Specifies the name of the file to which you want the command to
write during the export operation.

Sets the port number. The default port numbers are 80 for HTTP and
443 for HTTPS. Do not specify this option in conjunction with the -
url option.

Requests the password of the user specified in the -usermname option,
whose account is being used for authentication purposes.

Use certificate stored on smart card or security token for
authentication.

Sets the target BSM gateway server using either a hostname or an IP
address. The specified server must be a BSM gateway server.
Default is "{0}".

Note: Do not specify this option in conjunction with the -url option.

Omits the content pack consistency check. The content pack
consistency check verifies if dependent content that is not part of
another content pack is either in the content pack itself or already
imported.

Caution: This option should only be used when upgrading to a newer
version of the Content Pack.

Exports a snapshot of all content that can be managed by Content
Packs Manager.

Sets the protocol to HTTPS. The default protocol is HTTP. Do not
specify this option in conjunction with the -url option. If you do not use
the -port option to specify a non-standard port, the command uses the
standard port number reserved for HTTPS: 443.

Runs import in preview mode and display the results immediately. No
changes are committed to the database.

Specifies the URL of the BSM gateway server to access. The default
value is:

http://<Gateway Server DNS name>:<port>/opr-admin-server
Do not specify this option in conjunction with the -server option.

The name of the user, whose account is being used for authentication
purposes.
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Option Description

-v,-verbose Prints verbose output.

-version Prints the version information of the command and exits.

-wc, -winCrypto Use the windows certificate store for authentication. This option is

only available on Windows systems.

Exit Status
Exit Status Description
0 Successful completion
1 Failure of requested operation
300-399 HTTP Redirection (300-399)
400-499 HTTP Client Error (400-499)
500-599 HTTP Internal Server Error (500-599)

The exit status numbers (300-599) reflect a standard HTTP-status category (and number), for example:
Redirection (300-399). For more information about a specific HTTP error status, for example: 307,
which signifies a temporary HTTP re-direct, see the publicly available HTTP documentation.

Restrictions

The user running the ContentManager command-line interface must be a BSM user with permission to
create content packs.

The user executing the ContentManager command-line interface must have read access to the file:

<BSM_Root_Directory>/conf/TopazInfra.ini

Content Pack Auto Upload Command-Line Interface

The Content Pack Auto Upload Command-Line Interface enables you to upload the Content Pack
Definition files from the default content pack directory on the Data Processing Server.

This section describes the options and parameters available in the ContentAutoUpload command-line
interface.

The ContentAutoUpload command-line interface is located on the Data Processing Server in:

<BSM_Root_Directory>/bin

Note: The user executing the ContentAutoUpload CLI must have read access to the file:
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<BSM_Root_Directory>/conf/TopazInfra.ini

Usage

ContentAutoUpload <Operation> [Option]
Operation (one of the following)::

Import Operations:

-autoUpload [-uploadFolder <directory>]
[-forceReload]

Miscellaneous Operations:

-version

Options:

-verbose

The following table gives more information about the arguments recognized by the
ContentAutoUpload command:
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Option Description

-a,- Automatically uploads the Content Pack Definition files from the default content
autoUpload pack directory on the Data Processing Server:

<BSM Root Dir>/conf/opr/content/</ocale>/

Windows:
C:\HPBSM\conflopr\content\</ocale>\

Linux:
lopt/HP/BSM/conf/opr/content/<locale>/

If you want to upload content pack definitions from an alternative directory on the
Data Processing Server, specify the directory location using the -uploadFolder
<directory> option.

If you have more than one Data Processing Server, you must keep the content pack
folders synchronized because it is not possible to specify from which Data
Processing Server content packs may be imported.

All predefined content pack definition files in the specified directory are imported in
the order of their dependencies. If a content pack definition is already uploaded to
the repository, it is not uploaded again.

For information about import errors, see the following log file:
<BSM Root Dir>/log/Jboss/opr-webapp.log

Windows:
C:\HPBSM\log\Jboss\opr-webapp.log

Linux:
lopt/HP/BSM/log/Jboss/opr-webapp.log

-forceReload Enforces the reload of all content packs located in the default directory (<BSM Root
Dir>/conf/opr/content/<Locale>/) or the directory specified using the -
uploadFolder <directory> option. Non-customized content is overwritten.

-h,-help Displays a summary of the command options and exits.

-skipCheck Omits the content pack consistency check. The content pack consistency check
verifies if dependent content that is not part of another content pack is either in the
content pack itself or already imported.

Caution: This option should only be used when upgrading to a newer version of the
Content Pack.

- If you want to upload content packs from an alternative directory, specify the
uploadFolder directory location using the -uploadFolder <directory> option.

<directory>
For example:

ContentAutoUpload -a -uploadFolder c:\temp
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Option Description
-v,-verbose Prints verbose output.

-version Prints the version information of the command and exits.

The ContentAutoUpload command displays the following values to indicate the exit status of the
requested operation:

Exit

Status Description

0 SUCCESS (At least one content pack was imported and no errors occurred.)

1 FAILURE (No content packs were imported - complete failure.)

2 FAILURE_PARTIAL (Some content packs were imported successfully, others had
errors.)

3 NO_OPERATION (No new content was found for upload.)

4 NO_PERMISSION (User does not have appropriate permissions to execute this tool.)

5 SYNTAX_ERROR (Wrong command-line arguments were specified.)
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This section describes the tasks you can perform through the user management interface.

To access

Select Admin > Platform > Users and Permissions > User Management

Learn About

Configure BSM Users

Groups and Users Permissions enable you to restrict the scope of a user's access to predefined areas.
You can grant permissions directly to an individual user or to a user group. User groups make managing
user permissions more efficient; instead of assigning access permissions to each user one at a time,
you can group users who are assigned the same permissions levels on the same resources.

To create users and groups, see "Configuring Users and Permissions - Workflow" on page 197.

You may want to create different groups based on how users access the different resources in BSM.
For example:

Functions Within the Organization Locations and Territories

Customer service representatives Users working in different sales territories
System administrators Users based on geographical location
High-level management Users accessing network servers in different locations

You can change a user's parameters, including username and password, on the General tab. For
details, see "Create Users" on page 198.

Tip: To obtain more user management capabilities and security, we recommend using external
LDAPs or Active Directory user management. For details about how to configure BSM to work
with LDAP, see "LDAP Authentication and Mapping" on page 320

Define a Superuser

One superuser is defined for every installation of BSM. This superuser's login name is admin and the
initial password for this account is specified in the Setup and Database Configuration utility. This
original superuser is not listed among the users in User Management and therefore, this user's
password can be changed only on the General Settings page in Personal Settings (Admin >
Personal Settings).
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You can apply superuser permissions to other users in the system. These users with superuser
permissions can be modified in User Management.

Ul Description

User Management Page

When you first access the User Management page or the cursor is located on the All node, the page
displays:

« The Groups/Users pane. For details, see "Groups/Users Pane" below.

« The Workflow pane. The Workflow pane displays introductory information about the User
Management application, and a suggested workflow for configuring groups and users. The
Workflow pane consists of the following sub-panes:

m General
m "Recipient Management" on page 269
m "Permissions Tab (User Management)" on page 261

m "Hierarchy Tab (User Management)" on page 266

m "Customization Tab (User Management)" on page 267

Groups/Users Pane

The Groups/Users pane appears on the left side of the page, and is visible on all tabs of the User
Management application. This pane displays the list of users and groups of users configured to access
BSM.

Note: When selecting more than one user or group and modifying parameters, the changes take
effect only for the first selected user. The exception is the Delete option, which deletes multiple
users at once.

User interface elements are described below:
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Ul

Element Description

i

X &

g
=3
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b |

|

Creates a user or group.

Depending on whether you select to create a user or group, the Create User or Create
Group window opens.

When you create a new group or user, the Groups/Users pane refreshes and the newly
created group or user is selected.

When creating a group, the access permissions are automatically inherited by the group's
users.

When creating users with the cursor on a group, the users are automatically nested within
that group.

Note: In Firefox, after refresh, the All node is selected.

Clones the settings of an existing user or group to a new user or group

Deletes the selected user or group.

Note: When you delete a user, the linked recipient is also deleted.

Collapses or expands the groups selected in the hierarchy tree.

Note: Only previously loaded nodes are expanded.

Click Delete Obsolete Users to delete BSM users no longer configured on the LDAP
server. After selecting Delete Obsolete Users, choose a unique domain name. You can
remove multiple users at once by holding the Ctrl button while selecting users.

Click Group Mappings and select the unique domain name to map local groups to
groups configured on the LDAP server.

For details, see "Group Mappings Dialog Box" on the next page.

Note: This button is displayed only if LDAP Configuration was added using the LDAP
Configuration Wizard and enabled. For details, see "LDAP Configuration Wizard" on
page 300.

Click to assign or view the Security Officer. The security officer is a user who can
configure certain sensitive reporting information in the system, such as which RUM
transaction parameters to include or exclude from certain reports (such as Session
Details or Session Analyzer).

There can be only one security officer assigned in the system. Only a user with superuser
permissions can assign the security officer for the first time. Only the security officer
himself can assign it to another user or change his own password once it has been
assigned. For details on this topic, see "Security Officer" on page 194.
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Element Description

A configured user

E>»

A configured group

&l

o Security officer
¥ | Root node

Browse Displays alist of configured users and groups, and enables you to create or delete users
and groups.

Search | Displays a table view of users and groups, and enables you to search for a user or group
by any of the following criteria:

o Group name
« Login name
« Username

« Userlastlogin

You can sort the columns by clicking the column headers above the boxes.

You can include wildcards (*) in your search.

Group Mappings Dialog Box

This dialog box enables you to map groups configured in BSM to groups configured on the LDAP
server.
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To access  Select Admin > Platform > Users and Permissions > User Management. In the

Groups/Users pane, click the Group Mappings 7 putton and select the unique

domain name.

The Group Mappings dialog box consists of the following panes:

« Remote Corporate Directory Pane. For details, see "Remote Corporate
Directory Pane" below.

« BSM Local Directory For Remote Group Pane: <group name>. For details,
see "BSM Local Directory for Remote Group: <group name> Pane" on the next

page.

« Local Groups to Remote Group Mappings. Displays a table of the LDAP
groups and the BSM groups that they are assigned to. The LDAP groups are
displayed in the Remote Group Name column, and the BSM Groups are listed in
the Local Group Name column.

Select the Enable User Synchronization check box to enable User
Synchronization upon logging into BSM, to synchronize LDAP users with BSM
users.

Note: Ensure that you mapped LDAP groups to BSM groups before selecting this
check box. If you have not performed Group Mapping, all users are nested under
the Root group and are assigned System Viewer permissions. For details on
mapping groups, see "How to Map Groups and Synchronize Users" on page 327.

Important Note: This dialog box is accessible only if LDAP Configuration was added by the
information LDAP Configuration Wizard and enabled. For details, see "LDAP Configuration
Wizard" on page 300.

If you are switching from one LDAP server to another, ensure that you remove all
existing group mappings from the original LDAP server before mapping to the new
one.

Remote Corporate Directory Pane

This pane enables you to assign BSM groups to LDAP groups, and to list the users in the LDAP
groups.
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Important « Tosynchronize LDAP groups with BSM groups, click Assign Groups to open the
information Select Local Groups for Remote Group dialog box.

« Toview the list of users associated with the respective LDAP groups, click List
Users.

You can also select either of these options by right clicking on the group.

« Once the LDAP groups have been mapped to the BSM groups, the BSM groups
are managed only from the LDAP interface. This means that the following are
fields are affected on the Users and Permissions interface:

m The Create User field is disabled.
m The User Name field is disabled.
m The Password field is invisible.

m The Hierarchy tab is enabled only for groups and not for users.

BSM Local Directory for Remote Group: <group name> Pane

This pane displays the BSM mapped to the LDAP group selected in the Remote Corporate Directory
Pane, and enables you to remove the mapped BSM groups.

Important « Toremove groups, select the group you want to remove and click
information Remove Groups.

« You can remove multiple groups at once by holding the Ctrl button while
selecting groups.

Permissions

You can assign permissions to the groups and users defined in your BSM platform, enabling access to
specific areas of BSM.

Learn About

Granting Permissions

Granting permissions has the following components:
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o User
« Resource
« Role or operation being granted

For details on assigning permissions, see "Assign Permissions to Groups or Users" on page 199.

Permissions and Roles on Root Resource

Permissions and roles on the root resource (the top level resource relevant for all contexts) are exposed
only for a Superuser, while other users with the relevant permissions, can assign roles and permissions
for resources other than the root resource.

Permissions Tab

The Permissions tab includes the following areas:

« Theresource tree area in the center of the page, containing the contexts, resources, and resource
instances on which permissions are assigned. For details, see "Understanding Permissions
Resources" on the next page.

« Theroles and operations area on the right side of the page. For details on roles, see "Roles" on
page 193. For details on operations, see "Operations" on page 194.

Additionally, the Groups/Users pane is continually visible on the left side of the page.

The following is an example of Granting Permissions:

u s Service Management - Platform Administration Full Screen Miew  User: administrator  (PUBgouEm|
@ - MyBSM  Applications  Admin + Help = Site Map

| Users and Permissions = User Management

Setup and Report Scheduling Locations Content Packs Users and Permissions. | Recipients Downtime Event B
Groups/lsers Browse | Search Admin | General | Permissions || Hierarchy || Customization |
M| K| &2 ¥ Context | Roles Operations
End User Managemant -
ER=P .
. . N Role Grant
= B8 croupt [ 4 Business Service p—
"; m 1 Alert - Event Template P -
iy ] Alert - Create dependencies Administrator
“? O ey N System Modifier
.1 Steve 1 Applications
L] 21 BPM Agents System Viewer
= B2 Techz . BPI Administrator
" q El ) RUM Engines.
a Bil M O GincRUN SanityBA BPI User
& sam Al Al BPI Restricted View
5 % LABM3ANRND46 User
a Sarah 5
4% vmbsmbf07 RTSM Open AP| Query
221 Script Repository RTSH Open AP Update

RTSM Open APl Impact

RTSM Open AP Class
To select multiple resources, press Ctrl while Model -

making your selections.
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Upgrading and Maintaining Users and Security Levels

If you have upgraded from a previous version of BSM and had specific users and security levels
defined, those users and security levels are mapped to the new roles functionality in the Permissions
tab. For details, see "Roles" on page 193.

Exporting Users, Groups, and Roles

You can export users and groups, together with their assigned roles, from one BSM machine to
another. For details, contact HP Software Support.

Understanding Permissions Resources

BSM enables you to fine-tune your permissions management by applying permissions at the resource
level. All of the resources on which permissions can be applied are categorized in a hierarchical tree,
representing the BSM platform.

The resources and instances of those resources are organized according to logical groupings called
contexts. Contexts make it easier to identify and select the area of the platform on which you want to
apply permissions.

The resources are divided according to the context in which they function within the platform and not
necessarily where they are found in the user interface.

Resources and Resource Instances

There are the following types of resources in Permissions Management:

1 Resource collection (a resource that can have instances)
# Instance of a resource
&l Resource that cannot have instances in the permissions resource tree

Aninstance of a resource is displayed only if it has been defined in the platform. The instance of a
resource appears as a child object of the resource in the tree with the name as it has been defined in the
application. After instances of a resource are defined in the system, the resource collection acts as the
parent resource for those instances.

There are some resources, such as the different data collector profiles, that contain other resources
within them in the resource tree hierarchy. Some of these sub-resource types appear only if there are
instances of the resource defined in your platform, such as Monitor and Transaction resources within a
profile resource.

Resources that cannot have instances in the permissions tree are divided into the following types:
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« Resources that are functions or options within the system that do not have any other instances or
types.

Example:

The Outlier Value resource determines whether the user can edit the outlier threshold value. It
has no instances.

« Resources that do have instances; permissions can be applied only on the resource type and affect
all instances of the resource.

Example:

The Category resource includes all categories defined in End User Management
Administration. Change permissions granted on the categories resource enables a user to
modify all the categories defined in the system. You cannot grant or remove permissions for
specific categories, only for every category defined in End User Management Administration.

Examples of Resources and Instances:

An example of how resources and instances are displayed in the permissions hierarchy is the
Applications resource collection within the End User Management context. The Applications
resource includes instances only if applications have been defined in the system. Some
instances may be defined by default, but others only exist if defined by the user. If there are
applications defined in the system, each of these appears as an instance of the Applications
resource.

Because BPM, RUM, and alerts are defined in your platform per application, the BPM, RUM, and
Alerts resources appear under each of the instances of the application resource.

You can apply permissions to the Applications resource level. This provides the user with access
to all applications created in the system. If you want to restrict a user's access to specific
applications that relate to the user's tasks, you can apply permissions to those specific
applications, and can also apply or removed permissions to specific resources per application.
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test1 | General | Permi
Context
I End Uszer Mansgement ;I | i
= _+ Business Service Management = Cperation Grant Granted from Group/Roles/Pareni
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E i Applications S [
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Guidelines for Working with Resources

« The Business Service Management resource refers to all contexts in BSM.

« Only roles and not operations can be applied to the Business Service Management resource. For
details, see "Roles" below.

« Tomanage the permissions on a sub-resource, you must provide the user with at least View
permission on the selected resource's parent.

« You grant Add permission only on a resource and not on an instance of a resource.

o When a user defines or creates an instance of a resource, for example creates a Business Process
profile, that user has Full Control permission on that resource instance and all of its sub-
resources.

Roles

BSM enables you to apply permissions using roles for specific users or groups in your organization.
These roles include a preconfigured collection of resources and a set of operations that apply to those
resources.

Roles are organized by context, which define what resources and operations have been preconfigured
and included in the roles. For details on how each operation applies to a specific resource, see
"Operations" on the next page.

Roles can be applied only to specific resources:
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« Roles that include resources from several contexts can be applied only to the Business Service
Management resource. Business Service Management appears as the first resource collection in
every context.

» Roles whose resources are all within one context can be applied to specific resources within that
context.

For a description of each role, including details of the resources on which roles can be applied, see "
User Management Roles Applied Across BSM" on page 213.

Operations

When working with operations, keep the following in mind:

« All of the operations that can be applied to a resource collection can also be applied to any instance
of that resource. The one exception is the Add operation which cannot be applied to an instance of
aresource.

« The Full Control operation automatically includes all the other operations available on the
resource. When applied, the other operations are automatically selected.

« When the Full Control operation is applied to any resource, the user also has permissions to grant
and remove permissions on that resource, or resource instance, for other users or groups.

« When the View operation is one of the resource's available operations and you select one of the
other available operations, the View operation is also automatically selected.

For details on the available operations in BSM, see "User Management Operations" on page 243.

Security Officer

The security officer is a user who has security privileges to view sensitive information in the system.
The security officer is typically not a regular BSM user and receives access to configure certain
sensitive reporting information. In RUM, the security officer can configure settings for masking
sensitive data. For details, see Sensitive Data Area in the BSM Application Administration Guide.

This user does not generally access the other areas of BSM.

There can be only one user in the system assigned as security officer. Only the user with superuser
permissions can assign the security officer for the first time. Thereafter, only the user assigned as
security officer can pass on the security office designation to another user, or change their own
password. The superuser can no longer assign security officer status.

The security officer is designated by highlighting a user in the User Management tree and clicking on
the Security Officericon. For details on the user interface, see "Groups/Users Pane" on page 185.

No other user in the system can delete the user assigned as security officer. The security officer
designation must be assigned to a different user by the security officer before the user who is the
current security officer can be deleted from the system.
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In unforeseen circumstances, when the security officer is no longer able to access the system and
reassign the security officer designation to another user, the administrator can use the JMX console to
clear the security officer designation from the user. For details on how to perform this task procedure,
see "How to Remove Security Officer Status Using the JMX Console" below.

Tasks

How to Remove Security Officer Status Using the JMX Console

This task describes how use the JMX console to remove security officer status from a user. This may
be necessary if under unforeseen circumstances, the security officer cannot remove the status
himself. Once the security officer is assigned, there is no other user authorized to make this change
within the User Management interface. For details on this topic, see "Security Officer" on the previous

page.

To remove a security officer:

1. Inabrowser, enter the URL of the JMX console:
http://<Gateway or Data Processing Server name>:29000/

2. Enteryour JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. Locate:
= Domain name: Foundations
= Service: Infrastructure Settings Manager

= Setting: setSettingValuePerCustomerid

Note to HP BSM SaaS customers: You need to enter the relevant customer ID at the top
of the page. For assistance, please contact HP Support.

4. Modify the parameter values as follows:
m Context Name: enter security
m Setting Name: enter secured.user.login.name
= New Value: leave empty

5. Click Invoke.

Group and User Hierarchy

You can nest groups to make managing user and group permissions easier. Instead of assigning
access permissions to each group one at a time, you can nest a group to inherit the permissions of its

HP Business Service Management (9.26) Page 195 of 397



BSM Platform Administration Guide
Chapter 26: User Management

direct parent.

When nesting groups, note the following:
« A group can be a member of several groups.

« Permissions are assigned to nested groups in the same way as for regular, non-nested, groups.
Changes in nested group permissions take effect at the user's next login.

« There is no maximum number of levels of nested groups.

Example:

In the example below:

Group_A and Group_B are nested members of Group_C.
m Group_B is also a nested member of Group_D.

m Group_A and Group_B inherit the permissions of Group_C and indirectly inherit the
permissions of Group_E.

m Group_B also inherits permissions from its other parent, Group_D.
m Group_C and Group_D are nested members of Group_E.

m Group_C and Group_D inherit the permissions of their parent, Group_E.

Group_E
[execute + view)
AR
Group_Cis a member 7 . Group_D is a member
of Group_E Fd \\ of Group_E
Vd AN
i N
Group_C Group_D
|execute + view) + [add + change] [execute + view) + (delete)
A
/ . Fa
Group_A is a member Group_B i a member k"-.,' / Group_Bis a mernber
of Group_C ;/ of Group_C Y g of Group_D
i Y /
rd Y !
. \ !
Group_A Group_B
[add + change + view + execute] {add + change + delete + view + execute)

When permissions are added to, or removed from, a parent group, the changes are
automatically implemented in the parent group's immediate children and continue to propagate
onward. For example, if delete permission in Group_D is removed, Group_B's permissions
become add + change + view + execute.

A circle of nested groups is not permitted. For example, Group_A is a member of Group_B,
and Group_B is a member of Group_C. Group_C cannot be a member of Group_A.
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Note: All permissions in the previous example refer to the same resource.

For details on setting up nested groups, see "Configure User and Group Hierarchy" on page 199.

Configuring Users and Permissions - Workflow

Below is a suggested workflow for the User Management application. For a use-case scenario related
to this task, see "How to Configure Users and Permissions — Use-Case Scenario" on page 201.

Prerequisites

Before you configure User Management, you should map out the required users and groups and their
relevant permission levels. For example, enter the following information in an Excel page:

1.

A list of users required to administer the system, as well as the end users who are to access
Service Health and reports. Gather appropriate user details such as user names, login names,
initial passwords, and user time zones. Although not needed to define users, at this stage it might
be useful to also collect user contact information such as telephone numbers or email addresses.
(Contact information is required for HP Software-as-a-Service customers.)

If categorization of users into modes (operations and business) is required, specify into which user
mode to categorize each user. For details, see Create KPIs for Operations and Business User
Modes in the BSM Application Administration Guide.

If multiple users require similar system permissions, create a list of groups, and the users that
should belong to each group.

The permissions that each user or group requires. To aid in this process, review the Permissions
Management page to learn about the different contexts and resources for which permissions can
be granted. For details, see "Understanding Permissions Resources" on page 191.

Create Groups

You can create groups as sub-groups nested under other groups. Sub-groups have the same access
restrictions as the parent group.

1.

2.

Select Admin > Platform > Users and Permissions > User Management.

In the Groups/Users pane, select a location for the group, for example you may want to create the
group as a sub-group under another group.

Click the New Group/User EI button, and then select Create Group.

In the Create Group dialog box, enter the group name and, if required, a group description.
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Note:

= The group name must be unique, cannot exceed 40 characters, and cannot contain any of
the following special characters: "\ /[]:|<>+=;,?2*% &

m The group description is optional and cannot exceed 99 characters.

Create Users

You create users and then place them in the appropriate groups.

1. Inthe Groups/Users pane select the group that the user should belong to, click the New
Group/User El button, and then select Create User.

2. Inthe Create User dialog box, on the User Account tab, enter the following information:

= User name. Cannot exceed 40 characters and cannot contain any of the following special
characters: "\ /[]:|<>+=;,?2"% &

= Login name. The name that the user uses to log into the system. The Login name must be
unique, cannot exceed 40 characters, and cannot contain special characters.

m User Mode. Available options are:

o Unspecified. Leaves the user without a particular mode. Select this option if your system
does not work with user modes, or if the system works with user modes but you want this
user to see KPIs for both modes in Service Health views.

o Operations User. Enables the user to view the operations version of KPIs.
o Business User. Enables the user to view the business version of KPls.

m Time zone. The time zone of the user's location.

Note: When you modify the time zone, the linked recipient offset from GMT is also
updated after you confirm the change. Half time zones (also known as offset time zones)
are not supported.

m Password and Confirm password. The password cannot exceed 20 characters.

3. (Optional) On the Recipient tab, enter required information. For information about the fields on this
tab, see "New or Edit Recipient Dialog Box" on page 272.

After creating a user, you can modify user information in the Groups/Users page. For user interface
details, see "Groups/Users Pane" on page 185.
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Set Default Time Zone for New User Creation

BSM enables you to set a default time zone for new user creation. When creating new users in BSM
(with or without LDAP), you can set up a timezone for that specific user. This enables you to change
the time zone for a certain group of users or for all groups at one time.

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations.
3. Select Business Service Management Interface.

4. Inthe Business Service Management Interface - Display table, edit Default Time Zone for user
creation. You must specify the specific name of the time zone, such as Africa/Accra or
Asial/Jerusalem. For a list of time zone, see

HPBSM\AppServer\resources\ApplicationResources2.properties
# Time Zones presentations section

The setting should contain a string such as: ACT or Africa/Accra or Asia/Jerusalem

Assign Permissions to Groups or Users

BSM enables you to apply permissions to groups and users for specific resources and instances of
those resources that are defined in the system. For more information about permissions, see
"Permissions" on page 189.

1. Inthe Groups/Users pane, select the groups or users that you need to assign permissions to, and
select the Permissions tab on the right side of the page.

2. Select a context for the groups or users from the Context dropdown list. For details on the
available contexts, see "Resource Contexts" on page 263.

3. Select the required roles for the groups or users from the Roles dropdown list. For details on the
available roles, see " User Management Roles Applied Across BSM" on page 213.

4. (Optional) On the Operations tab, select the operations that the groups or users can perform. For
details on the available operations, see "User Management Operations" on page 243.

Note: After you have changed user permissions, the user needs to log out of BSM and log in again
for the changes to take effect.

Configure User and Group Hierarchy

In the Hierarchy tab, you set user and group hierarchy by adding users to groups and nesting groups
within other groups.
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Note:
« When deleting a parent group, the child groups and users are not deleted.

« If BSM groups have been synchronized with groups on an external LDAP server, BSM users
cannot be moved between groups, and only groups appear on the interface. For details on
synchronizing groups, see "Synchronizing Users" on page 324.

1. Ensure that you have configured at least one group and one user in the Groups/Users pane.

2. Select agroup or user in the Groups/Users pane, and select the Hierarchy tab on the right side of
the page to view the parent and child groups of the group or user.

3. Inthe Hierarchy tab, click the Edit Child Groups and Users button.

D] | <

4. Usethe or buttons to add or remove groups or users from the list of nested items.

Customize User Settings

You can customize user settings to:
« Select the default context that is displayed for specific users or groups when they log into BSM.

« Specify the first page that is displayed for specific users or groups in each of the different parts of
BSM.

« Select contexts, applications, tabs, and options that are available for users or groups.

You can customize settings for individual users or for all users in a group, including all members of sub-
groups that are part of a parent group. If you restrict access to a feature or report for a group, all
members of that group do not have access to the feature and you cannot override the setting for
individual users.

Users who are members of more than one group, assume the restrictions of both groups. For example,
the members of Group A are restricted from accessing all applications except App1 and App2, and the
members in Group B are restricted from accessing all applications except App2 and App3. Therefore,
users who are members of both Group A and Group B only have access to App2.

If you add users or sub-groups to a group that has group settings applied, the users or members of the
sub-groups automatically get the access restrictions that were applied to the parent group.

Note: For the Service Health and Operations Management applications, you cannot define user
access to specific pages; you can only enable or disable user access at the application level.

For a use-case scenario related to this task, see "How to Customize User Menus — Use-Case
Scenario" on page 208.

1. Select a group or user in the Groups/Users pane, and select the Customization tab on the right
side of the page.
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2. Select a context from the Contexts pane that you want to be the default entry context that this
user or all users in a group see when they log into BSM, and click Set as Default Entry Context.

Note: The Default Entry Page icon appears next to the specified context.

3. Inthe Contexts pane, clear the check boxes of the contexts and applications that you want hidden
from the user or all members of the group.

4. Inthe Pages and Tabs pane, select the pages and tabs that you want to be visible on the
selected context for the user or group.

5. If required, select a default page or tab for each context that appears by default when the user
opens that context.

Configure and Manage Recipients

You create recipients by defining one or more notification methods, the template to use for alert notices,
and a notification schedule to receive reports.

You create recipients and manage existing recipients in the Recipients page. For user interface details,
see "Configure and Manage Recipients" on page 269.

How to Configure Users and Permissions — Use-Case
Scenario

This use-case scenario describes how to configure users and groups in the User Management portal.

Note: For a task related to this scenario, see "Configuring Users and Permissions - Workflow" on
page 197.

1. Mapping Out Users and Groups

Jane Smith is the System Administrator at NewSoft Company, and wants to configure users and
groups to be authorized to use BSM, as well as end users who will be accessing Service Health
and reports. Before doing so, she requests the following preliminary information from relevant staff
members:

m Usernames
= Login names

m Initial Passwords
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m UserTime Zones

m Contact Information (for example, telephone number, pager, and email address)
Note: Contact information is mandatory only for HP Software-as-a-Service customers.

With this information, she then decides to create one group with the permission level of System
Modifiers, and another with the permission level of System Viewers. Further, one of the users is
assigned additional roles of SiteScope Administrator.

2. Creating Groups
Jane groups users together according to the level of permissions they are to be granted. She

clicks the New GrouplUserEl button in the Groups/Users pane and creates the following
groups:

= System Viewers
= System Modifiers

The Groups/Users pane appears as follows:

Groups/Uzers | Browse Search
kv [ M a2 I
= B3 an

Ef system Modifiers

=5y stem Viewers

3. Assigning Permissions to Groups

Once the groups have been created, Jane assigns the relevant permission levels to the groups.
After selecting System Modifiers in the Groups/Users pane, she navigates to the Permissions
tab in the Information pane, and selects the Root instance (Business Service Management)
from any context. In the Roles tab, she selects System Modifier and then clicks Apply
Permissions. She then selects System Viewers in the Groups/Users pane and selects System
Viewer in the Roles tab, clicking Apply Permissions.

The results are displayed on the Permissions tab as follows:
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Groupsilsers Browse || Search | lior General Il Recipient ||  Permizsi || Hierarchy || customization |
0 2% = Eex Roles Operations
I Platform ;I
= B3 an - =
5 usiness Service ialll = T
B2 am =" REusiness Service M e ]
o ior] &1 Authentication Stra & e
§ Administrator
=1 Audit Log
System Modifier
@] Users
System Viewer
4 @1 User Groups i
4 BPl&dministrator Il
M @1 Data Collectors e =
SET
@1 Motification System
. BPIRestrictedViewUser Il
4 [ CMDB Open API Query -
CMDB Open API Update -
To =elect multiple resources, press CMDB Open APl Impact | =
Ctrl while making your selections. -

4. Creating Users

Jane must now create users to nest within the groups, based on the required permission levels of

the individual users. She clicks the New Group/User button in the Groups/Users pane and
while on the Root group, (All), she selects Create User and configures settings for each new
user. The Groups/Users pane appears as follows:

Groups/Users | Browse Search
g X &2 ¥ B
= B an

[+ Ei Group1
System Modifiers

Boriz

Carlos
Donna
Mary
Rache
Steve

B> Bo Bo Ba Bo Bo [ LI

5. Configuring User and Group Hierarchy

Now that Jane has created users authorized to access BSM, she assigns their permission level
by nesting them within the appropriate group.

She selects the System Modifiers group from the Groups/Users pane to nest the appropriate
users in this group. Jane then selects the Hierarchy tab from the Information pane on the right
side of the page. The hierarchy tab indicates that the System Modifiers group has no child groups,
as follows:
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System Modifiers General | Permissions ||  Hierarchy ]_
Groups that are direct parentz of the group "System Groups and uzers that are direct children of the group
Modifiers”. "Sy=tem Modifiers”.

Parent Group= Child Group= and Uzsers
Mo parent groups defined for "Syatem Modifiers”. Mo child groups or uzers defined for "System
Modifiers’

Edit Child Groups and Users

Jane clicks the Edit Child Groups and Users button to open the Edit Child Groups and Users
dialog box:

Edit child groups and users for 'System Modifiers' group

Select groups and users from the left pane and click the right arrow to add them to the "System Modifiers' group. Select groups and users from the
right pane and click the left arrow to remove them from the "System Modifiers' group.

Groups/Users Child Groups and Users

= B A
E?- Group1
E‘:'& System Modifiers

System Viewers
Boriz

Carloz

Donna

Mary

Rachel

Steve

Ba B Eo Eo Ba Ba [

& @

I T
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She then selects the relevant users from the Groups/Users pane and clicks the right arrow to
move them to the Child Groups and Users pane. The Hierarchy tab indicates that these users
are nested within the System Modifiers group, as follows:

System Modifiers | General || Permizsions ||  Hierarchy |_
Groups that are direct parentz of the group "System Groups and uzers that are direct children of the group
Modifiers". "Sy=tem Modifiers”.
Parent Groups Child Groupz and Users
Mo parent groups defined for "System Modifiers”. ]
P group ¥ i Boriz
A
ih Carlos
A
s Donna

Edit Child Groups and Lisers

After following the same procedure to nest the relevant users in the System Viewers group, the
Groups/Users pane is displayed as follows:

HP Business Service Management (9.26) Page 205 of 397



BSM Platform Administration Guide
Chapter 26: User Management

Groups/Users | Browse | Search
wsew lll ﬂ -4 'r_-h?
= B3 A

E='..'. Group1

= EZ system Modifiers

Boriz

Carloz

E>» B2 Bo

Donna

SRE RSy stem Viewers
Mary
Rache
Steve

E> Eo B0

Since Steve has the added permission level of SiteScope Administrator, Jane selects the
username of the user in the Groups/Users pane whom she wants to give the added permission
level of SiteScope Administrator, and in the Permissions tab, selects the System Availability
Management context. After selecting a resource, she then selects SiteScope Administrator
from the Roles tab, and clicks Apply Permissions. The resulting screen appears as follows:

Groups/Users Browse | Search | Steve | General Il Recipient | Permissions || Hierarchy || Customization |
(T4 il Cun}ext — | Roles Operations
S a ISy:[err Awailability Management =1
ERE fystam Modifiers Eisiescones Ad:mnlstratur
': Bors System Modifier
l: Carlos System Viewer
an Donna BPlAdministrator
= F.'. System Viewers BPIU=er
a Mary BPIRestrictedViewlUser
|'_‘| Rachel CMDB Open API Query
[ Wsicvd CMDB Open APl Update

CMDB Open APl Impact

CMDB Open API Clazs Model
SiteScope Administrator

Default

BPN Viewer
TransactionManagementOperator
BPM Administrator
TransactionManagementAdministrator
RUM Administrator
TransactionManagementlUser
RUM Viewer

EESEEEEENEEEEEEEEEE A

To select multiple resources, press Ctrl
while making your selections.

m Apply Permssons

6. Customizing User Settings

Jane now sets the page each user sees when entering BSM, and the menu items available to
them on pages throughout BSM. After selecting each user, she clicks the Customization tab and
sets the following parameters:
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m The entry context that the user sees when logging into BSM. For example, Admin - End User
Management.

= The page within the entry context that the user sees on the selected context. For example,
Reports.

m The pages and tabs that are to be visible on each BSM page by selecting or clearing the
relevant check boxes. For example, the Transaction Topology and User-created reports
pages are cleared to ensure that they are not visible on the Applications - Transaction
Management context when the user logs in.

The configured settings are displayed on the customization tab as follows:

Boriz | General || Recipient || Permissions || Higrarchy ” Customization l_

Customize view and entry pages per user.

Select the default entry context that epens for thiz user when Select the default page that opens for each BSM context and the
legging into BSM by highlighting an application and clicking the pages and tabs to dizplay for thiz user.

butten at the top of the context list.

Set a= Default Entry Contest Set as Default Entry Page

Contexts Pages and Tabs
¥ Applications - MyBSH =5 [l Tranzaction Summary
v Applications - Service Health ¥ Tranzaction Summary
v Applications - Service Level Management
[V wiek Session Report
Il Applications - End User Management

[l Applications - Transaction Management [¥ Transaction Analysis
¥ Applications - System Availability Management [ Transaction Over Time
™ ;\;ﬂclatiuns - Buziness Service Management for ¥ Transaction Tracking Report
v Applications - Application Management for SOA [v! Event Analyzis
pplications - User Repo
¥ Applications - User Reports
[ Transaction Topology
¥ admin - Service Health

- Aggregated Topology

=l

Admin - Service Level Management
[ Component Topology Analysis

¥ aAdmin - Operations Management
[l Admin - End User Management ¥ Transaction Infrastructurs
W admin - Sy=tem Availability Management ~ Application Server Statistics Report
¥ Admin - ODB Administration
¥ Admin - Buginess Service Management for Siebel I™ User-created Reports
Administration

=l

Admin - Platform

3

Admin - Integrations

Admin - Perzonal Settings

<l =

Help - Site Map

K Cancel
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The login page that the user sees according to the customized configurations is as follows:

[  Business Service Management - Transaction Management Full Sereen View  User: Boris  [TCog0ut")

- MyBSM  Applications + Admin + Help = Site Map
_—

| Trangaction Summary |

Transaction Summary Transaction Analysis Transaction Infrastructure [

Web Session Report 7

Dizplays transaction activity for a web session, or fitering on a customer ID

How to Customize User Menus — Use-Case Scenario

This use-case scenario describes how to customize user menus for individual users.

Note: For a task related to this scenario, see "Customize User Settings" on page 200.

1. Choosing a User

Mary, the administrator of ABC Insurance Company, is creating several users in the User
Management section of BSM. She decides that the user John Smith should be able to view only
certain pages and tabs in BSM, and that a specific page should appear on his screen when he logs
into BSM.

2. Assigning a Default Context

Since John's chief responsibility at ABC relates to service level management, Mary designates
the Applications - Service Level Management page as the default entry context. Mary selects
Applications - Service Level Management in the Contexts pane, and clicks Set as Default
Entry Context. The Applications - Service Level Management context is indicated as the
default entry context with the default entry icon, as appears in the following image:
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Set as Default Entry Context

Contexts

< X

< X pE

U Y

Applications - MyBSM

Applicationz - Service Health

Applications - Service Level Management

Applicationzs - End U=er Management

Applicationz - Tranzaction Management

Applications - System Availability
Management

Applications - Buziness Service
Management for Siebel

Applicationz - Application Management for
S04

3. Selecting Context Pages and Tabs

Since John is not authorized to view Outage Reports, that option is cleared in the Pages and Tabs
pane, leaving the remaining pages and tabs checked to be visible when John logs into BSM. As
SLA Reports are of the highest priority for ABC Insurance, Mary designates this as the first page
for John to see upon logging in. She selects SLA Reports in the Pages and Tabs pane, and then
clicks Set as Default Entry Page. SLA Reports is indicated as the default entry page with the
default entry icon, as appears in the following image:

Set 2= Default Entry Page

Pages and Tabs

7

Status Snapshot

5 P

¥ sLa Status

V¥ sLas Summary
W ci Summary

¥ HiCl Summary
Co Impact

[ cl status -

4. Results
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The context that opens when John Smith logs into BSM is the Service Level Management
context on the Applications menu. The SLA Reports page opens, and the Status Snapshot,
Alerts, and SLA Management pages are also available to him.

The configured Customization tab in User Management appears as follows:

John Smith | General I Recipient || Permissions | Hierarchy ” Custemization l_

Customize view and entry pages per user.

Select the default entry context that opens for this user when  Select the default page that opens for each BSM context and
legging into BSM by highlighting an application and clicking the  the pages and tabs to display for this uzer.
button at the top of the context list.

‘Set as Default Entry Context Set as Default Entry Page

Contexts Pagez and Tabs

=l

Applications - MyBSM ¥ status Snapshot

3

Applications - Service Health
o ﬁj ¥l sLA Reports

Applications - Service Level Management
n = = [V SLa Status
[¥ Applications - End User Management
v SLAz S

v Applications - Tranzaction Management Cl ——
~ Applications - System Availability ¥ cl Summary

Management
Vv Applications - Buginess Service V! Hi I Summary

Management for Siebel -

Climpact

¥ Applications - Application Management for 3

S04

b [T clStatus -

Ok Cancel
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Screen that John sees when logging into BSM:

rvice Management - Service Level Management

- MyBSM  Applications + Admin + Help v Site Map
[
| SLA Reporis
Status Snapshot e H Alerts Outage Reports SLA Management [
SLA Status 7 = Time Range Comparison 1?2 2 -
£ —— ]
Displays the forecast status for the end of a calculation Dizplays the status of four levels of Cle: a Cl's status Z
period for selected SLAs and time intervals, compared {can be an SLA) and the statuses of the Cl's children, ﬁ
with the current SLA status for the time intervals. (The organized by time range, for a selected KPland = =
forecast status is based on the SLA behavior in the calendar. ——
past.)
SLAs Summary 7 r Cls Over Time 7
-
Displays a list of SLAs and their status organized by Displays selected Cl statuses over time for a selected
KPI, calendar and time period. KPl and calendar.
ClSummary 7 Cl Time Comparison 7
= ———
= =
Displays four levels of Cle: a Cl's status (can be an 5 3 Displays a selected Cl's status over time, organized by
SLA) and the statuses of the Cl's children. (This report ————— KPl and calendar vs. the SLA target and the Cl's history
iz reached by dril-dewn from the SLAz Summary “;1_5 resuliz.
report.) = — EE___
HI Cl Summary # e
e Eee
Displays summary of SLAs Cls with the addition of _— =
Heatth Indicators information. (This report is reached by | = - = -
dril-down from the SLAs Summary report.} = :
-

How to Export and Import User Information Using the JMX
Console

This task describes how use the JMX Console to copy user, role, and permission information from a
source system to a target system. For example, if you need to configure a new BSM database, you
may need to copy user information from an existing database.

Set Contexts to Export

You can limit which contexts will be included in the export. You can view a list of available contexts in
the JMX Console:

1. Inabrowser, enter the following URL:
http://<SOURCE_
Server>:29000/mbean?objectname=BSMPlatform%3Aservice%3DAuthorization+Service

2. Enteryour JMX Console user name and password.

3. Onthe JMX MBean View page, click the Invoke button below java.util.Set
listAuthorizationContexts(). JMX Console displays all contexts in TAS.
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If you need to limit the contexts included in the export:

1.

On the source server, open the following file HPBSM\confitas\exportedContexts.properties

2. Modify the contexts-to-export property.

Contexts in the contexts-to-export property must be separated by commas only, without spaces.

3. Save your changes.

Export
Use JMX Console to create a .zip file that contains .xml files with user, role, and permission
information.

1. Inabrowser, enter the following URL:
http://[<SOURCE_
Server>:29000/mbean?objectname=Topaz%3Aservice%3DAuthorization+Service+Data+|
mport+Export

2. Onthe JMX MBean View page, click the Invoke button below void loadExportedContexts() and
then click the Browser's Back button to return to the JMX MBean View page.

3. Below void exportAllTasEntities(), in the ParamValue field, enter a location and file name for
the export file on the source server. The file name must have a .zip extension for example:
C:\HPBSM\export.zip

4. Click the Invoke button below void exportAllTasEntities().

Transfer

You need to copy the export .zip file from the source server to the target server.

1.

On the source server, browse to the export file as defined above.

2. Copy thefile to the target server.

Import

Import the users, roles and permissions from the .zip file to the target BSM system.

Caution: Before you import user and group information, make sure that the target server does not
have any created resources, such as reports, profiles, and monitors, that have user information
that is not compatible with the information that you are importing.

1.

In a browser, enter the following URL:
http://[<TARGET _
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Server>:29000/mbean?objectname=Topaz%3Aservice%3DAuthorization+Service+Data+I
mport+Export

2. Enteryour JMX Console user name and password.

3. Below void importAllTasEntities(), in the ParamValue field, enter the location and file name of
the export file and click the Invoke button.

User Management Roles Applied Across BSM

This section lists roles that can be applied across all contexts within BSM and the resources that each
role applies to.

For details about roles that can be applied only to specific contexts, see "User Management Roles
Applied to Specific Contexts" on page 239.

The following are the roles that can be applied across all contexts within BSM:
o "Superuser" below
« "Administrator" on the next page
» "System Modifier" on page 221
» "System Viewer" on page 225
o "Customer Superuser" on page 228
o "Customer Administrator" on page 233
« "BPM Viewer" on page 237
« "BPM Administrator" on page 238
o "RUM Administrator" on page 239

« "RUM Viewer" on page 239

Superuser

The Superuser role can be applied only to the Business Service Management resource.
This role includes all available operations on all the resources in all the contexts. Only a superuser can

apply the Superuser role to another user.

Caution: The default superuser does not have permissions to write to Business Service
Management from the UCMDB WS API. Specific roles exist for that purpose. For details, see
"User Management Roles Applied to Specific Contexts" on page 239.
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Administrator

The Administrator role can be applied only to the Business Service Management resource.

Administrators have a collection of permissions that enable them to add profiles to the system and
manage the resources related to those profiles. After a profile has been added, the administrator has full
control privileges on all resources within that profile instance.

Diagnostics
Resource

Diagnostics

End User Management

Resource
Alert - Create dependencies

Applications

BPM Agents
RUM Engines

Script Repository

MyBSM

Resource
User Pages

Predefined Pages

User Components
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Allowed Operations
Change

View

Execute

Full Control

Allowed Operations
Change

Add
View

View
View

Add
Change
View
Delete

Full Control

Allowed Operations
Full Control

View

Full Control

Full Control
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MyBSM (Legacy)

Resource
Modules

Portlet Definitions

Operations Management

Resource

Events assigned to user

HP Business Service Management (9.26)

Allowed Operations
Full Control

Full Control

Allowed Operations

Work On/Resolve

Close

Reopen

Assign To

Launch Operator Action

Launch Automatic Action
Transfer Control

Close Transferred

Add/Remove Event Relations
Change Severity

Change Priority

Change Title

Change Description

Change Solution
Add/Delete/Update Annotations
Add/Delete/Update Custom Attributes
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Resource

Events not assigned to user

Health Indicators
Administrative Uls

Tool Categories

Allowed Operations

View

Work On/Resolve

Close

Reopen

Assign To

Launch Operator Action

Launch Automatic Action
Transfer Control

Close Transferred
Add/Remove Event Relations
Change Severity

Change Priority

Change Title

Change Description

Change Solution
Add/Delete/Update Annotations
Add/Delete/Update Custom Attributes

Reset
View

Execute

Operations Orchestration Integration

Resource

Administration

Execution

Platform

Resource

Audit Log
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Allowed Operations

Add
Change
View
Delete

Full Control

Execute
Full Control

Allowed Operations

View
Full Control
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Resource

Users

User Groups

Data Collectors

Scheduled Reports

Recipients

Custom Data Types

Downtime

Databases

HP Business Service Management (9.26)

Allowed Operations

Add
Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control

Change
View

Add
Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control

View
Full Control

Add
Change
View
Delete

Full Control
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RTSM

Resource

Views

RTSM

Cl Search
Data Modifier
Get Related
ITU Manager

Modeling Studio

Service Health Analyzer

Resource
Administration

Application

Service Level Management

Resource

SLAs
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Allowed Operations

Add
Change
View
Delete

Full Control
Full Control
Full Control
Full Control
Full Control
Full Control

Full Control

Allowed Operations
Full Control

Full Control

Allowed Operations

Add
Change
View
Delete

Full Control
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SiteScope On-demand monitors

Resource

Administration

Execution

Allowed Operations

Add
Change
View
Delete

Full Control

Execute
Full Control

System Availability Management

Resource

SiteScopes

Transaction Management

Resource

TransactionVision Processing Servers

TransactionVision Analyzers

TransactionVision Job Managers

TransactionVision Query Engines

Administration
User Data

Applications
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Allowed Operations

Add

Allowed Operations

Change
Full Control

Change
Execute
Full Control

Change
Execute
Full Control

Change
Execute
Full Control

Change
Full Control

View
Full Control

Add
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User Defined Reports

Resource

Custom Reports

Trend Reports

Custom Links

Excel Reports

Default Footer/Header

Favorite Filter

Annotation

Service Report

Custom Query Reports

HP Business Service Management (9.26)

Allowed Operations

Add
Change
View

Full Control

Add
Change
View

Full Control

Change
View
Full Control

Change
View
Full Control

Change
Full Control

Change
View
Delete

Full Control

Change
Delete
Full Control

Change
Delete
Full Control

Add
View
Full Control
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System Modifier

The System Modifier role can be applied only to the Business Service Management resource.

A system modifier can view and change any resources in BSM. There are some resources on which
the view or the change operation is not applicable. A system modifier has permissions for only those

operations that are available in BSM.

Diagnostics
Resource

Diagnostics

End User Management

Resource

Alert - Notification Template

Alert - Create dependencies

Applications

BPM Agents
RUM Engines

Script Repository

MyBSM
Resource
Pre-defined Pages
User Pages

User Components
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Allowed Operations

Change
View

Allowed Operations

Change
View

Change

Change
View

View
View

View
Full Control

Allowed Operations
View
Full Control

Full Control
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Operations Orchestration Integration

Resource

Administration
Execution

Platform

Resource
Audit Log

Users

User Groups

Data Collectors
Scheduled Reports
Recipients

Custom Data Types

Send SNMP trap
Run executable file
Log to Event Viewer
Downtime

Databases

System Recipient Template

HP Business Service Management (9.26)

Allowed Operations

Change
View

Execute

Allowed Operations
View

Change
View

Change
View

Change
View

Change
View

Change
View

Change
View

Change
Change
Change
Full Control

Change
View

Change
View
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RTSM
Resource Allowed Operations
Views Change
View
Cl Search Full Control
Get Related Full Control
ITU Manager Full Control
Modeling Studio Full Control
Service Health Analyzer
Resource Allowed Operations
Administration Full Control
Application Full Control
Service Level Management
Resource Allowed Operations
SLAs Change
View
SiteScopeOn demand monitors
Resource Allowed Operations
Administration Change
View
Execution Execute
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System Availability Management

Resource Allowed Operations
SiteScopes Change
View
Transaction Management
Resource Allowed Operations

TransactionVision Processing Servers = Change

TransactionVision Analyzers Change
Execute
TransactionVision Job Managers Change
Execute
TransactionVision Query Engines Change
Execute
Administration Change
Applications Change
View
User Defined Reports
Resource Allowed Operations
Custom Reports Add
Change
View
Trend Reports Add
Change
View
Custom Links Change
View
Excel Reports Change
View
Default Footer/Header Change
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Resource

Favorite Filter

Annotation
Service Report

Custom Query Reports

System Viewer

Allowed Operations

Change
View
Delete

Change
Delete

Change
Delete

Add
View

The System Viewer role can be applied only to the Business Service Management resource.

A system viewer can only view resources within BSM and does not have permission to change, add, or
delete any resources or resource instance with the exception of the RUM Engine resource. There are
some resources on which the view operation is not applicable, a system viewer has no access to those

resources.

Diagnostics
Resource

Diagnostics

End User Management
Resource
Alert - Notification Template
Applications
BPM Agents

RUM Engines

Script Repository
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Allowed Operations

View

Allowed Operations
View
View
View

View
Edit

View
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MyBSM

Resource

Predefined Pages

Allowed Operations

View

Operations Orchestration Integration

Resource

Administration

Platform
Resource
Audit Log
Users
User Groups
Data Collectors
Scheduled Reports
Recipients
Custom Data Types
Downtime
Databases

System Recipient Template

RTSM

Resource
Views

Cl Search
Get Related

ITU Manager
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Allowed Operations

View

Allowed Operations
View
View
View
View
View
View
View
View
View

View

Allowed Operations
View

Full Control

Full Control

Full Control
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Resource

Modeling Studio

Service Health Analyzer

Resource
Administration

Application

Service Level Management

Resource

SLAs

SiteScopeOn demand monitors

Resource

Administration

Allowed Operations

Full Control

Allowed Operations
Full Control

Full Control

Allowed Operations

View

Allowed Operations

View

System Availability Management

Resource

SiteScopes

Transaction Management

Resource

Applications
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Allowed Operations

View

Allowed Operations

View
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User Defined Reports

Resource

Custom Reports

Trend Reports

Custom Links
Excel Reports
Favorite Filter

Custom Query Reports

Customer Superuser

Allowed Operations

Add

View

Edit (only if you are the user who created the report)
Delete (only if you are the user who created the report)

Add

View

Edit (only if you are the user who created the report)
Delete (only if you are the user who created the report)

View
View
View

Add
View

Note: This role can be applied to HP Software-as-a-Service customers only.

The Customer Superuser role can be applied only to the Active Customer resource instance. The
Active Customer resource instance is available only to HP Software-as-a-Service customers and
represents the customer level in the permissions resource tree. It is available in all contexts and applies
to all contexts (like the Business Service Management resource).

Diagnostics
Resource

Diagnostics
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Allowed Operations

View
Execute
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End User Management

Resource

Alert - Create dependencies

Applications

BPM Agents
RUM Engines

Script Repository

MyBSM

Resource
Predefined Pages
User Pages

User Components

MyBSM (Legacy)

Resource
Modules

Portlet Definitions

HP Business Service Management (9.26)

Allowed Operations

Change
Full Control

Add
Change
View
Delete
Execute
Full Control

View
View
Add
Change
View

Delete
Full Control

Allowed Operations

Full Control
Full Control

Full Control

Allowed Operations

Full Control

Full Control
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Platform

Resource

Audit Log

Users

User Groups

Data Collectors

Central Repository Service

Notification System

Package Work Manipulation

Scheduled Reports

Recipients

HP Business Service Management (9.26)

Allowed Operations

View
Full Control

Add
Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control

Change
View

Add
Change
View
Delete
Execute
Full Control

View
Execute
Full Control

Change
Full Control

Add
Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control
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Resource Allowed Operations
Custom Data Types Add
Change
View
Delete
Full Control
Customer Recipient Template Add
Change
View
Delete
Full Control
Downtime View
Full Control
RTSM
Resource Allowed Operations
Views Add
Change
View
Delete
Full Control
RTSM Full Control
Cl Search Full Control
Data Modifier Full Control
Get Related Full Control
ITU Manager Full Control
Modeling Studio Full Control

Service Health Analyzer
Resource Allowed Operations
Administration Full Control
Application Full Control

HP Business Service Management (9.26)

Page 231 of 397



BSM Platform Administration Guide
Chapter 26: User Management

Service Level Management

Resource

SLAs

Allowed Operations

Add
Change
View
Delete

Full Control

System Availability Management

Resource

SiteScopes

User Defined Reports

Resource

Custom Reports

Trend Reports

Custom Links

Excel Reports

Default Header/Footer

HP Business Service Management (9.26)

Allowed Operations

Add
Change
View
Delete
Execute
Full Control

Allowed Operations

Add
Change
View

Full Control

Add
Change
View

Full Control

Change
View
Full Control

Change
View
Full Control

Change
Full Control
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Resource Allowed Operations

Favorite Filter Change
View
Delete
Full Control

Annotation Change
Delete
Full Control

Service Report Change
Delete
Full Control

Custom Query Reports Add
View
Full Control

Customer Administrator

Note: This role can be applied to HP Software-as-a-Service customers only.

The Customer Administrator role can be applied only to the Active Customer resource instance.
The Active Customer resource instance is available only to HP Software-as-a-Service customers and
represents the customer level in the permissions resource tree. It is available in all contexts and applies
to all contexts (like the Business Service Management resource).

The customer administrator is granted full control on a selection of resources, as well as either view,
execute, or both on other resources. This user can add profiles of any type, and has full control on the
created profile. However, the user is not granted permissions for profiles that were created by other
users, even if these profiles are for the same customer. In the case of the MyBSM resources, any user
with this role can make changes to resources defined by other users.

Diagnostics
Resource Allowed Operations
Diagnostics View

Execute
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End User Management

Resource

Alert - Create dependencies

Applications
BPM Agents

RUM Engines

MyBSM

Resource
Predefined Pages
User Components

User Pages

MyBSM (Legacy)

Resource
Modules

Portlet Definitions

Platform

Resource

Audit Log

Users
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Allowed Operations

Change
Full Control

Add View
View

View

Allowed Operations
View
Full Control

Full Control

Allowed Operations
Full Control

Full Control

Allowed Operations

View
Full Control

Add
Change
View
Delete

Full Control
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Resource

User Groups

Central Repository Service

Notification System

Package Work Manipulation

Scheduled Reports

Recipients

Custom Data Types

Customer Recipient Template

Downtime

HP Business Service Management (9.26)

Allowed Operations

Add
Change
View
Delete

Full Control

Add
Change
View
Delete
Execute
Full Control

View
Execute
Full Control

Change
Full Control

Add
Change
View
Delete

Full Control

Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control

Add
Change
View
Delete

Full Control

View
Full Control
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RTSM
Resource Allowed Operations
Views Add
Change
View
Delete
Full Control
RTSM Full Control
Cl Search Full Control
Data Modifier Full Control
Get Related Full Control
ITU Manager Full Control
Modeling Studio Full Control
Service Health Analyzer
Resource Allowed Operations
Administration Full Control
Application Full Control
Service Level Management
Resource Allowed Operations
SLAs Add
Change
View
Delete
Full Control

System Availability Management

Resource Allowed Operations

SiteScopes Add
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User Defined Reports

Resource

Custom Reports

Trend Reports

Custom Links

Excel Reports

Default Header/Footer

Favorite Filter

Annotation

Service Report

Custom Query Reports

BPM Viewer

Allowed Operations

Add
Change
View

Full Control

Add
Change
View

Full Control

Change
View
Full Control

Change
View
Full Control

Change
Full Control

Change
View
Delete

Full Control

Change
Delete
Full Control

Change
Delete
Full Control

Add
View
Full Control

The BPM Viewer role can be applied only to the Business Service Management resource.

These users have view permissions, but cannot modify transaction threshold settings and transaction

descriptions.
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Any regular user who was added as a user on a specific application in the previous version is upgraded
to the BPM Viewer role for that application.

Resource Allowed Operations
Applications View
BPM Agents View
Script Repository View
BPM Administrator

The BPM Administrator role can be applied only to the Business Service Management resource.
The BPM Administrator can manage all of the platform's BPM applications, including permissions.

Any administrator who was added as a user on a specific BPM application in the previous version is
upgraded to the BPM application administrator role for that application. This is in addition to being
assigned the administrator role as described above (for details, see "Administrator" on page 214).

Resource Allowed Operations

Applications Add
Change
View
Delete
Execute
Full Control

BPM Agents View

Script Repository Add
Change
View
Delete
Full Control
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RUM Administrator
The RUM Administrator role can be applied only to the Business Service Management resource.
Resource Allowed Operations
Applications Add
Change
View
Delete
Execute
Full Control
RUM Engines View

RUM Viewer

The RUM Viewer role can be applied only to the Business Service Management resource.

These users have view permissions, but can modify transaction threshold settings and transaction
descriptions.

Any regular user who was added as a user on a specific RUM profile in the previous version is
upgraded to the RUM Viewer role for that profile.

Resource Allowed Operations
Applications View
RUM Engines View

User Management Roles Applied to Specific Contexts

The following roles can be applied only to specific contexts within BSM. Details of the resources and
contexts on which roles can be applied appear within the description of each role below.

For details about roles that can be applied across BSM, see " User Management Roles Applied Across
BSM" on page 213.

CMDB Open API Query

The CMDB Open API Query role can be applied only to the RTSM Open API resource in the RTSM
context.

This role enables users to query the CMDB (Configuration Management Database) for communication
with third-party applications.
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Context Resource Allowed Operations
RTSM RTSM Open API View
CMDB Open API Update

The CMDB Open API Update role can be applied only to the RTSM Open API resource in the RTSM
context.

This role enables users to update the CMDB (Configuration Management Database) for communication
with third-party applications.

Context Resource Allowed Operations
RTSM RTSM Open API Change
CMDB Open APl Impact

The CMDB Open API Impact role can be applied only to the RTSM Open API resource in the RTSM
context.

This role enables users to impact operations on the CMDB.

Context Resource Allowed Operations

RTSM RTSM Open API View

CMDB Open API Class Model

The CMDB Open API Class Model role can be applied only to the RTSM Open API resource in the
RTSM context.

This role enables users to perform operations on CITs.

Context Resource Allowed Operations

RTSM RTSM Open API View

SiteScope Administrator

The SiteScope Administrator role can be applied only to the SiteScopes resource in the System
Availability Management context or specific instances of the resource.

When granted this role at the resource collection level, the SiteScope administrator can manage all of
the platform's SiteScopes, including permissions on the SiteScopes. When granted this role at the
instance level, the administrator can manage only those resources associated with the specific
SiteScope instance.
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Any administrator who was added as a user on a specific SiteScope in the previous version is upgraded
to the SiteScope administrator role for that SiteScope.

Context Resource Allowed Operations
System Availability SiteScopes Add
Management Change
View
Delete
Execute
Full Control
Default
The Default role is automatically assigned if no other role was selected. It allows very limited
permissions.

Note: To create meaningful reports, the user will likely need additional permissions to specific
applications or configuration items.

Context Resource Allowed Operations

User Defined Reports Custom Reports Add
Edit (only if you are the user
who created the report)
Delete (only if you are the
user who created the report)

Trend Reports Add
Edit (only if you are the user
who created the report)
Delete (only if you are the
user who created the report)

TransactionManagementOperator

The TransactionManagementOperator role can be applied only to the TransactionVision Analyzers
resource in the Transaction Management context.
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Context

Transaction Management

TransactionManagementAdministrator

Resource

TransactionVision Analyzers
TransactionVision Job Managers
TransactionVision Query Engines

Administration

Applications

Allowed Operations

Execute
Execute
Execute
Change

View

The TransactionManagementAdministrator role can be applied only to the TransactionVision
Processing Servers resource in the Transaction Management context. The
TransactionManagementAdministrator role is useful in providing added security by enabling users to
have Full Control access of TransactionVision administration, but not enabling access to the User Data

resource.

Context

Transaction Management

Resource

TransactionVision Processing Servers

TransactionVision Analyzers

TransactionVision Job Managers

TransactionVision Query Engines

Administration

Applications

TransactionManagementUser

The TransactionManagementUser role can be applied only to the Applications resource in the
Transaction Management context.
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Allowed Operations

Change
Full Control

Change
Execute
Full Control

Change
Execute
Full Control

Change
Execute
Full Control

Change
Full Control

Add
Change
View

Full Control
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Context Resource Allowed Operations

Transaction Management = Applications View

User Management Operations

Within each context listed below is a table listing:
» Everyresource
« Which operations can be applied to that resource

« A description of what the operation enables

Diagnostics
The Diagnostics context enables you to define operations permitted for the Diagnostics application.
Resources Operation Description

Diagnostics = Change Enables viewing Diagnostics administration and configuring the
Diagnostics settings.

View Enables viewing Diagnostics when accessing Diagnostics from BSM.

Execute Enables changing the settings in the Diagnostics Ul, such as setting

thresholds.
Full Enables performing all operations on Diagnostics, and granting and
Control removing permissions for those operations.
End User Management

The End User Management context enables you to define the operations permitted for the End User
Management application. Operations assigned to a folder affect all folders contained beneath it.

Resources Operation Description
Alert - Notification Change Enables editing the properties of a customer-specific
Template notification template.
View Enables viewing the properties of a notification template.
Full Enables performing all available operations on a notification
Control template, and granting and removing permissions for those
operations.
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Resources Operation
Alert - Create Change
dependencies
Full
Control
Applications Add

Change

View

Delete

Execute

Full
Control

Applications = BPM Add
(specific

instances) ch
ange

View

Delete

Execute

Full
Control

HP Business Service Management (9.26)

Description
Enables creating and removing dependencies between alerts.

Enables creating and removing alert dependencies, and
granting and removing permissions for those operations.

Enables adding applications.

Enables editing applications, or a specific instance of
applications.

Enables viewing applications. Applies to End User
Management (administration and reports) only.

Enables deleting applications, or a specific instance of
applications.

Enables starting and stopping applications, or a specific
instance of applications.

Enables performing all available operations on applications, or
a specific instance of applications, and granting and removing
permissions for those operations.

Enables creating a Business Process configuration for a
specific instance of applications.

Enables editing a Business Process configuration for a
specific instance of applications.

Enables viewing a Business Process configuration for a
specific instance of applications.

Enables deleting a Business Process configuration for a
specific instance of applications.

Enables activating and disabling a Business Process
configuration for a specific instance of applications.

Enables performing all available operations on a Business
Process configuration for a specific instance of applications.
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Resources Operation

RUM  Add

Change

View

Delete

Execute

Full

Control

Alert View

Full

Control

BPM Agents View

RUM Engines View

Script Repository Add
Change

View

Delete

Full
Control
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Description

Enables creating a Real User Monitor configuration for a
specific instance of applications.

Enables editing a Real User Monitor configuration for a
specific instance of applications.

Enables viewing a Real User Monitor configuration for a
specific instance of applications.

Enables deleting a Real User Monitor configuration for a
specific instance of applications.

Enables activating and disabling a Real User Monitor
configuration for a specific instance of applications.

Enables performing all available operations on a Real User
Monitor configuration for a specific instance of applications.

Enables viewing an Alert configuration for a specific instance
of applications.

Enables performing all available operations on an Alert
configuration for a specific instance of applications.

Enables viewing BPM agents and managing monitors on those
agents.

Enables viewing Real User Monitor engines and managing
RUM configurations on those engines.

Enables creating new folders in the script repository.

Enables renaming script repository folders and modifying
scripts in those folders.

Enables viewing script repository folders and the scripts in
those folders, as well as downloading scripts from the script
repository.

Note: This does not enable uploading scripts to the script
repository.

Enables deleting folders in the script repository.

Enables performing all available operations on script folders
and scripts in the script repository, and granting and removing
permissions for those operations.
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MyBSM

The MyBSM context enables you to define the operations permitted for user pages, predefined pages,
and user components

Resources Operation Description
UserPages Add Enables creating new user pages.

Change Enables changing the user page on which this permission occurs.

View Enables viewing/opening the user page on which this permission
occurs.

Delete Enables deleting the user page on which this permission occurs.

Locked Enables users to monitor information, but not to select a view or apply

filters on a page. For details, see User Permissions in MyBSM in the
BSM User Guide.

Full Enables all the above permissions.

Control
Predefined View Enables viewing/opening the predefined page on which this permission
Pages occurs.

Full Enables granting permissions to predefined pages.

Control
User Add Enables creating new user defined components.

Components
Change Enables changing the definition of the user defined component on which

this permission occurs.

View Enables viewing the component on which this permission occurs.

Note: If you are viewing a page and don't have permission for a
component in it, the page will appear without the component.

Delete Enables deleting the component definition for the component on which
this permission occurs.

Full Enables all the above permissions.
Control
Operations Management

Note: The Operations Management context is available only if you have installed OMi on your
BSM machine. For details on the OMi context, see User Context Pane in the BSM User Guide.
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The Operations Manager i (OMi) context enables you to assign permissions to work with the
Operations Manager context. For details on the operations available for the Operations Manager i (OMi)
context, see User Operations Tab in the BSM User Guide.

Resources Operation
Events Work On/ Resolve
assigned to
user
Close
Reopen
Assign To

Launch Operator
Action

HP Business Service Management (9.26)

Description

Enables the user to set the life cycle status for events that are
assigned to them to Work On or Resolve.

Enables the user to set the life cycle status for events that are
assigned to them to Closed.

Enables the user to set the life cycle status for Closed events
that are assigned to them to Open. The events can now be
reassigned for further investigation and resolution.

Note: Reopening symptom events with a closed cause is not
possible.

Enables the user to assign events that are assigned to them
to a specific user.

Enables the user to run HP Operations Manager operator
actions for events assigned to them containing event-related
actions.
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Resources Operation Description
Events Launch Automatic = Enables the user to run HP Operations Manager automatic
assigned to Action actions for events assigned to them containing event-related
user actions.

Transfer Control Enables the user to transfer control of events assigned to

them in the Event Browser to an external manager.

Close Transferred | Enables the user to close events assigned to them in the
Event Browser for which control has been transferred to an
external manager.

Add/Remove Enables the user to add and remove relations between events
Event Relations assigned to them in the Event Browser.

Change Severity Enables the user to change severity of events assigned to

them.
Change Priority Enables the user to change priority of events assigned to
them.
Change Title Enables the user to change title of events assigned to them.
Change Enables the user to change description of events assigned to
Description them.
Change Solution Enables the user to change solution of events assigned to
them.

Add/Delete/Update = Enables the user to create, modify and delete annotations for
Annotations events assigned to them.

Add/Delete/Update = Enables the user to create, modify and delete custom
Custom Attributes | attributes for events assigned to them.
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Resources Operation Description
Events not View Enables the user to view events not assigned to them.
assigned to

Work On/ Resolve = Enables the user to set the life cycle status for events not
assigned to them to Work On or Resolve.

user

Close Enables the user to set the life cycle status for events not
assigned to them to Closed.

Reopen Enables the user to set the life cycle status for Closed events
not assigned to them to Open. The events can now be
reassigned for further investigation and resolution.

Note: Reopening symptom events with a closed cause is not
possible.

Assign To Enables the user to assign events not assigned to them to a
specific user or group.

Launch Operator Enables the user to run HP Operations Manager operator
Action actions for events not assigned to them containing event-
related actions.

Launch Automatic ~ Enables the user to run HP Operations Manager automatic
Action actions for events not assigned to them containing event-
related actions

Transfer Control Enables the user to transfer control of events not assigned to
them in the Event Browser to an external manager.
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Resources Operation Description
Events not Close Transferred = Enables the user to close events not assigned to them in the
assigned to Event Browser for which control has been transferred to an
user external manager.
Add/Remove Enables the user to add and remove relations between events
Event Relations not assigned to them in the Event Browser.

Change Severity Enables the user to change severity of events not assigned to

them.

Change Priority Enables the user to change priority of events not assigned to
them.

Change Title Enables the user to change title of events not assigned to
them.

Change Enables the user to change description of events not

Description assigned to them.

Change Solution Enables the user to change solution of events not assigned to
them.

Add/Delete/Update = Enables the user to create, modify and delete annotations for
Annotations events not assigned to them.

Add/Delete/Update Enables the user to create, modify and delete custom
Custom Attributes | attributes for events not assigned to them.

Health Reset Enables the user to clear the current status of a health
Indicators indicator and reset the health indicator to the status specified
in the default health indicator value.
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Resources Operation Description
Administrative View Grants access to the Administration features in the
Uls Operations Management Administration, for example:

Correlation Rules manager
Content Packs manager
Performance Graphs manager
View Mappings manager

Event Processing Customization

Custom Actions

Users who do not have read access to Operations
Management Administration are not able to see the
Operations Management Administration features or see an
error message when they try to start an Administration

manager.
Tool Execute Grants access to tool categories. Any tools belonging to a
Categories tools category to which a user has access can be executed
by the user.
Custom Execute Grants access to custom actions. Any custom actions to
Actions which a user has access can be executed by the user.

Operations Orchestration Integration

The Operations Orchestration Administration context enables you to define the operations
permitted for the Operations Orchestration Administration application.

Resources Operation Description

Administration Add Enables adding a run book.
View Enables viewing run book administration.
Change Enables editing run book administration.
Delete Enables deleting a run book.
Full Enables performing all available operations on run book administration,
Control and granting or removing permissions for other users.

HP Business Service Management (9.26)
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Resources Operation Description

Execution Execute
Full
Control
Platform

Enables run book execution.

Enables performing all available operations on run book execution, and
granting or removing permissions for other users.

The Platform context includes all the resources related to administering the platform.

Resources Operation Description

Authentication = Change
Strategy

View

Full
Control

Audit Log View

Full
Control

Users Add
Change
View
Delete

Full
Control

User Groups  Add
Change
View
Delete

Full
Control

Enables creating and changing configurations on the Authentication
Management page.

Enables viewing the Authentication Management page.

Enables performing all available operations on the Authentication
Management page.

Enables viewing the audit log.

Enables viewing the audit log, and granting and removing permission
to view the audit log.

Enables adding users to the system.
Enables modifying user details.

Enables viewing user details.

Enables deleting users from the system.

Enables performing all available operations on users, and granting and
removing permissions for those operations.

Enables adding user groups to the system.
Enables modifying user group details.
Enables viewing user group details.
Enables deleting user groups.

Enables performing all available operations on user groups, and
granting and removing permissions for those operations.
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Resources Operation Description

Data Change Enables performing remote upgrades, remote uninstalls, and settings
Collectors updates on data collectors in Data Collector Maintenance.
View Enables viewing the data collectors in Data Collector Maintenance.
Delete Enables removing data collector instances.
Full Enables performing all available operations in Data Collector
Control Maintenance, and granting and removing permissions for those
operations.
Notification View Enables viewing system tickets details.
System _ _ _
Execute Enables executing system tickets in the system.
Full Enables performing all available operations on System Tickets, and
Control granting and removing permissions for those operations.
Scheduled Add Enables creating new scheduled reports.
Reports o
Change Enables modifying scheduled reports.
View Enables viewing scheduled reports.
Delete Enables deleting scheduled reports.
Full Enables performing all available operations on scheduled reports, and
Control granting and removing permissions for those operations.
Recipients Add Enables adding recipients to the platform.
Change Enables editing recipient details.
View Enables viewing recipients and recipient details.
Delete Enables deleting recipients from the platform.
Full Enables performing all available operations on recipients, and granting
Control and removing permissions for those operations.
Custom Data = Add Enables adding custom data types to the system.
Types
Change Enables modifying custom data types in the system.
View Enables viewing custom data types in the system.
Delete Enables deleting custom data types in the system.
Full Enables performing all available operations on sample types, and
Control granting and removing permissions for those operations.
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Resources Operation Description

Send SNMP | Change Enables selecting the option to send SNMP traps on alert, editing

trap SNMP trap addresses, and clearing the option to send SNMP traps on
alert.
Full Enables performing all available operations on sending SNMP traps on
Control alerts, and granting and removing permissions for those operations.
Run Change Enables selecting the option to run an executable file on alert,
executable file selecting and edition executable files to run on alert, and clearing the

option to run an executable file on alert.

Full Enables performing all available operations on running an executable
Control file on alert, and granting and removing permissions for those
operations.

Log ToEvent = Change Enables selecting whether alerts should be logged in the Windows

Viewer Event Viewer which is accessed from Window Administrative Tools.
Full Enables selecting whether alerts should be logged in the Windows
Control Event Viewer, and granting and removing permissions on that

operation.

Downtime View Enables viewing downtime properties
Full Enables performing all available operations on downtimes, and
Control granting and removing permissions for those operations.

Databases Add Enables adding profile databases to the system.
Change Enables modifying profile database details in database management.
View Enables viewing profile database management details.
Delete Enables deleting profile databases from the system.
Full Enables performing all available operations on profile databases in
Control database management, working with the purging manager, and

granting and removing permissions for those operations.

System Add Enables creating and cloning system recipient templates.
Recipient N o )
Template Change Enables editing system recipient templates properties.
View Enables viewing system recipient templates properties.
Delete Enables deleting a system recipient templates.
Full Enables performing all available operations on system recipient
Control templates, and granting and removing permissions for those
operations.
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Resources Operation Description

Customer Add

Recipient

Template Change
View
Delete
Full
Control

Package Change

Work

Manipulation )

(HP Software-  View

as-a-Service Delete

only)
Full
Control

RTSM

Enables adding a customer-specific recipient template.
Enables editing a customer-specific recipient template.

Enables viewing the properties of a customer-specific recipient
template.

Enables deleting a customer-specific recipient template.

Enables performing all available operations on a customer-specific
recipient template, and granting and removing permissions for those
operations.

Enables modifying package locations, renaming packages, and
selecting recipients for package notifications.

Enables viewing package information.
Enables removing packages from a location.

Enables performing all available operations on package information,
and granting and removing permissions for those operations.

The RTSM context enables you to define the operations permitted for the views defined in IT Universe
Administration and viewed in the Model Explorer, Service Health, and Service Level Management.

Tip: If a user has permissions on a view in RTSM, all the profiles that are in that view are visible to
the user, even if the user does not have permissions on the profile. To prevent a user from viewing
profiles for which the user does not have permissions while enabling the user to access a view,
create a view for the user including only those configuration items for which you want the user to
have permissions and grant the user permission on that view.

Resources Operation

Views Add
Change
View
Delete

Full
Control

Description

Enables adding and cloning views.
Enables editing views.

Enables viewing views

Enables removing views.

Enables performing all available operations on views.
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Resources Operation Description

RTSM Full Enables administrative operations for all of the Run-time Service Model
Control (RTSM), except ITU Manager and Modeling Studio.

Cl Search | Full Enables the Cl Search option from any location in the RTSM.

Control
Data Full Enables the Data Modifier option from any location in the RTSM.
Modifier Control
Get Full Enables the Get Related Cls option from any location in the RTSM.
Related Control
ITU Full Allows the user to enter the ITU Manager. Once inside, the available
Manager Control functionality within the ITU Universe Manager depends on permissions

the user has been granted on views.

Modeling Full Allows the user to enter the Modeling Studio. Once inside, the available
Studio Control functionality within the ITU Universe Manager depends on permissions
the user has been granted on views.

RTSM Change Enables running of updates in RTSM Open API.
Open API
View Enables running of queries in RTSM Open API.
Service Health

Resources Operation Description
User Pages Add Enables adding user pages.

Change Enables editing user pages.

View Enables viewing user pages.

Delete Enables removing user pages.

Full Enables performing all available operations on user pages.

Control
Predefined View Enables viewing predefined pages.
Pages
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Resources Operation Description
User Add Enables adding and cloning component definitions.
Components
Change Enables editing component definitions.
View Enables viewing component definitions.
Delete Enables removing component definitions.
Full Enables performing all available operations on component
Control definitions.
Service Health Analyzer

The Service Health Analyzer context enables you to define the operations permitted for the Service
Health Analyzer application.

Resources Operation Description

SHA Full Enables performing all available operations on the SHA application,
application Control including permission management

SHA Full Enables performing all available operations on the SHA administration,
administration = Control including permission management

Service Level Management

Use the Service Level Management context to assign permissions to all SLAs or specific instances.
Resources Operation Description
SLAs Add Enables adding SLAs.

Change Enables renaming SLAs, adding descriptions to SLAs, viewing SLA
configuration in administration pages, and changing SLA configurations.

View Enables generating and viewing reports and custom reports on SLAs.
Delete Enables deleting SLAs.

Full Enables performing all available operations on SLAs, and granting and
Control removing permissions for those operations.

System Availability Management

Use the System Availability Management context to assign permissions to the various SiteScopes
configured within the system.
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Note: The permission levels granted in the System Availability Management context override any
permission levels granted in the SiteScope standalone interface.

Resources Operation Description
SiteScopes Add Enables adding SiteScope profiles to System Availability Management.

Change Enables modifying a SiteScope profile in System Availability
Management and enables adding the contents to the SiteScope root node
(group, alert, report) and modifying contents to the SiteScope root node
(alert, report), if the user has permissions for these resources.

View Enables viewing SiteScope profiles in System Availability Management.

Delete Enables deleting a SiteScope profile from System Availability
Management and enables deleting the contents of the SiteScope root
node (alert, report), if the user has permissions for these resources.

Execute Enables executing contents of the SiteScope root node (alert, report), if
the user has permissions for these resources.

Full Enables performing all available operations on SiteScope profile and
Control SiteScope root node.

Transaction Management

Resources Operation Description

TransactionVision = Change Enables modifying TransactionVision processing servers.
Processing

Servers Full Enables performing all available operations on TransactionVision

Control processing servers, and granting and removing permissions for
those operations.

TransactionVision = Change Enables modifying TransactionVision analyzers.

Analyzers ) ) o
Execute Enables starting and stopping TransactionVision analyzers.
Full Enables performing all available operations on TransactionVision
Control analyzers, and granting and removing permissions for those
operations.
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Resources Operation Description

TransactionVision = Change Enables modifying TransactionVision job managers.

Job Managers
Execute Enables starting and stopping TransactionVision job managers.

Full Enables performing all available operations on TransactionVision
Control job managers, and granting and removing permissions for those
operations.
TransactionVision = Change Enables modifying TransactionVision query engines.
Query Engines
Execute Enables starting and stopping TransactionVision query engines.
Full Enables performing all available operations on TransactionVision
Control query engines, and granting and removing permissions for those
operations
Administration Change Enables administration changes. Does not include
TransactionVision specific changes.
Full Enables performing all available operations on administration, and
Control granting and removing permissions for those operations.
User Data View Enables viewing user data in reports and in event details.
Full Enables performing all available operations on user data, and
Control granting and removing permissions for those operations.
Applications Add Enables adding applications.
Change Enables modifying applications.
View Enables viewing applications.
Full Enables performing all available operations on applications, and
Control granting and removing permissions for those operations.
User Defined Reports

Use the User Defined Reports context to assign permissions to the various types of user-defined
reports and related settings.
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Resources Operation Description

Custom Add Enables adding custom reports.
Reports
Change Enables creating, editing, and deleting custom reports.
View Enables viewing custom reports.
Full Enables performing all available operations on custom reports, and
Control granting and removing permissions for those operations.
Trend Reports = Add Enables creating trend reports.

Change Enables creating, editing, and deleting trend reports.

View Enables viewing trend reports.
Full Enables performing all available operations on trend reports, and
Control granting and removing permissions for those operations.

Custom Links | Change Enables creating and deleting custom links.

View Enables viewing custom links.
Full Enables performing all available operations on custom links, and
Control granting and removing permissions for those operations.

Excel Reports = Change Enables adding, deleting, and updating Excel open API reports.

View Enables viewing Excel open API reports.
Full Enables performing all available operations on Excel open API reports,
Control and granting and removing permissions for those operations.
Default Change Enables modifying the default header and footer for custom and trend
Header/Footer reports.
Full Enables modifying, and granting and removing permissions to modify,
Control the default header and footer for custom and trend reports.

Favorite Filter = Change Enables editing favorite filter.

Delete Enables deleting favorite filter

Full Enables performing all available operations on favorite filter, and

Control granting and removing permissions for those operations.
Annotation Change Enables editing an annotation.

Delete Enables deleting an annotation.

Full Enables performing all available operations on annotations, and

Control granting and removing permissions for those operations.
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Resources Operation Description

Service Change Enables editing a service report.

Report
Delete Enables deleting a service report.
Full Enables performing all available operations on service reports, and
Control granting and removing permissions for those operations.

User Management User Interface

Permissions Tab (User Management)

This tab enables you to apply permissions to groups and users for specific resources and instances of
those resources that are defined in the system.

To access  Select Admin > Platform > Users and Permissions > User Management >
Permissions tab.

The Permissions tab is divided into the following areas:

« Groups/Users pane on the left side of the page. For details, see "Groups/Users
Pane" on page 185.

« Resource tree pane in the center of the page. For details, see "Resource Tree
Pane" on the next page.

« Roles tab on the right side of the page. For details, see "Roles Tab" on page 264.

« Operations tab on the right side of the page. For details, see "Operations Tab" on

page 265.
Important « You can grant permissions to only one user or group at a time.
information

« Assigning Add permissions on the Operations tab does not automatically grant
View permissions on the given resource.

« If you have many users for whom you have to grant permissions, it is
recommended that you organize your users into logical groups using the Hierarchy
tab.

Relevant "Configuring Users and Permissions - Workflow" on page 197
tasks
See also "Permissions" on page 189
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Resource Tree Pane

This tab displays the instances and resources available within each BSM context for which you set
permissions.

To access = Select Admin > Platform > Users and Permissions > User Management >
Permissions tab.

The types of resources displayed in the Resource Tree pane are:
« Resource with instances !
« Instances of aresource _#

Note: When a user defines or creates an instance of a resource, for example
creates a Business Process profile, that user has Full Control permission on that
resource instance and all of its child resources.

« Resource without instances &1

Important « The Business Service Management resource refers to all contexts in BSM and
information can have only roles applied to it.

« Theresources are divided according to the context in which they function within
the platform and not necessarily where they are found in the user interface.

« You can select multiple resources only when selecting instances. For information
on instances, see "Understanding Permissions Resources" on page 191.

Relevant "Configuring Users and Permissions - Workflow" on page 197
tasks
See also "Understanding Permissions Resources" on page 191

User interface elements are described below:

Ul
Element
(A-2) Description

L An instance of a resource.
| A resource without instances.
i A resource that has instances (a resource collection).

Select Select a BSM context for which to configure permissions. For details on BSM contexts,
Context | see "Resource Contexts" on the next page.
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Settings Applies specific permissions settings for configurations in your User Management
session. Select from the following options:

« Apply permissions automatically when selecting another resource. Selecting
this option removes the necessity for clicking the Apply Permissions button after
each operation. If this option is not selected, you must click Apply Permissions
before going on to the next operation.

« Do not display warning message when revoking VIEW from resource. WWhen
the view operation is removed from a resource for a user, that user has no access to
the resource or to any of its child resources or instances. Therefore, by default, a
warning message appears when removing view permissions. Selecting this option will
disable that warning message.

Note: When you select the settings for applying permissions, the options selected apply
only to the current BSM session.

Resource Contexts

The following contexts are included:

Ul Element (A-Z)
Diagnostics

End User
Management

MyBSM

MyBSM (Legacy)

Operations
Management

Operations
Orchestration
Integration

Platform

RTSM

HP Business Service Management (9.26)

Description
Includes all the resources relating to Diagnostics.

Includes all the resources relating to operating and administering the End
User Management application.

Includes resources needed to administer user pages, predefined pages, and
user components.

Includes resources needed to administer modules and portlet definitions.

Includes all the resources relating to the Operations Management
application.

Includes the resources enabling permissions for operating and administering
the Operations Orchestration Administration application.

Includes all the resources for administering the platform.

Includes all the resources for the Run-time Service Model (RTSM).
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Ul Element (A-2) Description

Service Health Includes all the resources relating to the Service Health Analyzer

Analyzer application.

Service Level Includes the SLA resource.

Management

SiteScope On Includes all the resources relating to the Service Health Analyzer to manage

Demand Monitors SiteScope monitors on demand.

System Availability | Includes the various SiteScope groups.

Management
Transaction Includes the resources relating to working with the TransactionVision
Management application.
User Defined Includes the custom report, trend report, custom link, and Excel report
Reports resources.

Roles Tab

Displays the roles configurable for groups and users in BSM.

To access Select Admin > Platform > Users and Permissions > User Management >
Permissions tab

Relevant "Configuring Users and Permissions - Workflow" on page 197
tasks
See also « "Understanding Permissions Resources" on page 191

« "User Management Roles Applied Across BSM" on page 213

User interface elements are described below:

Ul Element
(A-2) Description
Apply Applies the permissions configured for the roles

Permissions
Grant Select the check box to assign the specified roles to the group or user.

Roles The roles that can be assigned to a group or user for the selected resource or
instances. For a description of the available roles, see " User Management Roles
Applied Across BSM" on page 213.
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Operations Tab

Displays the predefined operations configurable for groups and users in BSM.

To access Select Admin > Platform > Users and Permissions > User Management >
Permissions tab

Relevant "Configuring Users and Permissions - Workflow" on page 197
tasks
See also « "Understanding Permissions Resources" on page 191

o "User Management Operations" on page 243

User interface elements are described below:

Ul Element (A-Z)
Apply Permissions
Grant

Granted from
Group/Roles/Parent

Inherit

Operation

Description
Applies the permissions configured for the resource.
Select the check box to assign the specified operation to the group or user.

Displays those permissions that have been granted from either a group, a
role, or a parent resource.

Note:

« You cannot remove any of these permissions individually, but you can
grant additional permissions.

« If you want to remove permissions that are granted from a group, role or
parent resource, you must make the change at the group, role or parent
resource level.

Select the check box in the Inherit column for the operation to be inherited to
all the child resources within the selected resource.

Note:
« The Inherit check box is enabled only for selected resources.

« By default, the Inherit check box is selected when you assign an
operation to specific resource instances. You can remove the Inherit
option to prevent the operation from being inherited to all the child
resources within the selected resource.

The operations that can be assigned to a group or user for the selected
resource or instances. For details on the available operations, see "User
Management Operations" on page 243.
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Hierarchy Tab (User Management)

This tab enables you to assign users to a group, unassign users from a group, or nest one group within
another.

To access, select Admin > Platform > Users and Permissions > User Management, select a
group or user from the Groups/Users pane, and click the Hierarchy tab.

To access  Select Admin > Platform > Users and Permissions > User Management, select
a group or user from the Groups/Users pane, and click the Hierarchy tab.

The Hierarchy tab displays:
« Parent Groups. The groups that the selected group is nested under.

« Child Groups and Users. The groups and users that are nested directly beneath
the selected group.

Important « Tonest a user, you must select the group into which you want to nest it and click
information the Edit Child Groups and Users button.

« When removing a nested group from its parent, the group itself is not deleted.
« When deleting a parent group, the child groups and users are not deleted.

« |f BSM groups have been synchronized with groups on an external LDAP server,
BSM users cannot be moved between groups, and only groups appear on the
interface. For details on synchronizing groups, see Synchronizing Users.

Relevant "Configuring Users and Permissions - Workflow" on page 197
tasks
See also "Group and User Hierarchy" on page 195

User interface elements are described below:

Ul Element (A-Z) Description

E?. Denotes a group that the selected group or user is nested under.
:l Denotes a user that is nested beneath the selected group.

Child Groups and Displays the groups and users that are nested directly beneath the group
Users selected in the Groups/Users pane.
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Ul Element (A-Z) Description

Edit Child Opens the Edit Child Groups and Users window enabling you to nest or
Groups and remove groups and users from the selected group.
Users

Note: This button is displayed only when selecting a group in the
Groups/Users pane.

Parent Groups Displays the groups that the group or user selected in the Groups/Users pane
is directly nested under.

Edit Child Groups and Users Dialog Box

User interface elements are described below:

Ul Element
(A-2) Description
> Moves the group or user to the Child Groups and Users pane and nests the
group or user under the specified group.
< Moves the group or user to the Groups/Users pane and removes the group or user
from being nested beneath the specified group.

Child Groups | Select a group or user you want to remove from the specified group.
and Users

Groups/Users | Select a group or user you want to nest under the specified group.

Customization Tab (User Management)

This tab enables you to select the page users see when entering BSM, and select the menu items
available on pages throughout BSM.

To access Select Admin > Platform > Users and Permissions > User Management, select
a node from the Groups/Users pane, and click the Customization tab.

Important Properties are inherited based on the hierarchy of the nodes. If a context is deselected
information = (hidden) for a group node, it cannot be selected for any child nodes.

Relevant « "Configuring Users and Permissions - Workflow" on page 197

tasks
« "How to Configure Users and Permissions — Use-Case Scenario" on page 201

User interface elements are described below:

HP Business Service Management (9.26) Page 267 of 397



BSM Platform Administration Guide
Chapter 26: User Management

Ul Element
(A-Z)

Contexts

Pages and
Tabs

Set as
Default
Entry
Context

Set as
Default
Entry Page

Description

Select a BSM context. You can perform the following actions on the context:

« Select contexts and applications in the Contexts pane to be visible for the
specified user or group. To hide a context or application, clear the check box. By
default, all contexts are visible.

« Select pages and tabs in the Pages and Tabs pane to be visible for the specified
user or group. By default, all pages and tabs are visible.

« Click the Set as Default Entry Context button to make it the context that is
displayed when the user logs into BSM.

For details on BSM contexts, see Resource Contexts.

« Select the pages and tabs you want to be visible for the BSM context selected in
the Contexts pane.

« Assign a page or tab as the default page that opens for the context selected in the
Contexts pane.

Note: For the Service Health and Operations Management applications, you cannot
define user access to specific pages; you can enable or disable user access only at
the application level.

Sets the selected context in the Contexts pane as the entry context that is displayed
when a user logs into BSM.

Note: The Default Entry Contexticon appears next to the specified context.

Assigns the specified page or tab as the default page that opens for the context
selected in the Contexts pane.

Note: The Default Entry Page icon appears next to the specified page or tab.
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A recipient definition includes information about how to communicate with the recipient. Recipients can
receive triggered alerts or scheduled reports:

« Alerts. For each recipient, you define one or more notification methods (email, pager, or SMS) and
the template to use for alert notices. You can configure alerts so specific recipients receive

information about the alerts when they are triggered. For details about alerts, see "Setting Up an
Alert Delivery System" on page 340.

« Scheduled reports. In the Report Manager, you can schedule the time intervals when recipients
can receive reports or report items. Only those recipients who have been configured to receive
email can be selected to receive scheduled reports. These recipients are listed in Available
Recipients when configuring scheduled reports. For details about scheduled reports, see "Report
Schedule Manager" on page 338.

For details on where to configure and manage recipients, see "Recipients Page" on page 271.

For more information about groups and users, see "Group and User Hierarchy" on page 195

Configure and Manage Recipients

This section provides information about configuring and managing recipients.

To access

Select Admin > Platform > Recipients > Recipient Management

Learn About

Creating Recipients

You create recipients by defining:
« One or more notification methods
« Thetemplate to use for alert notices
« A notification schedule to receive reports.

You create recipients and manage existing recipients in the Recipients page. For user interface details,
see "Recipients Page" on page 271.
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You can also create recipients while you are configuring users. Those recipients are automatically
added to the list of recipients in the Recipients page in Admin > Platform > Recipients > Recipient
Management.

The recipients you create in the Recipients page are automatically listed as available recipients when
you configure users in Admin > Platform > Users and Permissions > User Management.

The Recipients Page

The Recipients page enables you to create or edit recipient information including the corresponding
user and the email, SMS, and pager information. You can also, if you have the appropriate permissions,
detach the current recipient from the user, attach existing recipients to the user, or delete the attached
recipient.

How you access the Recipients page and what you see in the page depends on your user's
permissions. For details, see "Permissions Tab (User Management)" on page 261.

There is a one-to-one relationship between the user and the recipient: a recipient can be assigned to
one user or to no user, and a user can have a link to one recipient or to no recipient.

Tasks

This section includes:
« "How to Define Recipients" below

« "How to Attach Users to Recipients" below

How to Define Recipients

1. Select Admin > Platform > Recipients.

2. Click the Recipient Management tab.

3. Click III

4. Complete the fields in the New Recipient dialog box. For information, see "New or Edit Recipient
Dialog Box" on page 272.

5. Click Save.

How to Attach Users to Recipients
1. Select Admin > Platform > Recipients.

2. Click the Recipient Management tab.

HP Business Service Management (9.26) Page 270 of 397



BSM Platform Administration Guide
Chapter 27: Recipient Management

2]
3. Select arecipient in the table and click the Attach user to selected recipient button in the
Recipient page.

4. Complete the fields in the Attach user to selected recipient dialog box. For information, see
"Attach Recipient to a User Dialog Box" on page 276.

5. Click Save.

Ul Description

This section includes:

« "Recipients Page" below

« "New or Edit Recipient Dialog Box" on the next page

« "Attach Recipient to a User Dialog Box" on page 276

Recipients Page

User interface elements are described below:

Ul
Element
(A-Z)

X B E

E>

E»

<2

Description

Add new recipient. Opens the New Recipient dialog box. For details, see "New or Edit
Recipient Dialog Box" on the next page.

Edit selected recipient. Opens the Edit Recipient dialog box. For details, see "New or
Edit Recipient Dialog Box" on the next page.

Delete the recipient attached to the selected user. Detaches the recipient and
deletes the current recipient.

Attach user to selected recipient. Select a recipient in the list of and click this button
to open the Attach Recipient to a User dialog box where you can select the appropriate
user. For details, see "Attach Recipient to a User Dialog Box" on page 276.

Detach user from selected recipient. Detaches the current recipient from the
corresponding user (listed in the page). A confirmation message is issued.

Update selected recipients email address from LDAP. This icon appears only if
LDAP is connected to the BSM application. Click to synchronizes the user data,
meaning that the email information stored in the User Repository for the specific user
updates the email recipient information corresponding to the user linked to the recipient.
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Ul

Element

(A-Z) Description

Email The email address of the recipient as defined in the General tab.

Linked The name of the user linked to the recipient.

User
Important: Cannot exceed 49 characters.
Syntax Exceptions: The following characters are not supported: "~ @ #$% " & *-+
=[1{3\ /2., <>

Pager The pager numbers of the recipient.

Syntax Exceptions:
« The following characters are not supported: @ & "' ...

« The following special characters are allowed: ()-_+=[]1{}]:;<>.,

Recipient = The name of the recipient.

Name
Important: Cannot exceed 49 characters.
Syntax Exceptions: The following characters are not supported: "~ @ #$ % " & *-+
=[N /2, " <>

SMS The SMS numbers of the recipient.

Syntax Exceptions:
« Numbers and the following special characters are allowed: ()-_+=[]{}]:;.,

« Letters and characters other than those specified above are not allowed

New or Edit Recipient Dialog Box

The New/Edit Recipient dialog box enables you to define recipients, their email, pager, and SMS, and
the template to use to send alert notices to those recipients.

User interface elements are described below:
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Ul Element
(A-Z)

il

Communication
Method Area

Description

Attach user to selected recipient. Select a recipient in the list of and click the
button to open the Attach Recipient to a User dialog box where you can select the
appropriate user. For details, see "Attach Recipient to a User Dialog Box" on
page 276.

Note: This button is displayed only when you access the dialog box from Admin
> Platform > Users and Permissions > User Management.

Detach user from selected recipient. Detaches the current recipient from the
corresponding user (listed in the page). A confirmation message is issued.

Note: This button is displayed only when you access the dialog box from Admin
> Platform > Users and Permissions > User Management.

Delete the recipient attached to the selected user. Detaches the recipient from
the user and deletes the recipient.

Note: This button is displayed only when you access the dialog box from Admin
> Platform > Users and Permissions > User Management.

Update selected recipients email address from LDAP. This icon appears only
if LDAP is connected to the BSM application. Click to synchronize the user data,
meaning that the email information stored in the User Repository for the specific
user updates the email recipient information corresponding to the user linked to the
recipient.

This area enables you to define the communication methods. For information, see
"Recipient Management Communication Methods" on page 277.
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Ul Element

(A-2) Description

EUM Alert Select the template you want to use for the EUM alert notification, or any custom
notification template already created.

template

Note: When you change the selection in the EUM Alertnotification template
field in the top part of the page, the changes are propagated to the Email, Pager,
and SMS tabs in the same page. If you modify the selection in the EUM
Alertnotification template field in the Email, Pager, or SMS tabs, the Schedule
for receiving alerts changes to Mixed Value. When you change once more, the
selection in the EUM Alertnotification template field in the top part of the page,
the changes are propagated to the Email, Pager, and SMS tabs in the same page
and the Mixed Value button is cleared.

For details on EUM alert notification templates and creating custom templates,
see "How to Configure EUM Alerts Notification Templates" on page 360.

Note: This field is relevant only for event-based alerts.

For details on alert notification templates and creating custom templates, see
"Notification Templates Page" on page 366.

Note:
o The default template is LONG.

« Fordetails on the parameters displayed in each template, see "Notification
Template Properties Dialog Box" on page 361.

« Thefield lists the default templates and the custom templates.

« You must select the alert notification template and specify an alert notices
schedule for alert recipients. You do not have to perform this procedure for
recipients who are to receive only scheduled reports.

Link to user This field is displayed only when you access this page from:

o Admin > Platform > Users and Permissions > User Management, select
a userin the tree and click the Recipient tab.

« Admin > Personal Settings > Recipient.
Recipient The name of the recipient.
name
Important: Cannot exceed 49 characters.

Syntax Exception: The following characters are not supported: " ~! @ #$ % * & *
SN2 <>
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Ul Element
(A-2) Description
Schedule for Enabled if you selected the Per notification method scheduling option for the
receiving recipient in the Schedule for Receiving Alerts in the General tab.
alerts
Select:

« Mixed value. When you change the selection in the EUM Alertnotification
template field in the top part of the page, the changes are propagated to the
Email, Pager, and SMS tabs in the same page. If you modify the selection in
the EUM Alertnotification template field in the Email, Pager, or SMS tabs,
the Schedule for receiving alerts changes to Mixed Value. When you
change once more, the selection in the EUM Alertnotification template field
in the top part of the page, the changes are propagated to the Email, Pager, and
SMS tabs in the same page and the Mixed Value button is cleared.

« All Day. If you want the recipient to receive email messages all day.

« From... to. If you want the recipient to receive email messages during the
specified time period.

The time range is calculated based on the GMT offset selected for the recipient.

Scheduled reports are sent based on the schedule configured in the Scheduled
Reports page and not on the schedule configured for the recipient. For details, see
How to Schedule a Report in the BSM User Guide.
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Ul Element
(A-2) Description
Time zone Select the time zone for the recipient. Business Service Management uses the

time zone to send alert notices and HP Software-as-a-Service notifications to the
selected recipient.

Note:

« Thetime zone selected for the recipient is the time zone specified in the alert
notifications that the recipient receives. For example, if an alert is triggered
anywhere in the world and a notification is sent, the date and time of the alert
are converted to the recipient local time. The alert also specifies the GMT
offset of the recipient.

« If you defined a notification schedule for the recipient, the time zone selected
for the recipient is also the time zone that BSM uses for calculating when to
send the recipient notifications. For example, if you configure a recipient to
receive pager alerts from 9:00 AM - 9:00 PM, and select a GMT offset of -5
hours, the recipient receives alerts through a pager only from 9:00 AM - 9:00
PM Eastern Time.

Scheduled reports are sent based on the schedule configured in the Scheduled
Reports page and not on the schedule configured for the recipient. For details,
see How to Schedule a Report in the BSM User Guide.

« When you modify the time zone of the user to which the recipient is assigned,
a confirmation message is issued to verify that you also want to propagate the
time zone change to the recipient's offset from GMT. If you change the
recipient's offset from GMT, the time zone of the user to which the recipient is
assigned is not affected.

« Half time zones (also known as offset time zones) are not supported.

Attach Recipient to a User Dialog Box

The Attach Recipient to a User dialog box enables you to select the user you want to attach to the
selected recipient.

User interface elements are described below:

Ul Element Description
User Login | The name used to log into BSM.
User Name  The name of the user, as configured in the User Management page.

Select To assign a user to the selected recipient, select the user and click Select.
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Recipient Management Communication Methods

This section provides information about recipient management communication methods.

To access

Select Admin > Platform > Recipients > Recipient Management and click |:|

Learn About

Communication Method — Email

You can specify multiple email addresses for a recipient, the type of notification template (which
overrides the notification template selected in the global level in the page), the schedule for sending
email notifications, and the security certificate if necessary.

The text displayed in email messages can only be in Latin characters except for the contents of fields
inserted by the user that can be in any supported and relevant language. Those fields can include, for
example, Alert Name, Alert description, and KPI name.

Communication Method — SMS

You can specify the SMS (short message service) service provider, the SMS numbers, the type of
notification template (which overrides the notification template selected in the global level in the page),
and the schedule for sending alert notifications to the SMS.

SMS messages are useful to notify staff who are mobile, or who do not have email or pager access.
The maximum message length of SMS text messages is generally 160 characters.

Note: You can use a pager or an SMS service provider that does not appear on the default list. For
details, see "How to Add a Custom Pager or SMS Service Provider" on the next page.

Communication Method — Pager

You can specify the pager service provider, the pager numbers, the type of notification template (which
overrides the notification template selected at the global level in the page), and the schedule for sending
alert notification to the pager.

The text displayed in pager messages can only be in Latin characters except for the contents of fields
inserted by the user that can be in any supported and relevant language. Those fields can include, for
example, Alert Name, Alert description, and KPI name.

HP Business Service Management (9.26) Page 277 of 397



BSM Platform Administration Guide
Chapter 27: Recipient Management

Note: You can use a pager or an SMS service provider that does not appear on the default list. For
details, see "How to Add a Custom Pager or SMS Service Provider" below.

Custom Pager or SMS Service Provider

If you are configuring alerts to be sent by pager or SMS, and your pager or SMS service provider does
not appear on the default provider list, and the provider uses an email gateway, you can manually add
your provider to BSM. After doing so, your provider appears on the list.

To add a provider that uses an email gateway, manually add the gateway information to the
management database. If necessary, ask your database administrator for assistance.

See "How to Add a Custom Pager or SMS Service Provider" below for instructions on adding an SMS
Service Provider.

Tasks

How to Add a Custom Pager or SMS Service Provider

1. Openthe NOTIFICATION_PROVIDERS table in the management database.

2. Inthe NP_NOTIFICATION_PROVIDER_NAME column, add the name of the provider to the
bottom of the list. Add the name exactly as you want it to appear in the provider list that opens in
the SMS tab of the Recipient Properties wizard. For details, see "Communication Method Area -
SMS Tab" on page 280. Note the ID number that is automatically assigned to the provider.

3. Closethe NOTIFICATION_PROVIDERS table, and open the NOTIFPROVIDER_NOTIFTYPE
table.

4. Inthe NN_NOTIF_PROVIDER_ID column, add the ID number that was assigned to the new
provider.

5. Inthe NN_NOTIF_TYPE_ID column, assign the provider one of the following notification types:
= 102 —for pager service provider
m 101 —for SMS service provider

6. Closethe NOTIFPROVIDER_NOTIFTYPE table, and open the NOTIFICATION_PROVIDER _
PROP table.

7. Inthe NPP_NOTIFICATION_PROVIDER_ID column, add the ID number that was assigned to
the new provider. Note that you add the ID number to two consecutive rows.

8. Inthe NPP_NPROVIDER_PROP_NAME and NPP_NPROVIDER_PROP_VALUE columns,
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add the following new property names and values for the provider, one beneath the other (for
examples, see existing entries):

Property Property

Name Value Description

EMAIL_ <email_  The gateway's email suffix. For example, if the gateway email address

SUFFIX | suffix> is 12345@xyz.com, enter xyz . com as the property value for EMAIL _
SUFFIX.

EMAIL_ <max_  The maximum message length, in characters, of the body of the email

MAX_ length> | message. For example, 500.

LEN

When determining this value, take into consideration the maximum
length limit imposed by your service provider, as well as limitations to
your pager or mobile phone.

9. Inthe NPP_NPROVIDER_PROP_DATATYPE_ID column, specify an ID value as follows:
m for EMAIL_SUFFIX, specify: 1
m for EMAIL_MAX_LEN, specify: 2

10. Restart BSM.

Ul Description

Communication Method Area - Email Tab

User interface elements are described below:

Ul Element

(A-2) Description

Email Enter one or more email addresses. Separate multiple entries with a semi-colon (;).
Addresses

Only those recipients who have been configured to receive email can be selected to
receive scheduled reports and are listed in Available Recipients when configuring
scheduled reports.
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Ul Element
(A-2) Description
Enable Select this option if you want the recipient to receive encrypted mail. You must then

secure mail | copy, into the text box below the option, the contents of the certificate that the
recipient uses to secure incoming email messages.

Note:

« The encrypted mail option is supported only for alerts. Encrypted mail is not
supported for scheduled reports or subscription notification (HP Software-as-a-
Service customers only).

« The encrypted mail option is supported only when the BSM Data Processing
Server is installed on a Windows machine.

EUM Alert Select the template you want to use. For details, see "EUM Alerts Notification
notification = Templates" on page 360.

template Note: When you change the selection in the EUM Alert notification template field
in the top part of the page, the changes are propagated to the Email, Pager, and SMS
tabs in the same page. If you modify the selection in the EUM Alert notification
template field in the Email, Pager, or SMS tabs, the Schedule for receiving alerts
changes to Mixed Value. When you change once more, the selection inthe EUM
Alert notification template field in the top part of the page, the changes are
propagated to the Email, Pager, and SMS tabs in the same page and the Mixed
Value button is cleared.

Schedule Select the schedule you want to use for receiving emails. For details, see Schedule

for for receiving alerts in "New or Edit Recipient Dialog Box" on page 272.

receiving

Email

notifications

Communication Method Area - SMS Tab

User interface elements are described below:
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Ul Element
(A-2) Description

EUM Alert Select the template you want to use. For details, see "EUM Alerts Notification
notification Templates" on page 360.

template . . .
Note: When you change the selection in the EUM Alert notification template

field in the top part of the page, the changes are propagated to the Email, Pager,
and SMS tabs in the same page. If you modify the selection in the EUM Alert
notification template field in the Email, Pager, or SMS tabs, the Schedule for
receiving alerts changes to Mixed Value. When you change once more, the
selection in the EUM Alert notification template field in the top part of the
page, the changes are propagated to the Email, Pager, and SMS tabs in the
same page and the Mixed Value button is cleared.

Provider Select an SMS service provider from the list:
o Genie-UK
« ltineris
« SFR-France
o GoSMS-Israel
o MtnSMS-Global

Note: If your provider does not appear on the default provider list, and the
provider uses an email gateway, you can manually add your provider to BSM.
For details, see "How to Add a Custom Pager or SMS Service Provider" on
page 278.

Schedule for Select the schedule you want to use for receiving SMS text messages. For
receiving SMS  details, see Schedule for receiving alerts in "New or Edit Recipient Dialog
notifications Box" on page 272.

SMS numbers Type one or more SMS access numbers in the box. Separate multiple entries
with a semi-colon (;).

Communication Method Area - Pager Tab

User interface elements are described below:
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Ul Element
(A-2) Description

EUM Alert Select the template you want to use. For details, see "EUM Alerts Notification
notification = Templates" on page 360.

template L . . .
Note: When you change the selection in the EUM Alert notification template field

in the top part of the page, the changes are propagated to the Email, Pager, and SMS
tabs in the same page. If you modify the selection in the EUM Alert notification
template field in the Email, Pager, or SMS tabs, the Schedule for receiving alerts
changes to Mixed Value. When you change once more, the selection in the EUM
Alert notification template field in the top part of the page, the changes are
propagated to the Email, Pager, and SMS tabs in the same page and the Mixed
Value button is cleared.

Pager Enter one or more pager access numbers. Separate multiple entries with a semi-
Numbers colon (;).

Note: If your pager is numeric only, when creating an alert scheme in the Alert
Wizard, you can only type a numeric user message.

Schedule Select the schedule you want to use for receiving pager messages. For details, see
for Schedule for receiving alerts in "New or Edit Recipient Dialog Box" on page 272.
receiving

pager
notifications

Type Select a pager service provider. The following providers are supported:

« MetroCall

« Arch

« AirTouch

. PageMci

o SkyTel

o PageNet

. PageMart

« AmeriPage

« Nextel

. PageOne
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Personal settings enable customization of the way BSM presents information to individual users.

Individual users can configure personal settings to customize their specific user-related behavior of
BSM.

To access
« Select Admin > Personal Settings

« Click Change the default page on the Site Map

Learn About

User Account Settings

On the User Account tab, you can configure the following personal settings:
« Username
» Usermode
« Time zone used when displaying reports
« Password
« Refresh rate of reports

For details on the user interface for changing your password and updating other Personal Settings, see
"User Account Page" on page 288.

Menu Customization Settings

On the Menu Customization tab, you can:
« Specify the default context that is displayed when logging into BSM.
« Specify the first page that is displayed in each of the different parts of BSM.

« Specify the tabs and options that are available on pages throughout BSM.
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Customizing your entry page, menu items, and tabs enables your interface to display only the areas of
BSM that are relevant to you. For details on the Menu Customization User Interface, see "Menu
Customization Page" on page 289.

Tasks

How to Customize BSM Menus and Pages — Workflow

This task describes how to customize the page you see when entering BSM, and select the menu
items available on pages throughout BSM.

Tip: For a use-case scenario related to this task, see "How to Customize BSM Menus and Pages
— Use-Case Scenario" on the next page.

1. Assign a Default Context

Select a context from the Contexts pane that you want to be the default entry context you see
when logging into BSM, and click Set as Default Entry Context. For user interface details, see
"Menu Customization Page" on page 289.

2. Select Context Pages and Tabs

In the Pages and Tabs pane, select the context of the pages and tabs that you want to be visible
on the selected context for the user. Clear the check boxes of the pages and tabs that you want
hidden from the user.

3. Assign a Default Entry Page

Select a page or tab to be the default entry page for the selected context, and click Set as Default
Entry Page.

4. Results

The default entry icon appears next to the default entry context and page. Pages and tabs visible
to the user are selected in the Pages and Tabs pane. Pages and tabs hidden from the user are
cleared in the Pages and Tabs pane.
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Example:
Contexts Pages and Tabs

Applications - MyBSHK W Status Snapshot

Applications - Service Health
PP v sLa Reportz

Applications - Service Level Management

¥ sLA Status
Applicationz - End Uzer Management
W sLas Summary

Applications - System Availability W Summary
Management

Applications - Business Service M Hi ¢l summary

Management for Siebel

r
¥
=
r
- Applications - Traneaction Management
7
=

I climpact
¥

Applications - Application Management for

SOA
- [ cistatus -

EE =N

How to Customize BSM Menus and Pages — Use-Case Scenario

This use-case scenario describes how to customize user menus for individual users.

Note: For a task related to this scenario, see "How to Customize BSM Menus and Pages —
Workflow" on the previous page.

1. Assigning a Default Context

John Smith is a registered BSM user for the ABC Insurance Company. He wants to configure the
Service Level Management application interface to be the default Business Service Management
context that he sees when logging in. He navigates to the Personal Settings option by selecting
Admin > Personal Settings, and selects Menu Customization to open the Menu
Customization page. He selects Applications - Service Level Management in the Contexts
pane and clicks Set as Default Entry Context. The Applications - Service Level Management
option is indicated as the default entry context:
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Personal Settings

Customize view and entry pages per user.
In the left pane, select the default entry context that opens for this user when logging into BAC.
In the right pane, select the default page that opens for each BAC context and the pages and ta

Set as Default Entry Context

Contexts

Applications - My BAC
Applications - Dashboard

Service Lavel Management

Applications - End User Management

Applications - System Availability Management
Applications - Alerts

Applications - User Reports

Applications - Business Availability Center for Siebel
Applications - Business Availability Center for SOA
Applications - Application Performance Lifecycle
Admin - Dashboard

Admin - Service Level Management

Admin - End User Management

Admin - System Availability Management

Admin - Alerts

Admin - Problem Isclation

Admin - Business Availability Center for Siebel Administration
Admin - Platform

Admin - EMS Integrations

Admin - Personal Settings

Help - Site Map

2. Selecting Context Pages and Tabs

John wants to see only the pages and tabs that are relevant for his work, and wants to view the
Service Level Agreements (SLAs) Summary report immediately upon logging into BSM. In the
Pages and Tabs pane, he deselects the SLA Management option, as the information presented on
this tab is not relevant to his work. He selects the SLAs Summary option and clicks Set as
Default Entry Page. The SLAs Summary page is indicated as the default entry page that John
sees when logging into BSM:
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Sat as Default Entry Page

FPages and Tabs

¥ status Snapshot
|- SLA Management

¥ 5Lt Reports

W sLa status

|7 CI Summary

W cI impact

WV cI1 status

|7 Time Range Comparison
|7 Cls Over Time

|7 CI Cwer Time vs. Target

B - P

3. Results

The context that opens when John Smith logs into BSM is the Service Level Management
context on the Applications menu. The SLAs Summary Report page is displayed on the SLA

Reports tab:

Status Snapshot | SLA Reports Dutage Reports

|SLP« Reports > SLAs Summary

View: I Week to date = I 1|k

SLas: All [Clear All
Primary grouping: KPI - KPIL: All (Clear all

Secondary grouping: ICEIEndar vI Calendar: All [Clear All

LNEMEN

Advanced Options

Generate

SLAs = 24x7 Business Hours 247 Business Hours

Availability (%) Performance (%)

B Exceeded Met Minor Breached M Breached
W Failed No Data B Downtime
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Ul Description

User Account Page

BSM saves these settings per defined user. Any changes you make remain in effect for all future web
sessions for only that user.

User interface elements are described below:

Ul Element

(A-2) Description

Confirm Re-enter the password specified in the Password field.
Password

Login name  The name used to log into BSM.

Note: You cannot change the entry in this field.

Old Enter the existing password.
Password
Password Enter a password to be used when accessing BSM.

Select auto- | Select the rate at which you want BSM to automatically refresh the browser and
refresh rate load the most up-to-date data from the database.

Time zone Select the appropriate time zone, according to the user's location.

User mode Select the user mode for the user, from the following options:
« Unspecified. Leaves the user without a particular mode. Select this option if:

m BSMis working with user modes and you want this user to see KPIs for both
modes in Service Health views.

= Your system is not working with user modes.
« Operations User. Enables the user to view the operations version of KPIs.
» Business User. Enables the user to view the business version of KPIs.

Note: For details on user modes, see Create KPIs for Operations and Business
User Modes in the BSM Application Administration Guide.
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Ul Element
(A-2) Description

User name The user name for the user.

Notes:
o The maximum number of characters you can enter is 50.

« All special characters are allowed except the following: "\ /[]:|<>+=;,?2*%
&

Recipient Page

This page enables you to define recipients, their email, pager, and SMS information, and the template
to use to send alert notices to those recipients.

For user interface details, see "New or Edit Recipient Dialog Box" on page 272.

Menu Customization Page

This page enables you to customize the view and entry pages per user. You can specify:
« The default context that is displayed when logging into BSM.
« Thefirst page displayed in each of the different parts of BSM.
« Thetabs and options available on pages throughout BSM.

The Personal Settings tab can also be accessed by clicking Change the default page on the Site
Map.

User interface elements are described below:
Ul Element (A-Z) Description
Contexts Select a BSM context. You can perform the following actions on the context:

« Select pages and tabs in the Pages and Tabs pane to be visible for the
specified user.

« Click the Set as Default Entry Context button to make it the context that is
displayed when the user logs into BSM.
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Ul Element (A-Z) Description

Pages and Tabs . Select the pages and tabs you want to be visible for the BSM context
selected in the Contexts pane.

« Assign a page or tab as the default page that opens for the context selected
in the Contexts pane.

Set as Default Click to set the selected context in the Contexts pane as the entry context that
Entry Context is displayed when the specified user logs into BSM.

Note: The Default Entry Context icon appears next to the specified

context.
Set as Default Click to assign the specified page or tab as the default page that opens for the
Entry Page context selected in the Contexts pane.

Note: The Default Entry Page icon appears next to the specified page or
tab.
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BSM authentication is based on a concept of authentication strategies. Each strategy handles
authentication against a specific authentication service. Only one authentication service can be
configured with BSM at any given time.

To access

Select Admin > Platform > Users and Permissions > Authentication Management

Learn About

Authentication Strategies Overview

The default authentication strategy for logging into BSM is the BSM internal authentication service. You
enter your BSM user name and password from the Login page, and your credentials are stored and
verified by the BSM database.

Setting Up an SSO Authentication Strategy

Single Sign-On (SSO) is a method of access control that enables a user to log in once and gain access
to the resources of multiple software systems without being prompted to log in again. The applications
inside the configured group of software systems trust the authentication, and you do not need further
authentication when moving from one application to another.

The default single sign-on authentication strategy for BSM is Lightweight Single Sign-On (LW-SSO).
LW-SSO is embedded in BSM and does not require an external machine for authentication. For details
on LW-SSO, see "Lightweight Single Sign-On Strategy" on page 312.

If the applications configured outside of BSM do not support LW-SSO, or if you want a stronger Single
Sign-On implementation, you can configure Identity Management Single Sign-On (IDM-SSO) using the
SSO Configuration Wizard. When enabled as a Single Sign-On strategy, IDM-SSO also serves as an
authenticator. Users authenticated through IDM-SSO can log into BSM, provided they fulfill the criteria
defined in the Users Filter field of the LDAP Vendor Attributes dialog box. For details, see "LDAP
Vendor Attributes Dialog Box" on page 304.

Setting Up LDAP Authentication

The Lightweight Directory Access Protocol (LDAP) is an Internet protocol that email and other
programs use to look up information from an external server. LDAP can be configured with BSM in one
of the following ways:
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« As an authentication mechanism for users logging into BSM.

« Tomap groups and synchronize BSM users with users configured on the external LDAP server,
thereby simplifying the process of managing users for BSM administrators. For details, see "How to
Map Groups and Synchronize Users" on page 327.

You can define multiple LDAP authentication module configurations under one realm. Although these
additional configurations are visible from the User Management panel, they work in conjunction with the
primary configuration if an initial search for the requesting user’s authorization is not found. For
example, one realm can define a search through LDAP servers for authentication in two different
domains or it can configure multiple user naming attributes in one domain.

Smart Card Authentication

BSM supports user authentication using smart cards. If smart card authentication is configured, you
cannot log in without a valid smart card.

For more information on Smart Card Authentication, see "TLS and Smart Card Authentication" on
page 294.

Authentication Modes in BSM

The following table displays the Authentication Strategy used by BSM, as determined by both the
Single Sign-On mode and the selected LDAP mode.

Single Sign-On Mode LDAP Mode Authenticator
Disabled Disabled BSM Internal
Enabled LDAP
LW-SSO Disabled BSM Internal
Enabled LDAP
IDM-SSO Disabled IDM-SSO
Enabled IDM-SSO

Ul Description

Authentication Management Page

This page displays the current authentication strategy and Single Sign-on configurations for logging into
BSM.

Access to the Authentication Management page is dependent on the following permission levels:
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« View. Enables viewing the Authentication Management Page.

« Change. Enables you to access the Authentication Management page and create and change the

configuration.

You configure permissions on the Users and Permissions interface. For details, see "Permissions" on

page 189.

User interface elements are described below:

Ul Element (A-2)

Add LDAP

Configure

Delete
Edit
Enable/Disable

Lightweight Directory
Access Protocol
Configuration

Single Sign-On
Configuration

HP Business Service Management (9.26)

Description

Click to open the LDAP Configuration Wizard to add a new LDAP
configuration.

For details on the LDAP Configuration Wizard, see "LDAP Configuration
Wizard" on page 300.

Click to open the SSO Configuration Wizard and configure an
authentication strategy. For details on the SSO Configuration Wizard,
see "SSO Configuration Wizard" on page 306.

There is a separate Configure button for Smart Card Authentication
Configuration. For information on Smart Card Authentication
Configuration, see "TLS and Smart Card Authentication" on the next

page.
Click to remove an LDAP configuration.

Click to edit an LDAP configuration.

Click to enable/disable an LDAP configuration.

The section displays:

« Name. The name of the Lightweight Directory Access Protocol
parameter.

« Value. The value of the Lightweight Directory Access Protocol
parameter as configured in the wizard.

The section displays:
« Name. The name of the Single Sign-On parameter.

« Value. The current value of the Single Sign-On parameter as
configured in the wizard.
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Ul Element (A-2) Description

Smart Card The section displays:

Authentication

Configuration « Name. The name of the Smart Card Authentication

Configuration parameter.

« Value. The current value of the Smart Card Authentication
Configuration parameter as configured in the wizard.

TLS and Smart Card Authentication

BSM supports user authentication using smart cards. If smart card authentication is configured, you
cannot log in without a valid smart card.

To access the TLS and Smart Card Authentication Configuration Wizard:

Select Admin > Platform > Users and Permissions > Authentication Management and in the
TLS and Smart Card Authentication Configuration pane, click Configure.

Learn About

Smart Card Authentication

Smart cards are physical devices used to identify users in secure systems. These cards can be used
to store certificates both verifying the user's identity and allowing access to secure environments.

BSM can be configured to use these certificates in place of the standard model of each user manually
entering a user name and password. You define a method of extracting the user name from the
certificate stored on each card.

When using smart cards with BSM, users can only log in using the smart card. The option of logging in
by manually typing in your username and password is locked for all users unless smart card
configuration is disabled.

Tasks

Enable or Disable Smart Card Authentication

Smart cards are both enabled and disabled on the BSM Gateway and Data Processing servers by
using the Smart Card Authentication Configuration Wizard. This wizard is only a part of the overall
workflow for configuring smart card authentication in your BSM environment. For more details, see the
Smart Card Authentication Configuration Guide.
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Note: Your machine should have openssl installed. This is included as part of the Apache
installation included on Windows BSM and Linux environments. To check if this is installed on
your machine run

/usr/bin/openssl

If you do not have this command, install it and make sure you can execute it from any path before
configuring smart card authentication.

Emergency Disable of Smart Card Authentication
Note: This procedure should only be used if you cannot access BSM normally.

If you cannot log in to BSM using any smart card and want to disable smart card authentication, run the
following batch file from any BSM Gateway or Data Processing Server:

« Windows: <BSM Installation Directory>\bin\RevertHardening.bat
o Linux: <BSM Installation Directory>/bin/RevertHardening.sh

When the batch file is complete, restart all BSM Gateway Servers to activate the change.

Manually Configure Reverse Proxy for Smart Cards

This procedure differs depending on whether your reverse proxy is using the 11S or Apache web server.
This procedure describes the general settings that are required, but you may need to refer to the web
server documentation for the details. It must be performed before you restart your BSM Gateway
servers to enable smart card authentication.

For the IIS web server:
1. Prerequisite: 11S is already configured to require client certificate

2. Configure the reverse proxy to forward the encoded client certificate in the header CLIENT _
CERT_HEADER.

For the Apache web server:
1. Prerequisite: Apache is already configured to require a client certificate.
2. In httpd.conf, enable the mod_headers.so
3. Inhttpd-ssl.conf, add the following line before </VirtualHost>:

requestHeader set CLIENT_CERT_HEADER "%{SSL_CLIENT_CERT}s"
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Ul Descriptions

TLS and Smart Card Authentication Configuration Wizard

This wizard guides you through the process of enabling and disabling smart card authentication
configuration with BSM.

To access the TLS and Smart Card Authentication Configuration Wizard:

Select Admin > Platform > Users and Permissions > Authentication Management, and in the
TLS and Smart Card Authentication Configuration pane, click Configure.

Notes and Limitations

o User names are case sensitive

« When smart card authentication is enabled, the JXM console can only be accessed directly from
the BSM servers.

« When creating an admin user as directed in the smart card authentication wizard, make sure you
enter a secure password even though no password is required for authentication with smart cards. If
smart card authentication is disabled, the user will still exist on the system and if an insecure
password is defined it could pose a security risk.

« If your deployment is distributed and it uses a high availability configuration with two or more BSM
Gateways and you intend to use TLS configuration on each BSM Gateway which will be configured
using TLS and Smart Card Authentication Configuration you need to use a single Server Certificate
which is suitable for each BSM Gateway according toits FQDN names.

For example, you can use a wildcard Server Certificate for the domain OR a Subject Alternative
Name (SAN) certificate with a list of BSM Gateway FQDN names.

TLS and Smart Card Authentication Configuration -
Introduction Page

This wizard enables you to configure server side secure communication using TLS and client side
smart card authentication settings. Smart card authentication technology is used to identify users in
secure systems. These cards can be used to store digital identity credentials, thereby providing access
to secure environments. Once these settings are configured, you will not be able to log into BSM
without a valid smart card.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access andinthe TLS and Smart Card Authentication Configuration pane, click Configure.
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Wizard This wizard contains:

ma
P TLS and Smart Card Authentication Configuration Wizard Introduction Page >

"TLS and Smart Card Authentication Configuration - Front End Server Page" below > "TLS
and Smart Card Authentication Configuration - Configuration Mode Page" below > "TLS
and Smart Card Authentication Configuration - Server Certificate Page" on the next page
>"TLS and Smart Card Authentication Configuration - Client Certificate Page" on page 299
> "TLS and Smart Card Authentication Configuration - Admin Page" on page 299 > "TLS
and Smart Card Authentication Configuration - Summary Page" on page 300

TLS and Smart Card Authentication Configuration - Front
End Server Page

This wizard page enables you to select which BSM front end server you are using in your BSM
deployment.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access and inthe TLS and Smart Card Authentication Configuration pane, click Configure.
Navigate to the Front End Server page.
Choose which BSM front end server you are using in your BSM deployment. Options are:

« BSM Gateway Server - Apache

« Reverse Proxy / Load Balancer

TLS and Smart Card Authentication Configuration -
Configuration Mode Page

This wizard page enables you to select which CAC configuration you want to use.
To Select Admin > Platform > Users and Permissions > Authentication Management,
access andinthe TLS and Smart Card Authentication Configuration pane, click Configure.
Navigate to the Configuration Mode page.

User interface elements are described below:
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ul
Element
(A-Z) Description

Smart Options are:

Card
CAC « Custom - This mode is by default similar to Full CAC. However, if your smart card
mode software does not allow caching the pin code for the entire BSM session, only per

process, then this mode can be used instead of Full CAC. This will enforce smart card
authentication for users logging into BSM or data collectors accessing BSM. In
addition, Custom mode enables you to define URLSs to require Smart card
authentication.

Note: This option is not available in |1S.

« Full - Smart card authentication is required for any access to BSM. This is the default
mode.

« User login only - Smart card authentication is required for logging in to BSM only.
This mode requires smart card authentication for users logging into BSM, and SSL
authentication for data collectors to access BSM.

Server Selecting this option, means that you selected a server side configuration certificate.
side TLS | Therefore, all fields in the Client Certificate page are inaccessible.

only

mode

TLS and Smart Card Authentication Configuration - Server
Certificate Page

This wizard page enables you to enter the certificate of the CA that issued your BSM gateway server
certificate.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access andinthe TLS and Smart Card Authentication Configuration pane, click Configure.
Navigate to the Server Certificate page.

User interface elements are described below:

Ul Element (A-Z) Description

BSM java truststore password Enter the BSM Java truststore password. By default, the
password is changeit.

CA certificate issuer for the Enter the certificate for the CA that signed your BSM
BSM gateway server (Base 64 - .cer gateway server certificate
format)
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Ul Element (A-2) Description

Private key password Enter the password for the private key contained in the
server certificate .pfx file.

Server certificate (.pfx) Enter the server certificate. The .pfx file must contain a
public and private key (password protected).

TLS and Smart Card Authentication Configuration - Client
Certificate Page

This wizard page enables you to enter the certificate of the CA that issued your BSM gateway client
certificate.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access andinthe TLS and Smart Card Authentication Configuration pane, click Configure.
Navigate to the Client Certificate page.

User interface elements are described below:

Ul Element (A-Z) Description

CA certificate for the client Enter the public certificate of the CA that issues the client
certification (Base 64 - .cer format) = certificates in your organization.

Revocation verification method « None (skip it) - Disable revocation verification

« From local CRL - Enter the path to the local CRL on the
server (.pem)

« Obtain from Client Certificate

Certificate data used for Attribute used to identify users - Define the attribute from the
authentication certificate that will be used to identify BSM users.

Relevant part of the attribute field - for example
EMAILADDRESS

TLS and Smart Card Authentication Configuration - Admin
Page

In CAC mode, make sure that you have a BSM user with the super user roles defined according to the
format you specified on the previous page.

For example, if you identify users through the EMAILADDRESS attribute, make sure you have a user
whose login name fits this format and you have a valid smart card with a corresponding user.
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Note: Without such a user, you will not have administrative permission in BSM while smart cards
are enabled. If you need to add a new admin user, you can do it after the completion of hte smart
care authentication wizard.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access andinthe TLS and Smart Card Authentication Configuration pane, click Configure.
Navigate to the Admin page.

TLS and Smart Card Authentication Configuration -
Summary Page

This page indicates if the TLS or smart card authentication configuration was successful. If successful,
to activate smart card authentication, you need to restart all BSM gateway and data processing

servers.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access andinthe TLS and Smart Card Authentication Configuration pane, click Configure.
Navigate to the Summary page.

LDAP Configuration Wizard

This wizard enables you to create an LDAP authentication strategy for logging into BSM.

To access

Important
information

Wizard
map

Select Admin > Platform > Users and Permissions > Authentication
Management, and click Add LDAP.

If the User Interface does not respond properly after upgrading your version of BSM
(for example, the page does not load, or an error message is displayed), clean the
Java cache by following this procedure on your client PC:

1. Navigate to Start > Control Panel > Java.
2. Inthe Temporary Internet Files section, click Settings.

3. Inthe Temporary File Settings dialog box, click Delete Files.
This wizard contains:

LDAP Configuration Wizard > "LDAP General Configuration Page" on the next
page > ("LDAP Vendor Attributes Dialog Box" on page 304) > "LDAP Group Mapping
Configuration Page" on page 304 > "LDAP Summary Page" on page 305
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LDAP General Configuration Page

This wizard page enables you to use an external LDAP server to store authentication information (user
names and passwords) and to enable user synchronization between LDAP users and BSM users.

To access = Select Admin > Platform > Users and Permissions > Authentication
Management, and click Add LDAP for new or Edit for an existing LDAP
Configuration. Navigate to the LDAP General Configuration page.

Important « When configuring LDAP parameters, consult your LDAP Administrator for
information assistance.

LDAP General Configuration Section

User interface elements are described below:

Ul Element
(A-2) Description
Indicates that the value in the specified field is empty or invalid.
You can view a description of the error in one of the following ways:
« Hover over the erroricon to display a tooltip with the error message.
« Access the log file <HPBSM root directory>\log\Jboss\login.log.
Advanced Opens the LDAP Vendor Attributes dialog box enabling you to modify

configurations for the selected LDAP vendor. For details, see "LDAP Vendor
Attributes Dialog Box" on page 304.

Distinguished = Select to enable entering LDAP search user credentials.
Name (DN)

Resolution Note: If your LDAP requires user credentials to verify connection to LDAP server,

you will need to use the users-remote-repository service in the JMX console to
enter these credentials, because this Ul will not let you past LDAP server URL
without valid user credentials.

Distinguished | Defines the Distinguished Name (DN) of a user with search privileges on the LDAP
Name of directory server.
Search-

Entitled User Note: Leave this entry blank for an anonymous user.
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Ul Element
(A-Z)

LDAP server
URL

Description

Enter the URL of the LDAP server. For Active Directory users, we recommend
using the Global Catalog server (AD GC).

To represent different trees in the same forest, enter multiple DNs, separated by
semicolons.

To allow failover, enter multiple LDAP (AD GC) server URLs, separated by
semicolons.

The required format is: Idap://machine_name:port/scope??sub

« LDAP servers typically use port 389. Active Directory Global Catalog Servers
typically use port 3268 or secure port 3269. We recommend using the Global
Catalog server for Microsoft Active Directory.

« Possible values of scope = sub, one, or base, and are case sensitive.

« BSMignores the attribute between the two question marks, if one exists.

« When the port number and scope value are empty, default values are used.
m Default port number for regular communication: 389
m Default port number for SSL communication: 636
m Default scope value: sub

Examples:

Single DN, single LDAP server:
ldap://my.ldap.server:389/ou=People,o=myOrg.com??sub

You can configure multiple domains by entering LDAP server URLs separated by a
semicolon (;). The server names must be the same in order to search users in both
LDAP servers.

Multiple DNs: 1dap://my.ldap.server:389/ou=People,o=myOrg.com??sub;
ldap://my.ldap.server:389/ou=Staff,o=my2ndOrg.net??sub

You can configure failover by entering different LDAP server URLs separated by a
semicolon (;). For failover, the domain names must be the same.

Failover LDAP servers:
ldap://my.ldap.server:389/ou=People,o=myOrg.com??sub;
ldap://my.2ndldap.server:389/ou=People,o0=myOrg.com??sub

Note: If you receive ared X after entering the URL with the following popup text:
ERROR - sun.security.validator. ValidatorException: PKIX path building failed:
sun.security.provider.certpath. SunCertPathBuilderException: unable to find valid
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Ul Element
(A-2) Description

certification path to requested target

This means that you need to establish trust to the LDAP server. For details, see
"How to Secure Communication Between the LDAP Server and BSM Server Over
SSL" on page 322.

Note: The server names must be the same in order to search users in both LDAP
servers.

LDAP vendor Enterthe LDAP vendor you are using. Select from:

type
« Common LDAP

« Microsoft Active Directory
o Other

Note: If you click Advanced and modify the LDAP Vendor Attribute settings, the
value of this field automatically changes to Other.

Password of = Defines the password of the user entitled to search the LDAP server entities for
Search groups.
Entitled User )

Note: Leave this entry blank for an anonymous user.

Unique Enter a name for your LDAP configuration. This name should be unique in your
domain BSM system.

Test DN Resolution Section

Enables you to verify that both the configured LDAP parameters and the credentials of a specified user
are valid.

User interface elements are described below:

Ul
Element
(A-2) Description

Password The password of the user whose credentials are entered in the UUID field.
Note: This field is optional. If left empty, anonymous user is used.

Test Tests the LDAP configuration and user credentials validity. A message is displayed
indicating whether or not the validation was successful.

UuID The actual login name (Unique User ID) of the LDAP user you want to verify.
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LDAP Vendor Attributes Dialog Box

This dialog box page enables you modify the default LDAP settings that are specific to the selected
vendor.

To access | Click Advanced on the LDAP General Configuration Page of the LDAP
Configuration Wizard.

Important « If you modify the LDAP Vendor Attribute settings, the value of the LDAP Vendor
information Type field on the LDAP General Configuration page automatically changes to
Other.

User interface elements are described below:

Ul Element

(A-2) Description

Group class Defines which LDAP entities are to be considered groups on the LDAP server.

object

Groups Defines the specific attribute that determines which of the LDAP group's entities

member are to be considered members of the LDAP group.

attribute

Restore Restores the LDAP vendor attributes to their state upon logging into the current
session of BSM.

Users filter Defines which LDAP users are enabled to log into BSM.
Note: The filter should be as narrow as possible and include only users who
require access to BSM.

Users object Defines which LDAP entities are to be considered users on the LDAP server.

class

Users unique The attribute you want to log into BSM with, as it appears on the LDAP server.

ID attribute . .
Example: uid, mail

LDAP Group Mapping Configuration Page

This wizard page enables you configure the LDAP server to synchronize LDAP users with BSM users.
To access | Select Admin > Platform > Users and Permissions > Authentication

Management, and click Configure. Navigate to the LDAP Group Mapping
Configuration page.
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Important
information

« This page is enabled only if the LDAP General Configuration page has been
configured correctly.

User interface elements are described below:

Ul Element
(A-2)

24

Groups base
DN

Groups
search filter

Root groups
base DN

Root groups
filter

Test

Test Groups
Configuration
Pane

Description

Indicates that the value entered in the specified field is invalid.

The Distinguished Name (DN) of the LDAP entity from which you want to start your
groups search.

You can configure multiple domains by entering domains separated by a semicolon
G)-
For example: dc=devlab,dc=ad;dc=BSF_RND

Enter the relevant parameters to indicate which attributes are to be included in the
groups search.

The Distinguished Name (DN) of the LDAP groups that are to be first on the
hierarchical tree of mapped groups. This value must be a subset of the Groups
base DN.

Enter the parameters to determine which LDAP entities are to be the hierarchical
base for the LDAP groups. The specified entities are then available to be mapped to
groups in BSM.

Verifies that the parameters entered to define the LDAP groups structure are valid.

This button is disabled if the Test DN Resolution UUID field is empty

Displays the groups available for mapping with BSM groups and the LDAP groups'
hierarchical structure. The displayed groups are determined by the parameters
entered into the fields on the LDAP Users Synchronization Configuration page.

The maximum number of groups that can be displayed is 1000. If there are more
than 1000 groups, this list will be empty. If the list is empty, try to change the group
search filter.

For example, if the group search filter was (objectclass=groupOfUniqueNames)
change it to (&(objectClass=groupOfUniqueNames)(cn=BSM*))
or reduce the search range: ou=groups,dc=devlab,dc=ad

LDAP Summary Page

This wizard page displays a summary of the authentication strategies configured in the LDAP
Configuration Wizard.
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To Select Admin > Platform > Users and Permissions > Authentication Management,
access and click Add LDAP. Enter information in the LDAP pages, and navigate to the Summary
page.

User interface elements are described below:

Ul Element (A-Z) Description

LDAP General Configuration Displays the LDAP General Configuration parameters, as
configured on the LDAP General Configuration page of the
wizard.

LDAP Group Mapping Displays the LDAP Group Mapping Configuration

Configuration parameters, as configured on the LDAP Group Mapping

Configuration page of the wizard.

SSO Configuration Wizard

This wizard enables you to create an SSO authentication strategy for logging into BSM.

To access Select Admin > Platform > Users and Permissions > Authentication
Management, and click Configure.

Important If the User Interface does not respond properly after upgrading your version of BSM
information = (for example, the page does not load, or an error message is displayed), clean the
Java cache by following this procedure on your client PC:

1. Navigate to Start > Control Panel > Java.
2. Inthe Temporary Internet Files section, click Settings.

3. Inthe Temporary File Settings dialog box, click Delete Files.
Wizard This wizard contains:

ma
P SSO Configuration Wizard > "Single Sign-On Page" below > ("SAML2

Configuration Dialog Box" on page 309) > "SSO Summary Page" on page 311

Single Sign-On Page

This wizard page enables you to configure a Single Sign-On strategy. The elements displayed on the
Single Sign-On page are determined by the Single Sign-On mode you choose.
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Important

. . « |f avalue in one of the wizard fields is blank or invalid, an error icon is
information

displayed on the field's cell. You can view a description of the error in one of the
following ways:

m Hoverover the error icon to display a tooltip with the error message.

m Access the log file <HPBSM>/log/Jboss/login.log.

User interface elements are described below:

Ul Element (A-Z) Description
Disabled Select to disable the Single Sign-On (SSO) authentication strategy.

IdentityManagement = Select to configure the Identity Management Single Sign-On (IDM-SSO)
authentication strategy. For details on the elements displayed this page, see
below. For details on this topic, see "ldentity Management Single Sign-On
Authentication" on page 315.

Note: If you have selected this option, LDAP can be configured only for
group mapping and not for authentication.

Lightweight Select to configure the Lightweight Single Sign-On (LW-SSO) authentication
strategy. For details on the elements displayed on this page, see below. For
details on this topic, see "Lightweight Single Sign-On Strategy" on page 312.

Identity Management Single Sign-On (IDM-SSO) Configuration

User interface elements are described below:

Ul
Element
(A-2) Description
Indicates that the value in the specified field is empty or invalid.
Hover over this icon to view a tooltip describing the error.
Header Enter the header name for the token name passed by the Identity Management Single
Name Sign-On.

Example: sso_user

Note: Ensure that the Identity Management Single Sign-On strategy is securing BSM
resources before you enter this information.
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ul

Element

(A-Z) Description

Logout Enter an alternate logout URL, to view a page other than the main login page when
URL logging out of BSM.

Example:\<alternativelogoutURL>.jsp

Note: This field is optional.

Lightweight Single Sign-On (LW-SS0) Configuration

User interface elements are described below:

Ul Element

Add

Enable SAML2
authentication
schema

HP Business
Service
Management
Domain

Parse
automatically

SAML2
Settings

JMX to get/set
Token Creation
Key (initString)

Description

Indicates that the value in the specified field is empty or invalid.
Hover over this icon to view a tooltip describing the error.

Adds the host/domain to the list of protected hosts/domains.

Select to enable authentication using the Security Assertion Markup Language
2.0 protocol.

Enter the relevant BSM domain, to be used for token creation. This field may be
needed for multi-domain support and normalized URLs when the domain cannot
be parsed automatically, for example when using aliases.

Example: devlab.ad

Click to parse the BSM domain automatically.

Click to set parameters in the SAML2 Configuration Dialog Box.

This non-editable field contains a link to the attribute in the JMX console where
you can change the value of the initString.
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Ul Element Description

Trusted Displays the list of trusted hosts and domains that are participating in an LW-
Hosts/Domains =SSO integration.

List of trusted hosts can contain DNS domain name (myDomain.com), NetBIOS
name (myServer), I[P address, or fully qualified domain name for the specific
server (myServer.myDomain).

To add a host or domain to the list of trusted hosts/domains, click the Add icon

= |, enter the name of the host or domain in the text box under Trusted
Hosts/Domains, and select the type of host or domain name from the Type drop-
down box.

Examples: mercury.global, emea.hpqcorp.net, devlab.ad
To remove a host or domain from the list of trusted hosts/domains, select it and

ﬂ .

click the Remove button

SAML2 Configuration Dialog Box

This dialog box page enables you to modify the SAML authentication parameters for your Lightweight
Single Sign-On configuration.

To access | Inthe SSO Configuration Wizard, navigate to the Single Sign-On page, select
Lightweight, and select the Enable SAML2 authentication schema check box.
Click SAML2 Settings to open the SAML2 Configuration dialog box.

The SAML2 Configuration dialog box consists of the following sections:

« SAML2 Creation. Modify the SAML2 Authentication parameters for sending
SAML authentication requests from BSM.

« SAML2 Validation. Modify the SAML2 Authentication parameters for decrypting
SAML requests received by BSM.

Important « BSM comes with SAML enabled by default. If you want to disable SAML

information authentication, clear the Enable SAML2 authentication schema check box.

User interface elements are described below:

ul
Element Description

Restore  Restores the SAML2 configuration attributes to their state upon logging into the current
session of BSM.
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SAMLZ2 Creation Section

User interface elements are described below:

Ul Element
(A-Z)

Keystore
filename

Keystore
password

Look for
keystore in
classpath

Private key
alias

Private key
password

Description

The filename of the keystore in BSM.

« When Look for keystore in classpath is not selected, this value must be the
full path of the keystore's location, for example:
C:\mystore\java.keystore.

« When Look for keystore in classpath is selected, this value must be just the
file name of the keystore, for example: java.keystore.

The password which enables access to the keystore containing the private key
used for encryption during the SAML authentication request.

Select for the Lightweight Single Sign-On framework to search for the keystore in
the classpath.

Note: When this option is selected, you enter only the name of the actual keystore
file in the Keystore filename field.

Indicates the alias of the private key used for encryption during the SAML
authentication request.

Indicates the password of the private key used for encryption during the SAML
authentication request.

SAML2 Validation Section

User interface elements are described below:

Ul Element
(A-Z)

Look for
keystore in
classpath

HP Business Service Management (9.26)

Description

Select for the Lightweight Single Sign-on framework to search for the keystore in
the classpath.

Note: When this option is selected, you enter only the name of the actual keystore
file in the Keystore filename field.
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Ul Element
(A-2) Description
Keystore The filename of the keystore in BSM.
filename
« When Look for keystore in classpath is not selected, this value must be the
full path of the keystore's location, for example:
C:\mystore\java.keystore.
« When Look for keystore in classpath is selected, this value must be just the
file name of the keystore, for example: java.keystore.
Keystore The password of the public key used for decryption during the SAML
password authentication request.

SSO Summary Page

This wizard page displays a summary of the authentication strategies configured in the SSO
Configuration Wizard.

To Select Admin > Platform > Users and Permissions > Authentication Management,
access and click Configure. Enter information in the Single Sign-On page, and navigate to the
Summary page.

User interface elements are described below:

Ul Element (A-Z) Description
Single Sign-On Displays the Single Sign-On parameters, as configured in the
Configuration wizard.
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This section provides information and instructions for configuring Lightweight Single Sign-On (LW-
SSO).

Learn About

Lightweight Single Sign-On Overview

The default single sign-on authentication strategy for BSM is LW-SSO. LW-SSO is embedded in BSM
and does not require an external machine for authentication. BSM currently uses version 2.4 of LW-
SSO.

For an overview of Single Sign-On strategies, see "Authentication Strategies" on page 291.

Configuring LW-SSO

You can configure LW-SSO in BSM using the SSO Configuration Wizard. For details on the SSO
Configuration Wizard, see "SSO Configuration Wizard" on page 306.

LW-SSO can be configured using the JMX console to accept client-side authentication certificates.
Once a certificate is recognized, LW-SSO creates the token to be used by other applications. For
details, see "Using Client-Side Authentication Certificates for Secure User Access to BSM " on
page 22.

For details on limitations of working with LW-SSO, see "LW-SSO Authentication — General Reference'
on page 331.

LW-SSO Configuration for Multi-Domain and Nested Domain Installations

LW-SSO configuration, set in the SSO Configuration Wizard (for details, see "SSO Configuration
Wizard" on page 306), depends on the architecture of your BSM installation.

If you log into BSM through a man-in-the-middle, such as reverse proxy, a load balancer, or NAT, the
BSM domain is the domain of the man-in-the-middle.

If you log in directly to the BSM Gateway, the BSM domain is the domain of the BSM Gateway.

For LW-SSO to work with another application in a domain different from the BSM domain, all of these
domains must be listed in the Trusted Hosts/Domains list of the LW-SSO configuration.

If your BSM domain and integrating application are located in nested domains, then the suffix of the
domain should be the defined as the LW-SSO domain for both applications. In addition, you should
disable automatic domain calculation (Parse automatically in the SSO Configuration Wizard) and
explicitly state the domain suffix.
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Example 1:

BSM gateway server is located in emea.hp.com
TransactionVision server is located in cnd.hp.com
Disable automatic domain calculation and set domain name = hp.com

Example 2:

BSM gateway server is in corp.ad.example.com

NNMi server is in sdc.example.com

Load balancer is in example.com

Disable automatic domain calculation and set domain name = example.com

Tasks

How to Configure Unknown User Handling Mode

This task describes how to handle unknown users trying to log into BSM—users that were
authenticated by the hosting application but do not exist in the BSM users repository:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, click
Foundations, and select Single Sign On.

2. Locate the Unknown User Handling Mode entry in the Single Sign On - Lightweight (LW-SSO)
field, and select one of the following options:

= Integration User. A user with the User name Integration User is created in place of the user
who attempted to login. This user has System Viewer permissions.

m Allow. The useris created as a new BSM user and allowed access to the system. This user
has System Viewer permissions, and his default password is his login name.

m Deny. The useris denied access to BSM, and is directed to the Login page.

The changes take effect immediately.

Note: When User Synchronization is enabled between BSM and the LDAP server, unknown
users are always denied entry into BSM.

How to Modify LW-5SS0 Parameters Using the JMX Console

This task describes how to modify options and parameters used with LW-SSO in the JMX console.

You can also use the JMX console if you are locked out of BSM and must change SSO parameters to
gain access.
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1. Enter the URL of the JMX console (http://<server name>:29000/) in a web browser.

2. Enteryour JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. Locate the Lightweight Single Sign-On context, as follows:
a. Domain name: Topaz
b. Service: LW-SSO Configuration

4. Modify parameters accordingly.

The changes take effect immediately.

Troubleshooting and Limitations

Unable to Access BSM Due to Changes in LW-SSO Parameters

If you are locked out of BSM, you can update selected Lightweight Single Sign-On (LW-SSO)
parameters remotely using the JMX console on the application server that is embedded in BSM.

For details on how to change LW-SSO parameters outside the BSM interface, see "How to Modify LW-
SSO Parameters Using the JMX Console" on the previous page.

Synchronizing Users When Using LW-S50

LW-SSO does not ensure user synchronization between integrated applications. Therefore, you must
enable LDAP and configure group mapping for the integrated application to monitor users. Failure to
map groups and synchronize users may cause security breaches and negative application behavior.
For details on mapping users between applications, see "How to Map Groups and Synchronize Users"
on page 327.

Unable to Log into BSM when Using an External Authentication Point

If you enabled an external authentication point (AP) and are unable to log in through it, make sure that
the user whose credentials you are entering is defined as a userin BSM.
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Authentication

Identity Management Single Sign-On (IDM-SSO) provides a more secure connection than that offered
by LW-SSO. It also can be used if the applications configured outside of BSM do not support LW-SSO.

Learn About

This section includes:
» "IDM Server" below
« "Storing User Information" below
« "IDM Login" on the next page
« "Securing BSM Resources Under IDM-SSQ" on the next page
« "Resources Accessed by Application Users" on the next page
« "Resources Accessed by Data Collectors" on page 317
« "Resources Accessed by Web Services (Required)" on page 318
« "Additional Resources to be Protected with Basic Authentication" on page 318

« "Unprotected Resources" on page 318

IDM Server

The IDM server is monitored by a single center Policy Server, and consists of a User Repository, a
Policy Store (both could reside over the same server as the policy server), and a Web Server Agent
installed over each of the application's web servers communicating with the Policy Server. The IDM
server controls users' access to various organizational resources, protecting confidential personal and
business information from unauthorized users. For details, see your IDM vendor's documentation.

Storing User Information

BSM requires the IDM vendor to store user information to render it available as a header on http
requests. You configure both the Header name and the IDM-SSO strategy in the SSO Configuration
Wizard. For details, see "SSO Configuration Wizard" on page 306.
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IDM Login

Before configuring IDM-SSO in BSM, make sure you see your IDM login dialog box before the BSM
login screen.

If you do not see it, work with your IDM administrator. If the same LDAP was defined in BSM as used
by IDM, you should be able to authenticate through both the IDM and BSM login screens using the
same credentials. If not, verify that LDAP settings in BSM match those used by IDM. Now you are
ready to configure IDM-SSO in BSM. If you need help dumping headers in order to determine the
correct IDM header to use in configuration, you can return to the BSM login screen without closing the
session and append /DumpSession.jsp to the login URL. Look for your user login ID in the resulting
list. Before it should be the header name supplied by IDM. You can verify it using http://<HPBSM
server>/topaz/verifylDM.jsp in the same user session. Once it is verified as correct, you should be
able to use it in the SSO Configuration Wizard.

Securing BSM Resources Under IDM-SSO

When using IDM-SSO as a Single Sign-On strategy, BSM resources may be protected with form or
basic authentication schemes, or left unprotected.

Resources Accessed by Application Users

If you want to use IDM-SSO to secure BSM resources accessed by application users, use form
authentication on the following resources:

o [filters/*

o /hpbsm/*

o /mam-images/*
o /mcrs/*

o /MercuryAM/*
« /odb/*

o /opal/*
 /opr-admin-server/*
« /opr-console/*
« /opr-gateway/*
« /opr-web/*

o /ovpm /*
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o /topaz/*

« /topazSettings/*
o Jtv/*

o [tvb/*
 /ucmdb-ui/*

o Juim/*

o [utility_portlets/*

« /webinfra/*

Examples of URL with form authentication

= The following URL verifies that the IDM header is correct:
https://<gateway server>/topaz/verifyIDM.jsp?headerName=sm_user

Expected Result: The system displays the user name of the current user (provided that SM
authentication was performed prior to this action).

m The following URL shows values of all cookies in the session:
https://<gateway server>/topaz/DumpSession.jsp

Expected Result: The system displays a table of all cookies in the user session and their
corresponding values.

Resources Accessed by Data Collectors

If you want to use IDM-SSO to secure BSM resources accessed by data collectors in machine-to-
machine communication, use an authentication method that allows passing credentials, or basic
authentication.

The following resources are used by data collectors:
o /ext/* —used by RUM
o /mam/* —used by RTSM

« [topaz/topaz_api/* — used by all data collectors to get BSM version, server time, etc.

Example of URL with basic authentication
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« The following URL is used by data collectors to establish a connection to BSM:
https://<gateway server>/topaz/topaz_api/api_getsystemkey.asp

Expected Result: The system displays the basic authentication window followed by a value,
for example -7.

Resources Accessed by Web Services (Required)

If you use IDM-SSO with BSM, you must protect the following resources with basic authentication as
they are used by various BSM web services:

« /opr-admin-server/rest/*
« /opr-console/rest/*

« /opr-gateway/rest/*

« /topaz/bam/*

« /topaz/bsmservices/*
« /topaz/eumopenapi/*
 /topaz/servicehealth/*

« /topaz/sim/*

Additional Resources to be Protected with Basic Authentication

« [topaz/rfw/directAccess.do — used with published URL to a report

« /topaz/sitescope/* — used for SAM Admin embedded in BSM Ul

Unprotected Resources

The following resources should remain unprotected:
« /mam-collectors
« /topaz/Charts

[topaz/images

« /topaz/Imgs/chartTemp
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If you are using a Load Balancer, you should also unprotect the following resources:
 /topaz/topaz_api/loadBalancerVerify_core.jsp

« /topaz/topaz_api/loadBalancerVerify _centers.jsp

Troubleshooting and Limitations

Platform Administration Guide

[topazl/js

/topaz/rfw/static
/topaz/services/technical/time
/topaz/static
/topaz/stylesheets

ltvblrest

/ucmdb-api

Example of URL with unprotected authentication
« Thefollowing URL is used by the TV Component:

https://<gateway server>/topaz/services/technical/time

Expected Result: the system displays the time in XML format without a request for

authentication.

Errors When Entering IDM-SSO Header in SSO Configuration Wizard

Make sure the correct header is used. Ask your Siteminder administrator to dump all headers and look
for one that matches what you expect to use. For example, if you want to use an email address as your
login username, look for a field containing only an email address. Or, for example, if it looks like HTTP_

SEA, remove HTTP_ from the name and use sea as the header name.

Verifying Correct User ID
To verify that you get the correct user ID with the header you provided, go to https://<HPBSM

server>/topaz/verifylDM.jsp?headerName=sea (if sea is your header).
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This section provides an overview to LDAP authentication and mapping.

Learn About

LDAP Authentication Overview

You can use an external LDAP server to store users' information (usernames and passwords) for
authentication purposes, instead of using the internal BSM service. You can also use the LDAP server
to synchronize BSM and LDAP users. For optimal performance, it is recommended that the LDAP
server be in the same subnet as the rest of the BSM servers. For optimal security, it is recommended to
either configure an SSL connection between the BSM Gateway Server and the LDAP server, or to have
BSM servers and the LDAP server on the same secure internal network segment.

Authentication is performed by the LDAP server, and authorization is handled by the BSM server.

You configure the LDAP server for authentication and user synchronization using the LDAP
Configuration Wizard. For details on the LDAP Configuration Wizard, see "LDAP Configuration
Wizard" on page 300

For details on securing communication between an LDAP server and your BSM server over SSL, see
"How to Secure Communication Between the LDAP Server and BSM Server Over SSL" on page 322

Mapping Groups

You map groups to enable user synchronization between LD+AP users and BSM users. The Group
Mapping feature is accessible through the Users and Permissions interface, by clicking the Group

Mappings 7 putton and selecting the unique domain name. This button is enabled only if the
following conditions are met:

« Thereis at least one enabled LDAP Configuration on the Authentication Management page.
« The user has administrator permissions.
Once user synchronization is enabled, the User Management interface has the following limitations:
« You cannot create a user.
« The User name and Login name fields for individual users are disabled.
» The Password field is invisible.

« You cannot manually assign users to groups using the Hierarchy tab.
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Note: Users who are not assigned to any group will appear at the Root (All) level, with the role
defined in Automatically Created User Roles, in Infrastructure Settings, under LDAP
Global Configuration. If this does not give you sufficient control of user permissions, see
"Achieving Finer Control over Default User Permission Assignments" on page 330.

Note: Some customers like the concept of automatic user creation but prefer to put users into
the appropriate BSM groups manually. However, as noted above, with user synchronization
enabled, manual group assignment is disabled in BSM.

To manually assign users to the appropriate BSM group when LDAP User Synchronization is
enabled, do the following:

1) Disable User Synchronization in Group Mappings.
2) Assign users to groups manually using the Hierarchy tab.

3) Re-enable User Synchronization in Group Mappings.

You can optionally map an LDAP group to multiple BSM groups, or multiple LDAP groups to a BSM
group.

When enabling the Group Mapping feature, you can log into BSM with any unique user attribute that
exists on the LDAP server (for example, an email address). For details, see "How to Modify the
Attribute Used to Log into BSM" on the next page.

Mixed Authentication Mode

Mixed authentication mode enables users to be authenticated in the external LDAP and internally in
BSM. This mode is relevant only when there is at least one LDAP configuration defined and enabled.

If a user logs in when this mode is enabled, BSM attempts to locate and authenticate the userin LDAP.
If BSM does not locate the userin LDAP, BSM attempts to locate and authenticate the user in the
internal BSM users database.

This functionality enables you to create temporary BSM users and integration users in BSM and not in
the external LDAP.

Note: Creating users only in the BSM database is not recommended since a user that exists only
in BSM is a less secure user than a user that exists in the LDAP database.

Note that in mixed authentication mode, administrators can only modify user parameters in the User
Management interface for users who do not exist in the LDAP database.
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Tasks

How to Modify the Attribute Used to Log into BSM
This task describes how to modify the LDAP attribute with which you want to log into BSM.

1. Navigate to Admin > Platform > Users and Permissions > Authentication Management.
2. Click the Edit button under LDAP Configuration to activate the LDAP Configuration Wizard.
3. Navigate to the LDAP General Configuration page, and click the Advanced button.

4. Modify the User unique ID attribute to the attribute you want to log in with, as it appears on the
LDAP server.

How to Secure Communication Between the LDAP Server and BSM Server Over
SSL

1. If the LDAP server requires a secure connection perform the following steps:
a. Obtainroot CA certificate from the Certificate Authority that issued LDAP server certificate.
b. Importitinto the truststore of JVM on each BSM gateway (for both JRE and JREG64).

c. Restart the BSM gateway servers.

Example

cd C:\HPBSM\JRE64\bin

keytool -import -trustcacerts -alias myCA -file c:\RootCA.cer -keystore
..\lib\security\cacerts

cd C:\HPBSM\JRE\bin

keytool -import -trustcacerts -alias myCA -file c:\RootCA.cer -keystore
..\lib\security\cacerts:

2. Verify that communication between the LDAP server and the BSM server is valid over SSL, using
the LDAP Configuration Wizard, as follows:

a. Navigate to the LDAP Configuration Wizard by selecting Admin > Platform > Users and
Permissions > Authentication Management, click Edit under LDAP Configuration and
navigate through the LDAP Configuration Wizard to the LDAP General page.

b. Enterthe URL of your LDAP server, according to the following syntax: Idaps://machine_
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name:port/<scope>??sub.

Ensure that the protocol is Idaps://, and the port number is configured according to the SSL
port, as configured on the LDAP server (default is 636).

c. Test your configuration on the LDAP General Configuration page by entering the UUID and
password of a known LDAP user in the relevant fields. Click Test to authenticate the user. For
details, see "LDAP General Configuration Page" on page 301.

How to Enable Mixed Authentication Mode
From the BSM Console:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations > LDAP Global Configuration.
3. Enable Mixed Authentication mode.
From the JMX console:
1. Enterthe URL of the JMX console (http://<server name>:29000/) in a web browser.

2. Enteryour JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. Locate Foundations > service=users-remote-repository.

4. Setthe IsMixedAuthenticationModeEnabled parameter to True.

Troubleshooting and Limitations

Secure Connection to LDAP Server
When setting the LDAP server URL, you see a red cross containing the following error:

ERROR - sun.security.validator. ValidatorException: PKIX path building failed:
sun.security.provider.certpath.SunCertPathBuilderException: unable to find valid certification path to
requested target

This means that you have not yet configured a secure connection to the LDAP server.

For details about securing a connection to the LDAP server, see "How to Secure Communication
Between the LDAP Server and BSM Server Over SSL" on the previous page.
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Case Sensitive Login

When BSM is installed with an Oracle database and User Synchronization is enabled with an LDAP
Active Directory server, ensure that you log into BSM with the correct-case UID (uppercase or
lowercase), as configured on the LDAP server. This is because while the Oracle database is case
sensitive, the LDAP Active Directory is case insensitive, and logging in with an incorrect case UID can
create undesirable results.

For example, if a user called testuser exists on the LDAP Active Directory server and logs into BSM,
he is automatically created as BSM user testuser, who can be assigned permissions in the BSM User
Management interface. If you then log into BSM as Testuser, the LDAP Active Directory server sends
an acknowledgment that the user exists (because Active Directory is case insensitive) and he is
allowed entry to BSM. However, since the Oracle database does not identify this user as testuser
(because the Oracle database is case sensitive), the user Testuser is treated as a new user, without
the permissions that were assigned to testuser.

Empty User Fields

If when signing in to BSM with LDAP, the authentication is working, but the user fields are empty,
change the User display name attribute in Infrastructure Settings to displayName.

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundations > LDAP Global Configuration.

3. Under LDAP Global Configuration - LDAP Options for Classes and Attributes locate User
display name attribute and change the value to displayName.

Cannot Login to BSM with Administrator User Credentials

If LDAP contains an administrator user with the same login name as the BSM local administrator user,
the BSM local administrator user credentials will be overwritten by LDAP, and you will not be able to
login to BSM through this user if LDAP is disabled.

To enable users to login to BSM with local administrator user credentials when LDAP is disabled,
remove the administrator user from the LDAP database, and update the authentication users
parameters in the Users table in the BSM database.

Synchronizing Users

The user synchronization feature maps users from an LDAP server to users in BSM.
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Learn About

Mapping Users from LDAP Servers to BSM

Mapping users from an LDAP server to users in BSM simplifies the process of managing users for
BSM administrators, as all of the user management functions are done through the LDAP server.
Granting Permissions

It is recommended to grant permissions on the group level in BSM, and then nest users into groups
according to their desired permission level. If users are moved between LDAP groups, they are moved
between their corresponding mapped groups on the BSM server after logging into BSM.

Status of LDAP Users not in BSM

LDAP users who do not exist in, and log into, BSM, are created as BSM users. Their status is
determined as follows:

« Ifthe user belongs to a mapped LDAP group, she is automatically assigned to the BSM group that
is mapped to their LDAP group.

« If their group is not mapped to a BSM group, or if they do not belong to an LDAP group, they are
nested under the Root group and created as a BSM user with System Viewer permissions. Their
permissions and user hierarchy can be modified on the User Management interface.

LDAP User Management Process

The following flowchart displays the process of User Management when LDAP is enabled, as
performed by the BSM administrator and BSM itself when the user logs in:
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Matching the User Filter

For an LDAP user to log into BSM, he must match the criteria defined in the Users filter field on the
LDAP Advanced General Configuration dialog box in the LDAP Configuration Wizard. For details on the
LDAP General Configuration page, see "LDAP Vendor Attributes Dialog Box" on page 304.

Note: Be aware that any new LDAP user who satisfies the user filter will be created as a BSM
user on first login. Ask your LDAP administrator to help you narrow down the filter definition so that
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only appropriate users can gain access to BSM.

Synchronizing Users After Upgrading from a Previous Version of BSM

When upgrading from a previous version of BSM, User Synchronization becomes disabled by default.

For details on how to enable User Synchronization, see "How to Synchronize Users After Upgrading
from a Previous Version of BSM" on page 329.

Obsolete Users

Users that have been removed from the LDAP server are still displayed as BSM users, even though
they are no longer registered as LDAP users and cannot log into BSM. These users are called
Obsolete Users. For details on removing Obsolete Users from BSM, see "Synchronizing Users" on
page 324.

Tasks

How to Map Groups and Synchronize Users

1. Configure Group Filters on the LDAP Server for Mapping Groups

You can configure group filters on the LDAP Server for mapping groups using the LDAP
Configuration Wizard. For task details, see "LDAP Configuration Wizard" on page 300.

2. Create BSM Groups and Hierarchy

You create local groups in BSM with the appropriate roles to nest users into, and users adopt the
permission level of the group they are nested in. For task details, see "Groups/Users Pane" on
page 185.

3. Map LDAP Groups to BSM Groups
You map user groups on the LDAP server to groups in BSM.
Caution: Administrators must create an account in BSM with superuser permissions after
enabling the LDAP server but before configuring group mapping and user synchronization.
Without a BSM account with superuser permissions, you cannot configure group mapping

and user synchronization because only a user with superuser permission can access the
User Manager page.

a. Onthe Users and Permissions interface, navigate to the Groups/Users pane, click the Group

Mappings %77 putton and select the unique domain name to open the Group Mappings dialog
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box.

b. Inthe Remote Corporate Directory pane, select a remote LDAP server group and click

Assign Groups.

The BSM groups mapped to the selected LDAP group are displayed in the BSM Local
Directory for Remote Group: <group name> pane.

Existing mapping of all LDAP groups is displayed in the Local Groups to Remote Groups

Mapping pane.

Mapping local groups to remote groups:

Group Mappings

Map local groups to remote groups by selecting a group inthe remote groups tree and clicking on the "Assign Groups" button.

=
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4. Enable User Synchronization

Select this option to enable User Synchronization upon logging into BSM, to synchronize LDAP
users with BSM users. You enable synchronization of user groups on the LDAP server with user
groups in BSM by selecting the Enable User Synchronization check box in the Group

Mappings dialog box.

m Before enabling user synchronization, ensure that you have either created a superuser
account in BSM that matches your own LDAP user login, or mapped an appropriate LDAP
group to a BSM group that has the superuser role assigned toit. If you have not done so,
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and log out of BSM after enabling LDAP but before group mapping is completed and user
synchronization is enabled, the designated BSM superuser account will be locked out of
BSM.

m Ensure that you have mapped LDAP groups to BSM groups before selecting this check
box. If you have not performed Group Mapping, all users are nested under the Root group
and are assigned System Viewer permissions.

m Todisable user synchronization and enable management of users through the User
Management interface in BSM, clear the Enable User Synchronization check box in the
User Management > Group Mappings dialog box.

For details on synchronizing users, see "LDAP Group Mapping Configuration Page" on page 304.

How to Synchronize Users After Upgrading from a Previous Version of BSM

1. If you have upgraded from a version earlier than BSM 7.50, ensure that the Enable User
Synchronization check box on the User Management > Group mappings dialog box is
cleared.

2. Ensure that LDAP groups have been mapped to BSM groups and enable User Synchronization.
For details on performing this task, see "How to Map Groups and Synchronize Users" on
page 327.

How to Delete Obsolete Users

This task describes how to delete BSM users who no longer exist on the LDAP server. This option is
enabled only if the following conditions are met:

o The needed LDAP Configuration is enabled on Authentication Management page.
o The user has Delete permissions.
To delete obsolete users:

1. Select Admin > Platform > Users and Permissions, click the click the Delete Obsolete

]

Users - button and select the unique domain name.

2. Select the user you want to delete.
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Achieving Finer Control over Default User Permission
Assignments

If you need a default group mapping for all users who do not fit into any of the currently mapped groups,
and the default BSM user role (as defined in the infrastructure setting Automatically Created User
Roles under LDAP Configuration) provides insufficient granularity, use the Dynamic LDAP group
feature in BSM.

Request that your corporate LDAP server administrator create a dynamic LDAP group based on the
same user filter that you specified in the BSM LDAP configuration.

This user filter automatically populates and maintains members of the dynamic group in your corporate
LDAP.

In BSM, create a local group with the roles and permissions that you require by default. Map the
dynamic group created in your corporate LDAP to the BSM local group. Any user who is allowed to
enter BSM but does not belong to any other mapped group will belong to the default group. Without
such a default group, these users would be created at the root level in the User Management tree and
their permissions would need to be handled individually.

To enable dynamic LDAP groups in BSM, go to Infrastructure Settings, select the LDAP
Configuration context and set Enable Dynamic Groups to true. The change takes effect
immediately.

Before dynamic groups are enabled, List Users, in the Group Mappings dialog box under Users and
Permissions, will not display members of the dynamic group.

Note: Because corporate LDAP groups can be very large, List Users will display only up to the
first 100 users. To see the whole user list or search for specific users, use a standard LDAP
browser.
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LW-SSO is a method of access control that enables a user to log on once and gain access to the
resources of multiple software systems without being prompted to log on again. The applications inside
the configured group of software systems trust the authentication, and there is no need for further
authentication when moving from one application to another.

The information in this section applies to LW-SSO version 2.4.
o LW-SSO Token Expiration

The LW-SSO Token's expiration value determines the application's session validity. Therefore, its
expiration value should be at least the same value as that of the application session expiration
value.

o Recommended Configuration of the LW-SSO Token Expiration

Each application using LW-SSO should configure token expiration. The recommended value is 60
minutes. For an application that does not require a high level of security, it is possible to configure a
value of 300 minutes.

e GMT Time

All applications participating in an LW-SSO integration must use the same GMT time with a
maximum difference of 15 minutes.

o Multi-domain Functionality
Multi-domain functionality requires that all applications participating in LW-SSO integration
configure the trustedHosts settings (or the protectedDomains settings), if they are required to

integrate with applications in different DNS domains. In addition, they must also add the correct
domain in the Iwsso element of the configuration.

o Get SecurityToken for URL Functionality

To receive information sent as a SecurityToken for URL from other applications, the host
application should configure the correct domain in the lwsso element of the configuration.

L W-SS0 System Requirements

The following table lists LW-SSO configuration requirements:
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Application Version Comments
Java 1.5 and higher
HTTP Sevlets API 2.1 and higher

Internet Explorer 6.0 and higher Browser should enable HTTP session cookie and HTTP
302 Redirect functionality

FireFox 2.0 and higher Browser should enable HTTP session cookie and HTTP
302 Redirect functionality

JBoss JBoss 4.0.3
Authentications
JBoss 4.3.0
Tomcat Standalone
Authentications Tomcat 6.0.29
Standalone

Tomcat 5.0.28

Standalone
Tomcat 5.5.20

Acegi Acegi 0.9.0
Authentications i
Acegi1.0.4
Spring Security Spring Security
Authentication 2.0.4
Web Services Axis 1-1.4
Engines .
Axis 2-1.2
JAX-WS-RI 2.1.1

LW-5S0 Security Warnings

This section describes security warnings that are relevant to the LW-SSO configuration:

« Confidential InitString parameter in LW-SSO. LW-SSO uses Symmetric Encryption to validate
and create a LW-SSO token. The initString parameter within the configuration is used for
initialization of the secret key. An application creates a token, and each application using the same
initString parameter validates the token.

Caution:

HP Business Service Management (9.26) Page 332 of 397



BSM Platform Administration Guide
Chapter 33: LW-SSO Authentication — General Reference

m [t is not possible to use LW-SSO without setting the initString parameter.

m The initString parameter is confidential information and should be treated as such in terms
of publishing, transporting, and persistency.

= The initString parameter should be shared only between applications integrating with each
other using LW-SSO.

m The initString parameter should have a minimum length of 12 characters.

« Level of authentication security. The application that uses the weakest authentication framework
and issues a LW-SSO token that is trusted by other integrated applications determines the level of
authentication security for all the applications.

It is recommended that only applications using strong and secure authentication frameworks issue an
LW-SSO token.

« Symmetric encryption implications. LW-SSO uses symmetric cryptography for issuing and
validating LW-SSO tokens. Therefore, any application using LW-SSO can issue a token to be
trusted by all other applications sharing the same initString parameter. This potential risk is
relevant when an application sharing an initString either resides on, or is accessible from, an
untrusted location.

« User mapping (Synchronization). The LW-SSO framework does not ensure user mapping
between the integrated applications. Therefore, the integrated application must monitor user
mapping. We recommend that you share the same user registry (as LDAP/AD) among all integrated
applications.

Failure to map users may cause security breaches and negative application behavior. For example,
the same user name may be assigned to different real users in the various applications.

In addition, in cases where a user logs onto an application (AppA) and then accesses a second
application (AppB) that uses container or application authentication, the failure to map the user will
force the user to manually log on to AppB and enter a user name. If the user enters a different user
name than was used to log on to AppA, the following behavior can arise: If the user subsequently
accesses a third application (AppC) from AppA or AppB, then they will access it using the user
names that were used to log on to AppA or AppB respectively.

« ldentity Manager. Used for authentication purposes, all unprotected resources in the ldentity
Manager must be configured with the nonsecureURLSs setting in the LW-SSO configuration file.

L W-SSO Troubleshooting and Limitations

Known Issues

This section describes known issues for LW-SSO authentication.
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« Security context. The LW-SSO security context supports only one attribute value per attribute
name.

Therefore, when the SAML2 token sends more than one value for the same attribute name, only one
value is accepted by the LW-SSO framework.

Similarly, if the IdM token is configured to send more than one value for the same attribute name,
only one value is accepted by the LW-SSO framework.

o Multi-domain logout functionality when using Internet Explorer 7. Multi-domain logout
functionality may fail when the browser used is Internet Explorer 7 and the application is invoking
more than three consecutive HTTP 302 redirect verbs in the logout procedure.

In this case, Internet Explorer 7 may mishandle the HTTP 302 redirect response and display an
Internet Explorer cannot display the webpage error page instead.

As a workaround, it is recommended to reduce, if possible, the number of application redirect
commands in the logout sequence.

Limitations

Note the following limitations when working with LW-SSO authentication:
« Client access to the application.
If a domain is defined in the LW-SSO configuration:

m The application clients must access the application with a Fully Qualified Domain Name (FQDN)
in the login URL, for example, http://myserver.companydomain.com/\WebApp.

m LW-SSO cannot support URLs with an IP address, for example, http://192.168.12.13/WebApp.
m LW-SSO cannot support URLs without a domain, for example, http://myserver/\WWebApp.

If a domain is not defined in the LW-SSO configuration: The client can access the application
without a FQDN in the login URL. In this case, an LW-SSO session cookie is created specifically
for a single machine without any domain information. Therefore, the cookie is not delegated by the
browser to another, and does not pass to other computers located in the same DNS domain. This
means that LW-SSO does not work in the same domain.

o LW-SSO framework integration. Applications can leverage and use LW-SSO capabilities only if
integrated within the LW-SSO framework in advance.

o Multi-Domain Support.
= Multi-domain functionality is based on the HTTP referrer. Therefore, LW-SSO supports links

from one application to another and does not support typing a URL into a browser window,
except when both applications are in the same domain.
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m The first cross domain link using HTTP POST is not supported.

Multi domain functionality does not support the first HTTP POST request to a second application
(only the HTTP GET request is supported). For example, if your application has an HTTP link to
a second application, an HTTP GET request is supported, but an HTTP FORM request is not
supported. All requests after the first can be either HTTP POST or HTTP GET.

m LW-SSO Token size:

The size of information that LW-SSO can transfer from one application in one domain to another
application in another domain is limited to 15 Groups/Roles/Attributes (note that each item may
be an average of 15 characters long).

= Linking from Protected (HTTPS) to non-protected (HTTP) in a multi-domain scenario:

Multi domain functionality does not work when linking from a protected (HTTPS) to a non-
protected (HTTP) page. This is a browser limitation where the referrer header is not sent when
linking from a protected to a non-protected resource.

= Third-party cookie behavior in Internet Explorer:

Microsoft Internet Explorer 6 contains a module that supports the "Platform for Privacy
Preferences (P3P) Project," meaning that cookies coming from a Third Party domain are by
default blocked in the Internet security zone. Session cookies are also considered Third Party
cookies by IE, and therefore are blocked, causing LW-SSO to stop working.

To solve this issue, add the launched application (or a DNS domain subset as *.mydomain.com)
to the Intranet/Trusted zone on your computer (for example, in Microsoft Internet Explorer, select
Menu > Tools > Internet Options > Security > Local Intranet > Sites > Advanced), which
causes the cookies to be accepted.

Caution: The LW-SSO session cookie is only one of the cookies used by the Third Party
application that is blocked.

« SAML2 token.
= Logout functionality is not supported when the SAML2 token is used.

Therefore, if the SAML2 token is used to access a second application, a user who logs out of the
first application is not logged out of the second application.

m The SAML2 token's expiration is not reflected in the application's session management.

Therefore, if the SAML2 token is used to access a second application, each application's session
management is handled independently.

« JAAS Realm. The JAAS Realm in Tomcat is not supported.
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« Using spaces in Tomcat directories. Using spaces in Tomcat directories is not supported.

It is not possible to use LW-SSO when a Tomcat installation path (folders) includes spaces (for
example, Program Files) and the LW-SSO configuration file is located in the common\classes
Tomcat folder.

« Load balancer configuration. A load balancer deployed with LW-SSO must be configured to use
sticky sessions.
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This page enables you to edit, delete, resume, or pause scheduled reports.

To access | Select Admin > Platform > Report Scheduling

Important You cannot create a new schedule from the Report Schedule Manager. For details on
information = creating schedules, see How to Schedule a Report in the BSM User Guide.

Caution: Scheduled reports place pressure on the system and can cause performance issues for
users who are logged on. When possible, you should schedule reports for off hours when fewer
users access the system. If your system does not have off hours, you should stagger reports at
different times of the day to minimize the number of reports running simultaneously.

User interface elements are described below:

Ul Element

(A-2) Description

Opens the Edit Schedule for the <Report Name> dialog box enabling you to edit the
selected schedule. For details, see Creating a New Schedule Dialog Box in the BSM
User Guide.
Note: This dialog box enables you only to edit an existing schedule - you create a new
schedule from the Report Manager interface. For details, see Creating a New
Schedule Dialog Box in the BSM User Guide.

@’g Deletes the selected schedule.

Resumes the selected schedule, this button is only available if the selected report has
been paused.

)

Pauses the selected schedule.
Refreshes the Report Schedule Manager page.

Resets the width of the columns to the default setting.

B O B

Enables you to select columns to be visible in the table.

=
B

Generation = The time (in the indicated time zone) that the schedule is to be generated.
Time
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Ul Element
(A-2) Description

Recipients = The individuals configured in the Report Manager to receive the report or report item at
scheduled intervals. For details on configuring Schedules, see Creating a New
Schedule Dialog Box in the BSM User Guide.

Recurrence The recurrence pattern for the selected schedule.

Report The name of the report for which the schedule is configured.
Name
Report The type of report for which the schedule is configured.
Type
Status The status of the schedule. Possible values are:

« Active

« Paused
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BSM alerts proactively inform you when predefined performance limits are breached, by triggering
alerts.

For task details, see "How to Set Up an Alert Delivery System" on page 342.

Alert Recipients

Alerts can be configured to send notification to specified recipients. For task details on configuring
recipients, see "Recipient Management" on page 269.

Notification Template

For each recipient, you can specify the notification method (any combination of email, pager, and/or
SMS) and the template to use for alert notices. You can also create a notification schedule for the
alerts. For details, see "How to Configure EUM Alerts Notification Templates" on page 360.

Alert Schemes

In each alert scheme, you define a unique set of alert properties. After you create an alert scheme, you
view and edit it in the appropriate Alerts user interface. For detailed tips and guidelines, see "Planning
for Effective Alert Schemes" on page 342.

You can configure alerts and assign recipients to the alerts for:

« Cls in a view. Cl Status alerts are triggered by a pre-defined status change for the selected
configuration item (Cl) detected by the Business Logic Engine. For details, see Cl Status Alerts
Administration in the BSM User Guide.

« HP Service Manager automatically opens incidents when a Cl Status alert is triggered in BSM. For
details, see HP Service Manager in the BSM section of the Integrations tab in the HP Software
Integrations site.

o SLAs. SLA status alerts are triggered by changes to an SLA's key performance indicator status.
For details, see SLA Alerts Administration in the BSM User Guide.

o EUM alerts. EUM alerts are triggered when pre-defined conditions, such as transaction response
time, availability, success or failure, or completion time, are reached. For details, see End User
Management Alerts Administration in the BSM User Guide.

Open Events in OM

You can automatically open events in OM, when a Cl Status alert, an SLA alert, oran EUM alert is
triggered in BSM. For details, see Operations Manager in the BSM Platform section in the HP Software
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Integrations site.

Alert History

You can view the history of the alerts in the following:

« CI Status Alerts Report tab. Enables you to list all of the CI Status alerts that were triggered
during the specified time range. For details, see Configuration Item Status Alerts Report in the BSM
User Guide.

« SLA Alerts Report tab. Enables you to list all of the Service Level Management alerts that were
triggered during the specified time range. For details, see Alerts Log Report in the BSM User Guide.

« EUMAIlerts Report tab. Enables you to access the following reports:

= Alert Log report. Enables you to track all the details for the EUM alerts sent by BSM during the
specified time range. For details, see Alerts Log Report in the BSM User Guide.

= Alert Count Over Time report. Enables you to display an overview of the frequency of alerts.
For details, see Alerts Count Over Time Report in the BSM User Guide.

Delivery of Alerts

If the online components are experiencing downtime, the Alerts application makes sure that the data is
stored in the bus for one hour by default. After the components are back online, the Alerts engine
generates alerts from data in the bus.

Alerts and Downtime

When you configure a Cl Status alert, downtime can affect the Cls and skew the Cl's data.

When you configure an EUM alert scheme for Cls whose status is based on data from Business
Process Monitor or SiteScope data sources, downtime can affect the Cls and skew the Cl's data.

You may decide to trigger a Cl Status alert or an EUM alert during downtime or not. For concept details
about downtime, see "Downtime Management Overview" on page 370.

To specify how to handle the Cl Status alerts and the EUM alerts during downtime, select Admin >
Platform > Downtime, and select one of the following options:

« Take no actions
« Suppress alerts and close events
« Enforce downtime on KPI calculations; suppress alerts and close events

« Enforce downtime on Reports and KPI calculations; suppress alerts and close events
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« Stop active monitoring (BPM & SiteScope); enforce downtime on Reports & KPI
calculations; suppress alters and close events (affects all related SLASs)

CI Status or EUM alerts for Cls that are in a scheduled downtime are not sent for all the options listed
above apart from the Take no action option.

The Cl alert is sent even if one of the options listed above is selected (apart from the Take no action
option), if you configured the alert to be triggered when the status of the Cl changes to the Downtime
status. For user interface details, see General Page in the BSM User Guide.

For task details, see "How to Set Up an Alert Delivery System" below.

For user interface details, see "Downtime Management Page" on page 376.

Planning for Effective Alert Schemes

Before creating alert schemes, you should consider how to most effectively alert users to performance
issues. The information described below can assist you with effective alert planning.

Note: HP Professional Services offers best practice consulting on this subject. For information on
how to obtain this service, contact your HP representative.

« When creating alert schemes, categorize alerts by severity. Create critical alerts for events that
require immediate corrective action (for example, transaction failure, or excessive response times
for critical transactions). Create non-critical alerts for events that require early notification (for
example, slow response times).

« Determine the users that receive the different types of alerts, and consider the alert delivery method
that best suits the alert type. For example, pager delivery as opposed to email delivery might be
more effective for critical alerts. When determining the delivery method, take the time of day into
account as well. For example, email alerts might not be effective during non-business hours.

« Set BSMto alert you to a recurring problem, not one-time events. Recurring alerts are the most
accurate indicator of problems with your application. For example, as a rule, you should compare
the number of recurring events to the number of Business Process Monitor locations from which
you are monitoring. For example, if you had three failures, but you were monitoring from 100
locations, it would not be as critical as if you had five failures in all five locations.

How to Set Up an Alert Delivery System

This task and the associated flowchart describe how to set up a system for delivering alerts to
recipients.

Setting Up an Alert Delivery System - Flowchart
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Prepare detailed plan of recipients and
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Plan the alert recipient requirements

Before you start, we recommend that you:

« List the required recipients of alerts, including contact information and required delivery method to
the recipient (email, SMS, pager). For suggestions on how to proceed, see "Planning for Effective

Alert Schemes" on the previous page.

« Map out the types of alerts you plan to deliver. For details on the types of alerts, see "Result - define
the alerts schemes" on page 345.

Specify the appropriate user permissions

Specify the appropriate user permissions for the following. To set these permissions:
1. Select Admin > Platform > Users and Permissions > User Management.
2. Create or edit a user, and open the Permissions tab.

3. Select the required option from the Context drop-down list as described below.

« The EUM alerts.
You can specify that a user can have a View or Full Control permission per application.
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= Inthe End User Management context, select Business Service Management >
Applications > <Application> > Alert

You must also specify the permission for the CEM event template.
= Inthe End User Management context, select Alert - Notification template.

« The CI Status alerts.

You can specify that a user can have a Change, View, Delete, or Full Control permission per
view.

= Inthe RTSM context, select Business Service Management > Views > <view_name>.

o The SLA alerts.

You can specify that a user can have an Add, Change, View, Delete, or Full Control permission
per SLA.

= Inthe Service Level Management context, select Business Service Management > SLAs >
<sla_name> context.

« The alert external actions (Run executable, Send SNMP trap, or Log to Event Viewer).

You can specify that a user can have a Change or Full Control permission at the global level.

= Inthe Platform context, select Business Service Management > Run executable, Send
SNMP trap, or Log to Event Viewer contexts separately.

« The notification template you can specify for the alerts.

You can specify that a user can have an Add, Change, View, Delete, or Full Control permission
for the template.

= [nthe End User Management context, select Business Service Management > System
Recipient Template context.

These permissions are defined at the global level.

For user interface details, see "Operations" on page 194.

Specify how alerts are triggered during downtime

When you configure a Cl Status alert oran EUM alert scheme for Cls whose status is based on data
from Business Process Monitor or SiteScope data sources, downtime can affect the Cls and skew the
Cl's data.

You may decide to trigger a Cl Status alert or an EUM alert during downtime or not. To specify how to
handle the CI| Status alerts and the EUM alerts during downtime, select Admin > Platform >
Downtime, and select one of the available options.

For concept details, see "Alerts and Downtime" on page 341.

For user interface details, see "Downtime Management Page" on page 376.
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Customize the alerts triggering system, alerts system health, and event
handling characteristics — optional

Customize the alerts triggering system, system health, and event handling characteristics. For more
information, see "How to Customize Alerts" on the next page.

Define recipients

On the Recipients page, you define system recipients for alerts (except SiteScope alerts). You can
specify email, SMS, or pager delivery methods. If required, enter specific alert delivery schedules (for
example, recipients who receive alerts during business hours as opposed to evenings and weekends).
For more information, see "Recipient Management" on page 269.

Create custom notification templates — optional

If required, when defining EUM alerts, you have the option to create custom notification templates that
customize the format and information included in alert emails. For more information, see "How to
Configure EUM Alerts Notification Templates" on page 360.

Set up to open an event in Operations Manager and Operations Management
when an alert is triggered in BSM

You can set up to open events in Operations Manager and Operations Management when an alert is
triggered in BSM. For details, see Operations Manager in the BSM section of the Integrations tab in the
HP Software Integrations site.

Result - define the alerts schemes

You have planned the alert schemes, set up the relevant recipients, customized the alerts general
settings and customized the notification templates. You can now define the alert schemes you require:

« CI Status Alerts. Define Cl Status alerts as required to alert recipients to KPI status changes for
specific Cls and KPIs being monitored in Service Health. For more information, see How to Create
a Cl Status Alert Scheme and Attach it to a Cl in the BSM User Guide.

o SLA Alerts. Define SLA alerts as required to alert recipients to changes in the current and
forecasted status for service agreements. For more information, see How to Define an SLA Alert
Scheme in the BSM User Guide.

« EUM Alerts. Define EUM alerts as required to alert recipients to performance variance of Real

User Monitor entities or Business Process Monitor transactions. For more information, see How to
Create EUM Alert Schemes in the BSM User Guide.
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How to Customize Alerts

Note: All the steps in the task are optional and can be performed in any order.
This task describes the customization you can perform for Cl Status, SLA, and EUM alerts.
To customize alerts:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Select Foundation > Alerting and modify the required settings as described below.

Modify the way events are handled

You can modify the following parameters in the Event handling area:

Parameter Does the Following

Acceptable The system discards alerts after the number of minutes defined here.

event delay

(minutes)

Alert If this option is set to true, the system does not reset the alert persistent state when an
persistency = application goes into Downtime. This means that the system retains data and uses it
during when generating alerts after the Downtime ends. Applies to EUM alerts only.
Downtime

Calculation | If this option is set to true, if the system goes down, the system retains data and uses
persistency it when creating alerts when the system comes back up.

Modify the Alerting System Health parameters
You can modify the following parameters in the System Health monitors area:
Parameter Does the Following

Error threshold for The maximum number of messages that can wait in the alert queue of the
the notification notification queue monitor. When the maximum is reached the notification
queue monitor queue monitor status changes to error.

Error threshold for The maximum number of messages that can wait in the alert queue of the alert
the alert queue queue monitor. When the maximum is reached the alert queue monitor status
monitor changes to error.
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Parameter Does the Following

Warning threshold = The maximum number of messages that can wait in the alert queue of the
for the notification notification queue monitor. When the maximum is reached the notification
gueue monitor gueue monitor status changes to warning.

Warning threshold  The maximum number of messages that can wait in the alert queue of the alert
for the alert queue queue monitor. When the maximum is reached the alert queue monitor status
monitor changes to warning.

Modify the alerts triggering defaults

You can modify the following parameters in the Triggered alerts area:

Parameter Does the Following

Command line The default timeout for an action (by default 30 seconds) after which a command
execution line alert action is not executed.

timeout

(seconds)

Command line When specifying a command in the Executable Files action of an EUM alert, you

substitution pairs | can use special tokens that are replaced with actual values when the command
is prepared for execution. Those values might include a double quote (") or other
tokens that may cause the resulting command line to be inappropriately
interpreted by the operating system. To avoid this misinterpretation, you can
modify the default value of the Command line substitution pairs infrastructure
setting, as follows:

« Each pairis written using the |a|b| format, the first character (a) is replaced
by the second (b).

« Multiple pairs are separated by a comma (,).
Forexample: |a|b|,|c|d], |e]|f].

Default EXE The default path to the default executable for EUM alerts.
path
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Parameter Does the Following

o Default The default SNMP Trap host address. You can enter the IP address or server
SNMP Port name in the Default SNMP Target Address parameter, and the port number in
the Default SNMP Port parameter.

o Default
SNMP Target For SNMP v3 traps you must enter the following security settings:

Address
o Default SNMP v3 user name (HPBSMUSER by default)

o Default I I
SNMP v3 o Default SNMP v3 authentication protocol (MD5, SHA, or no authentication)
username » Default SNMP v3 authentication passphrase

» Default . .
SNMP v3 » Default SNMP v3 privacy protocol (CBS-DES, or no privacy protocol)
authenticatio | petayit SNMP v3 privacy passphrase
n protocol

o Default

SNMP v3 You can specify only one SNMP target address. The default host address of the

authenticatio = SNMP trap appears automatically in the Enter host destination box in the

n passphrase Create New/Edit SNMP Trap dialog box. For details, see Create New/Edit
SNMP Trap Dialog Box in the BSM Application Administration Guide or Create

« Default SNMP Trap/Edit SNMP Trap Dialog Box in the BSM Application Administration
SNMP v3 Guide. If, when you create or edit an SNMP trap, you select the default host
privacy address and then modify it afterwards in the Infrastructure Settings, the address
protocol in all the SNMP traps you created are updated to the new default. Any alert that

. is sent causes the SNMP trap to be sent to the new default address.

« Default
SNMP v3 Note to HP Software-as-a-Service customers: You can set the default host
privacy address per customer by selecting a customer when you log in. The updated host

passphrase  address is defined only for the specific customer. You can also define a global
host address.

Default URL The default URL address for EUM alerts.

Enable alert If this option is set to true, alert dependencies are allowed between Cls.
dependencies

across Cls

Enable alert If this option is set to true, an alert is triggered by a specific condition, then the
timer reset condition that triggered the alert does not exist any more. If the condition that

triggered the alert occurs again before the end of time period specified in the
Acceptable events delay parameter ends, the alert is sent because the trigger
condition has reset the notification frequency timer. The default is false.

Enable logging to | If this option is set to true, alerts and notifications are not logged in the Profile
DB database. The default is false.
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Parameter

Enable
notifications and
actions

« Legacy
SNMP Port

« Legacy
SNMP Target
Address

o Legacy
SNMP v3
user name

o Legacy
SNMP v3
authenticatio
n protocol

« Legacy
SNMP v3
authenticatio
n passphrase

o Legacy
SNMP v3
privacy
protocol

« Legacy
SNMP v3
privacy
passphrase

Notification
execution retries

Notification URL

Does the Following

If this option is set to true, the alert engine is able to perform actions and send
notifications. This customization is available only for EUM alerts. The default is
true.

The default SNMP Trap host address for EUM alerts. Modify the default SNMP
trap host address, by entering the IP address or server name in the Default
SNMP Target Address parameter, and the port number in the Default SNMP
Port parameter.

For SNMP v3 traps you must enter the following security settings:
o Legacy SNMP v3 user name (HPBSMUSER by default)
« Legacy SNMP v3 authentication protocol (MD5, SHA, or no authentication)
o Legacy SNMP v3 authentication passphrase
« Legacy SNMP v3 privacy protocol (CBS-DES, or no privacy protocol)
o Legacy SNMP v3 privacy passphrase

You can specify only one SNMP target address. The default host address of the
SNMP trap appears automatically in the Enter host destination box in the
Create New/Edit SNMP Trap dialog box. For details, see Create New/Edit
SNMP Trap Dialog Box in the BSM Application Administration Guide or Create
SNMP Trap/Edit SNMP Trap Dialog Box in the BSM Application Administration
Guide. If, when you create or edit an SNMP trap, you select the default host
address and then modify it afterwards in the Infrastructure Settings, the address
in all the SNMP trap you created are updated to the new default. Any alert that is
sent causes the SNMP trap to be sent to the new default address.

Note to HP Software-as-a-Service customers: You can set the default host
address per customer by selecting a customer when you log in. The updated host
address is defined only for the specific customer. You can also define a global
host address.

Specifies the number of retries of a notification. This customization is available
only for EUM alerts. By default, a notification is sent once. Change the default
using the Notification execution retries parameter. The number of retries that
is performed equals the number you specify plus one.

The URL embedded in the notifications.
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Parameter

Recipient
information
format in
template

SNMP alerts
charset

Symphony
request timeout
(seconds)

Wait interval
between retries
(seconds)

Does the Following

Use to modify how to display the recipient list in Emails or SMSs.You can assign
the following values:

« Address. Select this option to display the email address of the recipients in
the To field of Emails and SMS notifications.

For example, if you set Recipient information format in template to
Address and the template includes the following parameters:
To:<<Recipients>>, Profile Name: <<Profile Name>>, Severity:
<<Severity>>, then the Email would look as follows:

To:JSmith@example.com;MBrown@example.com
Profile Name: forAlert
Severity: Major

« Logical Name. Select this option to display the logical name of the recipients
in the To field of Emails and SMS notifications.

For example, if you set Recipient information format in template to
Logical Name and the template includes the same parameters as the
example above, then the Email is as follows:

To:John Smith, Mary Brown
Profile Name: forAlert
Severity: Major

The character set used to send SNMP alert traps. By default, the setting uses
the platform's default character set. If your operating system supports multi-byte
characters, it is recommended to use the "UTF-8" character set.

The number of seconds until an alert action times out.

The number of seconds between each attempt to execute a notification.

Modify the way alerts are sent by email

To modify the way email alerts are handled:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Select Foundation > Platform Administration.
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3. Inthe Alerts E-Mail Settings area, modify the following:

Parameter Does the Following

Password for authorized = The default password for authorized sending of email alerts.
email sending

SMTP server (Windows = The primary SMTP server used. In windows NT, set as <SMTPSVC> if

only) you want to send using the SMTP service.

SMTP server port The SMTP server port

(Windows only)

User for authorized The default user for authorized sending of email alerts. If not set, email
email sending alerts are sent without authorization

Modify the way alerts are sent by pager
To modify the way pager alerts are handled:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.
2. Select Foundation > Platform Administration.

3. Inthe Alerts Pager Settings area, modify the following:

Parameter Does the Following

Password for authorized = The default password for authorized sending pager alerts.
pager sending

SMTP server (Windows = The primary SMTP server used. In windows NT, set as <SMTPSVC> if

only) you want to send using the SMTP service.

SMTP server port The SMTP server port

(Windows only)

User for authorized The default user for authorized sending pager alerts. If not set, the
pager sending system sends pager alerts without authorization.

Modify the way alerts are sent by SMS
To modify the way SMS alerts are handled:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings.

2. Select Foundation > Platform Administration.
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3. Inthe Alerts SMS Settings area, modify the following:

Parameter Does the Following

Password for authorized = The default password for authorized sending SMS alerts.

SMS sending

SMTP server (Windows = The primary SMTP server used. In windows NT, set as <SMTPSVC> if
only) you want to send using the SMTP service.

SMTP server port The SMTP server port

(Windows only)

User for authorized The default user for authorized sending SMS alerts. If not set, the system
SMS sending send SMS alerts without authorization.

Modify the way notifications are handled

To modify the way notifications are handled:
1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings
2. Select Foundations > Platform Administration.

3. Inthe Platform Administration - Recipient Notification Service area, modify the following:

Parameter Does the Following

Alerts email sender = Used to modify the default sender email address used in emails. Use the

address parameter to modify the default value (HP_BSM_Alert_Manager) that
appears in the From field when BSM sends alerts is set when you install the
Data Processing Server.

Alternate SMTP Used to modify the alternate SMTP server:

server, (Windows

only) « A designated server with a defined port number. Enter a server name
Alternate SMTP for sending SMTP emails as the value in the Alternate SMTP server field
server port and enter a port number for the server in the Alternate SMTP server field.
(Windows only)

o Microsoft's SMTP services. Enter <SMTPSVC> as the value in the SMTP
server or Alternate SMTP server field.

Limitation: The following characters are invalid: _. -
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Parameter Does the Following

Email notifications  When an alert is triggered, recipients for the generated alert can be notified by
charset email, SMS, or pager messages. You can select one of the following
character sets:

o UTF-8. The default character set.
« 1S0-2022-JP.

Note to HP Software-as-a-Service customers: The settings described
in this section are per customer.

Email sender The name of the sender of alert emails.

If this value does not contain domain info, BSM will use <Email sender>@
<SMTP server> to send notification email.

If this value contains domain info, BSM will use <Email sender> to send
notification email.

You can enter a fake email address. However, If you need a reply to the
notification email, you must enter a real email address.

Enable recipient If this option is set to false, the system will not send email notifications.
notifications

Notification date The format used to display dates in notifications.
format

Pager notifications  The character set used to send pager notification messages You can select
charset one of the following character sets:

o UTF-8. The default character set.
o 1S0-2022-JP.

Note to HP Software-as-a-Service customers: The settings described in
this section are per customer.

Password for The default password for authorized message sending. If this option is not
authorized message = set, the system sends messages without authorization.
sending
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SMS notifications
charset

SMTP server
(Windows only)

SMTP server port
(Windows only)

SMTP server
socket connection
timeout (seconds)
(Windows only)

User for authorized
message sending
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Does the Following

The character set used to send SMS notification messages You can select
one of the following character sets:

o UTF-8. The default character set.
o 1S0-2022-JP.

Note to HP Software-as-a-Service customers: The settings described in
this section are per customer.

The primary SMTP server used. In windows NT, set as <SMTPSVC> if you
want to send using the SMTP service.

The SMTP server port

The default timeout (60 seconds) after which an SMTP server socket is
disconnected.

The default user for authorized message sending. If this option is not set, the
system sends messages without authorization.

How to Test Your Email Notification Configuration

The following provides instructions for testing your email notification configuration. Before beginning,
ensure that the Telnet Client is enabled on your Windows machines.

To test your email notification configuration:

From the command line in the DPS/GW, enter the following:

>telnet <your smtp server according to your BSM Infra Settings> <port defined in
your BSM Infra Settings>

>ehlo

>mail from: <mail from the sender. For example, name@hp.com>
>rcpt to: <mail from the receiver. For example, name@hp.com>

>data

><Whatever you want to write in the body of the email>

>.
>quit

For example:

>telnet smtp-xyz.hp.com 25

>ehlo

>mail from: john.smith@hp.com
>rcpt to: john.smith@hp.com
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>data

>Whatever I want to write here (this is the body of the email)
>,

>quit

Alert Logs

You can use the following logs to debug the Cl Status, SLA, and EUM alerts.

Path to Log and
to Properties File for Log

Alert Type Level Setup Description

All alerts Log: <BSM_data processing_ Alerts and notifications handling in the
server>\log\alerts\ MercuryAs process
alerts.ejb.log

Setup: <BSM_data_
processing_server>\conf\
core\Tools\log4j\EJB\
alerts.properties

Log: <BSM_Gateway _ For all alert reports
server>\log\alerts\
alerts.reports.log

Setup: <BSM_Gateway_
server>\conf\core\
Tools\log4j\EJB\
alerts.properties
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Alert Type

CI Status alerts
and SLA alerts

Path to Log and
to Properties File for Log
Level Setup

Log: <BSM_data_processing_
server>\log\

marble_worker _
1\status.alerts.log

Setup: <BSM_data_
processing_server>\conf\
core\Tools\log4j\marble_
worker\
cCialerts.properties

Log: <BSM_data_processing__
server>\log\

marble_worker_
1\status.alerts.downtime.log

Setup: <BSM_data
processing_server>\conf\
core\Tools\log4j\marble_
worker\
acialerts.properties

Log: <BSM_Gateway
server>\log\alerts\
alertui.log

Setup: <BSM_Gateway
server>\conf\core\
Tools\log4j\EJB\
alerts.properties

HP Business Service Management (9.26)

Description

Alert init and calculation in the MAR Business
Logic Engine worker process

Alert downtime handling in the MAR Business
Logic Engine worker process

Alert administration
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Alert Type

EUM alerts

Path to Log and
to Properties File for Log
Level Setup

Log: <BSM_data_processing_
server>\log\alerts\
alert.rules.log

Setup: <BSM data
processing_server>\confi\core\
Tools\log4j\marble_worker\
alerts-rules.properties

Log: <BSM_data_processing_
server>\log\alerts\
alerts.rules.init.log

Setup: <BSM_data_
processing_server>\confi\core\
Tools\log4j\marble_worker\
alerts-rules.properties

Log: <BSM_data_processing_
server>\log\alerts\
alerts.downtime.log

Setup: <BSM _data
processing_server>\conf\
core\Tools\log4j\marble_
worker\
alerts-rules.properties

Description

Alert calculation in the MAR Business Logic
Engine worker process

Alert initialization in the MAR Business Logic
Engine worker process

Alert downtime handling in the MAR Business
Logic Engine worker process

Note: When you modify a log properties file on one of the BSM processing servers, it affects only
the logs on this BSM processing server.

Alert Details Report

This report displays the triggering information that is available for the alert, including the actual
conditions at the time of the alert.

The following is an example of the Alert Details report.
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Alert Details
Time: 9/4/08 7:05 PM
Sewverity: Critical

Alert Name: Event.Fail

Alert Action: Send E-mail to: sanity_recipient:

Alert Actions Status

No actions for the alert.

Alert Me=s=zage

Profile Name: Default Client_SanityBPM_1
Sewvarity: Critical

Alert Name: Event.Fail

Trigger Condition:

Transactions failed

Current Description:

Transaction tx_2_failed failed.

on Thu Sep 04 7:05:42 PM 2008 (+0300)

User Message: N/A

Triggered at location "labmibac22_to_labmiamrnd42z_2"

Triggered by host "labmibac2z_to_labmiamrnd4z_2" (Group "Groupl")
Triggerad during run of script "t=_fail" (Transaction "t<_2_failed")

Transaction Error Message: 1.Actionl.c{15): Error: error message for tx_2 failed

Mercury Application Management Web Site URL: Mercury AM URL

To access Click E in the Configuration Item Status Alerts page, SLA Status Alerts page, or
Alerts Log reports.
Important For details about C| Status Alerts, see Configuration Item Status Alert

information Notifications Report in the BSM User Guide.

For details about SLA Status Alerts, see SLA Status Alert Notifications in the

BSM User Guide.

For details about EUM alerts, see Alert Details in the BSM User Guide.
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Troubleshooting and Limitations

This section describes troubleshooting and limitations for alerts.
Emails Are Not Received by Recipients When an Alert Should Have Been Triggered

If emails are not received by recipients, check the following possibilities:
« The alert definition is not as expected. Check the alert definition in the relevant alert administration.

« The data does not behave as expected so the alert triggering condition might not exist. Check the
alert calculation log or check the specific data origin logs and reports. For details, see "Alert Logs"
on page 355.

« There might be a connection problem with the SMTP email server. To check if the server works,
run telnet <smtp_server_host_name_or_IP_nbr> 25.

« The email address of the recipient might not be valid. Examine the recipient definition in the user
interface, and manually send an email to the recipient to check the address's validity.

« Therecipient considers the alert email as spam. You might have to ask the recipient's administrator
to reconfigure the spam filter.
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To determine the contents and appearance of the EUM alert notices, you can select predefined
templates or configure your own template for notifications.

Alerts notification templates specify the information that BSM includes when it sends various types of
alert notices. The available default templates are pre-configured with selected parameters for each
section of the alert notice. For details on the information included in the default templates, see
"Notification Templates Page" on page 366.

You can also create custom templates. For example, you can create different templates for different
alert notice delivery methods (email, pager, SMS), or for different recipients. A custom template is
defined in the Notification Template Properties page. Each section of the alert notice includes a list of
parameters that you can select. For details on the information that can be included in a custom
template, see "Notification Templates Page" on page 366.

Note for HP Software-as-a-Service customers: Your list of notification templates includes the
default notification templates, the notification templates created for your use by HP Software-as-a-
Service representatives and those created by your organization.

Clear Alert Notification Templates

When configuring alert schemes, you can set up an alert scheme to automatically send a clear alert
notification. For details on selecting this option while creating your alert scheme, see How to Create
EUM Alert Schemes in the BSM Application Administration Guide.

The default template for clear alert notifications is automatically used by BSM. If you do not want BSM
to use the default template, you can create your own clear alert template. The clear alert template must
be based on an existing notification template. BSM uses the clear alert notification template that you
create under the following circumstances:

« An alert has been triggered.
« Notification is sent to a recipient based on an existing template (default or user-defined).
« The alert scheme has been configured to send a clear alert.

For details on configuring a clear alert notification template, see "How to Configure a Template for
Clear Alert Notifications" on the next page.

How to Configure EUM Alerts Notification Templates

You can select predefined templates, modify existing templates, or create your own notification
templates to determine the contents and appearance of the alert notices. For details on notification
templates, see "EUM Alerts Notification Templates" above.
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Create custom templates

BSM gives you the flexibility to create different notification templates for the different alert schemes
and recipients that are defined for your platform.

Every template is divided into sections. You specify the information that you want to appear in each
section. For details, see "Notification Template Properties Dialog Box" below.

Manage existing templates

Over time, you may find it necessary to make changes to notification templates that you create,
because of organizational changes, changes in notification policies, changes to service level
monitoring contracts, and so on. You use the Notification Templates page to edit, clone, and delete
notification templates defined in BSM. For details, see "Notification Templates Page" on page 366.

How to Configure a Template for Clear Alert Notifications

You can select predefined clear alert notification templates, modify existing templates, or create your
own clear alert notification templates to determine the contents and appearance of the clear alert
notices. For details on notification templates, see "Clear Alert Notification Templates" on the previous

page.

Note: The notification template selected for the recipient has a clear alert template based on the
notification template's name. For details on naming a clear alert template, see "Notification
Template Properties Dialog Box" below. For details on clear alerts, see Advanced Settings Tab in
the BSM User Guide.

To create, modify, or manage clear alerts notification templates, see "Notification Templates Page" on
page 366.

EUM Alerts Notification Templates User Interface

This section describes:
« "Notification Template Properties Dialog Box" below

« "Notification Templates Page" on page 366

Notification Template Properties Dialog Box

This dialog box enables you to define a new alerts notification template.
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To access  Admin > Platform > Recipients > End User Management Alerts Notification
Templates

« Tocreate anew template, in the End User Management Alerts Notification
Templates page, click the New button.

« Toedit an existing template: in the End User Management Alerts Notification

A
Templates page, select an existing template, and click .

Important Clear alert notifications: To set up a clear alert notification, select the notification

information template to use as the basis for your clear alert template and clone it. Make you
determination based on the notification templates that was selected for users likely to
receive a clear alert notification. Change the name of the template by deleting Copy
of and adding FOLLOWUP (all caps, one word). Edit the template details as required.
It is recommended that you include in the Subject of a clear alert email, the Header,
the Alert Specific Information, or both.

Example: If you are creating a clear alert template based on the LONG default
template, you would call the clear alert template LONG_FOLLOWUP. If the clear alert
template is based on a user-defined template called MyTemplate, name the clear alert
template MyTemplate FOLLOWUP.

Default: The FOLLOWUP string is the default string recognized by BSM as the
template name for a clear alert message.

Customization: You can customize the _FOLLOWUP string. For details, see "How
to Configure a Template for Clear Alert Notifications" on the previous page.

Relevant "How to Configure a Template for Clear Alert Notifications" on the previous page
tasks

General Information Area

User interface elements are described below (unlabeled elements are shown in angle brackets):
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ul
Element
(A-Z) Description
<Insert> Select a parameter to add to the section. Repeat to add as many text parameters as you
want from the list.
Add free text before or after the text parameters. The text parameters available for this
section are:
« Alert Name. The name of the alert, as defined in the alert scheme.
« Severity. The severity label assigned to the alert in the alert scheme.
« HP BSM URL. The URL of the BSM web site.
« Entity Name. The name of the CI attached to the alert.
« Entity Type. The type of the Cl attached to the alert.
« Alert User Description. The description you specified in the alert scheme.
« Actions Result. A description of the results of the alert actions specified in the alert
scheme.
Message Select the format for the message: Text or HTML.
format
Name Enter a name for the template.
If possible, use a descriptive name that includes information on the type of alert (email,
pager, SMS) for which you plan to use the template, or the recipients who receive alerts
using this template.
Subject = Specify the information that you want BSM to include in the subject of the email, pager
message, or SMS message.
Use the <insert list for Subject / Header / Footer> to add parameters and free text to
create a customized subject. Use as many parameters as you want from the list.
Header Area

Use this area to specify the information that you want to appear at the top of the alert notice. Select
parameters from the <Insert> list and free text to create a customized header. Use as many
parameters as you want from the list.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description
<Insert> Select a parameter to add to the section. Repeat to add as many text parameters as

you want from the list.

Add free text before or after the text parameters. The text parameters available for
this section are:

« Alert Name. The name of the alert, as defined in the alert scheme.

« Severity. The severity label assigned to the alert in the alert scheme.

« HP BSM URL. The URL of the BSM web site.

« Entity Name. The name of the CI attached to the alert.

« Entity Type. The type of the Cl attached to the alert.

« Alert User Description. The description you specified in the alert scheme.

« Actions Result. A description of the results of the alert actions specified in the
alert scheme.

« Entity ID. The ID of the CI attached to the alert.

Alert Specific Information Area

Use this area to add alert information to the notification.

User interface elements are described below (unlabeled elements are shown in angle brackets):

Ul Element (A-Z) Description
<insert list for Alert Select a text parameter to add to the section. Repeat to add as many
Specific Information> text parameters as you want from the list.

« Trigger Cause. A description of the alert trigger conditions, as
specified in the alert scheme.

« Actual Details. A description of the actual conditions at the time
of the alert.

Transaction Area

Use this area to specify the BMP transaction details relevant only for the BPM alert type.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul
Element
(A-Z)

<Insert>

Footer Area

Description

Select a parameter to add to the section. Repeat to add as many text parameters as you
want from the list. Add free text before or after the text parameters. The text parameters
available for this section are:

Data Collector Name. The name of the data collector running the transaction related
to the alert.

Script Name. The name of the script containing the transaction related to the alert.
Transaction Time. The date and time of the alert.

Transaction Description. A description of the transaction, if it has been defined in
System Availability Management.

Transaction Name. The name of the transaction related to the alert.

Transaction Error. The error message generated by the data collector for the
transaction, if a transaction error occurred at the time of the alert.

Location Name. The location of the data collector running the transaction related to
the alert.

Use this area to specify the information that you want to appear at the bottom of the alert notice. Select
parameters from the <Insert> list and free text to create a customized footer. Use as many parameters
as you want from the list.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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Ul Element
(A-2) Description
<Insert> Select a parameter to add to the section. Repeat to add as many text parameters as

you want from the list.

Add free text before or after the text parameters. The text parameters available for
this section are:

« Alert Name. The name of the alert, as defined in the alert scheme.

« Severity. The severity label assigned to the alert in the alert scheme.

« HP BSM URL. The URL of the BSM web site.

« Entity Name. The name of the CI attached to the alert.

« Entity Type. The type of the Cl attached to the alert.

« Alert User Description. The description you specified in the alert scheme.

« Actions Result. A description of the results of the alert actions specified in the
alert scheme.

« Entity ID. The ID of the CI attached to the alert.

Notification Templates Page

This page lists the default templates and any custom template that has been defined. It enables you to
manage default and custom templates and to create new templates, or to edit clear alert notification
templates.

To access Admin > Platform > Recipients > End User Management Alerts Notification
Templates
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Important = When configuring alert schemes, you can instruct BSM to automatically follow up the

information = alert by sending a clear alert notification. For details on selecting this option while
creating your alert scheme, see "How to Configure a Template for Clear Alert
Notifications" on page 361.

The default template for clear alert notifications is automatically used by BSM. If you
do not want to use that default template, you can create your own clear alert template.
It is recommended to clone an existing notifications template and then to modify the
cloned template.

BSM uses the clear alert notification template that you create under the following
circumstances:

« An alert has been triggered.

« Notification is sent to a recipient based on an existing template (default or user-
defined).

« The alert scheme has been configured to send a clear alert.

« The notification template (DEFAULT_POSITIVE_FORMAT) selected for the
recipient has a clear alert template based on the notification template's name.

Relevant "How to Configure EUM Alerts Notification Templates" on page 360
tasks

User interface elements are described below:

Ul Element

(A-2) Description

Click to duplicate notification template. Clones the selected notification template.
The Notification Template Properties dialog box opens where you can edit the cloded
notification. For details, see "Notification Template Properties Dialog Box" on
page 361.

Click to modify notification template properties. Click to edit the selected
template. For details, see "Notification Template Properties Dialog Box" on page 361.

Click to delete notification template. Delete the selected templates
simultaneously.
To delete multiple templates simultaneously, select their check boxes, and click the
button located at the bottom of the templates list.

New Click the New Template button to open the Notification Template Properties dialog

Template box. For details, see "Notification Template Properties Dialog Box" on page 361.
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Ul Element

(A-Z) Description

Notification Lists the default templates and the custom templates. The default templates are:
Template

Name « DEFAULT_LOG_FORMAT. Includes all the elements needed to create a default

long format notification for reports.

« DEFAULT_POSITIVE_FORMAT. Includes all the elements needed to create a
default long format notification for positive or clear alerts. For details on clear
alerts, see "How to Configure a Template for Clear Alert Notifications" on
page 361.

« LONG. Includes all the elements needed to create a default long format
notification.

« SHORT. Includes all the elements needed to create a default short format
notification.

Note: For details on the parameters displayed in each template, see "Notification
Template Properties Dialog Box" on page 361.
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Downtime management enables you to exclude periods of time from being calculated for events, alerts,
reports, views, or SLAs that can skew Cl data. This section provides information and instructions for
creating downtimes.

To access

Select Admin > Platform > Downtime Management

Learn About

Downtime Management

Downtime or other scheduled events can skew Cl data. You may want to exclude these periods of time
from being calculated for events, alerts, reports, views, or SLAs.

Downtimes are configured based on associated Cls. For example, you might want to exclude a
recurring maintenance event or a holiday for a specific host Cl whose physical host you know will be
down for that period of time.

When defining downtimes, you configure how often the downtime will occur and select the specific
instances of Cls that are affected by the downtime. You can select Cls of the following Cl types:

« Node

« Running software

« Business application
« Cl collection

« Infrastructure service

« Business service

Downtime Actions

You can select what action is taken during the downtime on the Cls specified in the downtime
configuration. Downtime can impact the following:

« Alerts and Events. Events are suppressed and no Cl Status alerts, EUM alerts, or notifications
are sent for any of the Cls associated with the downtime.
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« KPIs. KPlIs attached to the Cl and impacted Cls are not updated and display the downtime for the
Clin Service Health. For details on how downtime configurations affect Service Health, see KPI
Status Colors and Definitions in the BSM User Guide.

« Reports. End User Management Reports are not updated and display the downtime for the CI. For
details on how downtime configurations affect reports, see Downtime Information in Reports in the
BSM User Guide.

o SLAs. Selected SLAs that are attached to the Cl are not updated. You can select which SLAs to
include in the downtime. For details on how downtime configurations affect SLAs, see Retroactive
SLA Data Corrections in the BSM Application Administration Guide.

« Monitoring. Business Process Monitor and SiteScope monitoring stops for any of the Cls
associated with the downtime. For details on how downtime configurations affect SiteScope
monitoring, see Cl| Downtime in the BSM Application Administration Guide.

The options you select in the downtime wizard are combinations of the above actions, grouped in this
order. This means that each option includes the previous options listed. The actions that are taken in
BSM during the downtime depend on the option selected during downtime configuration.

Permissions

To add, edit, or delete downtimes, you must have Full permission on the Downtime resource. In
addition, you should have View permission on the Views to which Cls in the downtime belong. For
details on permissions, see "Permissions" on page 189.

Maximum Number of Downtimes and Cls

By default, there is a maximum number of Cls and downtimes. These values are the recommended
number of Cls and downtimes that are appropriate for your deployment and are based on capacity
calculator values. These limits are enforced in both the BSM Ul and REST.

When adding a new downtime, BSM checks that the number of downtimes configured in the system is
less than the downtime threshold. You will only be able to continue adding a new downtime if the
number of downtimes in the system is below the threshold.

When adding Cls to a new or existing downtime, BSM checks that the number of Cls configured in the
system is less than the CI threshold. You will only be able to continue the process if the number of Cls
is below the threshold.

Although you can edit the downtime and CI thresholds, we recommend that you first try deleting
unnecessary Cls or downtimes. Increasing the downtime and CI thresholds could adversely affect your
system’s efficiency.
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Periodic Purging Downtimes

You can purge downtimes based on how long ago the downtime completed. By default, periodic purging
is active and the time period from which completed downtimes should be purged is 1095 days. This
means that by default, all downtimes that were completed more than 3 years ago are purged.

From the JMX console, you can also set how often periodic purging should be run. The default value is
7 days.

When starting the downtime service, the frequency for which the periodic purging is run is offset by 10
minutes. Therefore, if the periodic purging downtime runs every 7 days, and you start the downtime
service at 9 am on Monday, the periodic purging downtime is performed every Monday at 9:10 am.

Note: After a downtime is purged, the downtime info in BSM reports is inconsistent.

Events in Operations Management

When you select an action option that includes suppressing events in a downtime on a selected Cl, the
result in the Operations Management application depends on how the downtime behavior is configured
in Operations Management. For details, see Downtime Behavior in the BSM Application Administration
Guide.

Downtime REST Service

You can retrieve, update, create, and delete downtimes through a RESTful web service running on the
Gateway Server. For details, see Downtime REST Service in the BSM Extensibility Guide.

Tasks

How to Configure Maximum Number of Downtimes

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings. For user
interface details, see "Infrastructure Settings Manager Page" on page 81.

2. Select Foundations.
3. From the Foundations drop-down list, select Downtime.

4. From the Fuse for number of downtimes in the System parameter, click the Edit Setting

button .

5. Inthe Value field, enter a new value.
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6. Click Save.

7. Restart the server for the new value to take affect.

How to Configure Maximum Number of Cis in Downtimes

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings. For user
interface details, see "Infrastructure Settings Manager Page" on page 81.

2. Select Foundations.
3. From the Foundations drop-down list, select Downtime.

4. From the Fuse for total number of Cls in downtime in the System parameter, click the Edit

Setting button .

5. Inthe Value field, enter a new value.
6. Click Save.

7. Restart the server for the new value to take affect.

How to Disable Periodic Purging

By default, periodic purging is enabled. To disable periodic purging, change the value of the of the Run
Periodic Purging parameter to false.

1. Select Admin > Platform > Setup and Maintenance > Infrastructure Settings. For user
interface details, see "Infrastructure Settings Manager Page" on page 81.

2. Select Foundations.

3. From the Foundations drop-down list, select Downtime.

4. From the Periodic Purging Period parameter, click the Edit Setting button .
5. Inthe Value field, enter the time period from which completed downtimes should be purged .

6. Todisable periodic purging, from the Run Periodic Purging parameter, click the Edit Settings
button and select False.

7. Click Save.

8. Restart the server for the new value to take affect.
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How to Configure Periodic Purging Frequency

1.

How to Create and Manage Downtimes

1.

In a browser, enter the URL of the JMX console:
http://<Gateway or Data Processing Server name>:29000/

Enter your JMX console authentication credentials.

Go to service=Infrastructure Settings Manager.

Invoke the function setSettingValuePerCustomerld with context=downtime and

downtime.periodic.purging.days.interval.

Restart the server.

Plan how you want the downtime to affect the Cls in your system. Before working in the wizard:

m  When determining which Cls may need downtimes, take into consideration Cls that impact the
Cls that you selected. In some cases, these Cls are also affected by downtime.

To understand the downtime impact model, see the BSMDowntime_topology TQL in the
RTSM Modeling Studio.

You can only select Cls from the following Cl types:

o

Note: By default, BSMDowntime_topology TQL is hidden. To view this TQL, in the
Modeling Studio go to Admin > RTSM > RTSM Administration > Administration >
Package Manager > Tools > User Preferences > General > Show hidden queries
and set the value to True. The maximum depth that the impact can affect is 15 steps.

node
running_software
business_application
ci_collection
infrastructure_service

business_service
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Note: Even though SiteScope URL monitors are not included in this list of Cl types, you
can define a downtime on a SiteScope URL monitor by using a Cl type computer. For
example:

1. In SiteScope, define a SiteScope URL monitor as a Computer named HPSERVER.

2. In Platform Admin, create a downtime on a server name called HPSERVER.

m Determine which actions should be applied to which Cls.
2. How to Configure How Events are Handled in Operations Management — optional

You can manage how events associated with Cls that are in downtime are handled. You do this in
Admin > Operations Management > Event Automation > Downtime Behavior.

For details on this topic, see Downtime Behavior in the BSM Application Administration Guide.
3. Runthe Create Downtime wizard

Go to Admin > Platform > Downtime Management and click the Create New Downtime button

E3)

For user interface details, see "New Downtime Wizard" on page 378.
4. Review the Results

After running the wizard, the details of the downtime are displayed in the "Downtime Management
Page" on the next page. You can export the details of the downtimes to a PDF or Excel file.

For user interface details, see "Downtime Management Page" on the next page.

Tip: To limit the downtimes in the exported file to a specified selection, you can filter the
visible downtimes in the "Downtime Management Page" on the next page and then export to a
PDF or Excel file. You can filter by any combination of one or more columns, including:

Name, Cls, Status, Action, Scheduling, Next Occurrence, Modified By, Approved By,
Planned, and Category.

How to Filter the Downtimes List

1. Click the column head of the column by which you want to filter the list.

2. From the column's drop-down list, select an option. Only items of the selected type appear in the
list.
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How to View Completed Downtimes

By default, downtimes with status of "Completed" are hidden.

To view completed downtimes, click the Edit the Filter button at the top of the Status column.

Ul Description

Downtime Management Page

Information displayed on this page is view only. To edit any of the values, double-click on a downtime
or select a downtime and click the Edit button.

User interface elements are described below.

Ul Element
(A-2Z) Description

Create new downtime. Opens the New Downtime wizard where you configure a new
downtime. For details, see "New Downtime Wizard" on page 378.

El

Edit downtime. Opens the Edit Downtime wizard, which enables to you edit the
configuration of an existing downtime. This wizard contains the same screens as the
New Downtime wizard. For details, see "New Downtime Wizard" on page 378.

)

Duplicate downtime. Clones the settings of an existing downtime to a new
downtime.

Delete downtime(s). Deletes selected downtime(s). Downtimes that are active now
or were active at any time in the past cannot be deleted. This is designed to prevent
the loss of historical data.

£3

Terminate Active Downtime. Cancels all future occurrences of the selected
downtime and marks the downtime status as Completed.

Export to Excel. Exports the table of configured downtimes to a file in Excel format.

Export to PDF. Exports the table of configured downtimes to a PDF file.

o
=

The action that takes place when the downtime is in active status. You configure the
action for the downtime in the New Downtime wizard. For details about the possible
actions, see "Action Page" on page 386.

Cls The Cls associated with the downtime. These are the Cls that are impacted when the
downtime is in active status.
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Ul Element

(A-2) Description

Modified The user who last created or modified the downtime configuration.

by

Name The name of the downtime as configured in the Downtime wizard.

Next The date and time of the next occurrence of the downtime. This field is updated

Occurrence automatically.

Scheduling Displays the:
« Date, time, time zone, and duration
For recurring downtimes, also displays:
« What day of the week or month the downtime is scheduled to recur

« Range of recurrence

Status Displays whether the downtime is currently:

« Active. The Cls are currently in downtime and the action selected for the
downtime is now taking place.

« Inactive. The downtime is configured but it is currently not the time for the
downtime to take place.

« Completed. The time for the downtime has passed and the actions configured for
the downtime have occurred.

Optional Columns

Approved  Indicates if there was an approval for the downtime and who approved it.
by
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Ul Element
(A-2) Description

Category The category assigned to the downtime. Options include:
« Application installation
« Application maintenance
« Hardware installation
« Hardware maintenance
« Network maintenance
« Operating system reconfiguration
o Other
« Security issue

You can also create your own customized categories using Infrastructure Settings.

To add a custom downtime category:

1. Select Admin > Platform > Setup and Maintenance > Infrastructure
Settings.

2. Select Foundations > Downtime.

3. Inthe Downtime - General settings table, edit the Downtime categories
value to the name you want to use as a customized category for the downtime.
The name you enter will appear as an option in the list of available downtime
categories.

Planned Indicates whether the downtime is planned or not.

New Downtime Wizard

To access the New Downtime Wizard, from the Downtime page, click IZI or select and existing

downtime and click .

Wizard Map The New Downtime Wizard contains:

"Properties Page " on page 383> "Select Cls Page " on page 384> "Scheduling
Page " on page 384> "Action Page" on page 386 > "Notification Page " on
page 388> "Preview Page " on page 388
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Troubleshooting and Limitations

Editing Downtimes

« If while editing a downtime in the Downtime wizard its status changes from Idle to Active, the
downtime cannot be saved.

« If youwant to cancel a recurring downtime that already occurred at least once, edit the downtime's
End by date in the Scheduling page.

Downtime and Daylight Saving Time

In time zones that observe Daylight Saving Time (DST), downtime calculations take into account the
transitions between Standard and Daylight Time, using the following rules:

Note: The examples that follow use the daylight saving changes observed throughout most of the
United States.

o March 14 2010 -- when 2:00 am arrives, the clock moves forward to 3:00 am. Thus, the period
2:00-2:59 am does not exist.

o November 7 2010 -- when 2:00 am arrives, the clock moves back to 1:00 am. Thus, the period
1:00-1:59 am appears twice.

In other time zones, the behavior is the same, but the transition dates and times may vary.

These examples are summarized in the table "DST Changes Affecting Downtime — Example
Summary" on page 381.

Spring (Standard to Daylight Time)

« When downtime starts before the DST change and ends the day after the change, its end time is as
expected, but the duration is 1 hour less than defined.

Example 1:

Monthly downtime starting 14th day of month at 1:30 am and ending on 15th day of month at 2:40
am. Duration is 1 day, 1 hour, and 10 minutes.

No DST change: Downtime starts on 14th at 1:30 am and ends on 15th at 2:40 am. Duration is 1
day, 1 hour, 10 minutes.

DST change on March 14 2010: Downtime starts on 14th at 1:30 am and ends on 15th on 2:40 am,
but the duration is 1 day, 0 hours, 10 minutes (1 hour less than defined).
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« When downtime starts before the DST change and ends the same day as the change, but after the
change, its end time is 1 hour more than defined, but its duration is as defined.

Example 2:
Monthly downtime on 13th day of month, starting at 11 pm (23:00), for a duration of 5 hours.
No DST change: Downtime starts on 13th at 11:00 pm and ends on 14th at 4:00 am.

DST change on March 14 2010: Downtime starts on 13th at 11:00 pm and ends on 14th at 5:00 am,
and the duration remains 5 hours.

« When downtime is defined to start during the skipped hour, the start time shifts 1 hour forward and
keeps the defined duration.

Example 3:
Monthly downtime on 14th day of month, starting at 2:30 am, for a duration of 2 hours.
No DST change: Downtime starts on 14th at 2:30 am and ends on 14th at 4:30 am.

DST change on March 14 2010: Downtime starts on 14th at 3:30 am and ends on 14th at 5:30 am,
and the duration remains 2 hours.

« When downtime is defined to start before the DST change and end during the skipped hour, the end
time shifts 1 hour forward and keeps the defined duration.

Example 4:

Monthly downtime on 13th day of month, starting at 1:30 am, for a duration of 1 day, 1 hour, and 10
minutes.

No DST change: Downtime starts on 13th at 1:30 am and ends on 14th at 2:40 am. The duration is 1
day, 1 hour, and 10 minutes.

DST change on March 14 2010: Downtime starts on 13th at 1:30 am and ends on 14th at 3:40 am,
and the duration remains as defined -- 1 day, 1 hour, and 10 minutes.

o When downtime is defined to start and end during the skipped hour, downtime takes place one hour
later than defined.

Example 5:
Monthly downtime on 14th day of month, starting at 2:00 am, for a duration of 1 hour.
No DST change: Downtime starts on 14th at 2:00 am and ends on 14th at 3:00 am.

DST change on March 14 2010: Downtime starts on 14th at 3:00 am and ends on 14th at 4:00 am,
and the duration remains as defined - 1 hour.

Fall (Daylight Time to Standard Time)
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« When downtime starts and ends after the DST change, its end time and duration are as defined.

« When downtime starts before the DST change (same day as change or day before) and ends after
the change during the day of the change, the end time is 1 hour less than expected, and duration is
as defined.

Example 6:

Two monthly downtimes, both starting on the 7th day of month at midnight. The first downtime
duration is 1 hour, and the second is 2 hours.

No DST change: The first downtime is on 7th from 0:00 to 1:00 am (1 hour duration), and the second
on 7th from 0:00 to 2:00 am (2 hours duration).

DST change on November 7 2010: The first downtime starts on 7th at 0:00 Daylight Time and ends
on 7th at 1:00 am Daylight Time, with a duration of 1 hour. The second downtime starts on 7th at
0:00 Daylight Time and ends on 7th at 1:00 am Standard Time, and the duration remains 2 hours.

Example 7:
Monthly downtime on 7th day of month, starting at midnight, for a duration of 4 hours.
No DST change: Downtime starts on 7th at 0:00 and ends on 7th at 4:00 am.

DST change on November 7 2010: Downtime starts on 7th at 0:00 and ends on 7th at 3:00 am, and
the duration remains as defined -- 4 hours.

Example 8:
Monthly downtime on 6th day of month, starting at 8:00 pm (20:00), for a duration of 7 hours.
No DST change: Downtime starts on 6th at 8:00 pm and ends on 7th at 3:00 am.

DST change on November 7 2010: Downtime starts on 6th at 8:00 pm and ends on 7th at 2:00 am,
and the duration remains as defined -- 7 hours.

« When downtime starts before the DST change and ends the day after the change, the end time is as
expected, and duration is 1 hour more than defined.

Example 9:

Monthly downtime on 7th day of month, starting at midnight (0:00), for a duration of 1 day, 1 hour (25
hours).

No DST change: Downtime starts on 7th at 0:00 and ends on 8th at 1:00 am.

DST change on November 7 2010: Downtime starts on 7th at 0:00 and ends on 8th at 1:00 am, but
the duration is 26 hours.

DST Changes Affecting Downtime — Example Summary
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Downtime as Set/With

Example DST Change
1 Set
With DST Change
2 Set
With DST Change
3 Set
With DST Change
4 Set
With DST Change
5 Set
With DST Change
6 1st Set
With DST
Change
2nd Set
With DST
Change
7 Set
With DST Change
8 Set
With DST Change
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Start Time

14th at 1:30
am

14th at 1:30
am

13th at
11:00 pm

13th at
11:00 pm

14th at 2:30
am

14th at 3:30
am

13th at 1:30
am

13th at 1:30
am

14th at 2:00
am

14th at 3:00
am

7th at 0:00
7th at 0:00

7th at 0:00

7th at 0:00

7th at 0:00
7th at 0:00

6th at 8:00
pm

6th at 8:00
pm

End Time

15th at 2:40 am

15th at 2:40 am

14th at 4:00 am

14th at 5:00 am

14th at 4:30 am

14th at 5:30 am

14th at 2:40 am

14th at 3:40 am

14th at 3:00 am

14th at 4:00 am

7th at 1:00 am

7th at 1:00 am

7th at 2:00 am

7th at 1:00 am
Standard Time

7th at 4:00 am
7th at 3:00 am

7th at 3:00 am

7th at 2:00 am

Duration

1 day, 1 hour, 10
minutes

1 day, 0 hours, 10
minutes
5 hours
5 hours

2 hours

2 hours

1 day, 1 hour, and 10

minutes

1 day, 1 hour, and 10

minutes

1 hour

1 hour

1 hour

1 hour

2 hours

2 hours

4 hours
4 hours

7 hours

7 hours
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Downtime as Set/With

Example DST Change Start Time End Time Duration
9 Set 7that 0:00 8that 1:00 am 25 hours
With DST Change 7that0:00 8that 1:00 am 26 hours

Properties Page

This wizard page enables you to configure the general properties of the downtime. For information
about downtimes, see "Downtime Management Overview" on page 370.

This page is part of the "New Downtime Wizard" on page 378.

User interface elements are described below:

Ul Element Description

Downtime  Cannot exceed 200 characters.
name

Downtime | This description also appears in the Downtime Information Area in the BSM User
description Guide. The description cannot exceed 2000 characters.

Approved  You can enter the person or department who approved this downtime. Cannot exceed
by 50 characters.

Note: In Oracle, if you are using East Asian Languages (Chinese, Japanese, or
Korean), the maximum number of characters for Downtime Name, Downtime
Description, or Approved by may be less than specified above.

Planned Select if you want this downtime marked as planned. You can create downtimes that
are unplanned. This is for information purposes only.

Downtime | Select a category that describes the reason for the downtime.

Category . . . .

You can also create your own customized categories using Infrastructure Settings.

To add a custom downtime category, select Admin > Platform > Setup and
Maintenance > Infrastructure Settings:

o Select Foundations.
o Select Downtime.

« Inthe Downtime - General settings table, edit the Downtime category value to
the name you want to use as a customized category for the downtime. The name
you enter appears as an option in the list of available downtime categories after
you restart BSM.
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Select Cls Page

This wizard page enables you to select the Cls that are affected by the downtime. For information
about downtimes, see "Downtime Management Overview" on page 370.

You cannot edit the selected Cls for downtimes that already occurred.
This page is part of the "New Downtime Wizard" on page 378.

User interface elements are described below:

ul

Element

(A-2) Description

Available = Select from the list the view that contains the Cls to be affected by this downtime. Click
Cls i=to browse and search for the C| from the available views.

Highlight a CI from the view to move it to the Selected Cls list. Press the Ctrl key to
select multiple Cls.

You can select any view that you have permission to see. You can select Cls only of the
following Cl types:

« Node

Running software

Business application

« ClI collection

Infrastructure service

« Business service

Selected = Once Cls are selected, they appear in the Selected Cls list. To remove a Cl from a
Cls downtime, select the Cl in the Selected Cls and click the back arrow to move it back to
the Available Cls list.

Scheduling Page

This wizard page enables you to configure the schedule for the downtime. For information about
downtimes, see "Downtime Management Overview" on page 370.

Note: You cannot schedule a downtime in the past.

For downtimes that have already occurred, only the following field is editable in the Scheduling page:
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End by date in Range of recurrence
To cancel a recurring downtime that occurred at least once, edit the downtime and modify this field.
This page is part of the "New Downtime Wizard" on page 378.

User interface elements are described below:

Ul Element Description

Time of « Start. The drop-down list includes times set for every half hour on the hour and half

occurrence hour. To select a different time of day, select the closest half hour and edit the field
to enter the actual time you want the downtime to start. For example, for 2:10 am,
select 2:00 am and edit the minutes to indicate 2:10 am.

« End. When you select an end time, the duration field automatically updates. Or
you can select the duration and the end time field automatically updates.

« Duration. Includes options from 5 minutes to one week. The downtime duration
must be in increments of 5 minutes and be defined in lengths of minutes, hours,
days, or weeks.

If the length of time you want to specify does not appear, for example 1-1/2 hours,
enter the end time and the duration automatically updates.

To select a time greater than 1 week, select 1 week and edit the field to the correct
number of weeks.

Recurrence Select one of the following:
pattern

« Once. The downtime happens only once as scheduled and does not recur. Select
the calendar date for the occurrence.
« Weekly. Select the day of the week for the scheduled weekly recurrence.

« Monthly. Select a day in the month or a monthly repeated downtime pattern.

For example, you can schedule a downtime event on the first Sunday of every
third month.

Range of If you selected Weekly or Monthly:
recurrence
1. Define a Start date.

2. Select either an End by date or No end date.

Time zone | All time zones are displayed in relation to GMT.
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Action Page

This wizard page enables you to define the set of actions taken during the downtime. For information
about downtimes, see "Downtime Management Overview" on page 370.

You cannot edit fields in teh Action page for downtimes that already occurred.

This page is part of the "New Downtime Wizard" on page 378.

User interface elements are described below:

Ul Element

Take no actions

Suppress alerts and
consider events

Enforce downtime on
KPI calculations;
suppress alerts and
consider events

Description

There is no action taken on the associated Cls or the Cl monitoring,
alerts, reports, or SLAs.

Note: During this downtime, the affected Cl doesn't change its status to
Downtime. Cl status alerts are configured to be triggered if the CI
changes its status.

« No alerts or their associated notifications or actions are sent for any
of the Cls associated with the downtime.

« By default, events are submitted as closed. If OMi is installed, event
handling in downtime can be configured in Admin > Operations
Management > Event Automation > Downtime Behavior, and
overrides the setting here.

« Monitoring continues, and reports, status in Service Health, and
SLAs are updated.

Note: During the downtime period, the affected Cl may change its
status, and the status change may trigger the relevant Cl status alert.

« KPI calculations are not run and the status in Service Health is not
updated. The downtime for the Cl is displayed.

« Noalerts or their associated notifications or actions are sent for any
of the Cls associated with the downtime.

« By default, events are submitted as closed. If OMi is installed, event
handling in downtime can be configured in Admin > Operations
Management > Event Automation > Downtime Behavior, and
overrides this setting.

« Reporting and monitoring continue. SLAs are updated.
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Enforce downtime on
Reports and KPI
calculations; suppress
alerts and consider
events

Stop active monitoring
(BPM & SiteScope);
enforce downtime on
Reports & KPI
calculations; suppress
alerts and consider
events (affects all
related SLASs)
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Description

« Report data is not updated and the downtime is displayed for the
associated Cls.

« Selected SLAs are not updated for the SLAs affected by the Cls
associated with the downtime.

« KPI calculations are not run and the status in Service Health is not
updated. The downtime for the Cl is displayed.

« Noalerts or their associated notifications or actions are sent for any
of the Cls associated with the downtime.

« By default, events are submitted as closed. If OMi is installed, event
handling in downtime can be configured in Admin > Operations
Management > Event Automation > Downtime Behavior, and
overrides this setting.

« Monitoring continues.

« Business Process Monitor and SiteScope monitoring stops.

« Report data is not updated and the downtime is displayed for the
associated Cls.

« SLAs are not updated for the SLAs affected by the Cls associated
with the downtime.

o KPI calculations are not run and status in Service Health is not
updated. The downtime for the Cl is displayed.

« No alerts or their associated notifications or actions are sent for any
of the Cls associated with the downtime.

« By default, events are submitted as closed. If OMi is installed, event
handling in downtime can be configured in Admin > Operations
Management > Event Automation > Downtime Behavior, and
overrides this setting.

Note: If you configure a downtime period for an Application Cl (whose
datais updated by BPM monitoring), the Downtime Manager
automatically sends an event to the BPM Agent when the downtime
period starts. The agent stops sending samples to BSM. The samples
that are suppressed are the BPM samples that correspond to the
Transaction Cls, which are child Cls of the Application Cls on which the
downtime is configured. There is one sample per transaction.
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Notification Page

The New Downtime wizard - Notification page enables you to select recipients to receive notification of
the downtime. Notifications are sent by email at the time of downtime occurrence and immediately after
it completes. You can select only those recipients with an email address defined. For information about
downtimes, see "Downtime Management Overview" on page 370.

Note: You can edit the Selected Recipients for downtimes that already occurred.

This page is part of the "New Downtime Wizard" on page 378.

User interface elements are described below:

ul
Element Description

|:| Opens the New recipient dialog box that enables you to create a recipient that is not
yet in the list of available recipients. The recipients you create are available as
recipients in all of BSM. For details on creating recipients, see "Recipient
Management" on page 269.

Available  Lists the available recipients for downtime notification by means of email, SMS, or
Recipients  pager.

Selected Lists the selected recipients for downtime notification by means of email, SMS, or
Recipients pager. You can select either one, two or all three notification options.

Preview Page

The New Downtime wizard - Preview page enables you to preview a summary of your Downtime
settings. For information about downtimes, see "Downtime Management Overview" on page 370.

This page is part of the "New Downtime Wizard" on page 378.
User interface elements are described below:
Ul

Element Description

Preview Displays a table listing all the values configured for this downtime. You can click the
table Back button to return to a page in the wizard that contains a value that should be modified
or deleted.

When you click Finish, the downtime is added to the system and displayed in the
Downtime Manager page.
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This section describes common problems that you may encounter when working in the Platform
Administration area of BSM.

For additional troubleshooting information, use the HP Software Self-solve knowledge base
(h20230.www2.hp.com/selfsolve/documents).

Need to change password for access from data collectors (RUM, TV,
Diagnostics) to RTSM

During deployment, you can optionally set an Access to RTSM password to secure communication
between BSM data collectors (such as Real User Monitor, and TransactionVision), and the Run-time
Service Model. This password can be changed later using the JMX console.

To modify the password for RTSM access using the JMX console:

1. Enterthe URL of the JMX console (http://<Gateway or Data Processing Server name>:29000/)
in a web browser. (For detailed instructions, see "JMX Console" on page 93.)

2. Enteryour JMX console authentication credentials. If you do not know your authentication
credentials, contact your system administrator.

3. Inthe Foundations domain, select the service RTSM passwords manager.

4. Modify changeDataCollectorsOdbAccessPwd. The operation gets customer ID and new
password as parameters and changes all data collector passwords to the new one.

RTSM Administration pages do not load

If the links from RTSM Administration do not work, this may be caused by one of the following:

« Make sure that the BSM Gateway Server is able to access the Default Virtual Server for Application
Users URL. This URL can be found in Admin > Platform > Setup and Maintenance >
Infrastructure Settings. In the Foundations field, specify Platform Administration. The URL is
located in the Host Configuration table.

« If you are using a reverse proxy or load balancer, make sure you log in through the URL specified
above.

Java applets fail to load with "class not found" error

Make sure that you created a Profile Database. This database must be created manually in Platform
Administration. For more information, see "Creating Databases" on page 56.
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Java applets fail to load

Open Control Panel > Java > Temporary Internet Files > Settings and make sure Keep
temporary files on my computer is checked. If the problem persists, clear the Java cache by
clicking Delete Files in the same location.

Intermittent Ul failures after connecting through Load Balancer

BSM requires sticky sessions for users. Make sure the persistency settings are set to stickiness by
session enabled or Destination Address Affinity (depending on the Load Balancer).

BSM Login page does not appear when connecting through Load Balancer
o Check the KeepAlive URIs.

« Virtual hosts and Load Balancer should be configured with a fully qualified domain name (and not an
IP) for LW-SSO to work.

BSM dialog boxes and applets, such as the Configuration Wizards, do not load
properly

Possible Cause:

Old java files on your client PC.

Solution:

Clear the java cache by following this procedure:
1. Navigate to Start > Control Panel > Java.
2. Inthe Temporary Intermet Files section, click Settings.

3. Inthe Temporary File Settings dialog box, click Delete Files.

BSM has been installed, but the Downloads page is empty

Possible Cause:
The components setup files have not been installed to the Downloads page.
Solution:

Install the components setup files to the Downloads page. For details on installing the component
setup files on a Windows platform, see Installing Component Setup Files.
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General connectivity problems related to ports

Verify that all ports required by BSM servers are not in use by other applications on the same machine.
To do so, open a Command Prompt window, and run netstat (or use any utility that enables you to view
port information). Search for the required ports.

You can also check the <HPBSM root directory>\log\Jboss
\jboss_boot.log for ports in use. If the jboss_boot.log reports "Port <> in use" but you do not see
that this port is in use when you run netstat utility, restart the server and then start BSM.

For details on the ports required by BSM, see Port Usage in the BSM Hardening Guide.

Tip: To troubleshoot port usage problems, use a utility that lists all ports in use and the application
that is using them.

BSM connectivity is down, but the Tomcat servlet engine and jboss
application server appear to be working

Connectivity problems include the inability to log into BSM, and the inability of Business Process
Monitor to connect to the Gateway Server.

Possible Cause:
This can happen if the Topazinfra.ini file is empty or corrupt.

To verify that this is the problem:
1. Inthe browser, type http://<Gateway Server>:29000/ to connect to the JMX Console.

If prompted, enter the JMX Console authentication credentials (if you do not have these
credentials, contact your system administrator).

2. Under System > JMX MBeans > Topaz, select Topaz:service=Connection Pool
Information.

3. Click the showConfigurationSummarylnvoke button toward the bottom of the page. If the
Operation Result page is blank, the Topazinfra.ini file is empty or corrupt.

Solution:

To solve this problem, rerun the Setup and Database Configuration utility and either reconnect to your
existing management database or define a new management database. If you did not discover a
problem with the Topazlnfra.ini file, contact HP Software Support.

Inability to log into BSM, and jboss application server fails to initialize

Run the database schema verify program to verify that the database server on which the management
database is located is up and running. For details, see Database Schema Verification in the BSM
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Database Guide.

Browser unable to reach BSM and an error about insufficient heap space

A message box opens indicating that BSM is not available and you should try logging in at a later time.
Possible Cause 1:
Check log files in <HPBSM root directory>\log directory for errors.

Microsoft's Security Update 921883 for Windows 2003 Service Pack 1 and for Windows XP
Professional x64 Edition may cause applications using more than 700 MB of contiguous memory to fail.
BSM JVM uses a heap size larger than 768 MB memory. For more information about Security Update
921883, see http://www.microsoft.com/technet/security/Bulletin/MS06-040.mspx.

If the BSM server goes down, look for the following errorin <HPBSM server root
directory>\log\jboss_boot.log when the service or process is restarted:

Error occurred during initialization of VM.
Could not reserve enough space for object heap.

Solution:

Although Microsoft has a hotfix available only for Microsoft Support customers, it is recommend to wait
for the next Service Pack release. For more information about this hotfix, see
http://support.microsoft.com/kb/924054.

If Security Update 921883 is already installed, do the following:
« Ifthe Security Update is not critical at your site:
= Uninstall it and wait for Microsoft's next Service Pack.

m Disable Windows Automatic Updates to prevent Security Update 921883 from being installed
again.

« Ifthe Security Update is critical at your site, install the hotfix.

Possible Cause 2:
The page file size is too small.
Solution:

Configure the page file size to be at least 150% of RAM size. Restart the server.

Browser unable to reach BSM or the .jsp source code appears in the browser
window

A message box opens indicating that the BSM page does not exist.

Solution:
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Ensure that the Jakarta filter path is correct. The path might be incorrect—for example, if you uninstall
BSM servers and then reinstall to a different directory. In this case, the Jakarta filter path is not
updated, causing redirection problems.

To update the Jakarta filter path:
1. Open the IIS Internet Services Manager.
2. Right-click the machine name in the tree and select Properties.
3. With WWW Service displayed in the Master Properties list, click Edit.
4. Select the ISAPI Filter tab.
5. Select jakartaFilter and click Edit.

6. Inthe Filter Properties box, update the path to point to the drive and directory of the current BSM
installation.

7. Apply your changes and quit the Internet Services Manager.

8. Restart the |IS service.

BSM is sitting behind a proxy and the server name is not recognized by the
proxy

The problem occurs for both Microsoft IIS and Apache web servers.

Possible Cause:

The web server redirects the browser page to a URL that replaces the server name entered by the user.
Solution:

Add the BSM server name to the <Windows system root directory>\system32\drivers\etc\hosts
file on the proxy server machine.

Host names of Gateway or Data Processing Server have changed

You can no longer access BSM using the server names on which they were installed and must change
the names of the servers. Refer to the HP Software Self-solve knowledge base, article number
KM522738, which can be accessed at http://h20230.www2.hp.com/selfsolve/document/KM522738.

Processes do not resume restart automatically after automatic failover

If the High Availability Controller's Automatic Failover mode is enabled and the management database
has been down for some time, some processes may be stopped and will not resume automatically
when the management database returns to normal operation. These processes will have the status
STARTING on the BSM Status page, accessible on the Windows operating system from Start >
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Programs > HP Business Service Management > Administration > HP Business Service
Management Status).

Solution:

Restart these processes once the management database is available again.

Applets may take longer to open for clients with JRE 7 update 25 and later

This is due to Java security enhancements. Before Java applets and Java Web Start applications run,
the signing certificates are checked to ensure that a signing certificate was not revoked.

If there is a proxy problem or any other network issue, you should disable this Java feature.

To disable Java from performing certificate revocation checks:
1. Click the Start button and select the Control Panel option.
2. Click the Javaicon to open the Java Control Panel.
3. Click the Advanced tab.

4. Locate and deselect the option to perform certificate revocation checks.

Unable to access a BSM component that requires the Java applet (Windows
system only)

If a user tries to access a BSM component that requires the Java applet, the component may not open
and the following error appears int he Java console log:

java.io.IOException: Error © writing to WindowsNamedPipe: server: false; readPipe:
jpi2_pid20984 pipe8, readBufferSz: 4096; writePipe: jpi2_pid20984 pipe9,
writeBufferSz:

at sun.plugin2.message.transport.NamedPipeTransport$SerializerImpl.flush(Unknown
Source)

at sun.plugin2.message.transport.NamedPipeTransport.signalDataWritten(Unknown

Source)
at sun.plugin2.message.transport.SerializingTransport.write(Unknown Source)
at sun.plugin2.message.Pipe.send(Unknown Source)

This error is due to a link (or ‘heartbeat’) between the browser's JRE and the client’s JRE. If the
browser's virtual machine and the local system's Java virtual machine are not able to communicate for
that thread within 10 seconds, the local machine's JVM kills the thread.

If this situation occurs, create the following environment variable JPI_PLUGIN2_NO_HEARTBEAT =
1 on the customer’s client system.
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To create the environment variable:

1. Onthe desktop of the customer’s client system, right-click the Computer icon and select
Properties.

2. Click Advanced system settings. The System Properties dialog box appears.
3. Click Environment Variables. The Environment Variables dialog box appears.
4. Inthe System variables area, click New. The New System Variable dialog box appears.
5. Enter the following information:
m Variable Name: PI_PLUGIN2 NO_HEARTBEAT
= Variable Value: 1

6. Click OK.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on BSM Platform Administration Guide (Business Service Management 9.26)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to SW-doc@hp.com.

We appreciate your feedback!
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